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About the Edge SWG (ProxySG) Admin Console
The Edge SWG (ProxySG) Admin Console is the next-generation web interface for the Edge SWG (ProxySG) appliance,
designed to help youmanage andmonitor the appliancemore efficiently. The Admin Console is the successor to the
Java-basedManagement Console and can be accessed through the latest browsers.

To access the Admin Console, you require SymantecManagement Center. See "Compatibility Information" below for
supported software versions to access the Admin Console.

This documentation applies to all versions of SGOS running the Edge SWG (ProxySG) Admin Console. Differences
amongst versions are noted in documentation where appropriate. See "Documentation Conventions" on page 16 for
information.

Note: Some features can't be configured in the Admin Console; youmust use the CLI to
complete some tasks. See the CLI documentation on Tech Docs formore information.

Compatibility Information
The Admin Console supports the following product and browser versions:

Supported Versions

n SGOS 6.7.4 and later

n Advanced Secure Gateway 6.7.4 and later

Tip: Use the Admin Console to manage Edge SWG (ProxySG) configuration only; for
Content Analysis configuration, use the Advanced Secure Gateway management
console.

n Management Center version 2.4.x and later

Tip: Users require appropriate read/write permissions to view and work in the Admin
Console viaManagement Center. For information on role-based administration in
Management Center, and to download the Admin Console installation package, refer
to Management Center documentation.

Supported Browsers

You can use the Admin Console in the latest versions of the following web browsers:
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n Apple Safari

n Google Chrome

n Microsoft Edge

n Mozilla Firefox

Getting Started
If this is your first time using the Edge SWG (ProxySG) appliance or the Admin Console, perform the following steps:

1. Refer to the Edge SWG (ProxySG) Release Notes for your version to learn about features, known issues, and bug
fixes.

2. (If upgrading) Refer to the Edge SWG (ProxySG) Upgrade/Downgrade documentation to learn about important
upgrade information, behavior changes, and removals.

3. Create amyBroadcom account. You need an account to register your appliance and retrieve the license key.

Refer to Knowledge Base article 145885: https://knowledge.broadcom.com/external/article?articleId=145885

4. (Recommended) Review the following topics in this help system:

n "Navigate the Admin Console" on the next page

n "Documentation Conventions" on page 16
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Navigate the Admin Console
Refer to the following topics to learn about navigating the Admin Console, including this help system.

Functional Area
The Admin Console divides functions into four areas, represented by icons in the navigation pane:

n Dashboard: Allows you to quickly view important device data.

n Reports: Look at statistics about the appliance

n Configuration: Configure all aspects of the appliance, such as network, services, policy, andmore.

n Administration: Manage the appliance license, upgrades, data services, and diagnostics.

To collapse or expand the navigationmenu, select the < > at the bottomof the pane.

See the "Example" on page 9 below.

Default View and Compact View
By default, the Admin Console displays areas in Detailed View:

To display links in compact groups without descriptions, select Compact View:
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Saving Favorites
In both Detailed View and Compact View, you can savework areas that you often use for quick access later. Hover over
an option and select the star that appears, as shown in Compact View below:

You can also save frequently-used work areas at the top of each page:

After you save a favorite, it appears under Favorites:
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To remove a favorite, select the star beside its name.

Breadcrumbs
Pages in the Admin Console are organized hierarchically. Use the breadcrumb links at the top right of each page to
identify your location in a process. See the "Example" on the facing page below.

Navigation
You can navigate pages within the Admin Console using several methods:

n Move down tomore specific levels: Select the link on a page, depending on context. In the following example, you
can select the Policy Options link.

The following shows the links in Compact View:
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n Move up to more general levels: Select a link in the breadcrumbs on the top right. In the following example, you
can select the Policy link in breadcrumbs to go up one level. Select Configuration to go up two levels.

n (If applicable) Move to another page at the same level as the current page: If the breadcrumbs shows the current
pagewith an arrow, select it to see other pages. In the preceding example, select Policy Options to go to
Exception Pages, which is also under Configuration > Policy.

Example

In the following example:

n The navigationmenu is expanded.

n In themenu, Configuration is selected.

n Breadcrumbs show the navigation path Configuration > General > Time.

n You can select Time in the breadcrumbs to go to another page.
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Sorting and Filtering
Some columns in the Admin Console can be sorted; if you hover over a column name, it appears underlined to indicate it
can be sorted.

Select a column name to sort the rows in ascending (null, 0-9, A-Z) or descending order (Z-A, 9-0, null). An arrow appears
in the column header to indicate the sort order.

The following example shows the Interface column sorted in ascending order.

Column headers with a filter icon indicate that the column fields can be filtered. Select the filter icon and enter the filter
text in the dialog.

The filter icon turns blue to indicate that a filter is active and not all of the data is visible. Clear the filter by selecting the
filter icon and deleting the filter text.
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Changing Settings
TheActions column in some sections of the Admin Console displays options for editing and deleting settings or entries
in a section. Select the appropriate icon to edit or delete an entry. Sometimes, system-defined or default entries can't be
deleted; for these, only edit icons are available.

The following section shows that the default routing domain can be edited, but not deleted. The user-created domain1
can be edited or deleted.

Some defaults can't be edited or deleted, such as system-defined service groups. For these items, no icons are available
in theActions column.

Saving Changes
The Admin Console indicates if there are pending changes while you work:

11 of 676



SGOS Administration (Admin Console Edition)

Select Save to save changes. Alternatively, you can select Show Pending to display pending CLI changes; see
"Save Changes Confirmation" below for an example.

Otherwise, select Discard Changes to clear your changes. The settings revert to the previous configuration.

If there are no changes to save, the console indicates that you have unsaved pending changes. In addition, the Save
option is unavailable (grayed out) and there is noDiscard option.

If you navigate away from a page or dialog while changes are in progress, the console warns you to save changes or
discard them:

Save Changes Confirmation
When you save changes, the Admin Console prompts you to confirm the action. The Save Changes dialog displays the
configuration changes you are about to make, including the underlying CLI commands that are executed.

In the following example, the CLI shows that saving changes will enable policy tracing for all proxy transactions. Selecting
Copy copies the CLI commands to the clipboard.
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Note: This dialog only confirms that changes are saved, and doesn't check the data you
enter (for example, whether a specified server URL is reachable or not).

Automatically Saved Changes
The Instant Save feature is available in some areas of the Admin Console when youmake configuration changes:
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These changes are applied immediately without confirmation from you.

Help Topics
Two kinds of help are available in the Admin Console:

n Select the ? icon at the top right of each Admin Console page to open a general help topic.

n To read a brief description about a section, select SHOW HELP. For full information on a topic, select the Learn
more link. The following example shows an expanded description.

Whenever you open a help topic, it is displayed within the hierarchy of the full Admin Console help system. For other
ways to navigate the help system:

n Browse the table of contents in the navigation pane.

n Type text into the Search field at the top of help pages.
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n Select links in the breadcrumbs at the top of help pages.

n Use cross-reference links throughout the documentation.
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Documentation Conventions
This help systemprovides comprehensive information to help you configure and use the Edge SWG (ProxySG) appliance.
Refer to the following to understand the help system's conventions.

Help System Version
The Admin Console has a single-version help system. Thismeans that the same documentation is available for versions
6.7.x and 7.x. Any feature or behavior differences between versions are described in the help.

Typography
The following table lists the typographical conventions as well as CPL and CLI syntax conventions used in this guide.

Convention Usage Example

bold text Labels, such as page and dialog names, in the Admin
Console.

Select Allow or Deny.

bold text
separated by >

Navigation path in the Admin Console. Select Configuration > Policy > Policy
Options.

fixed-width text CLI input/output, CPL, log output, other output. Download log:
Local database download at:
2021/08/11 17:40:42-0400
...

fixed-width
text, bold

In CLI or CPL, a literal string to be entered as shown. # (config proxy-services) dynamic-
bypass

fixed-width
text, italics

regular text, italics

CLI or CPL variable to be substituted with a literal name or
value.

Variable to be substituted with a literal name or value.

# (config dynamic-bypass) max-
entries number

{ } One of the CLI or CPL parameters enclosed within the
braces must be supplied.

# (config dynamic-bypass) {enable |
disable}

| The CLI or CPL parameter before or after the pipe
character can or must be entered.

[ ] Optional CLI or CPL parameter. # (config dynamic-bypass) [no]
trigger all

Procedures
When you follow a procedure in this document, youmight not want to save the changes immediately. For this reason, all
procedures omit the final step of saving or applying changes.
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If you attempt to navigate away from a pagewith unsaved settings, the Admin Console prompts you with anUnsaved
pending changes dialog.

See "Navigate the Admin Console" on page 6 formore information.

Abbreviations
This help system includes abbreviated terms. See Abbreviations for the expanded forms and definitions of the terms.
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Configure the Edge SWG (ProxySG) Appliance
Refer to the following topics to learn to configure Edge SWG (ProxySG) features:

n "Manage Edge SWG (ProxySG) Policy" on the facing page

Configure global policy settings such as default proxy policy (Allow or Deny) and policy coverage. Customize policy
evaluation order for policy files. Configure policy exception response pages.

n "ConfigureNetworking" on page 57

Configure network settings including physical interfaces, VLANs, link aggregate interfaces (LAGGs), and bridges.
Configure routing, IP forwarding, and routing domains. Configure DNS forwarding. ConfigureWCCP for
acceleration. Set up forwarding hosts and groups. Set up SOCKS gateways and groups for forwarding. Configure
advanced settings including virtual IP addresses and failover groups.

n "Manage Edge SWG (ProxySG) Services" on page 168

Configure access to the Edge SWG (ProxySG) appliance via HTTP, HTTPS, SSH, SNMP, and Telnet. Specify whether
to intercept or bypass traffic matched to IP address/port and configure how the appliance proxies the traffic.
Specify global settings that apply to all proxies. Configure the SSL proxy. Drop or reject traffic (SGOS 7.3.2+).
Configure UDP tunnel flows (SGOS 7.3.4+).

n Malicious Content Scanning Services

Add and configure ICAP services, ICAP feedback and ICAP patience page. Configure Edge SWG (ProxySG) to work
in conjunction with Symantec threat-protection appliances to analyze incoming web content and protect users
frommalware andmalicious content.

n "Configure SSL and Device Authentication" on page 259

Configure SSL on the appliance for secure connections. Configure keyrings and associate themwith self-signed
certificates or create certificate signing requests (CSRs) to import certificates signed by a certificate authority (CA).
Manage CA certificates, external certificates, and SSL device profiles. If required for your environment, change the
SSL client settings. Import Certificate Revocation Lists (CRLs) to check server and client certificates against CA lists
of expired and invalid certificates. Add configured Online Certificate Status Protocol (OCSP) responders to
perform real-time certificate revocation checks and send certificate statuses to the appliance. Add a configured
Thales LunaHSM to the appliance. Offload SSL/TLS traffic to configured SSL Visibility (SSLV) devices.

n "Authenticate Administrators and Users" on page 319

Manage administrator access to the appliance, including login credentials and serial console access. Control who
can access the Admin Console and CLI via access control list (ACL). Configure IWA-BCAAA, IWA-Direct, LDAP,
RADIUS, or SAML authentication realms. ConfigureWindows Domains. Manage inbound and outbound SSH
connections.
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Manage Edge SWG (ProxySG) Policy
Refer to the following topics to learn about managing policy on the Edge SWG (ProxySG) appliance:

n "Configure Policy Options" on the next page

Set the appliance policy to Allow or Deny, and enable or disable policy coverage. Customize policy evaluation
order for policy files.

n "About Policy Exception Pages" on page 25

Configure response pages which are presented to users based on policy rules defined by the Edge SWG (ProxySG)
administrator, such as denial by policy.

See Also:

n Web Visual Policy Manager Reference

n Content Policy Language Reference
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Configure Policy Options
Policy options allow you to change the default transaction setting, enable policy coverage, and re-order policy
evaluation.

Transaction Settings: Deny and Allow
The default proxy transaction policy is to either deny proxy transactions or to allow proxy transactions.

A default proxy transaction policy of Deny prohibits proxy-type access to the appliance; youmust then create policies to
explicitly grant access on a case-by-case basis.

A default proxy transaction policy of Allow permitsmost proxy transactions; however, if protocol detection is enabled,
the appliance allows HTTP CONNECT for both port 443 and other ports—provided the appliance detects a known
protocol. If protocol detection is disabled, HTTP CONNECT is only allowed on port 443. If your policy is set to Allow, you
must create policies to explicitly deny access on a case-by-case basis.

Note: The default proxy policy does not apply to admin transactions. By default, admin
transactions are denied unless you log in using console account credentials or if explicit
policy is written to grant read-only or read-write privileges.

What is the default proxy policy?

n If you installed SGOS using the front panel or a serial console port, the default setting is Deny.

n If you upgraded SGOS from a previous version, the default remains whatever it was for the previous policy.

Note: Changing the default proxy transaction policy affects the basic environment in
which the overall policy is evaluated. It is likely that youmust revise policies to retain
expected behavior after such a change. Changing the default proxy transaction policy
does not affect the evaluation of cache and admin transactions.

To set the default proxy policy, select Allow orDeny.

View Policy Coverage Statistics
Policy coverage reports on the rules and objects that match user requests processed through the appliance’s current
policy. You can enable the feature and view the Advanced URL statistics. Refer to KB 165841 formore information.

View policy coverage statistics:
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1. In the Admin Console, select Configuration > Policy > Policy Options.

2. In the Policy Options section, select the Enable Policy Coverage (Hit Count) switch.

3. Select the Show Policy Coverage link to display the policy coverage Advanced URLs. If needed, enter the Edge
SWG (ProxySG) username and password.

Note: The browser prompt shows theManagement Center IP address, but the credentials
you require are for the Edge SWG (ProxySG) appliance.

The first time you open an Edge SWG (ProxySG) device link, the browser prompts you to log in. After a successful
authentication, you should not be prompted to enter credentials for the device again, unless they are changed or
removed in the Edge SWG (ProxySG) configuration. In this case, enter valid credentials.

Keep the Central Policy File Up to Date
By default, the central policy file on the Edge SWG (ProxySG) appliance ismanaged by Broadcom.

Keep the central file up to date:

1. In the Admin Console, select Configuration > Policy > Policy Options.

2. In the Policy Options section, select one or both of the following options:

n Automatically Install New Policy When Central File Changes: Update the current policy in the event
of a central policy change.

n Send Me Email Notification When Central File Changes: Email a notification in the event of a central
policy change. The email address is the same as that used in diagnostic reporting (the event recipient for
the customheartbeat email).
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Manage Policy Files
The order in which the appliance evaluates policy rules is significant. Changes to the evaluation order can result in
different effective policy, as the order of policy evaluation defines general rules and exceptions. While this order is
configurable, the default and recommended order is:

n VPM

n Local

n Central: The Central policy file is updated when needed by Symantec. The file can be updated automatically or you
can request e-mail notification. You can also configure the path to point to your own customCentral policy file.

Note: If you import policy that was created externally (for example, by a third-party
tool) into a policy file, the Edge SWG (ProxySG) appliance validates the policy file's
contents for syntax errors but cannot check for formatting or typographical
mistakes. Such errorsmay result in unintended behavior after the policy is loaded.
Review the CPL in imported policy for correctness before installing the file.

n Forward

This order prevents policies in the Central file that block virus signatures frombeing inadvertently overridden by allow
(access-granting) policy rules in the VPM and Local files.

On an upgraded appliance, the policy evaluation order is the order that existed on the appliance before the upgrade.

View Installed Policy
To view installed policy files in the VPM:

1. In the Admin Console, select Configuration > Policy > Policy Options.

2. In the Policy Files section:

n Select Show Current Policy to view the installed and running policy, as assembled from all policy source
files.

n Select Show Last Install Status to view any warnings or errors resulting from the last attempt (successful
or not) to install policy.

The source file opens in a new browser tab. If needed, enter the Edge SWG (ProxySG) username and password.
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Note: The browser prompt shows theManagement Center IP address, but the
credentials you require are for the Edge SWG (ProxySG) appliance.

The first time you open an Edge SWG (ProxySG) device link, the browser prompts you to log in. After a successful
authentication, you should not be prompted to enter credentials for the device again, unless they are changed or
removed in the Edge SWG (ProxySG) configuration. In this case, enter valid credentials.

Change the Policy Evaluation Order
To change policy order, use the arrows in theActions column tomove files up and down on the list.

Tip: When changing the policy file evaluation order, remember that decisions from files
later in the order can override decisions from earlier files.

Formore information on policy files, refer to the Content Policy Language Reference.

Install and Edit Policy Files
Compose CPL in the CPL Layer using one of the followingmethods:

n Use the appliance Text Editor, which allows you to enter directives (or copy and paste the contents of an existing
file) directly onto the appliance.

n Create a file on your local system; the appliance can browse to the file and install it.

n Use a remote URL, where you place an already-created file on an FTP or HTTP server to be downloaded to the
appliance.

The appliance compiles the new policy from all source files and installs the policy, if the compilation is successful.

If errors or warnings are produced when you load the policy file, a summary of the errors and/or warnings is displayed
automatically. If errors are present, the policy file is not installed. If warnings are present, the policy file is installed, but
thewarnings should be examined.

Install and edit policy files:

1. In the Admin Console, select Configuration > Policy > Policy Options.

2. In the Policy Files section, select the Edit icon beside the appropriate policy file.

3. To install the VPM policy file, select the Edit icon.

4. In the Edit Visual Policy File dialog, select one of the following options:
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n Install VPM-CPL: Install the policy file that is automatically generated whenever policy is installed in the
VPM.

n Install VPM-XML: Install the XML file that defines the look and feel of the VPM, such as information on
layers, their order, all objects created, and policy-based category lists.

Then, use one of themethods described in the following table.

5. To install or edit the local, central, or forward policy file, select the Edit icon. Then, use one of themethods
described in the following table.

Method Instructions

Text editor 1. Select Install from Text Editor.

2. In the Load Edit and Install from text editor dialog, enter the contents manually or copy and paste the
contents from another file.

3. Select Install.

Local file 1. Select ... > Local File.

2. In the Load Edit and Install from local file dialog, browse to the directory of the file on the local system.

3. Select Install.

Remote
URL

1. Select ... > Remote URL.

2. In the Load Edit and Install from remote URL dialog, enter the fully-qualified URL, including the filename,
where the file is located.

3. Select Download.

View Policy Source Files
Use the Admin Console to display uncompiled policy files.

To view installed policy source files:

1. In the Admin Console, select Configuration > Policy > Policy Options.

2. In the Policy Files section, select the View icon beside the appropriate policy file. For VPM policy, select VPM-
CPL orVPM-XML.

The policy file opens in a new browser tab.
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About Policy Exception Pages
Exception pages areweb pages displayed to users under specified conditions, and are intended to provide feedback to
users about errors and policy actions. When users request a URL that triggers such an error or action, exception pages
are returned to theweb browser instead of users' requested content.

The appliance ships with a number of predefined exceptions, which you can usewith or without customization. In
addition, you can create custom exception pages. See "Exception Page Types" on page 27.

Exception definitions consist of specific fields, such as details and summary, which provide information about the
exception. The format field in an exception definition contains valid HTML to format the exception page (applicable to
HTTP responses). You can also include substitution variables in any part of the exceptions page. See "
Exception Definition Overview" on page 33.

Implement Exception Pages
Implementing exception pages consists of two steps:

1. Creating or editing exception pages:

n Creating and installing user-defined exception pages.

n Updating existing built-in or user-defined exception pages.

See "Examples: Create and Update Exception Pages" on page 42.

2. Referencing the exception pages in policy.

While configuring policy, you can also override the exception's current definition for the specific policy rule. See
"Include Exceptions in Policy" on page 50.

Note: Exception pages are returned to users whose requests are intercepted andmatch
the policy conditions. See "Change the State of a Proxy Service" on page 178 for details on
setting services to Intercept.

Tip: Enable access logging to record when exceptions are returned and users' ensuing
actions. See "Configure Edge SWG (ProxySG) Logging" on page 559.

See Also:

n "Manage Policy Exceptions" on page 39

n "Exception Page Types" on page 27
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n " Exception Definition Overview" on page 33

n "Include Exceptions in Policy" on page 50

26 of 676



SGOS Administration (Admin Console Edition)

Exception Page Types
Exceptions are sent in response to certain Edge SWG (ProxySG) client requests, such as denial by policy, failure to handle
the request, and authentication failure. Exceptions are returned to users based on policy rules defined by the Edge SWG
(ProxySG) administrator. For example, if a client sends a request for content that is not allowed, an exception HTML
page (for HTTP connections) or an exceptions string (for non-HTTP connections) is returned, informing the user that
access is denied.

Two types of exceptions can be used on the appliance: "Built-in Exceptions" below and "User-Defined Exceptions" on
page 32.

Built-in Exceptions
Built-in exceptions are a set of pre-defined exceptions. They send information back to the user under operational
contexts that are known to occur, such as policy_denied or invalid_request.

Built-in exceptions are always available and can also have their contents customized; however, they can't be deleted. To
edit a built-in exception, see "Configure Exception Pages" on page 40.

The table below lists the built-in exceptions and the context under which they are issued.

Exception
Type

HTTP Response
Code

Issued When...

authentication_
failed

401 The transaction cannot be authenticated, usually because the credentials were incorrect.
authentication_failed is a synonym for deny.unauthorized.

bad_credentials 400 The username or password were sent using an invalid/ unrecognized format. This can
have two causes:

n The username or password contains non-ASCII characters, and the appliance is
not configured to use the same authentication character encoding as is being used
by the web browser.

n The username or password is too long. (The limits for the username and password
are 64 bytes each,after being translated to UTF-8.)

client_failure_
limit_ exceeded

503 Too many requests from your IP address ($(client.address)) have failed.

configuration_
error

403 A configuration error on the appliance was detected, and the requested operation could
not be handled because of the configuration error. This exception is a likely indicator that
the administrator of the Edge SWG (ProxySG) must intervene to resolve the problem.

connect_
method_denied

403 A user attempted an CONNECT method to a nonstandard port when explicitly
proxied.Symantec does not allow CONNECT methods to non-standard ports by default
because it is considered a security risk to do so.

content_
encoding_error

502 A Web site presented a content encoding header of one type but encoded the data
differently
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Exception
Type

HTTP Response
Code

Issued When...

content_filter_
denied

403 A particular request is not permitted because of its content categorization.

content_filter_
unavailable

403 An external content-filtering service could not be contacted, and the appliance is failing
closed in such a situation.

dns_server_
failure

503 The request could not be processed because the appliance was unable to communicate
with the DNS server in order to resolve the destination address of the request.

dns_
unresolved_
hostname

404 The request could not be processed because the appliance was unable to resolve the
hostname in the request with DNS.

dynamic_
bypass_reload

200 The dynamic_bypass policy action is matched.

gateway_error 504 There was a network error while attempting to communicate with the upstream gateway.

icap_
communication_
error

504 A network error occurred while the appliance was attempting to communicate with an
external ICAP server.

icap_error 504 A network problem occurred, the ICAP service might be misconfigured, or the ICAP server
might have reported an error.

internal_error 500 The appliance encountered an unexpected error that resulted in the inability to handle the
current transaction.

invalid_auth_
form

403 The submitted authentication form is invalid. The form data must contain the username,
password, and valid original request information.

invalid_request 400 The request received by the appliance was unable to handle the request because it
detected that there was something fundamentally wrong with the syntax of the request.

invalid_
response

502 The server's response could not be processed because of a malformed response or a
misconfiguration.

license_
exceeded

403 Access is denied because a license has been exceeded on the proxy, and the request is
not permitted.

license_expired 403 The requested operation cannot proceed because it would require the usage of an
unlicensed feature.
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Exception
Type

HTTP Response
Code

Issued When...

method_denied 403 The requested operation utilizes a method that has been explicitly denied because of the
service properties associated with the request.

not_
implemented

501 The protocol cannot handle the requested operation because it utilizes a feature that is
not currently implemented.

notify 200 Used internally by the VPM. You do not need to customize the text of this exception, since
in this case the entire HTML response is generated by VPM and is not taken from the
exception definition.

notify_missing_
cookie

403 This exception is returned when a Notify User action is being used to notify the user, and
the user has disabled cookies in the Web browser.

policy_denied 403 policy_denied is a synonym for deny.

policy_redirect 302 A redirect action is matched in policy.

radius_splash_
page

200 The user is authorized. Click the refresh button on the browser to proceed to the
requested site. The user/ session ID is $(x-radius-splash-username)/$(x-radiussplash-
session-id)

redirected_
stored_
requests_ not_
supported

403 This applies to forms authentication with POST requests only): The origin server returned
a redirect for the request. The appliance is configured to not allow stored requests to be
redirected.

refresh 200 A refresh (using the HTTP Refresh: header) is required. The refresh exception (by default)
refreshes the originally requested URL (or in some cases, its post-imputed form).

server_request_
limit_ exceeded

503 Too many simultaneous requests are in progress to $(url.host).

silent_denied 403 An exception(silent_denied) is matched in policy. This exception is pre-defined to have no
body text, and is silent in that it results in only the status code being sent to the client.

server_
authentication_
error

500 Internal error. The appliance encountered an internal error while preparing to send the
username/password upstream. This error can only occur when the appliance “server
authentication” feature is enabled.

ssl_client_cert_
expired: Expired
SSL Client
Certificate

503 A web site presents an incorrect or invalid certificate or a configuration error has
occurred.

ssl_client_cert_
ocsp_check_
failed OCSP
Error On Client
Certificate

503 An error occurred while checking the revocation status of the certificate.
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Exception
Type

HTTP Response
Code

Issued When...

ssl_domain_
invalid: SSL
Certificate Host
Mismatch

409 There was a failure contacting a web site through HTTPS because the certificate has a
common name that does not match the web site's domain name.

ssl_failed: SSL
Certificate
Verification
Error

503 A secure connection could not be established to an web site. This typically occurs when a
web site that is not configured to accept SSL connections.

ssl_server_cert_
expired: Expired
SSL Server
Certificate

503 A Web site presents an incorrect or invalid certificate or a configuration error has
occurred.

ssl_server_cert_
ocsp_check_
failed OCSP
Error On Server
Certificate

503 An error occurred while checking the revocation status of the certificate.

ssl_client_cert_
revoked:
Revoked SSL
Client
Certificate

503 The client presents a revoked certificate or a configuration error has occurred.

ssl_client_cert_
ocsp_status_
unknown:
Unknown OCSP
Status of Client
Certificate

503 An OCSP check returned unknown status for a client certificate.

ssl_client_cert_
untrusted_
issuer
Untrusted SSL
Client
Certificate

503 A Web site presents an incorrect or invalid certificate or a configuration error has
occurred.

ssl_server_cert_
ocsp_status_
unknown
Unknown OCSP
Status of Server
Certificate

503 The server certificate revocation status is unknown. This is caused by a certificate
revocation check for which the server does not have a status.
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Exception
Type

HTTP Response
Code

Issued When...

ssl_server_cert_
revoked:
Revoked SSL
Server
Certificate

503 A Web site presents a revoked certificate or a configuration error has occurred.

ssl_server_cert_
untrusted_
issuer:
Untrusted SSL
Server
Certificate

503 A Web site presents an incorrect or invalid certificate or a configuration error has
occurred.

tcp_error 503 A network error occurred attempting to communicate with an upstream host.

transformation_
error

403 The server sends an unknown encoding and the appliance is configured to do content
transformation.

unsupported_
encoding

406 The client makes a request with an Accept- Encoding: Identity;q=0, … header. Only
uncompressed content is available in cache, the appliance is not configured to compress
the content, or the compression license is expired, or the client request results in to
Accept-Encoding: Identity;q=0 because of the combination of request and configured
policy.

unsupported_
protocol

406 The protocol used in the request is not understood.

upstream_407_
rejected

407 An authentication challenge (HTTP status code 407 "Proxy authentication required") from
an upstream OCS was blocked.

virus_detected 200 Virus was detected in the content.

data_leak_
detected

200 A violation of DLP policy was detected in the content.

The ICAP response must contain the following:

n X-Violations-Found in the HTTP header

n dlp string in the Server header

Somebuilt-in exceptions can be initiated directly through the exception() action (or in the VPM, theReturn Exception
object). Some require additional states, whichmakes initiating them either problematic or out of context. The following
are exceptions that can't be initiated though policy:

n authentication_failed

n authentication_failed_password_expired

n authentication_redirect_from_virtual_host
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n authentication_redirect_to_virtual_host

n authentication_success

n dynamic_bypass_reload

n license_expired

n ssl_domain_invalid

n ssl_failed

To view the contents of a built-in exception, enter the show exceptions exception_id at the #(config) prompt, as
follows:

#(config) exceptions
#(config exceptions) show exceptions configuration_error
configuration_error exception:
all protocols:
summary text:

SG configuration error
details text:

Your request could not be processed because of a configuration error: $(exception.last_error)
help text:

The problem is most likely because of a configuration error, $(exception.contact) and provide
them with any pertinent information from this message.
http protocol:

code: 403

User-Defined Exceptions
User-defined exceptions are created and deleted by the administrator. If a user-defined exception is referenced by
policy, it can't be deleted. The default HTTP response code for user-defined exceptions is 403. To create and edit user-
defined exceptions, see "Configure Exception Pages" on page 40.

See Also:

n "About Policy Exception Pages" on page 25

n " Exception Definition Overview" on the facing page

n "Examples: Create and Update Exception Pages" on page 42
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Exception Definition Overview
In Edge SWG (ProxySG) appliance policy, an exception definition is a file that specifies the contents and appearance of
exception pages that are returned to users. Exception definitions are either built-in or user-defined.

You can deploy exceptions with their default values (some fields are undefined by default), whichmeans that the
browser presents plain exception pages withminimal information to the user. To provide specific error details,
organizational information, and custom styling, define the appropriate exception fields.

An exception definition file shows the fields in a structured data list format and allows you to define each field:

(exception.exception_id
(contact "") ; defines the $(exception.contact) variable <---- start of fields that apply to all protocols
(details "") ; the exception reason using the $(exception.details) variable
(format "") ; defines format of the HTML
(help "") ; defines the $(exception.help) variable 
(summary "") ; the exception message using the $(exception.summary) variable
(http ; specific settings for HTTP/S exceptions <---- start of fields that apply to just HTTP

(code "") ; valid HTTP response code to return to the client
(contact "") ; defines the $(exception.contact) text 
(details "") ; HTML exception detail text
(format "") ; HTML exception format with variables
(help "") ; defines the $(exception.help) text 
(summary "") ; short name for $(exception.summary)

) <---- closing tag for HTTP fields
) <---- closing tag for exception definition

To view exception definition files, in the Admin Console, select Configuration > Policy > Exception Pages.

Exception Fields
Refer to the following descriptions of exception fields:

Field name Description

exception.exception_id Specifies the exception identifier:

n A built-in exception is called exception.exception_
id, where exception_id is the exception type. See
"Exception Page Types" on page 27 for the built-in
exception types.

n A custom exception is called exception.user-
defined.exception_id, where exception_idis a
name you specify.
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Field name Description

contact Sets site-specific contact information that can be used in all
exceptions. It is possible to customize contact information per
exception, but setting the top-level contact information for all
exceptions is sufficient in most environments.

format Controls the appearance of the exception page. For an HTTP
exception response, the format is an HTML file. For other
protocol responses that can't render HTML, the exception
page returns a single line.

summary Gives a reason for the exception. For example, the default
policy_denied exception summary is “Access Denied”.

details Describes in more detail the reason for the exception. For
example, the default policy_denied exception (for the HTTP
protocol) detail is Your request has been denied by
system policy.

help Provides possible causes and potential steps for users to take.
For example, to review URL categories, append the
$(exception.category_review_url) and
$(exception.category_review_message) substitutions to
the $(exception.help) definition. See "Use Substitution
Variables in Exceptions" on page 36 and
SGOS Administration Guide for details.

http Specifies the HTTP response code to use when the exception
occurs. For example, the policy_denied exception by default
returns the 403 Forbidden HTTP response code.

Note: Fields other than formatmust contain fewer than 8000 characters. Characters
exceeding this limit are not shown to the user.

Recommendations for Modifying Exception Files

n To prevent issues fromoccurring with exception pages in production, download the existing exception file, modify
it locally, and then install the new file.

n To ensure correct syntax, begin each file with a definition for exception.all. End each file with the
exception.all closing parenthesis:

(exception.all
(exception.policy_denied)
...
)
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n Before deleting a user-defined exception, check if it is referenced in installed policy. Remove the reference from
policy, reinstall policy, and then delete the exception.

How Fields Inherit Definitions
Exceptions are stored on the appliance in a hierarchical model. Two parent exceptions, exception.all and
exception.user-defined.all, provide definitions that all child exceptions inherit. Child exception files don't need each
field to be defined as long as they inherit definitions fromone of the parent exceptions.

The user-defined.all exception is the parent of all user-defined exceptions, but it is also a child of exception.all.
Configuring exception.user-defined.all is only necessary if you want certain fields to be common for all user-defined
exceptions, but not common for built-in exceptions.

Note: By default, the built-in exceptions don't define the format field; however, because
each built-in and user-defined exception derives its default values from exception.all,
built-in exception format fields inherit the exception.all's format field definition. To
change the format text for all built-in and user-defined exceptions, customize the format
field in exception.all.

See Also:

n "Use Substitution Variables in Exceptions" on the next page

n "Examples: Create and Update Exception Pages" on page 42
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Use Substitution Variables in Exceptions
When defining exception fields, you can use substitution variables to generate details specific to the request. Refer to
the Content Policy Language Reference at Tech Docs for information on substitution variables.

Some exception fields can be configured as substitutions:

n $(exception.id)

n $(exception.summary)

n $(exception.details)

n $(exception.help)

n $(exception.contact)

Additionally, the format, summary, details, help, and contact fields can be configured specifically for HTTP in the http
section of the format, or configured commonly for all protocols. See "Use Substitution Variables in Exceptions" above for
an example.

The format field contains theHTML body of the exception. It is not available as a substitution itself, but it can include
substitutions. The following is a simple HTML format that uses substitution variables:

$(exception.id): $(exception.summary)
Request: $(method) $(url)
Details: $(exception.details)
Help: $(exception.help)
Contact: $(exception.contact)

Tip: Other useful substitutions related to exceptions:

- $(exception.last_error): Includes additional exception details when available.
- $(exception.reason): Shows the reason when the appliance terminates a transaction.
For example, a transaction that matches a DENY rule in policy has its
$(exception.reason) set to "Either 'deny' or 'exception' wasmatched in policy".

Specify Substitution Key-Value Pairs
You can specify substitution variables in key-value pairs in the exception file:

(exception.all
(format "This is an exception: $(exception.details)")
(details "")
(exception.policy_denied 
(format "")
(details "your request has been denied by system policy")
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)
)

In this example, policy_denied defines the $(exception.details) substitution as "Your request has been denied by
systempolicy". Because the policy_deniedformat field is undefined, it inherits the format field from its parent
exception (exception.all). When the policy_denied exception is issued, the resulting text is:

This is an exception: your request has been denied by system policy.

Configure a Substitution Variable Using the Command Line
Use the # (config exceptions) inline command to configure substitution variables. The following sets the
$(exception.contact) substitution for every HTTP exception:

# (config exceptions) inline http contact EOF
For assistance, contact <a href="mailto:sysadmin@example.com">sysadmin</a>EOF

To configure a different $(exception.contact) substitution for every HTTP exception:

# (config exceptions) user-defined inline http contact EOF
For assistance, contact <a href="mailto:policyadmin@example.com">policyadmin</a>EOF

Customize a Substitution Variable in the Exception File
To customize the $(exception.contact) substitution variable for every HTTP exception, edit the exception.all
element:

(exception.all
(contact "For assistance, contact your network support team.")
(details "")
(format "$(exception.id): $(exception.details)")
(help "")
(summary "")
(http 

(code "200")
(contact "")
(details "")
(format <<EOF

<format_contents>
EOF
    )

(help "")
(summary "")

    )
<built_in_exceptions>

)
)

To add the $(exception.contact) information, modify the contact substitution variable under the http element:
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(exception.all
(contact "For assistance, contact your network support team.")
(details "")
(format "$(exception.id): $(exception.details)")
(help "")
(summary "")
(http

(code "200")
(contact "For assistance, contact <a href="mailto:sysadmin@example.com">sysadmin</a>")EOF
(details "")
(format <<EOF 

<format_contents>
EOF
      )

(help "")
(summary "")

<built_in_exceptions>
)

)

See "Examples: Create and Update Exception Pages" on page 42 for detailed instructions onmodifying exception files
and examples of custom exception pages.
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Manage Policy Exceptions
You can create new custom exceptions and edit existing built-in and custom exceptions. The Admin Console allows you
to edit and install exceptions, and also provides details on the contents of the exceptions files.

To manage policy exceptions:

1. In the Admin Console, select Configuration > Policy > Exception Pages.

2. Select the following as needed:

Task Field or Value

Display current exceptions In the Source section, select Current - Source. The browser opens the
current exceptions in a new browser tab.

Display default exceptions definition In the Source section, select Default - Source. The browser opens the
default source in a new browser tab.

Install new and edit existing policy
exceptions

For instructions, see "Configure Exception
Pages" on the next page.

For help with editing the structured data
language format of the exceptions file, see
" Exception Definition Overview" on
page 33.

In the Install section, select an installation method:

n Text editor, which allows you to enter settings (or copy and paste
the contents of an existing file) directly onto the appliance.

n Local file, to which the appliance can browse and install.

n Remote URL, where you put an already-created file on an FTP or
HTTP server to be downloaded to the appliance.

Use the # (config exceptions) path URL command to set the
path and the # (config exceptions) load exceptions
command to load the exceptions.

When the exceptions file is edited, it updates the existing exceptions
already on the appliance. The configuration remains in effect until it is
overwritten by another update.
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Task Field or Value

Viewmost-recently installed policy
definitions, including any substitution
variables, and preview policy exception
pages in HTML format

In the Install section, selectMost recent install. A new browser tab shows
the following information:

n Common Configuration: Fields in exception.all and
exception.user-defined.all that have default values and are
not overridden in child exceptions.

n User-Defined Exceptions: Installed user-defined exceptions.

n Built-in Exceptions: Pre-defined exceptions.

In both user-defined and built-in exceptions lists, you can select the
following options:

n View Sample HTML: Exception page as it appears to users.

n View Settings: Overview of exception fields.

n View Expanded Settings: Detailed view of exception fields and
Format contents.

Verify results of most recent exception
page installation

In the HTML Pages and Configuration section, selectMost recent
install. The console opens the results of the last installation, including any
errors or warnings.

If the browser prompts you to enter a username and password, enter the Edge SWG (ProxySG) credentials.

Note: The browser prompt shows theManagement Center IP address, but the credentials
you require are for the Edge SWG (ProxySG) appliance.

The first time you open an Edge SWG (ProxySG) device link, the browser prompts you to log in. After a successful
authentication, you should not be prompted to enter credentials for the device again, unless they are changed or
removed in the Edge SWG (ProxySG) configuration. In this case, enter valid credentials.

Configure Exception Pages
You can edit existing exceptions and create user-defined exception pages.

Tip: Before configuring exception pages, review " Exception Definition Overview" on
page 33 for details on the structure of an exception file and the use of each element in the
file.
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Note: You can't create user-defined exceptions for patience pages.

To configure exception pages:

1. In the Admin Console, select Configuration > Policy > Exception Pages.

2. Prepare the exception page file and select an installationmethod in Install:

n If using a local file, create the file (for example, select Install from text editor, copy and paste the
contents to a new file, andmake your changes).

n If using a remote URL, create the exception file, host the file on a server that the Edge SWG (ProxySG)
appliance can access, and specify the URL.

n If using text editor, open the text editor andmake changes within the file.

For example, to change the default contact details on all built-in exception pages, make the following edit under
exception.all:

(contact "For assistance, email support@yourcompany.org.")

To create a new exception page, see "Create a User-Defined Exception Page " on the next page.

3. Save the exception page and check the results of the installation (inHTML Pages and Configuration, select
Most Recent Install).

You can also preview the page as it would appear to users. In Install, selectMost Recent Install. In the list of
user-defined exceptions, select View Sample HTML for the exception you created.

After you create or edit exceptions (following the "Examples: Create and Update Exception Pages" on the next page),
they can be selected in theReturn Exception action in the VPM.

Next, include the exception page in a policy rule. See "Include Exceptions in Policy" on page 50 for instructions; these
instructions also include steps on using the VPM to customize single exception pages for specific use cases.

See Also:

n " Exception Definition Overview" on page 33

n "Examples: Create and Update Exception Pages" on the next page

n "Include Exceptions in Policy" on page 50
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Examples: Create and Update Exception Pages
The following examples illustrate how to create and update exception pages:

n "Create a User-Defined Exception Page " below

n "Edit an Existing Exception PageDefinition" on page 46

Create a User-Defined Exception Page
This example uses the text editor to create a user-defined exception page called user-defined.legal_reasons for
internal compliance.

To create a user-defined exception page:

1. In the Admin Console, select Configuration > Policy > Exception Pages.

2. Under Install, select Install from text editor.

3. In the dialog that opens, look for exception.user-defined.all. Go to the bottomof the exception definition
and enter a new line before the last closing parenthesis:

(exception.user-defined.all <---- opening exception.user-defined.all tag
(contact "")
(details "")
(format "")
(help "")
(summary "")
(http

(code "403")
(contact "")
(details "")
(format "")
(help "")
(summary "")

)
<---- put the new exception definition here

) <---- closing exception.user-defined.all tag

4. Copy an exception definition and paste it in the new line, omitting the fields preceding http. Then, edit the http
fields as follows:

Note: All user-defined exceptions are named user-defined.exception_id.

(exception.user-defined.all <---- opening exception.user-defined.all tag
(contact "")
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(details "")
(format "")
(help "")
(summary "")
(http

(code "403")
(contact "")
(details "")
(format "")
(help "")
(summary "")

)
(exception.user-defined.legal_reasons <---- opening user-defined exception tag, start of new user-defined
exception definition

(http <---- opening http tag
(code "404")
(contact "")
(details "")
(format <<--legal_reasons-- <---- opening format tag; the <<--exception_id-- is required
<!DOCTYPE html>
<html>
<head><!--Specify the text that appears in the browser toolbar and any metadata attributes-

->
<title>Denied due to legal policy </title>
<meta name="author" content="organization_name">
<meta name="description" content="description">
<meta name="category" content="$(exception.category)">
</head>
<body>
<center>
<img src="path_to_logo_image"/><br> <!--Make sure that the appliance can access the URL-->
<p><font face="Arial, Helvetica, sans-serif" color="blue"><b>You are about to access the

internet<br>
INTERNET USAGE IS MONITORED AND LOGGED.</font></p> <!--Enter any text as required-->
<p><font face="Arial, Helvetica, sans-serif" size="4">Your IP address: $(client.address)

<br>Your username: $(user.name)<br>
YOU HAVE BEEN DENIED ACCESS TO THIS SITE. PLEASE READ THE COMPLIANCE POLICY AT: <a

href="url">http://intranet.example.com/up.html</a><br>
This has been reported by: $(proxy.name)<br>
<!--Use any substitution variables that are useful-->
If you have questions about this decision, email: <a

href="mailto:YourCompany@example.com?subject=Monitored web page $(url), IP address:
$(client.address), User ID: $(user)">Compliance Team</a></font></p>

</center>
</body>
</html>
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--legal_reasons-- <----the --exception_id-- is required
) <---- closing format tag

) <---- closing http tag
) <---- closing user-defined exception tag, end of new user-defined exception definition

) <---- closing exception.user-defined.all tag
(exception.coach

...

5. Select Install to save the exception page. If there are no syntax errors, the exception installs successfully:

If the appliance reports syntax errors, review and correct the file before installing again.

6. Check the results of the installation (in Install, selectMost Recent Install).

You can also preview the page as it would appear to users. InHTML Pages and Configuration, select
HTML Pages. In the list of user-defined exceptions, select View Sample HTML for the exception you created.

7. Include the exception in a policy rule. See "Include Exceptions in Policy" on page 50 for instructions.

The exception page is available in theReturn Exception VPM object as follows:
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When a user request matches the policy rule referencing this exception, the appliance returns the user-
defined.legal_reasons exception page as follows:
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Edit an Existing Exception Page Definition
You can edit any existing built-in or user-defined exception page. This example uses the text editor to edit the contact
text and logo on the exception.all page. It also adds a email link for user feedback.

To edit the exception.all exception page:

1. In the Admin Console, select Configuration > Policy > Exception Pages.

2. In Install, select Install from text editor.

3. In the dialog that opens, exception.all is at the top. Edit or add the definition as follows:

(exception.all
(contact "For assistance, contact your local IT help desk.") <---- modify the contact message
(details "")
(format "$(exception.id): $(exception.details)")
(help "")
(summary "")
(http

(code "200")
(contact "")
(details "")
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(format <<--3ed3acdf.0--
<HTML><HEAD>
<TITLE>$(exception.summary)</TITLE>
</HEAD>
<BODY>
<center> <---- center the contents
<img src="path_to_logo_image"/><br> <!--Make sure that the appliance can access the URL--> <----
 add company logo
<FONT face="Helvetica">
<big><strong>$(exception.company_name)</strong></big><BR>
</FONT>
<blockquote>
<TABLE border=0 cellPadding=1 width="80%">
<TR><TD>
<FONT face="Helvetica">
<big>$(exception.summary) ($(exception.id))</big>
<BR>
<BR>
</FONT>
</TD></TR>
<TR><TD>
<FONT face="Helvetica">
$(exception.details)
</FONT>
</TD></TR>
<TR><TD>
<FONT face="Helvetica">
$(exception.help)
</FONT>
</TD></TR>
<TR><TD>
<BR>
<FONT face="Helvetica">Transaction ID: $(x-bluecoat-transaction-uuid)</FONT>
</TD></TR>
<TR><TD>
<FONT face="Helvetica" SIZE=2>
<BR>
$(exception.contact)
</FONT>
</TD></TR>
</TABLE>
</blockquote>
<!--Use any substitution variables that are useful--> <---- add user feedback option
If you have questions about this decision, email: <a
href="mailto:YourCompany@example.com?subject=Monitored web page $(url), IP address:
$(client.address), User ID: $(user)">Compliance Team</a></font></p>
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</FONT>
</center>
</BODY></HTML>
--3ed3acdf.0--

)
(help "")
(summary "")

)

4. Select Install to save the exception page. If there are no syntax errors, the exception installs successfully.

If the appliance reports syntax errors, review and correct the file before installing again.

5. Check the results of the installation (inHTML Pages and Configuration, selectMost Recent Install).

You can also preview the page as it would appear to users. In Install, selectMost Recent Install. In the list of
user-defined exceptions, select View Sample HTML for the exception you created.

6. Include exceptions in a policy rule. See "Include Exceptions in Policy" on page 50 for instructions.

When a user request matches the policy rule referencing an exception page that inherits the defaults specified in
exception.all (that is, the settings are not overridden), the appliance returns an exception page as follows:
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See Also:

n " Exception Definition Overview" on page 33

n "Include Exceptions in Policy" on the next page
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Include Exceptions in Policy
Create exception policies in the VPM by configuring aWeb Access Layer that includes a trigger (Destination object) and
a selected exception (Action object). Other settings, such as Source and Time, are optional.

To include an exception in policy:

1. In theWeb VPM, add or edit aWeb Access policy rule.

2. Specify conditions that will trigger the exception, for example, using aDestination object. If needed, specify
properties such as a Time object to make the rule effective only at certain times or on certain days.

3. Add theReturn Exception action and select a built-in or custom exception type:

a. From Exception Type, select Built-in exception orUser-defined exception. See "Exception Page Types"
on page 27 for descriptions of exceptions.

b. Select an exception type from the drop-downmenu. Note that custom exceptionsmust be defined on the
systembefore they are available from themenu.

c. (Optional) Select Force exception even if later policy would allow request to supersede other policy
that applies to this request.

d. (Optional) Add a custommessage to the exception page:

a. InDetails, enter themessage text.

b. Select Edit to add ELFF and CPL strings to the exceptionmessage.

By default, exception pages show the exception type, a general message about the policy denial, and the
transaction ID:

If you specify a custommessage, it replaces the default message (see the image at end of "Example: Create
Exception Policy for Request Categories" on the facing page).
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Example: Create Exception Policy for Request Categories
This example creates policy to deny access to shopping websites.

To create exception policy for request categories:

1. In theWeb VPM, select Add Layer > Web Access to add the policy layer.

2. In theWeb Access layer, add a rule and specify the request categories that will trigger the exception:

a. InDestination, select Set and add aRequest URL Category object.

b. In theRequest URL Category dialog, select Add Category. The Add Category dialog opens.
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c. Name the object "Shopping sites" and add a list of URLs, one per line.

After you apply changes, the category is saved as a Policy category. Select it as shown below and then save
the object.
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3. In the same policy rule, configure the exception to return when a requested URL matches the categories specified
in the previous step:
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a. In Action, select Set and add aReturn Exception object.

b. From Exception Type, select Built-in exception.

c. Select policy_denied from the drop-downmenu.
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4. (Optional) Override the exception page's default settings for this policy rule only:

a. In theDetails field, enter themessage text: "You are not permitted to access".

b. To add an ELFF substitution to themessage, select Edit. Select the $(c-uri-hostname) ELFF variable and
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then apply changes.

5. Install policy. Select Apply Policy > OK.

When users request sites that match the policy rule, they receive the following exception page:
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Configure Networking
Refer to the following topics to learn about network configuration on the Edge SWG (ProxySG) appliance:

n "Configure Adapters and Bridges" on the next page

Configure network settings including physical interfaces, VLANs, link aggregate interfaces (LAGs), and software or
hardware bridges. Specify a failover appliance for redundancy.

n "Configure Routing" on page 86

Configure routing, IP forwarding, and routing domains.

n "Configure DNS" on page 111

Enable DNS recursion and EDNS, and configure DNS forwarding groups and imputing.

n "About WCCP" on page 121

ConfigureWCCP and service groups for acceleration.

n "Configure a Forwarding System" on page 138

Configure proxies as forwarding hosts and forwarding groups. Configure general forwarding settings that apply to
all connections. Set global defaults for load balancing and host affinity. Configure the default sequence of
forwarding hosts to usewhen there is no forwarding policy.

n "About SOCKS Gateways" on page 150

Configure SOCKS gateways and gateway groups for forwarding. Configure general SOCKS forwarding settings that
apply to all connections. Set global defaults for load balancing and host affinity. Configure the default sequence
of SOCKS gateways to usewhen there is no SOCKS forwarding policy.

n "About Virtual IP Addresses " on page 163

Configure virtual IP addresses for the appliance. Configure failover groups to facilitate network redundancy.
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Configure Adapters and Bridges
This section describes:

n Edge SWG (ProxySG) appliance network adapters, the adapter interfaces, and how to configure the appliance to
function within a VLAN environment. Although youmost likely have performed initial configuration tasks to get
the appliance live on the network, youmight require additional conceptual information to ensure the
configurationmatches the deployment requirement.

n The appliance's hardware and software bridging capabilities. Network bridging through the Edge SWG (ProxySG)
appliance provides transparent proxy pass-through and failover support.

How Appliance Adapters Interact on the Network
Each appliance ships withmultiple network adapters installed on the system, each with one ormore interfaces (the
number of available interfaces varies by appliancemodel).

In Symantec documentation, the convention for the interface is adapter:interface, for example, 0:0.

About WAN and LAN Interfaces

Recent appliancemodels have labels next to the physical interfaces (on the appliance backplate) that identify theWAN
and LAN links. These interface labels are hard-coded and displayed in the respective interface graphics in the Admin
Console. Based on your deployment type (the appliance directly in-path between users and a router or the appliance
connected to a router that resides in-path, virtually in-path, and explicit), verify the following connections:

n The appliance is deployed in-path with bridging.
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n Clients andWAN links connect to the appliance transparently through a router withWCCP.

See Also:

n "Configure a Network Adapter" on page 62

n "Interface Settings" on page 71

n "About VLAN Configuration" on page 67

n "Configure a VLAN" on page 65

Improve Resiliency or Create a Bigger Pipe with an Aggregate Interface
Multiple physical interfacesmay be bundled into one logical multi-gigabit aggregate interface using standard 1 GB or 10
GB physical interfaces. This provides increased throughput and network resiliency. If an interfacewhich is part of an
aggregated link goes down, its traffic will move to the other interfaces within the aggregate interface. When the interface
comes back up, the traffic is redistributed across all of the links.

An aggregate interface is created on the fly when the first physical interface is added to it. Settings from the first member
are applied to the aggregate link (or group). Consequent members take their common settings from the parent
aggregate link. Common settings include:

n MTU size Configure a Network Adapter 

n  Interface Settings 

n  About VLAN Configuration 

n  Configure a VLAN 

n  Troubleshooting  
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n Reject inbound

n Allow intercept

n VLAN trunking

n Native VLAN

n Spanning tree

n IPv6 auto-linklocal

Editing VLAN settings will update the settings for that specific VLAN on all member interfaces.

Link aggregation is accomplished using the industry-standard IEEE 802.1AX Link Aggregation standard. Switch support
and switch configuration are required. The switch and appliancemust be cabled port-to-port.

See Also:

n "Configure an Aggregate Interface" on page 73

About Bridging
A bridge is a network device that interconnectsmultiple computer networks. Unlike a hub, a bridge uses the Ethernet
frame’s destinationMAC address to make delivery decisions. Because these decisions are based onMAC addressing,
bridges are known as Layer 2 devices. This Layer 2 functionality is similar to that used by switches. Bridging is especially
useful in smaller deployments in which explicit proxies or L4 switches are not feasible options.

Bridging functionality allows each appliance to be easily deployed as a transparent redirection device, without requiring
the additional expense andmaintenance of L4 switches orWCCP-capable routers. Transparent bridges are deployed in-
path between clients and routers—all packetsmust pass through hem, though clients are unaware of their presence.

A branch office that would take advantage of a bridging configuration is likely to be small; for example, it might have
only one router and one firewall in the network, as shown below.

To ensure redundancy, the appliance supports both serial and parallel failovermodes. See "About FailoverMode" on
page 83 formore information about serial and parallel failover configurations.
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See Also:

n "Configure a Software Bridge" on page 79

n "Bridge Settings" on page 81
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Configure a Network Adapter
The following procedure describes how to disable, enable, or change the default adapter and interface settings for site-
specific network requirements. These include inbound connection restrictions, link settings, browser/PAC file settings,
and VLAN settings. Repeat the process if the systemhas additional adapters. By default, the appliance:

n Allows the transparent interception of inbound connections.

n Auto-negotiates link settings with the connected switch or router. Use auto-negotiation except under special
circumstances.

Note: Rejecting inbound connections improperly ormanually configuring link settings
improperly might cause the appliance to malfunction. Ensure that you know the correct
settings before attempting either of these. If the appliance fails to operate properly after
changing these settings, contact Symantec Support.

Identify Interface Details
The Interfaces section (Configuration > Network > Adapters) lists all configured interfaces on the appliance and
displays information about each one:

Setting
or field

Description

Enable Enable or disable the interface. If you disable an interface, the console displays a warning message prompting you
to confirm the action.

If the interface you are disabling is in use by the Admin Console, you will see a warning message. If you lose
connection to the Admin Console, reconnect with an active IP address.

Interface Physical interface.

Label Connection purpose or other identifying information.
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Setting
or field

Description

Link
State

Displays information:

n Auto/Manual: speed FDX/HDX

o Auto/Manual: Whether or not the appliance auto-negotiates with the router.

o speed: The maximum transfer speed available through the interface, depending on the type of
Ethernet technology. The values are: 10 megabit/sec, 100 megabit/sec, 1 gigabit/sec, and 10
gigabit/sec.

Note: An N/A status might indicate a network connectivity issue.

n FDX/HDX:

o FDX: Full Duplex—the interface can simultaneously send and receive at the definedmaximum speed
(previous bullet). For example, a 100 Mbps full duplex link can send up to 100 Megabits per second
(Mbps) of data and simultaneously receive up to 100 Mbps of data.

o HDX: Half Duplex—the interface can only send data in one direction at a time. For example, a 100
Mbps half duplex link can only send and receive a combinedmaximum of 100 Mbps of data.

VLANs VLANs configured for the interface.

To configure a network adapter:

1. In the Admin Console, select Configuration > Network > Adapters.

2. In the Interfaces section, select the adapter and interface to configure.

The Configure Interface page displays interface settings.

3. Enter or edit the following settings as needed:

Setting
or field

Description

Label Associate the appliance interface with the connection purpose. For example, label an interface "wansfodc" to
indicate a WAN-OP connection to a datacenter concentrator in San Francisco.
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Setting
or field

Description

When
receiving
packets
on this
interface

Select behavior when receiving packets on inbound connection:

n Allow transparent interception (default): The appliance intercepts the appropriate traffic based on
settings configured in Configuration > Services; all other traffic is bridged or forwarded.

n Bypass transparent interception: The appliance bridges or forwards all inbound traffic on this
interface, regardless of the services configuration.

n Firewall incoming traffic: The appliance drops all inbound connections on this interface, regardless of
the services configuration.

The default is Allow transparent interception. The appliance performs normal proxy interception, as
configured in Configuration > Services, for the traffic arriving on the interface. If you require this appliance
to perform interception on traffic from a specific interface or set of interfaces, set the other interfaces to
either bypass the traffic (pass it through but not intercept it) or firewall it (block it completely). For more
information, see " Interception Options Per Interface" on page 71.

Link
settings

Select the link settings:

n Automatically negotiate link settings (default, recommended): The appliance auto-negotiates the link
settings for this interface.

n Manually configure link settings: Select the options that meet your network requirements. This
method requires a consistent configuration on the router or switch connected to this appliance. Half
is not available for an aggregate interface.

For more information, see " Link Settings" on page 71.

4. (Optional) Assign, change, or bindmultiple IP addresses to the interface. See "Configure a VLAN" on the facing
page for instructions.

Troubleshooting
The appliance can detect whether the network adapters in an appliance are functioning properly. If the appliance detects
a faulty adapter, it stops using it. When the fault is remedied, the appliance detects the functioning adapter and uses it
normally.

To detect network adapter faults, check:

n Whether the link is active (that is, a cable is connected and both sides are up).

n The ratio of error packets to good packets: both sent and received.

n If packets have been sent without any packets received.

n The event log. If an adapter fault is detected, the appliance logs a severe event. In addition, the appliance logs an
entry even when a faulty adapter is restored.
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Configure a VLAN
You can assignmultiple IP addresses to a single interface using VLANs. Formore information, see "BindMultiple
IP Addresses to an Interface" on page 72.

To configure a VLAN:

1. In the Admin Console, select Configuration > Network > Adapters.

2. In Interfaces, select the adapter and interface to configure.

The Configure Interface page displays interface settings.

3. In theVLAN on interface section, edit the Physical Interface.

4. On the Edit Native VLAN for Interface dialog, specify the IP address (IPv4 or IPv6) and subnet mask (for IPv4)
or prefix length (for IPv6). An IPv6 address can be link-local or global.

5. Select Add IP Address to add the entry.

6. (Optional) Configure VLAN options:

a. In theVLAN on interface section, select Add VLAN.

b. Enter or edit the following settings as needed:

Setting or
field

Description

Label Unique name, such as connection purpose.

VLAN ID VLAN identifier.

By default, the native VLAN ID for any appliance interface is 1, as most switches by default are
configured to have their native VLAN IDs as 1. Only change the Native VLAN for Interface value if
the native VLAN ID of the switch or router connected to this interface is a value other than 1;
match that value here.

When
receiving
packets on
this VLAN

The receiving packet and browser behavior is the same as for physical interfaces with the
exception of Use physical interface, which applies the same configuration to the VLAN as was
set on the physical interface.

The default setting is to inherit the behavior from the physical interface.

IP Addresses VLANs on the interface. To addmore VLANs to the interface, enter the IP address and subnet
mask.
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Note: If you attempt to edit a VLAN with an IP address being used by the Admin
Console you will see amessagewarning of loss of connectivity. If you lose connection
to the Admin Console, reconnect with an active IP address.

See Also:

n Configure a Network Adapter
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About VLAN Configuration
Virtual LANs (VLANs) are logical network segments that allow hosts to communicate, regardless of physical network
location. The benefit to this is that clients can be separated logically—based on organizational unit, for example— rather
than based on physical connectivity to interfaces. The appliance treats VLAN interfaces identically to traditional physical
LAN interfaces.

VLAN segments are defined on the switch. The network administrator specifies which ports belong to which VLANs. The
following diagram illustrates a port-based VLAN configuration. Clients on network segments attached to switch ports 1
and 2 belong to VLAN 1, which has the network address 10.0.1.x; network segments attached to switch ports 14 and 15
belong to VLAN 2, which has the network address 10.0.2.x.

As also illustrated in the diagram, clients of different OS types can residewithin a VLAN. Not all clients are able to detect
(send or receive) VLAN-tagged packets.

VLAN Trunking
Trunk ports are ports that carry traffic formore than one VLAN. They tag each packet with the VLAN ID in the packet
header. Trunk ports are commonly used between switches and routers that must switch or route traffic fromor to
multiple VLANs. By default, VLAN trunking is enabled on the appliance.

In the following diagram,multiple VLANs are connected by a trunk link between two switches.
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Native VLANs
Each switch port has a designated native VLAN. Traffic on the port associated with the native VLAN is not tagged. Traffic
destined for VLANs other than the native VLAN is tagged.

The trunk link carries both the native VLAN and all other VLAN (tagged) packets, as illustrated in the following diagram.
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In this example, the client attached to port 7 belongs to VLAN 2. Even though port 7 is part of VLAN 2, it does not set
tags or receive VLAN-tagged packets. The switch associates the traffic with VLAN 2 and tags it accordingly when
appropriate. Conversely, it strips the VLAN 2 tag on the response. The trunk link carries VLAN 1 (the native) and 2 traffic
to a router that forwards traffic for those VLANs.

Deployment complications arisewhen a device (other than a router) is required between switches. Any network device
without VLAN-tagging support might drop ormisinterpret the traffic.

As a best practice, do not deploy a device that is not configured to recognize VLAN-tagged traffic in-path of a trunk link.

Note: In Symantec documentation, the convention for VLAN is adapter:interface.VLAN_
ID. Example: 1:0.10 refers the VLAN ID 10 on adapter 1, interface 0.

Edge SWG (ProxySG) VLAN Support
The appliance supports VLAN tagging and it is enabled by default; therefore, an appliance can be deployed in-path with
switches that are exchanging VLAN tagged traffic. This allows for uninterrupted VLAN service, plus enables benefits
gained with the proxy features.

The Admin Console enables you to configure VLAN interfaces the sameway you configure physical interfaces. After a
VLAN is added, it appears in the list of network interfaces. Settings such as allow-intercept and reject-inbound are
applicable to VLAN interfaces.

Themost common deployment is an appliance residing between two switches or a switch and a router; in these cases,
preserving tagged packets is essential to correct network operation.
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Based on this deployment:

n If configuration and policy allow, the appliance accepts all packets regardless of their VLAN tag and passes them
fromone interface to the other with the original VLAN tag preserved.

n If a packet arrives on one interface tagged for VLAN 2, it remains on VLAN 2 when it is forwarded out on another
interface. If a packet arrives untagged and the destination interface has a different native VLAN configured, the
appliance adds a tag to ensure the VLAN ID is preserved. Similarly, if a tagged packet arrives and the VLAN ID
matches the native VLAN of the destination interface, the appliance removes the tag before transmitting the
packet.

n The appliance strips the native VLAN tag on all outgoing traffic.

About Bridging and VLANs

On the appliance, bridges can be created between two physical interfaces only. If you have configured virtual interfaces
(VLANs), all the VLANs on the selected physical interfaces will be bridged.

Although VLANs are supported on bridges, the appliance does not support creating a bridge group between VLANswhen
bridging or bypassing traffic. For example, when bridging you cannot send packets fromVLAN 0:0.2 to 0:1.3.

For information on bridging, see "Configure a Software Bridge" on page 79.

See Also:

n "Configure a VLAN" on page 65
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Interface Settings
Refer to the following information when configuring an interface:

Interception Options Per Interface
You can execute one of three actions upon intercepting traffic on a per-interface basis:

n Allow: Bridge/forward traffic and intercept appropriate traffic as defined by Proxy Services.

n Bypass: Bridge/forward all traffic without interception.

n Firewall: Drop (silently block) any traffic not related to established appliance connections.

The following table describes what effect each interception option setting has on different traffic types.

Option
reject-
inbound

allow-intercept
Edge SWG (ProxySG)
management and console
connections

Explicit proxy
service traffic

Transparent
proxy service
traffic

Other
traffic

Allow Disabled Enabled Intercepted Intercepted Intercepted Forwarded

Bypass Disabled Disabled Intercepted Intercepted Forwarded Forwarded

Firewall Enabled Enabled/Disabled Silently dropped Silently dropped Silently dropped Silently
dropped

By default, the intercept behavior is to bypass transparent interception.

Link Settings
By default, the appliance auto-negotiates the interface speed and duplex settings with the switch or router to which it is
connected.

n The appliance supportsmultiple Ethernet modes. The speed setting is themaximum transfer speed, in Megabits
or Gigabits per second (Mbps/Gbps), the interface supports.

n The duplex setting designates two-way traffic capabilities. In Full duplex mode, both devicesmay transmit to and
from each other simultaneously, allowing each direction to use themaximum transfer speed without affecting the
other direction. In Half duplex mode, only one devicemay transmit at any one time, effectively sharing the
maximum transfer speed of the interface.

The appliance’s healthmonitoring capability provides alerts if interface use reaches warning and critical capacity levels. In
Full duplex mode, the appliance reports the larger percentage value of the sending and receiving values. For example, if
the appliance is receiving 20 Mbps and sending 40 Mbps on a 100 Mbps-capable interface, the reported value is 40%. If
the same interfacewas set to half duplex, the reported value is 60%, or the aggregated values.
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It is best practice to use the (default) auto-negotiation feature. The key issue is the appliance settingsmust match the
settings on the switch; therefore, if youmanually change the settings on the appliance, youmust also match the settings
on the router or switch.

Note: When the 100 Mbps Ethernet interfaces on the appliance 210 are connected to
Gigabit Ethernet capable devices, they might incorrectly auto-negotiate when fail-open
pass-through is used. If both the interfaces on these appliances are connected to Gigabit
capable switches or hubs, Symantec recommends that you configure the link settings
manually to 100 Mbps. To configure the link settings, see "Configure a Network Adapter"
on page 62.

The following table lists the results of various appliance and router link settings for 100 Mbps speeds. Result values are
listed in format speed/duplex.

Router/switch auto-
negotiation result

Router/switch interface
settings

Edge SWG (ProxySG)
interface setting

Edge SWG (ProxySG) auto-
negotiation result

100/Full Duplex Auto Auto 100/Full Duplex

N/A 100/Full Duplex Auto 100/Half Duplex

N/A 100/Full Duplex 100/Full Duplex N/A

100/Half Duplex Auto 100/Full Duplex N/A

The following table lists the results of various appliance and router link settings for 1 Gbps speeds. The values are listed
in format speed/duplex.

Router/switch auto-
negotiation result

Router/switch interface
settings

Edge SWG (ProxySG)
interface setting

Edge SWG (ProxySG) auto-
negotiation result

No link Auto Gig/full duplex No link

Gig/full duplex Auto Auto Gig/full duplex

No link Gig/full duplex 100/Full Duplex No link

Bind Multiple IP Addresses to an Interface
The appliance allows you to bindmultiple IP addresses to an interface, and typically, the assigned IP addresses are on the
same subnet. Multiple IP addresses on an interface allows formanaging one service under a specific IP and another
service under a different IP. For example, you can assign one IP address formanagement services/console access and
another IP address formanaging proxy traffic. In addition, you could assign unique IP addresses to manage different
services, that is haveHTTP traffic on one and native FTP on another.

When using the appliance in amixed IPv4/IPv6 environment, you should assign IPv4 and IPv6 addresses to each
interface. The IPv6 address can be link-local or global.
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Configure an Aggregate Interface
In the Admin Console (Configuration > Network > Adapters), theAggregate Interface section lists all configured
aggregate interfaces on the appliance and displays information about each one:

Setting or
field

Description

Enable
toggle

If disabled, the aggregate link interface will disable the physical interface of eachmember of the aggregate group.

Individual physical interfaces within the group can be enabled or disabled.

ID Identifier for the aggregate interface.

Label Label for the aggregate interface.

Interface Interfaces that are members of the aggregate interface.

LACP State Possible states:

n Up: The member is healthy and operates normally from LACP perspective.

n Synchronizing: Peers are out of sync with the port, or unable to exchange LACP PDUs.

n Negotiating: Exchanging key information with the peer. If it persists, this might indicate that the peer is not
in the correct link aggregation, or that other configuration on the switch port differs from the rest of the
aggregation.

n Suspended: The port is not being used by LACP. Potential reason is port is in half-duplex.

n Disabled: The physical interface is disabled.

n Down: The physical interface has no link.

Link aggregation should work on any switch configured to use LACP; consult the documentation from your switch
vendor when configuring link aggregation. LACP standby link selection and dynamic key management are not
supported.

VLANs VLANs that have been added to the aggregate interface.

To add an aggregate interface or edit an existing aggregate interface:

1. In the Admin Console, select Configuration > Network > Adapters.

2. In Aggregate Interfaces:

a. Select Add Aggregate to add an aggregate.

b. Select an existing aggregate in the list or select Edit under Actions.

The Add New Interface/Configure Interface page displays aggregate interface settings.
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3. Enter or edit the following settings as needed:

Setting or
field

Description

Label Label for the aggregate interface.

Identifier Identifier for the aggregate interface.

Select
from
available
interfaces

Add or remove aggregate members. Note the following:

n Only available interfaces are displayed.

n Up to 32 interfaces can be added to an aggregate interface.

n The MAC address of the first physical interface assigned to the aggregate interface becomes the
MAC address of the aggregate link.

n Interfaces from different adapters may belong to the same aggregate link.

n Interfaces with different speeds are allowed in an aggregate interface.

n The Link State column provides link information such as Enable requested, Disabled, Auto
<negotiated speed, duplex>, and so on.

VLANs on
interface

This information is for viewing only. To configure VLANs, see "Configure a Network Adapter" on page 62.

When a physical link is added to an aggregate interface, the VLAN configurations are merged. A VLAN on
the new physical interface is created on the aggregate, and the existing configuration is copied to the
aggregate and all other groupmembers; if a VLAN exists on the aggregate interface, it will be created on
the new physical interface. If both a newmember and the aggregate interface have a VLAN configuration,
all VLAN settings are copied from the aggregate VLAN to the member VLAN, except the IP address.

Notes

n See theReports > Interface History to view statistics on an aggregate interface.

n Packets for any given connection will always be transmitted over the same physical link, limiting the burst speed
for the connection to the capacity of that specific link rather than the sumof all the links.

n Link aggregation and bridging can’t be configured on the same physical interface, though they can both be used in
a single deployment.
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About Bridging
Review the following bridging concepts:

Bridging Methods
The appliance provides bridging functionality by twomethods:

n Software—A software, or dynamic, bridge is constructed using a set of installed interfaces. Within each logical
bridge, interfaces can be assigned or removed. In the event of failure, software bridges fail closed—traffic is not
passed. This behavior can be desirable if you want to pass traffic to a redundant appliance and/or link.

n Hardware—Ahardware, or pass-through, bridge uses a dual interface Ethernet adapter. This type of bridge
provides pass-through support—in the event of failure, traffic passes through the appliance.

See "About the Pass-Through Adapter" on the next page formore information.

Note: If you want to use an L4 switch or an explicit proxy instead of bridging, youmust
disable the pass-through card.

Traffic Handling
Bridges are used to segment Ethernet collision domains, thus reducing frame collisions. To make efficient delivery
decisions, the bridgemust discover the identity of systems on each collision domain. The bridge uses the sourceMAC
address of frames to determine the interface that the device can be reached from and stores that information in the
bridge forwarding table. When packets are received, the bridge consults the forwarding table to determinewhich
interface to deliver the packet to. The only way to bypass the bridge forwarding table lookup is to define a static
forwarding entry. Formore information on static forwarding entries, see "About Static Forwarding Table Entries" on
page 82.

Trust Destination MAC

When the appliance is in transparent bridgingmode, the appliance always “trusts” the destinationMAC address of
inbound packets and does not consult its routing table. Trust DestinationMAC is enabled by default (when the appliance
is in transparent bridgingmode) and cannot be disabled. Formore information on Trust DestinationMAC, see "About
Trust DestinationMAC" on page 92.

About Bridging and Policy
Because the bridge intercepts all traffic, you can take advantage of the powerful proxy services and policies built into the
appliance to control how that traffic is handled. If the appliance recognizes the intercepted traffic, you can apply policy
to it. Unrecognized traffic is forwarded out. The following diagram illustrates this traffic handling flow.
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Because policy can be applied only to recognized protocols, it is important to specify port ranges that will capture all
traffic, even that operating on lesser known ports.

About the Pass-Through Adapter
A pass-through adapter is a dual interface Ethernet adapter designed to provide an efficient fault-tolerant bridging
solution. If this adapter is installed on an appliance, SGOS detects the adapter on systembootup and automatically
creates a bridge—the two Ethernet interfaces serve as the bridge ports. If the appliance is powered down or loses power
for any reason, the bridge fails open; that is, network traffic passes fromone Ethernet interface to the other. Thus,
network traffic is uninterrupted, but does not route through the appliance.

Caution: This scenario creates a security vulnerability.

After power is restored to the appliance, the bridge comes back online and network traffic is routed to the appliance and
thus is subject to that appliance’s configured features, policies, content scanning, and redirection instructions. Bridging
supports only failover; it does not support load balancing.
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Note: To view adapter state, in the Admin Console, select Configuration > Network >
Adapters.

Deployment Recommendations
Rack and cable the appliancewhile it is powered off. This enables you to confirm that the pass-through adapter is
functioning and that traffic is passing through the appliance. If traffic is not being passed, confirm that you have used
the correct cabling (crossover or straight).

Reflecting Link Errors
When the appliance is deployed transparently with bridging enabled, link errors that occur on one interface can be
reflected to the other bridge interface. This allows a router connected to the appliance on the healthy link to detect this
failure and recompute a path around this failed segment. When the interfacewith the original link error is brought back
up, the other interface is automatically restarted as part of the health check process.

Reflecting link errors requires that two interfaces be available and connected in a bridging configuration; it also requires
that Propagate Failure be enabled. By default, it is disabled.

Note: This feature is only applicable to a two-interface hardware or software bridge.
Propagate Failure sets itself to disabled in any other scenario.

If the link goes downwhile Propagate Failure is disabled, the previous link state is immediately reflected to the other
interface if Propagate Failure is enabled. See "Configure a Software Bridge" on page 79 for details.

Bypass List Behavior
Static and dynamic bypass operate depending on how the appliance intercepts the traffic, as follows:

n When the appliance is installed in a bridging deployment, bridging is used for bypass.

n When the appliance is installed as a router or external layer 4 load balancers are used to redirect traffic to the
appliance, routing is used for bypass, but only if IP Forwarding is enabled. Otherwise, traffic is dropped instead of
being bypassed.

n When the appliance is installed in aWCCP deployment, either GRE or layer 2 redirection is used for bypass.

SGOS usesWCCP packet return to redirect bypassed traffic back to the router, supporting the following combination of
packet forwarding and return options:

Packet forwarding Packet return

GRE GRE
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Packet forwarding Packet return

L2 GRE

L2 L2

To set these options in the Admin Console, see "Configure Service Groups" on page 129.
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Configure a Software Bridge
This section describes how to link adapters and interfaces to create a network bridge.

Before configuring a software bridge, ensure that your adapters are of the same type and use the same settings.
Although the software does not restrict you from configuring bridges with adapters of different speeds andMTU
configurations (for example, ports speeds of 10/100 Mbit/s and 1 GigE combined with anMTU of 1400 and 1500,
respectively), the resulting behavior is unpredictable.

Note: The Bridges section (Configuration > Network > Adapters) displays the
bandwidth class used for all bridges. After you have created and configured a bandwidth
management class for bridging, you can configure bridging bandwidth allocation. See
"BandwidthManagement for Bridging" on page 81 for details.

To configure a software bridge:

1. In the Admin Console, select Configuration > Network > Adapters.

2. In Bridges:

n To add a bridge, select Add Bridge.

n To edit an existing bridge, select it.

The Add NewBridge/Configure Bridge page displays bridge settings.

3. Enter or edit the following settings as needed:

Setting or
field

Description

Name Name of the bridge.

Failover
Group

(Optional) Assign the bridge to a failover group.

Failover groups are configured in the CLI. See "About Failover Mode" on page 83.

Propagate
Failure

If you have a two-interface bridge, select to enable link error propagation.

Clear
Statistics

(Editing an existing bridge only) Select to reset the traffic history of the bridge, which includes packet and
byte counts, to 0.
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Setting or
field

Description

Interfaces Configure the interface settings to:

n Allow transparent interception. It is bypassed by default. Youmust configure the WAN interface to
allow transparent interception.

n Firewall incoming traffic. Firewalls must be specifically configured.

See "Configure a Network Adapter" on page 62 for details.

To configure bridge interface settings:

1. Select Add to add an interface to the bridge, or edit an existing bridge interface.

2. Enter or edit the bridge settings:

n Spanning Tree: Select to enable bridging loop avoidance. See "About Bridging Loop
Detection" on page 82 for details.

n Static Forwarding Table: If you are using firewall configurations that require the use of
static forwarding table entries, add a static forwarding table entry that defines the next hop
gateway that is on the correct side of the bridge. See "About Static Forwarding Table Entries"
on page 82 for details.

n MAC Address: MAC addresses for the next hop gateways.
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Bridge Settings
Refer to the following information when configuring a bridge:

Note: For failover settings, see "About FailoverMode" on page 83.

Bandwidth Management for Bridging
After you have created and configured a bandwidthmanagement class for bridging, you canmanage the bandwidth
used by all bridges.

Note: This setting only controls the bandwidth class used by bypassed traffic. To manage
intercepted traffic, youmust define bandwidthmanagement policy (using VPM or CPL).

To set bandwidthmanagement for bridging:

1. In the Admin Console, select Configuration > Network > Adapters.

2. In Bridges, select one of the following from the Bandwidth Classmenu:

n A bandwidth class for bridging.

n None to disable bandwidthmanagement for bridging.

Programmable Pass-Through/NIC Adapters
Some Edge SWG (ProxySG) appliances ship (when ordered) with a network adapter card that can be used as a pass-
through adapter or as a NIC, depending on the configuredmode. If the network adaptermode is set to disabled, the
adapter interfaces can be used as NICs or as part of a software bridge.

If your appliance includes a programmable adapter card, the following programmable adaptermodes are available:

n Disabled: Disables the bridge and allows the adapter interfaces to be reused as NICs or as part of another bridge.

n Fail Open: If the appliance fails, all traffic passes through the bridge so clients can still receive data.

n Fail Closed: If the appliance fails, all traffic is blocked and service is interrupted. Thismode provides the same
functionality as a user-configured software bridge.

Note: If you create a software bridge, the programmable bridge cardmode is implicitly Fail
Closed (if the appliance fails, the software bridge is non-functional).
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About Bridging Loop Detection
Bridging supports the Spanning Tree Protocol (STP). STP is a link management protocol that prevents bridge loops in a
network that has redundant paths that can cause packets to be bridged infinitely without ever being removed from the
network. STP ensures that a bridge, when faced withmultiple paths, uses a path that is loop-free. If that path fails, the
algorithm recalculates the network and finds another loop-free path. The administrator can enable or disable spanning
tree participation for the interface.

About Static Forwarding Table Entries
Certain firewall configurations require the use of static forwarding table entries. These firewall failover configurations use
VIP addresses and virtual MAC (VMAC) addresses. When a client sends an ARP request to the firewall VIP, the firewall
replies with a VMAC (which can be an Ethernet multicast address); however, when the firewall sends a packet, it uses a
physical MAC address, not the VMAC. The solution is to create a static forwarding table entry that defines the next hop
gateway that is on the correct side of the bridge.
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About Failover Mode
In failovermode, two appliances are deployed, a primary and a replica. The primary sends keepalivemessages
(advertisements) to the replica appliance. If the replica does not receive advertisements at the specified interval, the
replica takes over for the primary. When the primary comes back online, the primary takes over from the replica again.

The SGOS bridging feature allows two different types of failovermodes, parallel and serial. Hardware and software
bridges allow different failovermodes:

n Software bridges allow serial or parallel failover. Note that if the appliance fails, serial failover also fails.

n Hardware bridges allow serial or parallel failover.

Parallel Failover
In parallel failovermode, two systems are deployed side by side on redundant paths. In parallel failover, the replica does
not actively bridge any packets unless the primary fails. If the primary fails, the replica takes over the primary IP address
and begins bridging. A parallel failover configuration is shown in the following figure.

Because of the redundant paths, youmust enable Spanning Tree to avoid bridge loops. See "About Bridging Loop
Detection" on the previous page formore information about STP.

Serial Failover
In serial failovermode, the replica is in-path and continuously bridges packets, but does not perform any other
operations to the bridged traffic unless the primary fails. If the primary fails, the replica takes over the primary IP
address and applies policy, etc. A serial configuration is shown in the following figure.

If you are relying on a hardware bridge for serial failover, youmust configure the pass-through bridge to be in fail open
mode. See "Programmable Pass-Through/NIC Adapters" on page 81 formore information about configuring bridge
modes.
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Configure Failover
Failover is accomplished by doing the following:

n Creating virtual IP addresses on each proxy.

n Creating a failover group.

n Attach the failover group to the bridge configuration.

n Selecting a failovermode (parallel or serial - this can only be selected using the CLI).

Both proxies can have the same priority (for example, the default priority). In that case, priority is determined by the
local IP address—the appliancewith the highest local IP will assume the role of primary.

Example

The following example creates a bridging configuration with one bridge on standby.

n Appliance A—software bridge IP address: 10.0.0.2. Create a virtual IP address and a failover group, and designate
this group the primary.

# (config) virtual-ip address 10.0.0.4
# (config) failover
# (config failover) create 10.0.0.4
# (config failover) edit 10.0.0.4
# (config failover 10.0.0.4) primary
# (config failover 10.0.0.4) enable

The preceding commands create a failover group called 10.0.0.4. The priority is automatically set to 254 and the
failover interval is set to 40.

n Appliance B—software bridge IP address: 10.0.0.3. Create a virtual IP address and a failover group.

Note: This deployment requires a hub on both sides of the bridge or a switch
capable of interfacemirroring.
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# (config) virtual-ip address 10.0.0.4
# (config) virtual-ip address 10.0.0.4
# (config) failover
# config failover) create 10.0.0.4
# (config failover) edit 10.0.0.4
# (config failover 10.0.0.4) enable

On both appliances, attach the bridge configuration to the failover group:

# (config bridge bridge_name) failover group 10.0.0.4

n On both appliances, specify the failovermode:

# (config bridge bridge_name) failover mode serial
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Configure Routing
Because it does not participate in a network routing protocol, the Edge SWG (ProxySG) appliancemust be configured to
reach clients and servers. To reach devices outside the network, youmust configure a primary packet delivery path. This
path is known as the default route (or the default gateway) and is configured during initial setup when you specify a
default gateway. The appliance sends all traffic to the default gateway unless another route is specified. These alternate
routes are called static routes and they list the IP addresses of other gateways that can be used to reach clients and
servers in other parts of the network. Static routes are discussed in "About Static Routes" on page 99.

The appliance can be configured to distribute traffic throughmultiple default gateways, as explained in "Distribute
Traffic ThroughMultiple Default Gateways" on page 90.

See Also:

n "Distribute Traffic ThroughMultiple Default Gateways" on page 90

n "Routing in Transparent Deployments" on page 92
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IP Forwarding
IP forwarding is a special type of transparent proxy. The appliance is configured to act as a gateway and is configured so
that if a packet is addressed to the appliance adapter, but not its IP address, the packet is forwarded toward the final
destination. If IP forwarding is disabled, the packet is rejected as beingmisaddressed.

By default, IP forwarding is disabled to maintain a secure network. You can enable IPv4 and IPv6 forwarding
independently:

n For IPv4, switch the Enable IPv4 Forwarding toggle.

n For IPv6, switch the Enable IPv6 Forwarding toggle.

Caution: When IP forwarding is enabled, be aware that all appliance ports are open and all
the traffic coming through them is not subjected to policy, with the exception of the ports
that have explicitly defined in Configuration > Services > Proxy Services.

How Routes are Determined
Typically, the appliance uses the routing table to determinewhich interface to send the outbound packets to. When a
packet is received, the appliance does a routing lookup to see if it can determine the correct route, either by using a static
route or, if one is not defined, by sending it over the default route; however, the routing lookupmight be bypassed
depending on how the appliance is deployed and configured.

See Also

n "About Static Routes" on page 99

Routing Domains
Routing domains allow you to route traffic for unique networks through the same appliance, where each network has its
own gateway and DNS server.

The following illustrates typical network flow through an appliancewith Routing Domains configured:
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In large network architectures, it is common formultiple logical networks to traverse the same set of physical network
devices. Often, segregation of these networks is required to:

n Increase visibility

n Reducemaintenance cost

n Minimize security risk
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Routing domains provides this segregation by partitioning network interfaces into disjoint groups that only allow traffic
to be forwarded to one of the other interfaces in the same group. Traffic cannot be forwarded between interfaces in
different routing domains. Thus, network traffic is effectively segregated and can never cross routing domains.

Each routing domain object includes its own routing table that enforces layer 3 segregation as follows:

n Each routing table is associated with one ormore logical interfaces.

n IP traffic that arrives on these interfaces is subject to routing and forwarding decisions defined by the routing
table.

n To enforce network segregation, traffic never crosses routing domains.

Interfaces that are not assigned to any routing domain are automatically added to the default routing domain, which is
subject to the configuration specified in the Admin Console in Configuration > Network > Routing.

See Also

n "Implement a Routing Domain" on page 102

n Creating Multiple Logical Networks on a Single Appliance with Routing Domains document at MyBroadcom
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Distribute Traffic Through Multiple Default Gateways
You can distribute traffic originating at the Edge SWG (ProxySG) appliance throughmultiple default gateways and fine-
tune how the traffic is distributed. This featureworks with any routing protocol.

By usingmultiple gateways, an administrator can assign a number of available gateways into a preference group and
configure the load distribution to the gateways within the group. Multiple preference groups are supported. In amixed
IPv4/IPv6 environment, youmust define two default gateways: one for IPv4 and one for IPv6.

The specified gateway applies to all network adapters in the system.

Note: Load balancing throughmultiple gateways is independent from the per interface
load balancing the appliance automatically does whenmore than one network interface is
installed.

Which default gateway the Edge SWG (ProxySG) appliance uses at a given time is determined by the preference group
configuration assigned by the administrator. An appliance can have from 1 to 10 preference groups. A group can contain
multiple gateways or only a single gateway.

Each gateway within a group can be assigned a relative weight value from 1 to 100. Theweight determines howmuch
bandwidth a gateway is given relative to the other gateways in the same group. For example, in a group with two
gateways, assigning both gateways the sameweight, whether 1 or 100, results in the same traffic distribution pattern.
Alternatively, assigning one gateway a value of 10 and the other gateway a value of 20 results in the appliance sending
approximately twice the traffic to the gateway with aweight value of 20. If there is only one gateway, it automatically
has aweight of 100.

All gateways in the lowest preference group are considered to be active until one of thembecomes unreachable and is
dropped from the active gateway list. Any remaining gateways within the group continue to be used. If all gateways in
the lowest preference group becomeunreachable, the gateways in the next lowest preference group become the active
gateways (unless a gateway in a lower preference group becomes reachable again).

Configure Multiple Gateways for Load Balancing
When a gateway goes down, the networking code detects the unreachable gateway in 20 seconds, and the switchover
takes place immediately if a secondary gateway is configured.

To createmultiple gateways:

1. In the Admin Console, select Configuration > Network > Routing.

2. In theRouting Config section, enter or edit a routing domain name inDomain Name.

3. In the IP Gateways section:
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a. Select Add Gateway to add a gateway.

b. Select an existing gateway in the list or select Edit under Actions.

4. Enter or edit the following settings:

Setting or
field

Description

Group Select a preference group.

Weight Which default gateway the Edge SWG (ProxySG) appliance uses at a given time is determined by the
assigned preference group configuration. Note that:

n An appliance can have from 1 to 10 preference groups.

n A group can contain multiple gateways or only a single gateway.

n Each gateway within a group can be assigned a relative weight value from 1 to 100. 

Gateway The gateway IP address (IPv4 or IPv6).

Repeat the previous steps to define all gateways as needed.

5. (Optional) Add a new routing domain in Routing Config to set gateways for additional routing domains. See
"Implement a Routing Domain" on page 102 for information.

Note: The appliance uses the default route configuration for all appliance-initiated
traffic requests.
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Routing in Transparent Deployments
This section describes themechanisms the appliance uses to route packets.

Outbound Routing
By default, the appliance sends outbound traffic to the default gateway unless one of the following is used (in order of
precedence):

n The Trust DestinationMAC feature, which is used when the appliance is in transparent bridgingmode (unless
certain other conditions are true—see "About Trust DestinationMAC" below.

n A static route, if one is defined. Formore information, see "About Static Routes" on page 99.

n The outbound RTS feature. Formore information, see "About Return-to-Sender (RTS)" on the facing page.

n An interface route, if the device is on the same subnet as the appliance. The appliance automatically adds an
interface route to the routing table for hosts on the same subnet as the appliance interface. The interface route
maps the subnet to the interface. The appliance can then do an ARP lookup for those hosts and send the packets
directly to the client’s MAC address.

Inbound Routing
By default, the appliance sends inbound traffic to the default gateway unless one of the following is used (in order of
precedence):

n A static route, if one is defined. Formore information, see "About Static Routes" on page 99.

n The inbound RTS feature. Inbound RTS is enabled by default. Formore information, see "About Return-to-Sender
(RTS)" on the facing page.

n An interface route, if the device is on the same subnet as the appliance.

About Trust Destination MAC
When the appliance is in transparent bridgingmode (in-path), it “trusts” the destinationMAC address of the first client
SYN packet and does not consult its routing table. The appliance notes the destinationMAC address and outgoing
interface specified in the frame and passes that information to the software process initiating the server connection,
thus avoiding a routing lookup on the appliance. This feature is called Trust DestinationMAC. It is enabled by default
when the appliance is in transparent bridgingmode and cannot be disabled.

Trust DestinationMAC eliminates the need to create static routes and circumvents any routing issues encountered when
the information in a packet is not sufficient for the appliance to make a routing decision.
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Note: Trust DestinationMAC uses only the first client SYN packet to determine theMAC
address and outgoing interface and continues to use this information even if the
destinationMAC address is not responding. To work around this limitation, enable
outbound RTS, as described in "About Return-to-Sender (RTS)" below.

Override Trust Destination MAC

Unlike RTS, non-default static routes cannot override Trust DestinationMAC. However, Trust DestinationMAC behavior
can be overridden if any of the following conditions are true:

n The result of the DNS lookup does not match the destination IP address. If Trust Destination IP is enabled, the
DNS lookup is bypassed, and the IP address should alwaysmatch.

n A policy rule does one of the following:

o Specifies a forwarding host or SOCKS gateway

o Rewrites the server URL in away that causes the server connection to be forwarded to a different host

About Return-to-Sender (RTS)
As stated previously, the appliance does a routing lookup to see if it can determine the correct route for a packet, either
by using a static route or, if one is not defined, by sending it over the default route. However, using the default route is
sometimes suboptimal. For example, if the appliance satisfies a request and sends the client response traffic over the
default route, the gateway router simply returns the traffic to the client router on the LAN side of the appliance. This
causes unnecessary traffic between the switch and gateway, before the packet is finally received by the client router.
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To specify a direct route, a static routemust be created, which requires the administrator to update the routing table
every time a new route is needed.

The Return-to-Sender (RTS) option eliminates the need to create static routes by configuring the appliance to send
response packets back to the same interface that received the request packet, entirely bypassing any routing lookup on
the appliance. Essentially, the appliance stores the source Ethernet MAC address that the client’s packet came from and
sends all responses to that address.

The RTS interfacemapping is updated each time a packet is received. For example, if there are two gateways and both of
them send packets to the appliance, the packets are sent back to the last MAC address and interface that received the
packet.

Note: Non-default static routes override RTS settings.

RTS can be configured in two ways, inbound or outbound. These two options can be enabled at the same time.
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Inbound RTS

Inbound RTS affects connections initiated to the appliance by clients and is enabled by default. Inbound RTS configures
the appliance to send SYN-ACK packets to the same interface that the SYN packet arrived on. All subsequent TCP/IP
response packets are also sent to the same interface that received the request packet.

RTS inbound applies only to clients who are on a different subnet than the appliance. If clients are on the same subnet,
interface routes are used.
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Inbound RTS Process Flow

1. Client A sends SYN to Server C across theWAN. The SYN is intercepted on the appliance B interface 0:1.

2. The appliancemaps Client A to interface 0:1. All packets to Client Awill now go to interface 0:1.

3. When a packet arrives for Client A, the appliance checks its interfacemapping and sends the packet to the client
over interface 0:1.

Outbound RTS

Outbound RTS affects connections initiated by the appliance to OCSes and causes the appliance to send ACK and
subsequent packets to the same interface that the SYN-ACK packet arrived on. Outbound RTS requires a route to the
client, either through a default gateway or static route.
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Outbound RTS Process Flow

1. Server C sends SYN-ACK to appliance B. The SYN-ACK is received on appliance interface 0:0.

2. The appliancemaps Server B to interface 0:0. All packets to Server B will now go to interface 0:0.

3. When a packet arrives for Server B, the appliance checks its interfacemapping and sends the packet out of
interface 0:0.
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Configure RTS

To configure RTS, use the following CLI commands:

# (config) return-to-sender inbound {disable | enable}

Enable or disable return-to-sender for inbound sessions.

# (config) return-to-sender outbound {disable | enable}

Enable or disable return-to-sender for outbound sessions.

Formore information, refer to the Command Line Interface Reference.

DNS Verification
In transparent deployments, the appliance verifies the destination IP addresses provided by the client. This is known as
L2/L3 transparency.

Note: The Trust Destination IP option overrides DNS verification. This option is
recommended for acceleration deployments only. Formore information about this
option, see "Trust the Destination IP Address Provided by the Client" on page 211

For hostname-less protocols such as CIFS and FTP, the IP address can always be trusted. For other protocols, such as
HTTP, RTSP, andMMS, which have a hostname that must be resolved, verification can be an issue. URL rewrites that
modify the hostname also can cause verification to fail.

L2/L3 transparency is not supported in explicit proxy deployments, or if the destination IP addresses cannot be verified
by the appliance. In these cases, youmust configure static routes to hosts that are only accessible through gateways
other than the default gateway.

Transparent ADN connections that are handed off to an application proxy (HTTP orMAPI, for example) can utilize L2/L3
transparency. Also, transparent ADN connections that are tunneled but not handed off can utilize the functionality.
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About Static Routes
Static routes define alternate gateways that the appliance can send packets to. A static route is amanually-configured
route that specifies a destination network or device and the specific router that should be used to reach it.

Note: For transparent bridge deployments, Trust DestinationMAC overrides any static
routes.

How Static Routes are Defined
You define static routes in a routing table. The routing table is a text file containing a list of static routesmade up of
destination IP addresses (IPv4 or IPv6), subnet masks (for IPv4) or prefix lengths (for IPv6), and gateway IP addresses
(IPv4 or IPv6). The table is broken out into sections for each routing domain; the topmost entries are in the default
routing domain. You are limited to 10,000 entries in the static routes table.

The following is a sample routing table:

10.25.36.0 255.255.255.0 10.25.36.1
10.25.37.0 255.255.255.0 10.25.37.1
2001::/64 fe80::2%0:1

[ROUTING_DOMAIN1]
10.73.37.0 255.255.255.0 10.73.37.1
[ROUTING_DOMAIN2]
10.73.38.0 255.255.255.0 10.73.38.1

Note that a routing table can contain a combination of IPv4 and IPv6 entries, but the gateway for each destinationmust
be on the appropriate network type. For example, an IPv6 destinationmust use an IPv6 gateway.

When a routing table is installed, all requested URLs are compared to the list and routed based on the best match.

View the Current Routing Table Configuration
To view the current routing table configuration:

1. In the Admin Console, select Configuration > Network > Routing.

2. In Routing Table, select Source.

The routing table configuration page opens in a new browser window.

Install a Routing Table
You can install the routing table using the followingmethods:

99 of 676



SGOS Administration (Admin Console Edition)

n Text editor, which allows you to enter settings (or copy and paste the contents of an existing file) directly onto the
appliance.

n Local file, to which the appliance can browse and install.

n RemoteURL, where you put an already-created file on an FTP or HTTP server to be downloaded to the appliance.

Use the # (config) static-routes path url command to set the path and the # load static-route-table
command to load the new routing table.

n CLI command # (config routing_domain_name) inline static-route-table EOF to install the static routing
table on the appliance.

Formore information on the CLI commands, refer to the Command Line Interface Reference.

To install a routing table:

1. In the Admin Console, select Configuration > Network > Routing.

2. In Routing Table, choose amethod to install the routing table:

Method Instructions

Text
editor

1. Select Install from Text Editor.

2. In the Load Edit and Install from text editor dialog, enter the contents manually or copy and paste the
contents from another file.

3. Select Install.

Local file 1. Select ... > Local File.

2. In the Load Edit and Install from local file dialog, browse to the directory of the file on the local
system.

3. Select Install.

Remote
URL

1. Select ... > Remote URL.

2. In the Load Edit and Install from remote URL dialog, enter the fully-qualified URL, including the
filename, where the file is located.

3. Select Download.

Note: If you useURL host rewrite functionality in your policies, mismatches can occur
between the client-provided IP address and the resolved, rewritten hostname. In these
cases, a routing lookup is performed and an interface route, static route, or default route is
used.
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Advanced Static Route Statistics
To view advanced static route statistics:

1. In the Admin Console, select Configuration > Network > Routing.

2. In Routing Table, select Static Routing Table.

The TCP/IP Static Routes page opens in a new browser window.

Caution: Proceed with caution. Symantec recommends that you refer to Symantec
Support for assistancewith this URL. Support might direct you to this link to provide
additional information during troubleshooting.
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Implement a Routing Domain
The Admin Console shows the following details about all configured routing domains and interfaces. Select
Configuration > Network > Routing and go to the specified section.

Section
Setting or field Description

Routing Domains Name Name of the routing domain.

Referenced Indicates whether or not the routing domain is referenced elsewhere in the
configuration (such as in Configuration > Network >DNS).

Before deleting a routing domain, remove any references to it.

Gateways All configured interfaces and aggregate interfaces on the appliance. For information
on gateways, see "Distribute Traffic ThroughMultiple Default Gateways" on page 90.

Interface to
Routing Domain
Mapping

See "Assign an Interface to a Routing Domain" on the facing page for details.

The appliance is configured with a default routing domain which cannot be deleted. Interfaces that are not assigned to
any routing domain are automatically added to the default routing domain. See "Assign an Interface to a Routing
Domain" on the facing page to assign an interface to a different routing domain.

To implement a routing domain:

1. Add or edit an adapter for the network.

Determine the interfaces to use for each routing domain (ingress and egress) and define them in the Admin
Console (Configuration > Network > Adapters). You can use either physical or VLAN interfaces, based on your
network configuration:

n If you are adding the new logical network to physical ports, connect your network to those ports on the
appliance. Then, add a VLAN to the appropriate interface (see step 5 in Configure a Network Adapter).
Leave theVLAN ID field blank, and define an IP address congruent with the new network.

n If your new logical network is based on VLAN tagging on a preexisting physical connection, add a VLAN to
the physical interface used for the connection (see step 5 in Configure a Network Adapter). Configure the
VLAN ID and IP address as appropriate for the new network.

2. Configure the routing domain for the new network. Select Configuration > Network > Domains. In Routing
Domains:
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a. Select Add Domain to add a routing domain.

b. Select an existing routing domain in the list or select Edit under Actions.

3. Add a gateway for the new network. In the Properties section:

a. InDomain Name, enter a routing domain name.

b. To add or edit IP gateways, follow instructions in "ConfigureMultiple Gateways for Load Balancing" on
page 90.

Add asmany gateways as needed.

4. Set a uniqueDNS server for the new network.

If you don’t define a DNS server for the new network, the routing domain uses the primary/alternate DNS server
configuration.

Note: The appliance uses the primary/alternate DNS configuration for all proxy-
initiated lookups, regardless of additional configuration.

See "Configure DNS Forwarding Groups" on page 116 for instructions.

Assign an Interface to a Routing Domain
You can assign an interface to a routing domain or change the current routing domain assignment.

The Admin Console provides an overview of the network interface configuration. Select Configuration
> Network > Routing and go to Interface to Routing Domain Mapping for the following configuration
information:

Setting or field Description

Interface Interface in the form adapter:interface or (if an aggregate interface) aggr:number.

VLAN ID VLAN identifier, if applicable. Otherwise, states "Physical Interface".

IP Address All VLANs (both IPv4 and IPv6) on the interface.

Routing
Domain

Routing domain to which the interface belongs. If the interface doesn't belong to a domain, value is
"None".

To assign the interface to a different routing domain, select the domain from the list.
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Configure Routing Information Protocol
RIP is designed to select the fastest route to a destination. Default routes added by RIP are treated the same as the static
default routes; that is, the default route load-balancing schemes apply to the default routes fromRIP. The appliance's
RIP implementation also supports advertising default gateways.

View the Current RIP Configuration
To view the current RIP configuration:

1. In the Admin Console, select Configuration > Network > Routing.

2. In RIP, select Sources.

The RIP configuration page opens in a new browser window.

Install RIP Settings
No RIP configuration file is shipped with the appliance; to configure RIP, you create a RIP installation file and install it
using one of the followingmethods:

n Text editor, which allows you to enter settings (or copy and paste the contents of an existing file) directly onto the
appliance.

n Local file, to which the appliance can browse and install.

n RemoteURL, where you put an already-created file on an FTP or HTTP server to be downloaded to the appliance.

Use the # (config) rip url command to set the path and the # load rip-settings command to load the
RIP settings.

n CLI command # inline rip-settingsEOF to install the RIP configuration on the appliance.

Formore information on the CLI commands, refer to the Command Line Interface Reference.

To install RIP settings:

Note: Do not enable RIP until after you have installed RIP settings.

1. Create the RIP configuration file. See "RIP Configuration File Commands" on page 107 for details.

2. In the Admin Console, select Configuration > Network > Routing.

3. In RIP, choose amethod to install RIP settings:
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Method Instructions

Text
editor

1. Select Install from Text Editor.

2. In the Load Edit and Install from text editor dialog, enter the contents manually or copy and paste the
contents from another file.

3. Select Install.

Local file 1. Select ... > Local File.

2. In the Load Edit and Install from local file dialog, browse to the directory of the file on the local
system.

3. Select Install.

Remote
URL

1. Select ... > Remote URL.

2. In the Load Edit and Install from remote URL dialog, enter the fully-qualified URL, including the
filename, where the file is located.

3. Select Download.

Enable RIP
RIP is disabled by default. After you have installed RIP settings, you can enable RIP.

To enable RIP:

1. In the Admin Console, select Configuration > Network > Routing.

2. In RIP, switch the Enable RIP (Routing Information Protocol) toggle.

View the Current RIP Commands
To view the current RIP commands:

1. In the Admin Console, select Configuration > Network > Routing.

2. In RIP, select RIP Settings.

The RIP Parameters page opens in a new browser window. See "RIP Configuration File Commands" on page 107
for information on supported commands.

Advanced RIP Statistics
To view advanced RIP statistics:

1. In the Admin Console, select Configuration > Network > Routing.

2. In RIP, select RIP Routes.
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The RIP Information page opens in a new browser window.

Caution: Proceed with caution. Refer to Broadcom Support for assistancewith this
URL. Support might direct you to this link to provide additional information during
troubleshooting.

Note: The browser prompt shows theManagement Center IP address, but the credentials
you require are for the Edge SWG (ProxySG) appliance.

The first time you open an Edge SWG (ProxySG) device link, the browser prompts you to log in. After a successful
authentication, you should not be prompted to enter credentials for the device again, unless they are changed or
removed in the Edge SWG (ProxySG) configuration. In this case, enter valid credentials.

Create Advertising Default Gateway Routes
Default routes advertisements are treated the same as the static default routes; that is, the default route load balancing
schemes also apply to the default routes fromRIP.

By default, RIP ignores the default routes advertisement. You can change the default fromdisable to enable and set the
preference group and weight through the CLI only.

To create advertising default gateway routes:

1. Log in to the CLI mode and enter # (config)mode.

2. Issue the following commands:

# (config) rip default-route enable
# (config) rip default-route group group_number
# (config) rip default-route weight weight_number

where group_number defaults to 1 and weight_number defaults to 100, the same as the static default route set by
the # (config) ip-default-gateway command.

3. (Optional) To view the default advertising routes, issue the # (config) show rip default-route command. The
CLI shows output similar to the following:

# (config) show rip default-route
RIP default route settings:
Enabled: Yes
Preference group: 3
Weight: 30
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RIP Configuration File Commands
You can put any of the commands below into a RIP configuration text file. You cannot edit a RIP file through the
command line, but you can overwrite a RIP file using the command # inline rip-settingsEOF. After the file is
complete, put it on an HTTP or FTP server accessible to the appliance and download it.

To view current RIP commands, see "View the Current RIP Commands" on page 105.

Note: RIP parameters are accepted in the order that they are entered. If a RIP parameter
is added, it is appended to the default RIP parameters. If a subsequent parameter conflicts
with a previous parameter, themost recent one is used.

net
net Nname[/mask] gateway Gname metric Value {passive | active | external}

Parameter Description

Nname Name of the destination network. It can be a symbolic network name, or an Internet address
specified in dot notation.

/mask Optional number between 1 and 32 indicating the netmask associated with Nname.

Gname Name or address of the gateway to which RIP responses should be forwarded.

Value The hop count to the destination host or network. A net Nname/32 specification is equivalent to
the host Hname command.

passive | active |
external

Specifies whether the gateway is treated as passive or active, or whether the gateway is external
to the scope of the RIP protocol.

host
host Hname gateway Gname metric Value {passive | active | external}

Parameter Description

Hname Name of the destination network. It can be a symbolic network name, or an Internet address specified
in dot notation.

Gname Name or address of the gateway to which RIP responses should be forwarded. It can be a symbolic
network name, or an Internet address specified in dot notation.

Value The hop count to the destination host or network. A net Nname/32 specification is equivalent to the
host Hname command.

passive | active
| external

Specifies whether the gateway is treated as passive or active, or whether the gateway is external to the
scope of the RIP protocol.
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RIP Parameters
Lines that do not start with net or host commandsmust consist of one ormore of the following parameter settings,
separated by commas or blank spaces:

Parameter Description

bcast_rdisc Specifies that Router Discovery packets should be broadcast instead of multicast.

if=[0|1|2|3] Specifies that the other parameters on the line apply to the interface numbered 0,1,2, or 3 in SGOS terms.

no_ag Turns off aggregation of subnets in RIPv1 and RIPv2 responses.

no_rdisc Disables the Internet Router Discovery Protocol. This parameter is set by default.

no_rdisc_adv Disables the transmission of Router Discovery Advertisements.

no_rip Disables all RIP processing on the specified interface.

no_ripv1_in Causes RIPv1 received responses to be ignored.

no_ripv2_in Causes RIPv2 received responses to be ignored.

no_solicit Disables the transmission of Router Discovery Solicitations.

no_super_ag Turns off aggregation of networks into supernets in RIPv2 responses.

passive Marks the interface to not be advertised in updates sent through other interfaces, and turns off all RIP and
router discovery through the interface.

passwd=XXX Specifies an RIPv2 password included on all RIPv2 responses sent and checked on all RIPv2 responses
received. The passwordmust not contain any blanks, tab characters, commas or ‘#’ characters.

rdisc_adv Specifies that Router Discovery Advertisements should be sent, even on point-to-point links, which by default
only listen to Router Discovery messages.

rdisc_pref=N Sets the preference in Router Discovery Advertisements to the integer N.

rdisc_
interval=N

Sets the nominal interval with which Router Discovery Advertisements are transmitted to N seconds and their
lifetime to 3*N.

redirect_ok Causes RIP to allow ICMP Redirect messages when the system is acting as a router and forwarding packets.
Otherwise, ICMP Redirect messages are overridden.

ripv2_out Turns off RIPv1 output and causes RIPv2 advertisements to be multicast when possible. ripv2 Is equivalent to
no_ripv1_in and no_ripv1_out. This parameter is set by default.

send_solicit Specifies that Router Discovery solicitations should be sent, even on point-topoint links, which by default only
listen to Router Discovery messages.

trust_
gateway=rname

Causes RIP packets from that router and other routers named in other trust_gateway keywords to be
accepted, and packets from other routers to be ignored.
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Edge SWG (ProxySG)-Specific RIP Parameters
The following RIP parameters are unique to Edge SWG (ProxySG) configurations.

Parameter Description

advertise_
routes

-s option:

Supplying this option forces routers to supply routing information whether it is acting as an Internetwork router or
not. This is the default if multiple network interfaces are present or if a point-to-point link is in use.

-g option:

This flag is used on Internetwork routers to offer a route to the 'default' destination. This is typically used on a
gateway to the Internet, or on a gateway that uses another routing protocol whose routes are not reported to
other local routers.

-h option:

Suppress_extra_host_routes advertise_host_route

-m option:

Advertise_host_route onmulti-homed hosts

-A option:

Ignore_authentication //

supply_
routing_
info

no_supply_
routing_
info

-q option:

Opposite of -s.

no_rip_out Disables the transmission of all RIP packets. This setting is the default.

no_ripv1_
out

Disables the transmission of RIPv1 packets.

no_ripv2_
out

Disables the transmission of RIPv2 packets.

rdisc Enables the transmission of Router Discovery Advertisements.

rip_out Enables the transmission of RIPv1 packets.

ripv1 Causes RIPv1 packets to be sent.

ripv1_in Causes RIPv1 received responses to be handled.

ripv1_out Enables the transmission of RIPv1 packets.
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Using Passwords with RIP
The first password specified for an interface is used for output. All passwords pertaining to an interface are accepted on
input. Consider the following settings:

if=0 passwd=aaa
if=1 passwd=bbb
passwd=ccc

Interface 0 accepts passwords aaa and ccc, and transmits using password aaa.

Interface 1 accepts passwords bbb and ccc, and transmits using password bbb.

Other interfaces accept and transmit the password ccc.
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Configure DNS
This section describes various configuration tasks associated with DNS services. During initial configuration of the
appliance, you configured the IP address of a single primary DNS server. You can add one ormore alternate DNS servers,
and also define customDNS service groups.

DNS comprises a hierarchical set of DNS servers. For each domain or sub-domain, one ormore authoritative DNS
servers publish information about that domain and the name servers of any domains that are under it.

There are two types of DNS queries:

n Non-recursive, whichmeans that a DNS server can provide a partial answer or return an error to the client.

n Recursive, whichmeans that theDNS server either fully answers the query or returns an error to the client.

By default, recursive DNS is disabled on the appliance.

See Also:

n "Recursive and Non-Recursive DNS" on page 113

DNS Forwarding Groups
DNS servers are configured in groups. Customers with split DNS server configuration (for example, environments that
maintain private internal DNS servers and external DNS servers) might choose to add servers to an alternate DNS server
group as well as to the primary DNS server group. In addition, you can create customDNS server groups.

On the appliance, internal DNS servers are placed in the primary group, while external DNS servers (with the Internet
information) populate the alternate group.

If routing domains are configured on the appliance, you can associate DNS server groups with a routing domain. See
"Implement a Routing Domain" on page 102 for details.

Note: The appliance always uses the primary and alternate DNS groups for requests
initiated by the appliance.

See Also:

n "Configure DNS Forwarding Groups" on page 116

Resolve Hostnames Using Name Imputing Suffixes
The Edge SWG (ProxySG) appliance queries the original hostname before checking imputing suffixes unless there is no
period in the hostname. If there is no period in the hostname, imputing is applied first.
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The appliance uses name imputing to resolve hostnames based on a partial name specification (DNS name imputing
suffix). When the appliance submits a hostname to theDNS server, the DNS server resolves the hostname to an IP
address.

The appliance then tries each entry in the name-imputing suffixes list until the name is resolved or it reaches the end of
the list. If by the end of the list the name is not resolved, the appliance returns a DNS failure. For example, if the name-
imputing list contains the entries example.com and com, and a user submits the URL http://www.eedept, the appliance
resolves the host names in the following order.

www.eedept
www.eedept.example.com
www.eedept.com

See Also:

n "Configure DNSName Imputing Suffixes" on page 120

Negative DNS Response Caching
By default, the appliance caches negative DNS responses sent by a DNS server. You can configure the appliance to set
the TTL value for a negative DNS response to be cached. You can also disable negative DNS response caching. This
functionality is only available through the CLI. You can't configure DNS negative caching through the Admin Console.

The appliance supports caching of both type A and type PTR DNS negative responses.

Note: The appliance generatesmoreDNS requests when negative caching is disabled.

To configure negative caching TTL values, issue the CLI command:

# (config) dns negative-cache-ttl-override seconds

where seconds is an integer between 0 and 600. Setting the TTL value to 0 seconds disables negative DNS caching;
setting the TTL setting to a non-zero value overrides the TTL value from theDNS response.

To restore negative caching defaults, issue the CLI command:

# (config) dns no negative-cache-ttl-override
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Recursive and Non-Recursive DNS
There are two types of DNS queries:

n Non-recursive, whichmeans that a DNS server can provide a partial answer or return an error to the client

n Recursive, whichmeans that theDNS server either fully answers the query or returns an error to the client

Non-Recursive DNS
If you have definedmore than oneDNS server, the Edge SWG (ProxySG) appliance uses the following logic to determine
which servers are used to resolve a DNS host ame and when to return an error to the client.

Note: Servers are always contacted in the specified order in a group list.

n The Edge SWG (ProxySG) appliance first checks all the DNS groups for a domainmatch, using domain-suffix
matching to match a request to a group.

o If there is amatch, the servers in thematched group are queried until a response is received; no other DNS
groups are queried.

o If there is nomatch, the appliance selects the Primary DNS group.

n The appliance sends requests to DNS servers in the Primary DNS server group in the order in which they appear in
the list. If a response is received fromone of the servers in the Primary group, no attempts aremade to contact
any other Primary DNS servers.

n If none of the servers in the Primary group resolve the host name, the appliance sends requests to the servers in
the Alternate DNS server group. (If no Alternate servers have been defined, an error is returned to the client.)

o If a response is received from a server in the Alternate group list, there are no further queries to the
Alternate group.

o If a server in the Alternate DNS server group is unable to resolve the host name, an error is returned to the
client, and no attempt ismade to contact any other DNS servers.

The Alternate DNS server is not used as a failover DNS server. It is only used when DNS resolution of the
Primary DNS server returns a name error. If the query to each server in the Primary list times out, no
alternate DNS server is contacted.

n If the appliance receives a referral (authoritative server information), DNS recursion takes over if it is enabled.

If the appliance receives a negative DNS response (a responsewith an error code set to name error), it caches that
negative response. See "Negative DNS Response Caching" on the previous page.
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Recursive DNS
If you have enabled recursive DNS, the appliance uses the following logic to determine how to resolve a DNS host name
and when to return an error to the client.

If the DNS server response does not contain an A record with an IP address but instead contains authoritative server
information (a referral), the appliance follows all referrals until it receives an answer. If the appliance followsmore than
eight referrals, it assumes there is a recursion loop, aborts the request, and sends an error to the client.

When to Enable Recursive DNS

If you have a DNS server that cannot resolve all host names, it might return a list of authoritative DNS servers instead of
a DNS A record that contains an IP address. To avoid this situation, configure the appliance to recursively query
authoritative DNS servers.

To enable recursive DNS:

1. In the Admin Console, select Configuration > Network > DNS.

2. In Settings, switch the Enable DNS Recursion toggle.

Extensions for DNS
TheDNS proxy supports EDNS, which allows DNS requesters to receive DNS UDPmessages longer than the default 512
bytes. For detailed information on EDNS, refer to the following RFCs:

n RFC 2671: https://www.ietf.org/rfc/rfc2671.txt

n RFC 6891: https://tools.ietf.org/html/rfc6891

EDNS request messages consist of the following sections:

n constant section: Includes an acceptable DNS response size. TheDNS proxy uses this value to send long
responses.

n variable section: TheDNS proxy does not parse this section and transparently forwards it to upstreamDNS server
instead.

When EDNS is enabled on the appliance, the DNS proxy:

n accepts EDNS queries

n allocates DNS RESPONSE buffers with respect to the original queries

n forwards EDNS variable sections to the upstreamDNS server

n saves long DNS server responses in theDNS cache

n creates long responses to EDNS clients

To enable EDNS:
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1. In the Admin Console, select Configuration > Network > DNS.

2. In Settings, switch the Enable EDNS toggle.
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Configure DNS Forwarding Groups
The following rules apply to DNS forwarding groups:

n You can add servers to the primary and alternate groups, but you cannot change the domain or add additional
domains; these groups are defined at initial configuration.

n The primary and alternate DNS groups can't be deleted.

n A customDNS groupmust include at least oneDNS server address before adding a domain. In addition, youmust
delete all domains associated with the last server in theDNS group before you can delete the server.

DNS Health Checks
Each time you add aDNS server to a group, the appliance automatically creates a DNS health check for that server IP
address and uses a default configuration for the health check. For example, if you add aDNS server to a primary or
alternate DNS group, the created health check has a default hostname of symantec.com. If you add aDNS server to a
custom group, the longest domain name is used as the default hostname for the health check.

After you add DNS servers to a group, check theDNS server health check configurations and edit them as required.

DNS Forwarding Group Details
In the Admin Console, select Configuration > Network > DNS. The Forwarding Groups section lists all configured
DNS server groups on the appliance and displays information about each one:

Setting or field Description

Name Name of the DNS server group.

Servers The DNS server addresses belonging to the specified group. Both IPv4 and IPv6 addresses are supported.

Domains The DNS server domains belonging to the specified group. Does not apply to the primary and alternate
groups.

Routing
Domain

Routing domains associated with the DNS server group.

Configure the Primary or Alternate Group
When you first set up the appliance, you configured a primary DNS server. If your deployment makes use of more than
oneDNS server, you can them to the primary or alternate server group; you can also delete DNS servers from the
primary group, but you cannot delete the group or change the domain or add additional domains—the group is defined
at initial configuration.

If you are using the appliance in amixed IPv4/IPv6 environment, you should configure both IPv4 and IPv6 DNS servers.

To configure the primary/alternate group:
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1. In the Admin Console, select Configuration > Network > DNS.

2. In Forwarding Groups:

n Select Add Group to add a group.

n Select an existing group in the list or select Edit under Actions.

The Editing group page displays group settings.

3. (Optional) BesideRouting Domain, select a routing domain to associate with the group. See "Implement a
Routing Domain" on page 102 for details.

4. Configure DNS server addresses in the group:

n To add addresses:

o Select Add > Add Server to add entries one at a time.

o Select Add > Paste Multiple to addmultiple entries at a time. In the PasteMultiple dialog, enter
each address on a separate line. The addresses are added in the specified order.

If needed later, you can change the order of DNS servers using the CLI. See "ChangeOrder of
DNS Servers in a List" on page 119.

n To edit an existing address, type directly in the Server field.

Define a Custom DNS Group
Custom groups enable you to specify servers and domains for specific company needs (such as resolving internal or
external hostnames) depending on how you have set up your primary and alternate DNS groups.

DNS Group Requirements

n Valid DNS entry formats arewww.example.com, example.com.

n You can create amaximumof 8 custom groups , and each custom group can contain amaximumof four DNS
servers and eight domains.

n Groups don't accept wild cards, such as *.example.com.

n Groups don't partially match domain names, such as *.example.com and .example.com. exam.comdoesn't
match queries for www.example.com.

n DNS record requirements have been relaxed, as discussed in RFC 2181. Review sections 10 and 11 formore
information.

To define a customDNS group:
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1. In the Admin Console, select Configuration > Network > DNS.

2. In Forwarding Groups:

n Select Add Group to add a group.

n Select an existing group in the list or select Edit under Actions.

The Editing group page displays group settings.

3. Specify the following settings as needed:

Setting or
field

Description

Group Name Name of the DNS server group.

Routing
Domain

(Optional) Routing domain associated with the DNS server group. See "Implement a Routing Domain" on
page 102 for details.

4. Configure DNS server addresses in the group:

n To add addresses:

o Select Add > Add Server to add entries one at a time.

o Select Add > Paste Multiple to addmultiple entries at a time. In the PasteMultiple dialog, enter
each address on a separate line. The addresses are added in the specified order.

If needed later, you can change the order of DNS servers using the CLI. See "ChangeOrder of
DNS Servers in a List" on the facing page.

n To edit an existing address, type directly in the Server field.

5. Configure DNS server domains in the group:

n To add domains:

o Select Add > Add Server to add entries one at a time.

o Select Add > Paste Multiple to addmultiple entries at a time. In the PasteMultiple dialog, enter
each domain on a separate line. The domains are added in the specified order.

n To edit an existing domain, type directly in theDomain field.

Note: If a domain becomes defunct, you can delete it from aDNS group. In
addition, youmust delete all domains associated with the last server in any DNS
group before you can delete the server.
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Change Order of DNS Servers in a List
Using the CLI, you can promote DNS servers in the list for any DNS forwarding group.

To promote or demote DNS servers in a list:

# (config dns forwarding) edit group_alias

This changes the prompt to:

# (config dns forwarding group_alias)
# (config dns forwarding group_alias) { demote | promote} server_ip_address number

where theDNS server specified by server_ip_address is demoted or promoted number places in the list, and number is a
positive number.
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Configure DNS Name Imputing Suffixes
Using name imputing suffixes is particularly useful for a company’s internal domains. For example, name imputing
enables you to enter webServer rather than webServer.inOurInternalDomain.ForOurCompany.com.

Also, this resolves any problemwith external root servers being unable to resolve names that are internal only. The Edge
SWG (ProxySG) appliance supports up to 30 name imputing suffixes.

To configure DNS name imputing suffixes:

1. In the Admin Console, select Configuration > Network > DNS.

2. In Imputing:

n To add an entry, select Add DNS name imputing suffix and enter the suffx in theName Imputing
Suffix field that becomes available.

n To edit an existing entry in the list, type directly in theName Imputing Suffix field.

Change the Order of DNS Name Imputing Suffixes
The appliance uses imputing suffixes according to the list order. You can organize the list of suffixes so the preferred
suffix displays at the top of the list.

Note: This functionality is only available through the Admin Console. You can't configure
it using the CLI.

To change the order of DNS name imputing suffixes:

1. In the Admin Console, select Configuration > Network > DNS.

2. In Imputing:

n To promote an entry, select the up arrow under Actions.

n To demote an entry, select the down arrow under Actions.
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About WCCP
TheWCCP protocol allows certain Cisco routers and switches to transparently redirect traffic to a cache engine such as an
Edge SWG (ProxySG) appliance. This traffic redirection helps to improve response time and optimize network resource
usage. The appliance can be configured to participate in aWCCP scheme, in whichWCCP-capable switches or routers
collaboratewith appliances to form one ormore groups that service requests from clients.

Note: WCCP is supported for the default routing domain only. You cannot configure
WCCP formultiple routing domains. See "Implement a Routing Domain" on page 102 for
information on routing domains.

WCCP on the Edge SWG (ProxySG) Appliance
In virtually in-path deployments, when the Edge SWG (ProxySG) appliance is not in the physical path of clients and
servers, aWCCP-capable router is used to redirect traffic to the appliance for transparent proxy services.

In a transparent proxy deployment the client is not aware that it is interacting with an intermediate proxy and not the
OCS. The process works as follows:

1. The client sends a packet addressed for theOCS.

2. TheWCCP-enabled router redirects the packet to the appliance.

3. The appliance determines what to do with it based on the transparent proxy services that have been configured
for the traffic type. If it cannot service the request locally (for example by returning a page from its local cache), it
sends a request to the specified OCS on behalf of the client.

TheOCS response is routed (or redirected depending on the configuration) back to the appliance.

The appliance then forwards the response back to the client. To implement this transparent redirection scheme, one or
more appliances and one ormore routers/switchesmust form a service group.

The appliance offers VLAN Support forWCCP and allows you to redirect traffic from the router over physical or virtual
interfaces. If you configuremultiple virtual interfaces between the appliance and theWCCP-capable router, you can
segregateWAN and LAN traffic on the same physical interface by enabling a VLAN trunk between the appliances. By
default, VLAN trunking is enabled on the appliance. For information on VLANs, see "Configure a VLAN" on page 65.

See Also:

n "Requirements for ConfiguringWCCP" on page 125

n "ConfigureWCCP" on page 126
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Service Groups
A service group unites one ormore routers/switches with one ormore appliances in a transparent redirection scheme
governed by a common set of rules. The service groupmembers agree on these rules by announcing their specific
capabilities and configuration to each other in WCCP protocol packets. When creating a service group on the appliance,
you define the following:

Home Router Address

In order to establish andmaintain a service group, the appliances and routersmust be able to communicate. To specify
the addresses of all the routers in a service group, youmust choose one of the followingmethods:

n Unicast: Each Edge SWG (ProxySG) appliancemust be explicitly configured with the IP address of every router in
the service group. You will need to reconfigure each appliancewhenever you add or remove a router from the
group.

n Multicast: The routers and Edge SWG (ProxySG) appliances in the service group communicate using a single IP
address in the range of 224.0.0.0 to 239.255.255.255. To configure this, each appliance and each router in the
groupmust be configured with themulticast IP address. If theWCCP routers and/or appliances aremore than
one hop apart, IP multicast routingmust also be enabled on the intervening routers.

Service Group Authentication

If you are usingWCCP v2, you can secure a service group by configuring anMD5 authentication between the Edge SWG
(ProxySG) appliances and the routers in the group.

To configure authentication, youmust define the same password on all routers and all appliances in the service group.
When authentication is enabled, an appliance is not allowed to join the service group unless it knows the password.

Packet Forward and Return Methods

The packet forward and returnmethod for a service group defines how the router forwards packets to the Edge SWG
(ProxySG) appliance as well as how the appliance returns packets that it does not intercept because of the policy or
services configured on it, back to the router.

Symantec recommends that all service groups configured on a router use the same forwarding and returnmethods.

The appliance supports the following forward/returnmethods:

n GRE Forwarding/GRE Return: With GRE forwarding, the router encapsulates the intercepted packet in an
additional IP and GRE header that shows the router address as the source IP address and the address of the
appliance as the destination IP address. When the appliance receives the packet, it strips the outside header and
then determines how to process the request, either forwarding the request on to theOCS or servicing it locally.

When returning the redirected packet, the appliance encapsulates the packet with an IP and GRE header that
bears the IP address of the appliance as the source and the router IP address as the destination.
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n L2 Forwarding/L2 Return: With Layer 2 (L2) forwarding the router rewrites the destinationMAC address of the
intercepted packet to theMAC address of the appliance to which it is redirecting the packet. Thismethod is faster
than GRE forwarding because the forwarding is done at the hardware level and doesn’t require encapsulating and
decapsulating the packet at Layer 3. However, to use L2 forwarding, the appliance and the routers in the service
groupmust all be on the same L2 broadcast domain (that is, there cannot bemore than one hop between them).

When returning the redirected packet, the appliance rewrites the destinationMAC address to that of the router.

To determinewhether L2 forwarding is supported on your hardware platform, refer to your Cisco
documentation. For a list of the Cisco platforms on which Symantec has tested L2 forwarding with the appliance,
refer to theWCCP Reference Guide.

n L2 Forwarding/GRE Return: With L2 forwarding the router rewrites the destinationMAC address of the
intercepted packet to theMAC address of the appliance to which it is redirecting the packet.

When returning the redirected packet, the appliance encapsulates the packet with an IP and GRE header that
bears the IP address of the appliance as the source and the router IP address as the destination.

Note: The appliance does not support GRE forwarding and L2 packet return. If you
configure this combination, the appliancewill generate a capability mismatch error. To
view the errors and warnings, use the # show wccp status CLI command.

Router Affinity

By default, the Edge SWG (ProxySG) appliance uses the configured returnmethod to return bypassed traffic to the
router that redirected it and uses regular routing table lookups to determine the next hop for intercepted traffic. With
router affinity, the appliance also uses the configured returnmethod to return intercepted clientand/ or server-bound
traffic to theWCCP router that redirected it, bypassing the routing table lookup. This is a useful feature if you have
routing policies that may prevent your client- and/or server-bound traffic from reaching its destination and simplifies the
appliance configuration process by eliminating the need to replicate these policies on the appliance. It is also useful in
configurations where you havemultiple home routers or where yourWCCP router ismultiple hops away from the
appliance because it ensures that the traffic is always returned to the sameWCCP router that redirected it.

Keep inmind, however, that enabling this feature unnecessarily when using GRE return does add additional CPU
overhead on the router due to the need to decapsulate theGRE packets. In addition, the appliance and the router use a
reducedMTU for GRE packets, which reduces the amount of data that can be transferred per packet.

Assignment Types

For every service group, youmust configure theway the router determines the appliance to which to redirect a given
packet, by setting an assignment type on the appliance. When the service group is formed, the appliancewith the lowest
IP address automatically becomes the designated cache (and if there is only one appliance in the service group, it is
automatically the designated cache). The designated cache is responsible for communicating the assignment settings to
the router, that is which appliance should be assigned a particular packet.

The appliance supports two assignment types:

123 of 676



SGOS Administration (Admin Console Edition)

n Hash Assignment (Default): With hash assignment, the designated cache assigns each appliance in the service
group a portion of a 256-bucket hash table and communicates the assignment to the routers in the group. When
the router receives a packet for redirection, it runs the hashing algorithm against one ormore of the fields in the
packet header to determine the hash value. It then compares the value to the hash assignment table to seewhich
appliance is assigned to the corresponding bucket and then forwards the packet to that appliance. When you
configure the service group on the appliances, you specify which field(s)—destination IP address, destination port,
source IP address, and/or source port—should be used to calculate the hash value.

In some cases, since all of the packets are hashed using the same fields and algorithm, it is possible that one of the
caches in the group can become overloaded. For example, if you have a large proportion of traffic that is directed
to the same server and you are using the destination IP address to run the hashing function, it is possible that the
bulk of the traffic will be redirected to the same appliance. Therefore, you can configure an alternate field or
group of fields to use to run the hashing algorithm. The router will then use this alternate hashing algorithm if the
number of GRE packets orMAC addresses (depending on the forwardingmethod you’re using) redirected to a
given appliance exceeds a certain number.

For details on configuring a hash-weight value to adjust the proportion of the hash table that gets assigned to an
appliance, see "WCCP Load Balancing " below below.

n Mask Assignment: Withmask assignment, each router in the service group has a table of masks and values that it
uses to distribute traffic across the appliances in the service group. When the router receives a packet, it performs
a bitwise AND operation between themask value and the field of the packet header that is designated in the
appliancemask assignment configuration. It then compares the result against its list of values for eachmask; each
value is assigned to a specific appliance in the service group.

WCCP Load Balancing

Each Edge SWG (ProxySG) appliance in the service group is assigned roughly an even percentage of the load by default,
regardless of assignment type. If you would like to adjust or balance the load acrossmultiple appliances, you can assign a
weight value to each appliance in the group. Edge SWG (ProxySG) appliances with higher weight values receive a larger
portion of the redirected traffic.

For example, suppose you have assigned the following weight values: Edge SWG (ProxySG) appliance1=100, Edge SWG
(ProxySG) appliance2=100, and Edge SWG (ProxySG) appliance3=50 respectively. The total weight value is 250, and so
Edge SWG (ProxySG) appliance1 and Edge SWG (ProxySG) appliance2 will each receive 2/5 of the traffic (100/250) and
Edge SWG (ProxySG) appliance3 will receive 1/5 of the traffic (50/250).

If an Edge SWG (ProxySG) appliance becomes unavailable, the load will automatically be redistributed across the
remaining Edge SWG (ProxySG) appliances in the service group.

See Also:

n "Requirements for ConfiguringWCCP" on the facing page

n "Configure Service Groups" on page 129
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Requirements for Configuring WCCP
Before you configureWCCP on the Edge SWG (ProxySG) appliance, complete the following tasks:

n Plan your service groups by determining:

o Which routers and which appliances will work together in the redirection scheme.

o TheWCCP capabilities that your router/switch supports. Refer to the documentation that camewith your
router for the specifics on your router/switch.

o What traffic you want to redirect. Do you want to redirect all traffic, or just a specific protocol or specific
ports? Do you want to exclude certain hosts or traffic from redirection?

o What forwarding and returnmethod you plan to use. Make sure that all the routers in the service group
support the chosenmethod(s).

o If you want to enable router affinity so that the appliance uses the chosen returnmethod to return
intercepted server- and/or client-bound traffic to the originatingWCCP router as well as bypassed traffic.

o How the router will assign a specific redirected packet to an appliance. Make sure the router(s) in the
service group support the assignment method you plan to use. If there ismore than one appliance in the
service group, decidewhether you want to distribute traffic equally, or if you want to assign varying
weights.

n Configure the routers. For information on the feature sets and the capabilities of your router and for instructions
on how to configureWCCP on the router, refer to the router documentation. For sample routerWCCP
configurations, refer to theWCCP Reference Guide.
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Configure WCCP
Make sure you havemet requirements before proceeding withWCCP configuration.

View the Current WCCP Configuration
To view the current WCCP configuration:

1. In the Admin Console, select Configuration > Network > WCCP.

2. InWCCP Settings, select Show Source.

The console displays theWCCP settings source.

WCCP Configuration Example

The following is an example of an enabledWCCP configuration:

wccp enable
wccp version 2
service-group 9

forwarding-type L2
returning-type GRE
router-affinity both
assignment-type mask
mask-scheme source-port
priority 1
protocol 6
service-flags ports-defined
ports 80 21 1755 554 0 0 0 0
interface 0:0
home-router 10.16.18.2

end

For descriptions of the values in the configuration file, refer to theWCCP Reference Guide.

Install WCCP Settings
Youmust create aWCCP configuration file on the appliance that contains theWCCP settings specific to the appliance.
When installed, these configuration settings enable the appliance to collaboratewith theWCCP-capable router or switch.
To configureWCCP, you create aWCCP installation file and install it using one of the followingmethods:

n Text editor, which allows you to enter settings (or copy and paste the contents of an existing file) directly onto the
appliance.

n Local file, to which the appliance can browse and install.
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n RemoteURL, where you put an already-created file on an FTP or HTTP server to be downloaded to the appliance.

Use the # (config) wccpurl command to set the path and the # load wccp-settings command to load the
WCCP settings.

n CLI command # inline wccp-settingsEOF to install thewccp configuration on the appliance.

Formore information on the CLI commands, refer to the Command Line Interface Reference.

To install WCCP settings:

Note: Do not enableWCCP until after you have installedWCCP settings.

1. Create theWCCP configuration file.

2. In the Admin Console, select Configuration > Network > WCCP.

3. InWCCP Settings, choose amethod to install WCCP settings:

Method Instructions

Text
editor

1. Select Install from Text Editor.

2. In the Load Edit and Install from text editor dialog, enter the contents manually or copy and paste the
contents from another file.

3. Select Install.

Local file 1. Select ... > Local File.

2. In the Load Edit and Install from local file dialog, browse to the directory of the file on the local
system.

3. Select Install.

Remote
URL

1. Select ... > Remote URL.

2. In the Load Edit and Install from remote URL dialog, enter the fully-qualified URL, including the
filename, where the file is located.

3. Select Download.

Enable WCCP
WCCP is disabled by default. After you have installedWCCP settings, you can enableWCCP.

To enableWCCP:
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1. In the Admin Console, select Configuration > Network > WCCP.

2. InWCCP, switch the Enable WCCP toggle.

Note: To exclude a Edge SWG (ProxySG) appliance from receiving traffic or from
participating in any of the services groups configured on it, you can disableWCCP on the
appliance. DisablingWCCP does not delete theWCCP configuration settings; it makes
themout-of-service until WCCP is re-enabled on the appliance.
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Configure Service Groups
Make sure you havemet requirements before proceeding with service group configuration.

In the Admin Console (Configuration > Network > WCCP), theWeb Cache Service Groups section lists all
configured service groups on the appliance and displays basic information about each one:

Setting or field Description

Group Number Unique identifier (from 0 to 255).

Home Router Home router address.

Ports Ports to redirect on: All, Source, or Destination.

To configureWCCP service groups:

1. In the Admin Console, select Configuration > Network > WCCP.

2. InWeb Cache Service Groups:

n To add a service group, select Add Aggregate.

n To edit an existing service group, select it in the list.

The Add/Edit Web Cache Service Group page opens.

3. Enter or edit the following settings as needed:

Section Setting or
field

Description

Number,
Priority

Service
Group
Number

Unique identifier (from 0 to 255).

Priority (Optional) Select a service group priority. Whenmultiple service groups that are redirecting
the same traffic (such as HTTP on port 80) are assigned to a common router interface, the
priority defines the order in which the router evaluates the service groups.

Password Use
Password

Switch the Use password toggle to configure MD5 authentication for added security. The
password can include 1 to 8 characters. When authentication is enabled on the router, the
Edge SWG (ProxySG)appliance must be configured with the same password to join the
service group.
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Section Setting or
field

Description

Interfaces Interface Physical or virtual interface to which the service group is applied. Virtual interfaces are
depicted as adapter:interface.vlan_id, for example, 0:0.3.

Select Add to apply the service group to more interfaces. To remove interfaces, delete
them from the list.

Weight (Optional) Specify a weight value (from 1 to 255) to determine the proportion of traffic that
the router redirects to this interface.

Use this field only if you are redirecting traffic in the same service group to multiple
interfaces or to multiple Edge SWG (ProxySG) appliances and you want to allocate the
percentage of traffic redirected to each appliance and/or interface in the service group.

Redirect Redirect
On

Ports to redirect on: All, Source, or Destination.
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Section Setting or
field

Description

Forwarding,
Returning

Forwarding
Type

How the router and the Edge SWG (ProxySG) appliance handle packet forwarding.

Select GRE or L2 forwarding. For the GRE forwarding method, the Edge SWG (ProxySG)
appliance only supports GRE return. For a description of these options, see "Packet Forward
and Return Methods" on page 122.

Returning
Type

How the router and the Edge SWG (ProxySG) appliance handle packet return.

(Only applicable if you select L2 forwarding) Select GRE or L2 returning. For a description of
these options, see "Packet Forward and Return Methods" on page 122.

Router
Affinity

(Optional) To ensure that intercepted traffic is always routed through the WCCP router that
redirected it, select a Router affinity value:

n Client indicates that the appliance will return client-bound traffic to the originating
WCCP router using the configured Returning Type.

n Server indicates that the appliance will return server-bound traffic to the originating
WCCP router using the configured Returning Type.

n Both indicates that the appliance will return both client- and server-bound traffic to
the originating WCCP router using the configured Returning Type.

n None (the default) indicates that the appliance will use regular routing table lookups
rather than the configured Returning Type to route the client- and server-bound
traffic that it intercepts.

Home
Router

Home router address. Specify individual unicast or a single multicast address for the router
(s) in the service group:

n To use multicast addressing, selectMulticast Home Router and enter the Group
Address, Optionally, enter aMulticast TTL value.

n To use unicast addresses, select Individual Home Router Addresses. For each
router in the service group, select Add and enter a Home Router address. The
home router address that you use for a service group on the appliance should be
consistent with the IP address (virtual or physical) over which the appliance
communicates with the router.

Group
Address

Group address for multicast addressing. Specify ifMulticast Home Router is selected for
Home Router.

Multicast
TTL

How long a multicast packet is propagated. Default value is 1. Specify ifMulticast Home
Router is selected for Home Router.
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Section Setting or
field

Description

Assignment
Type

Hash Instructs the router to use hash to distribute redirected traffic, using packet header
information. You can select a different assignment method for each service group
configured on the same appliance.

To use hash:

1. Select Hash.

2. For Primary Hash, select one or more packet header fields.

3. (Optional) For Alternate Hash, select one or more header fields. The alternate
hashing function is used to distribute traffic when a particular appliance exceeds a
given number of redirected packets.

Mask Instructs the router to use mask to distribute redirected traffic, using packet header
information. You can select a different assignment method for each service group
configured on the same appliance.

To use mask:

1. SelectMask.

2. ForMask Scheme, select the packet header field to use to run the mask function.

3. Enter a Value in either decimal or, when prefixed by 0x, a hexadecimal value. The
default value for this field is 0x3f.

The following Cisco Web page describes the mask value in detail:

https://www.cisco.com/c/en/us/products/collateral/switches/catalyst-6500-series-
switches/white_paper_c11-629052.html
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About the Forwarding System
Forwarding creates a proxy hierarchy, which consists of a set of proxies (including Edge SWG (ProxySG) appliances that
are configured as proxies; see "About Proxy Services " on page 174). Appliances close to the origin server perform object
caching for server content and distribute the content to the object caches of other proxies that are farther away from
the origin server. If forwarding is set up in an organizedmanner, the load involved with object caching is distributed
throughout the proxy hierarchy, which avoids sending any piece of content across any givenWAN link more than once.

Forwarding redirects content requests to IP addresses other than those specified in the requesting URL. Forwarding
affects only the IP address of the upstreamdevice to which a request is sent; forwarding does not affect the URL in the
request.

The Edge SWG (ProxySG) forwarding system consists of forwarding, upstream SOCKS gateways, load balancing, host
affinity, and health checks. The forwarding systemdetermines the upstream address where a request is sent, and is tied
in with all the protocol proxies.

Note: The Edge SWG (ProxySG) forwarding systemdirectly supports the forwarding of
HTTP, HTTPS, FTP, MMS, RTSP, Telnet, and TCP tunnels.

Example of a Forwarding System
This section discusses an example of using forwarding to minimize traffic overWAN links and to the Internet by
leveraging object caching on proxies in the forwarding system.

Note: The Edge SWG (ProxySG) forwarding systemdirectly supports the forwarding of
HTTP, HTTPS, FTP, MMS, RTSP, Telnet, and TCP tunnels.

The example discussed in this section uses the following logical proxy hierarchy:
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There are five Edge SWG (ProxySG) appliances configured as proxies: one in the central data center and one apiece in
four branch offices or sites.

Appliance 1, located in the central data center, provides Internet access for the entire system. Appliance 4 uses Appliance
2 as its forwarding host and Appliance 2 uses Appliance 1 as its forwarding host. Similarly, Appliance 5 uses Appliance 3
as its forwarding host and Appliance 3 uses Appliance 1 as its forwarding host. Thismeans that, for example, any piece of
content in Appliance 1’s object cache can be distributed to Appliance 2 or Appliance 3’s object cachewithout having to
send the content over the Internet.

The following figure shows amore detailed view of the example network.
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n Appliance 1 (located in the central data center) acts as a gateway to the Internet; in other words, all Internet access
goes through Appliance 1. Two regional data centers accept requests from four branch offices or sites, each with
appliances configured as proxies.

n Appliance 1 is the gateway to the Internet, so it is upstreamof all other Appliances shown above.

n Load-balanced Appliance 2 and Appliance 3 are configured to use Appliance 1 as their forwarding host, so they are
downstreamof Appliance 1.

n Appliance 4 is configured to use the load-balanced group of Appliances labeled 2 as its forwarding host, so
Appliance 4 is downstreamof both Appliance 2 and Appliance 1.

n Appliance 5 is downstreamof Appliance 3 and Appliance 1.

Another way of stating this, using Appliance 4 as an example, is that any request to the Internet goes through Appliance
2 and Appliance 1 instead of going directly to the host specified in theURL of the request.

How the Example Uses Object Caching
The following example shows how forwarding and object caching work together to minimize traffic over the example
network’sWAN links and to the Internet.
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In this example:

n A user connected to Appliance 4 requests content located on aWeb server in the Internet. The content—which
might be a spreadsheet ormultimedia—is in the object cache of load-balanced Appliance 2, and therefore is
retrieved from the object cache. Neither theWAN links nor the origin server are used to retrieve the content. The
content is then cached on Appliance 4’s object cache so the next time a user requests the same content, it is
retrieved fromAppliance 4’s object cache.

n If a user connected to Appliance 5 requests the same content—and the content is in neither Appliance 5’s nor
Appliance 3’s object cache—load-balanced Appliance 3 gets the content fromAppliance 1 and object caches it.
Subsequently, Appliance 5 gets the content fromAppliance 3 and object caches it.

n Because the content is in Appliance 1’s object cache, the content is not retrieved from the origin server. In this
scenario, only theWAN links are used; the Internet link is not used to retrieve the content.

136 of 676



SGOS Administration (Admin Console Edition)

Note: In the figures above, each appliance is assumed to use one IP address for
forwarding. You could achieve similar results using load balancing if you configure a DNS
host name as a forwarding host and used DNS load balancing to forward requests to more
than one appliance. Formore information, see "About Load Balancing " on page 139.
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Configure a Forwarding System
You can configure forwarding hosts to which client requests can be redirected. Those hosts can be servers or proxies.
Rules to redirect requests are set up in policy. High-level steps to configure forwarding are:

n Create the forwarding hosts and groups, including parameters such as protocol agent and port.

A forwarding host is an appliance configured as a proxy to which certain traffic is redirected for the purpose of
leveraging object caching to minimize trips to the Internet and overWAN links. After hosts are created, you can
add them to forwarding groups.

n Set load balancing and host affinity values.

View Configured Forwarding Hosts and Groups
The Forwarding Hosts page (Configuration > Network > Forwarding Hosts) lists all configured forwarding hosts and
lists configured on the appliance and displays information about each one:

Section Setting or field Description

Forwarding Hosts Show Settings Displays the forwarding hosts currently defined on
the appliance.

Name Name of the forwarding host.

Host IP address or hostname of the forwarding host.

Local Overrides Number of load balance and host affinity defaults
that are overridden in the host.

Forwarding Host Groups Name Name of the forwarding host group.

Host Count Number of hosts belonging to the group.

Local Overrides Number of load balance and host affinity defaults
that are overridden in the host group.

General Settings
Configure general forwarding settings that apply to all connections. Unlike global defaults for hosts and groups, these
settings apply per connection and can't be overridden in individual host or group configurations.

To configure general settings:

1. In the Admin Console, select Configuration > Network > Forwarding Hosts.

2. In Settings, enter or edit the following as needed:

138 of 676



SGOS Administration (Admin Console Edition)

Setting or field Description

If no forwarding
host available

Specify how connections behave if no forwarding is available, Connect directly (fail open) or
Deny the request (fail closed). Fail open is insecure; fail closed is the default setting.

This setting can be overridden by policy.

Use forwarding
for administrative
downloads

Specify whether forwarding is applied to requests generated for administrative reasons on the
system, such as downloading policy files or new system images.

If enabled (default setting), you can control the forwarding in policy as needed.

This option also affects the use of SOCKS gateways.

Integrated host
timeout

An integrated host is an OCS that has been added to the health check list through the integrate_
new_hosts() CPL property.

The host ages out after being idle for the specified time. Default is 60 minutes.

Host affinity
timeout

The amount of time a user's IP address, SSL ID, or cookie remains valid after its most recent use.
The default is 30 minutes, meaning that the IP address, SSL ID or cookie must be used once every
30 minutes to restart the timeout period.

About Load Balancing
Load balancing distributes forwarding traffic amongmultiple IP addresses to achieve optimal resource utilization, to
maximize throughput, and to minimize response time. Typically, you use load balancing to distribute requests to more
than one Edge SWG (ProxySG) appliance, although you can also distribute requests to multiple IP addresses on a single
appliance—or a combination of the two.

Edge SWG (ProxySG) load balancingmethods include round robin—which selects the next system in the list—or least
connections—which selects the systemwith the fewest number of connections. You can configure load balancing in any
of the following ways:

n For hosts: If a host is DNS-resolved to multiple IP addresses, then that host's load-balancingmethod (round robin,
least connections, or none) is applied to those IP addresses. Themethod is either explicitly set for that host or
taken from the configurable global default settings.

n For lists: Load balancing for groups works exactly the same as load balancing for hosts withmultiple IP addresses
except there are two additional load balancingmethods for groups:

o URL hash: Requests are hashed based on the request URL.

o Domain hash: Requests are hashed based on the domain name in the request.

About Host Affinity
Host affinity is the attempt to direct multiple connections by a single user to the same groupmember. Host affinity
causes the user’s connections to return to the same server until the configurable host affinity timeout period is
exceeded.
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For example, suppose aWeb site with a shopping cart has several load-balancedWeb servers, but only oneWeb server
has the session data for a given user’s shopping cart transaction. If a connection is sent to a different Web server that
has no data about the user’s session, the user has to start over. Edge SWG (ProxySG) host affinity helpsmake sure each
request goes to its proper destination; however, the proxy does not interact with the session or with session data.

Host affinity allows you to use the following options:

n Client IP address: Use the client IP address to determinewhich groupmemberwas last used. When the same
client IP sends another request, the host makes the connection to that groupmember.

n Accelerator cookie: Insert a cookie in the response to the client. When the client makes future requests, the cookie
data is used to determinewhich groupmember the client last used. The host makes the connection to that group
member.

n SSL session ID: For HTTPS, extract the SSL session ID name from the connection information. The host uses the
session ID in place of a cookie or client IP address to determinewhich groupmemberwas last used. The host
makes the connection to that groupmember.

See Also:

n "Configure Forwarding Hosts " on the facing page

n "Configure Forwarding Groups" on page 144

n "Set Global Default Settings for Forwarding Hosts and Groups" on page 146

n "Set the Forwarding Default Sequence" on page 148
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Configure Forwarding Hosts
You can configure forwarding hostsmanually by specifying settings for individual hosts, or you can upload a file
containing a list of hosts to the appliance. The file settings will overwrite any existing forwarding host configuration on
the appliance. See "Upload a Forwarding Host Configuration File" on page 156 formore information.

To configure individual forwarding hosts:

1. In the Admin Console, select Configuration > Network > Forwarding Hosts.

2. In Forwarding Hosts:

n Select Add Host to add a new host.

n Select an existing host to edit it.

3. On the Add/Edit Host page, enter or edit the following as needed:

Section Setting or
field

Description

Properties Alias Unique name for the forwarding host.

Note: Because the forwarding host alias is used in policy, the alias
cannot be a CPL keyword, such as no, default, or forward.

Host Host's fully qualified domain name (FQDN) or IPv4/IPv6 address.

Type Select the forwarding host type:

n Server: Use for reverse proxy deployments. This choice means the appliance the
relative path for URLs in the HTTP header because the next hop is a web server, not a
proxy server. HTTPS, TCP tunnels, and Telnet can be forwarded to a server only; they
cannot be forwarded to a proxy.

n Proxy: Use for forward proxy deployments.

Ports Select the protocol(s) to forward. When Server is selected, more protocols are available.

When selected, a protocol's default port is (except for TCP, which has no default). Change the
port if needed.
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Section Setting or
field

Description

Load
balancing
and host
affinity

Use
balancing
for
Forwarding
Hosts

Specify the load balancing method to override the global setting, or accept the global default:

n Round Robin: Forward the request to the next host in the sequence.

n Least Connections: Forward the request to the host that currently has the least
number of connections.

Host
affinity
methods

Select host affinity methods to override the global setting, or accept the global default.See
"Set Global Default Settings for Forwarding Hosts and Groups" on page 146.

If a setting saysOverride, it is set to override the global default and shows the current value. If a setting says
Default, it inherits the global value that's displayed.

See Also:

n "Set Global Default Settings for Forwarding Hosts and Groups" on page 146

n "Upload a Forwarding Host Configuration File" on page 156

Upload a Forwarding Host Configuration File
You can create and install the forwarding host configuration file as follows:

142 of 676



SGOS Administration (Admin Console Edition)

n Use the Text Editor, which allows you to enter directives (or copy and paste the contents of an existing file)
directly onto the appliance.

n Create a local file on your local system; the appliance can browse to the file and install it.

n Use a remote URL, where you place an already-created file on an FTP or HTTP server to be downloaded to the
appliance.

When the forwarding host configuration file is installed, it overwrites any previous forwarding host configurations on the
appliance. The configuration remains in effect until it is overwritten by another file.

Note: Install the forwarding host file outside peak traffic times. While the file is being
compiled and installed, forwarding hostsmight not be available. Any transactions going
through the appliance during this timemight not be forwarded as expected.

Upload a forwarding host configuration file:

1. In the Admin Console, select Configuration > Network > Forwarding Hosts.

2. In Forwarding Hosts, select themethod to install the forwarding host configuration:

Method Instructions

Text
editor

1. Select Install from Text Editor.

2. In the Load Edit and Install from text editor dialog, enter the contents manually or copy and paste the
contents from another file.

3. Select Install.

Local file 1. Select ... > Local File.

2. In the Load Edit and Install from local file dialog, browse to the directory of the file on the local
system.

3. Select Install.

Remote
URL

1. Select ... > Remote URL.

2. In the Load Edit and Install from remote URL dialog, enter the fully-qualified URL, including the
filename, where the file is located.

3. Select Download.

See Also:

n "Configure Forwarding Hosts " on page 141
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Configure Forwarding Groups
To configure forwarding groups:

1. In the Admin Console, select Configuration > Network > Forwarding Hosts.

2. In Forwarding Host Groups:

n Select Add Group to add a new group.

n Select an existing group to edit it.

3. On the Add/Edit Forwarding Host Group page, enter aName for the forwarding group.

If editing the group, the name can't be changed.

4. The Selected Forwarding Hosts section shows hosts belonging to the group. Select one of the following:

n Select Hosts: Adds hosts to the group. On the Select Forwarding Hosts dialog, select hosts or clear
selections. The Show Selected toggle filters the view to show only selected hosts.

n Remove: Removes the host from the group.

5. Review load balancing and host affinity settings.

Setting or
field

Description

Forwarding
Host Groups

Specify the load balancing method to override the global setting, or accept the global default:

n Round Robin: Forward the request to the next group in the sequence.

n Least Connections: Forward the request to the group that currently has the least number of
connections.

n Domain Hash: Hash requests based on the domain name in the request.

n URL Hash: Hash requests based on the URL in the request.

Host affinity
methods

Select host affinity methods to override the global setting, or accept the global default. See "Set Global
Default Settings for Forwarding Hosts and Groups" on page 146.

If a setting saysOverride, it is set to override the global default and shows the current value. If a setting says
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Default, it inherits the global value that's displayed.

See Also:

n "Set Global Default Settings for Forwarding Hosts and Groups" on the next page
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Set Global Default Settings for Forwarding Hosts and Groups
The global defaults apply to all forwarding hosts and groups that are configured to use theDefault setting. If hosts and
groups have different settings specified, they override the global defaults.

To configure global defaults:

1. In the Admin Console, select Configuration > Networking > Forwarding Hosts.

2. In Global Defaults, enter or edit the following as needed:

Setting or field Description

Forwarding
Hosts

Specify the load-balancing method for all forwarding hosts except those whose configuration
specifically override the global settings.

n Round Robin: Forward the request to the next host in the sequence.

n Least Connections: Forward the request to the host that currently has the least number of
connections.

Clear the Forwarding Hosts setting to specify no global default.

Forwarding Host
Groups

Specify the load-balancing method for all forwarding hosts groups except those whose configuration
specifically override the global settings.

n Round Robin: Forward the request to the next group in the sequence.

n Least Connections: Forward the request to the group that currently has the least number of
connections.

n Domain Hash: Hash requests based on the domain name in the request.

n URL Hash: Hash requests based on the URL in the request.

Clear the Forwarding Groups setting to specify no global default.

Host affinity
methods

Select host affinity methods. See "Host Affinity Methods" below.

Host Affinity Methods
If you enable load balancing, you also enable host affinity. By default, if you use load balancing, each connection is
treated independently. The connection ismade to whichevermember of the load-balancing group the load-balancing
algorithm selects.

If host affinity is configured, the system checks host affinity first to see if the request comes from a known client. If this
is a first connection, the load-balancing algorithm selects the groupmember to make the connection.
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Host affinity records the result of the load balancing and uses it if that client connects again. Host affinity does not make
a connection to a host that health checks report is down; instead, if host affinity breaks, the load-balancing algorithm
selects a groupmember that is healthy and re-establishes affinity on that working groupmember.

Host affinity methods are discussed in the following table.

Setting Description HTTP SSL Other

Global Default Uses the default setting for all forwarding hosts or SOCKS gateways on the
system.

x x x

None Disables host affinity. x x x

Client IP Address Uses the client IP address to determine which forwarding group or SOCKS
gateway groupmember was last used.

x x x

Accelerator Cookie Inserts a cookie into the response to the client. x x

SSL Session ID Used in place of a cookie or client IP address. Extracts the SSL session ID
name from the connection information.

x
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Set the Forwarding Default Sequence
The default sequence is the forwarding sequence used when there is nomatching forwarding rule in policy. The following
is an example of forwarding policy:

<Forward>
url.domain=symantec.com forward(FWGrp2, FWGrp1)

In the example, requests that match theURL domain broadcom.com are sent to a forwarding group named FWGrp2
unless all of themembers in FWGrp2 are down, in which case requests are sent to FWGrp1. Health checks are performed
continually to minimize the possibility that requests are sent to a forwarding host or group that is known to be down.

The default sequence (and any sequence specified in policy) works by allowing healthy hosts to take over for an
unhealthy host or group (one that is failing its DNS resolution or its health check). If more than onemember is in the
sequence, the sequence specifies the order of failover, with the second host or group taking over for the first one, the
third taking over for the second, and so on.

If all of the hosts in the sequence are down, the request either fails open or fails closed (that is, the connection is denied).
Symantec recommends you set this behavior in policy as follows:

forward.fail_open(yes|no)

You can also configure it using global defaults.

Note: To create forwarding policy (including sequences), use the VPM or CPL. For
information on using VPM, refer to theWeb Visual Policy Manager Reference; for
information on using CPL, refer to the Content Policy Language Reference.

To configure the default sequence:

1. In the Admin Console, select Configuration > Networking > Forwarding Hosts.

TheDefault Sequence section shows the current default sequence, if one is configured.

2. Modify the default sequence as needed:

n To remove hosts or groups from the current default sequence, select Remove in the list of entries.

n To change the order of entries in the sequence, use the MoveUp orMoveDown arrows in the entries.

n To add configured forwarding hosts or forwarding groups to the default sequence, select Select Hosts,
Groups. On the dialog that opens, select hosts or groups.

Save the changes to the default sequence.
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Note: Any host or group in the default sequence is considered in use by policy. As a
result, if you try to delete a host/group while it is in the default sequence, you receive
an errormessage. Youmust remove the host/group from the sequence before
removing it from the forwarding configuration.
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About SOCKS Gateways
SOCKS servers provide application-level firewall protection for an enterprise. You can use SOCKS gateways to forward
traffic. Symantec's implementation of SOCKS includes the following:

n A SOCKS proxy server that supports both SOCKSv4/4a and SOCKSv5, running on the Edge SWG (ProxySG)
appliance.

n Support for forwarding through SOCKS gateways.

View Configured SOCKS Gateways and Groups
The SOCKS Gateways page (Configuration > Network > SOCKS Gateways) lists all configured SOCKS gateways and
SOCKS gateway groups configured on the appliance and displays information about each one:

Section Setting or field Description

SOCKS Gateways Show Settings Displays the SOCKS gateways currently defined on
the appliance.

Name Name of the SOCKS gateway.

Host IP address or hostname of the gateway.

Port Port number for the gateway.

Version SOCKS version selected for the gateway.

Local Overrides Number of load balance and host affinity defaults
that are overridden in the gateway.

SOCKS Gateway Groups Name Name of the SOCKS gateway group.

Gateway Count Number of gateways belonging to the group.

Local Overrides Number of load balance and host affinity defaults
that are overridden in the gateway list.

General Settings
Configure general settings that apply to all connections. Unlike global defaults for gateways and lists, these settings
apply per connection and can't be overridden in individual gateway or list configurations.

To configure general settings:

1. In the Admin Console, select Configuration > Network > SOCKS Gateways.

2. In Settings, enter or edit the following as needed:
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Setting or
field

Description

If no
forwarding
host
available

Specify how connections behave if no forwarding is available, Connect directly (fail open) or Deny the
request (fail closed). Fail open is insecure; fail closed is the default setting.

This setting can be overridden by policy.

Host affinity
timeout

The amount of time a user's IP address, SSL ID, or cookie remains valid after its most recent use. The
default is 30 minutes, meaning that the IP address, SSL ID or cookie must be used once every 30 minutes
to restart the timeout period.

Machine ID If you use a SOCKS gateway server for the primary or alternate forwarding gateway, specify the ID for
the Identification (Ident) protocol used by the SOCKS gateway in SOCKS server handshakes.

See Also:

n "Configure SOCKS Gateways" on the next page

n "Configure SOCKS Gateway Groups" on page 158

n "Set Global Default Settings for SOCKS Gateways and Groups" on page 160
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Configure SOCKS Gateways
You can configure SOCKS gatewaysmanually by specifying settings for individual gateways, or you can upload a file
containing a list of gateways to the appliance. The file settings will overwrite any existing SOCKS configuration on the
appliance. See "Upload a SOCKS Gateway Configuration File" on page 154 formore information.

To configure individual SOCKS gateways:

1. In the Admin Console, select Configuration > Network >SOCKS Gateways.

2. In SOCKS Gateways:

n Select Add Gateway to add a new gateway.

n Select an existing gateway to edit it.

3. On the Add New/Edit SOCKS Gateway page, enter or edit the following as needed:

Section
Setting or field Description

Properties Name Meaningful name for the gateway. SOCKS gateway names cannot be CPL
keywords, such as default, forward, or socks_gateways.

Host Add the IP address or the host name of the gateway where traffic is directed.
The host name must DNS resolve.

Port Port for the gateway. Default is 1080.

Version Version that the SOCKS gateway can support. Version 5 is recommended.

Username (If SOCKS version 5 is selected) The username of the user on the SOCKS
gateway. The username already must exist on the gateway. If you have a
username, youmust also set the password.

Password (If SOCKS version 5 is selected) The plaintext password or encrypted password
of the user on the SOCKS gateway. The passwordmust match the gateway’s
information. The password can be up to 64 bytes long. Passwords that include
spaces must be within quotes. You can specify an encrypted password (up to 64
bytes long) either through the CLI or through an uploaded file directives.
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Section
Setting or field Description

Load Balancing
and Host Affinity

SOCKS Gateways Specify the load balancing method to override the global setting, or accept the
global default:

n Round Robin: Forward the request to the next gateway in the sequence.

n Least Connections: Forward the request to the gateway that currently
has the least number of connections.

Host Affinity
Methods

Select host affinity methods to override the global setting, or accept the global
default. See "Set Global Default Settings for SOCKS Gateways and Groups" on
page 160.

If a setting saysOverride, it is set to override the global default and shows the current value. If a setting says
Default, it inherits the global value that's displayed.

See Also:

n "Set Global Default Settings for SOCKS Gateways and Groups" on page 160

n "Upload a SOCKS Gateway Configuration File" on the next page
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Upload a SOCKS Gateway Configuration File
You can create and install the SOCKS gateway file as follows:

n Use the Text Editor, which allows you to enter directives (or copy and paste the contents of an existing file)
directly onto the appliance.

n Create a local file on your local system; the appliance can browse to the file and install it.

n Use a remote URL, where you place an already-created file on an FTP or HTTP server to be downloaded to the
appliance.

When the SOCKS gateway configuration file is installed, it overwrites any previous SOCKS gateway configurations on the
appliance. The configuration remains in effect until it is overwritten by another file.

Note: Install the SOCKS configuration file outside peak traffic times. While the file is being
compiled and installed, SOCKS gatewaysmight not be available. Any transactions going
through the appliance during this timemight not be forwarded as expected.

Upload a SOCKS gateway configuration file:

1. In the Admin Console, select Configuration > Network > SOCKS Gateways.

2. In SOCKS Gateways, select themethod to install the SOCKS gateway configuration:

Method Instructions

Text
editor

1. Select Install from Text Editor.

2. In the Load Edit and Install from text editor dialog, enter the contents manually or copy and paste the
contents from another file.

3. Select Install.

Local file 1. Select ... > Local File.

2. In the Load Edit and Install from local file dialog, browse to the directory of the file on the local
system.

3. Select Install.

Remote
URL

1. Select ... > Remote URL.

2. In the Load Edit and Install from remote URL dialog, enter the fully-qualified URL, including the
filename, where the file is located.

3. Select Download.

154 of 676



SGOS Administration (Admin Console Edition)

See Also:

n "Configure SOCKS Gateways" on page 152
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Upload a Forwarding Host Configuration File
You can create and install the forwarding host configuration file as follows:

n Use the Text Editor, which allows you to enter directives (or copy and paste the contents of an existing file)
directly onto the appliance.

n Create a local file on your local system; the appliance can browse to the file and install it.

n Use a remote URL, where you place an already-created file on an FTP or HTTP server to be downloaded to the
appliance.

When the forwarding host configuration file is installed, it overwrites any previous forwarding host configurations on the
appliance. The configuration remains in effect until it is overwritten by another file.

Note: Install the forwarding host file outside peak traffic times. While the file is being
compiled and installed, forwarding hostsmight not be available. Any transactions going
through the appliance during this timemight not be forwarded as expected.

Upload a forwarding host configuration file:

1. In the Admin Console, select Configuration > Network > Forwarding Hosts.

2. In Forwarding Hosts, select themethod to install the forwarding host configuration:

Method Instructions

Text
editor

1. Select Install from Text Editor.

2. In the Load Edit and Install from text editor dialog, enter the contents manually or copy and paste the
contents from another file.

3. Select Install.

Local file 1. Select ... > Local File.

2. In the Load Edit and Install from local file dialog, browse to the directory of the file on the local
system.

3. Select Install.

Remote
URL

1. Select ... > Remote URL.

2. In the Load Edit and Install from remote URL dialog, enter the fully-qualified URL, including the
filename, where the file is located.

3. Select Download.
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See Also:

n "Configure Forwarding Hosts " on page 141
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Configure SOCKS Gateway Groups
You can add an existing gateway to one ormore groups.

1. In the Admin Console, select Configuration > Network >SOCKS Gateways.

2. In SOCKS Gateway Groups:

n Select Add Group to add a new gateway group.

n Select an existing gateway group to edit it.

3. On the Add/Edit SOCKS Gateway Group page, enter or edit the following as needed:

Section Setting or field Description

Properties Name Specify a name of the SOCKS gateway group.

Selected SOCKS Gateways Select
SOCKS Gateways

Select to add or remove gateways from the group. On the Select
SOCKS Gateways dialog, you can enable Show Selected Only to
display only the gateways that are added to the group.

Alternatively, select Remove under Actions to remove a gateway
from a group.

Load Balancing and Host
Affinity

SOCKS Gateway
Groups

Specify the load balancing method to override the global setting, or
accept the global default:

n Round Robin: Forward the request to the next gateway in
the sequence.

n Least Connections: Forward the request to the gateway
that currently has the least number of connections.

Host Affinity
Methods

Select host affinity methods to override the global setting, or accept
the global default. See "Set Global Default Settings for SOCKS
Gateways and Groups" on page 160.

If a setting saysOverride, it is set to override the global default and shows the current value. If a setting says

158 of 676



SGOS Administration (Admin Console Edition)

Default, it inherits the global value that's displayed.

See Also:

n "Set Global Default Settings for SOCKS Gateways and Groups" on the next page
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Set Global Default Settings for SOCKS Gateways and Groups
The global defaults apply to all SOCKS gateways and groups that are configured to use theDefault setting. If gateways
and groups have different settings specified, they override the global defaults.

To configure global defaults:

1. In the Admin Console, select Configuration > Networking > SOCKS Gateways.

2. In Global Defaults, enter or edit the following as needed:

Setting or field Description

SOCKS
Gateways

Specify the load-balancing method for all SOCKS gateways except those whose configuration
specifically override the global settings.

n Round Robin: Forward the request to the next gateway in the sequence.

n Least Connections: Forward the request to the gateway that currently has the least number
of connections.

Clear the SOCKS Gateways setting to specify no global default.

SOCKS Gateway
Groups

Specify the load-balancing method for all SOCKS gateway groups except those whose configuration
specifically override the global settings.

n Round Robin: Forward the request to the next group in the sequence.

n Least Connections: Forward the request to the group that currently has the least number of
connections.

n Domain Hash: Hash requests based on the domain name in the request.

n URL Hash: Hash requests based on the URL in the request.

Clear the SOCKS Gateway Groups setting to specify no global default.

Host affinity
methods

Select host affinity methods. See "Host Affinity Methods" below.

Host Affinity Methods
If you enable load balancing, you also enable host affinity. By default, if you use load balancing, each connection is
treated independently. The connection ismade to whichevermember of the load-balancing group the load-balancing
algorithm selects.

If host affinity is configured, the system checks host affinity first to see if the request comes from a known client. If this
is a first connection, the load-balancing algorithm selects the groupmember to make the connection.
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Host affinity records the result of the load balancing and uses it if that client connects again. Host affinity does not make
a connection to a host that health checks report is down; instead, if host affinity breaks, the load-balancing algorithm
selects a groupmember that is healthy and re-establishes affinity on that working groupmember.

Host affinity methods are discussed in the following table.

Setting Description HTTP SSL Other

Global Default Uses the default setting for all forwarding hosts or SOCKS gateways on the
system.

x x x

None Disables host affinity. x x x

Client IP Address Uses the client IP address to determine which forwarding group or SOCKS
gateway groupmember was last used.

x x x

Accelerator Cookie Inserts a cookie into the response to the client. x x

SSL Session ID Used in place of a cookie or client IP address. Extracts the SSL session ID
name from the connection information.

x
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Set the SOCKS Gateway Default Sequence
The default sequence defines what SOCKS gateways to usewhen no policy is present to specify something different. The
systemuses the first host or group in the sequence that is healthy, just as it does when a sequence is specified through
policy. Only one default sequence is allowed. All membersmust be pre-existing hosts, and nomember can be in the
groupmore than once.

A default failover sequence allow healthy hosts to take over for an unhealthy host (one that is failing its DNS Resolution
or its health check). The sequence specifies the order of failover, with the second host taking over for the first host, the
third taking over for the second, and so on.

If all hosts are unhealthy, the operation fails either open or closed, depending upon your settings.

This configuration is usually created andmanaged through policy. If no SOCKS gateways policy applies, you can create a
default sequence using policy. This single default sequence consists of a single default host (or group) plus one ormore
hosts to use if the preceding ones are unhealthy.

Note: Traffic is forwarded to the first member of the group until it fails, then traffic is sent
to the secondmember of the group until it fails or the first member becomes healthy
again, and so on.

To configure the default sequence:

1. In the Admin Console, select Configuration > Networking > SOCKS Gateways.

TheDefault Sequence section shows the current default sequence, if one is configured.

2. Modify the default sequence as needed:

n To remove gateways or groups from the current default sequence, select Remove in the list of entries.

n To change the order of entries in the sequence, use the MoveUp orMoveDown arrows in the entries.

n To add configured SOCKS gateways or SOCKS gateway lists to the default sequence, select Select
Gateways, Lists. On the dialog that opens, select gateways or lists.

Save the changes to the default sequence.

Note: Any host or group in the default sequence is considered in use by policy. As a
result, if you try to delete a gateway/group while it is in the default sequence, you
receive an errormessage. Youmust remove the gateway/group from the sequence
before deleting it.
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About Virtual IP Addresses
Virtual IP addresses are addresses assigned to a system (but not an interface) that are recognized by other systems on
the network. Use VIPs to:

n Assignmultiple identities to a systemon the same or different network, partitioning the box in to separate logical
entities for resource sharing or load sharing.

n Create an HTTPS Console to allowmultiple, simultaneous, secure connections to the system.

n Direct authentication challenges to different realms.

n Set up failover amongmultiple Edge SWG (ProxySG) appliances on the same subnet.

The Virtual IPs section (Configuration > Network > Advanced) shows a list of the VIPs configured on the appliance.
To edit a VIP, see "Configure VIPs" on page 165.

About Failover
Using IP address failover, you can create a redundant network for any explicit proxy configuration. If you require
transparent proxy configuration, you can create software bridges to use failover. Using a pool of IP addresses to provide
redundancy and load balancing, Symantecmoves these IP addresses among a group of machines.

Note: If you use the Pass-Through adapter for transparent proxy, youmust create a
software bridge rather than configuring failover. See "About the Pass-Through Adapter" on
page 76.

Failover allows a secondmachine to take over if a first machine (not just an interface card) fails, providing redundancy to
the network through a primary/replica relationship. In normal operations, the primary (themachinewhose IP address
matches the group name) owns the address. The primary sends keep-alivemessages (advertisements) to the replica. If
the replicas do not receive advertisements at the specified interval, the replica with the highest configured priority takes
over for the primary. When the primary comes back online, the primary takes over from the replica again.

The Symantec failover implementation resembles the Virtual Router Redundancy Protocol (VRRP) with the following
exceptions:

n A configurable IP multicast address is the destination of the advertisements.

n The advertisement interval is included in protocolmessages and is learned by the replicas.

n A virtual router identifier (VRID) is not used.

n Virtual MAC addresses are not used.

n MD5 is used for authentication at the application level.
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Primaries are elected based on the following factors:

n If the failovermechanism is configured for a physical IP address, themachine owning the physical address have
the highest priority. This is not configurable.

n If amachine is configured as a primary using a virtual IP address, the primary has a priority that is higher than the
replicas.

When a replica takes over because the primary fails, an event is logged in the event log. No email notification is sent.

Requirements for Failover
Complete the following tasks to enable failover:

n Create virtual IP addresses on each appliance.

n Create a failover group.

n Attach the failover group to the bridge configuration.

n Selecting a failovermode (parallel or serial - this can only be selected using the CLI).

You also must decidewhichmachine is the primary and whichmachines are the replicas, and whether you want to
configure explicit proxy or transparent proxy network. When configuring the group, the primary and all the systems in
the groupmust have exactly the same failover configuration except for priority, which is used to determine the rank of
the replicas. If no priority is set, a default priority of 100 is used. If two appliances have equal priority, the onewith the
highest local IP address ranks higher.

Configuring failover groups is required to enable network redundancy on the Edge SWG (ProxySG) appliance.

You enable failover by completing the following tasks:

n Creating virtual IP addresses on each appliance.

n Creating a failover group.

n Attach the failover group to the bridge configuration.

n Selecting a failovermode (parallel or serial - this can only be selected using the CLI).

The Failover Groups section (Configuration > Network > Advanced) shows a list of the failover groups configured on
the appliance. From this page, you can switch the Enable toggle to enable or disable a forwarding group. To make other
changes, see "Configure Failover Groups" on page 166.
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Configure VIPs
You can create up to 255 VIPs through the Admin Console. To createmore VIPs, use the #(config)virtual-ip address
<IP_address> command.

Configure VIPs:

1. In the Admin Console, select Configuration > Network > Advanced.

2. In the Virtual IPs section, select Add Virtual IP.

3. In the Add new virtual IP dialog, enter an IP address.

Note: The address can be IPv4 or IP6. It cannot be amulticast or group address.

4. Select Add. The address appears in the Virtual IPs list.

5. (If needed) To delete an existing VIP, select theRemove icon. VIPs that are associated with a forwarding group
can't be deleted; youmust remove the forwarding group first.
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Configure Failover Groups
Configuring failover groups will not, in and of itself, enable failover on your Edge SWG (ProxySG) appliance deployment.
You also must decidewhich system is the primary and which systems are the replicas, and whether you want to
configure explicit proxy or transparent proxy network.

When configuring the group, the primary and all the systems in the groupmust have exactly the same failover
configuration except for priority, which is used to determine the rank of the replicamachines. If no priority is set, a
default priority of 100 is used. If two appliances have equal priority, the onewith the highest local IP address ranks
higher.

Configure failover groups:

1. In the Admin Console, select Configuration > Network > Advanced.

2. In the Failover Groups section:

n To add a new failover group, select Add Failover Group.

n To edit an existing failover group, select it.

3. On the Add/Edit Failover Group page, specify the following properties:

Settings Description

Enable Failover Group Select to enable the system for the failover group.

Group IP Address SelectNew to enter a new virtual IPv6 or IPv4 address in the New
Virtual IP field.

Select Existing to select an already-defined IP address from the
Existing IP list (this list includes IP addresses across all appliance
network interfaces as well as defined VIPs). Existing IP addresses
that are already selected for failover groups do not appear in the
list.

After the failover group is created and saved, the group IP address
can't be edited. To change the IP address for a group, youmust
delete the group and create a new one.
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Settings Description

Multicast Address Class D IP address that is used for multicast. It is not a virtual IP
address.

Note: Class D IP addresses (224 to 239) are
reserved for multicast. A Class D IP address has
a first bit value of 1, second bit value of 1, third
bit value of 1, and fourth bit value of 0. The
other 28 bits identify the group of computers
that receive the multicast message.

Priority Type Relative specifies a replica system, and is selected by default.
Replica systems must have a priority specified (see Relative
Priority).

SelectMaster to configure a master system, which has the highest
priority.

Note: Keep in mind that only one system can be
designated as the Master.

Relative Priority Range from 1-255 that is assigned to replicas in the group. 255 is
reserved for the system whose failover group ID equals the real IP
address.

Advertisement Interval (Optional) Length of time between advertisements (keep-alive
messages) sent by the group's master system. The default is 40
seconds. If the groupmaster fails, the replica with the highest
priority takes over (after approximately three times the interval
value). This value controls the failover time of the group.

Group Secret (Recommended) Password shared only with the group. Configured
passwords are not displayed in plaintext.
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Manage Edge SWG (ProxySG) Services
You can configure two types of services on the appliance: proxy services andmanagement services. Refer to the
following topics to learn about proxy services and services groups and their roles in intercepting traffic:

n "About Management Services" on the facing page

Create andmodify HTTP, HTTPS, SSH, SNMP, and Telnet services for administrative access to the Edge SWG
(ProxySG) appliance. For each service, configure listeners that allow requests from specified IP addresses/ports.
For theHTTPSmanagement service, specify the keyring, CCL, and SSL versions to secure access to the appliance.

n "About Proxy Services " on page 174

Create proxy services for specified IP addresses and ports. Set actions for proxy services. Configure proxy service
groups. Prevent the appliance from intercepting requests to or from specific addresses. For troubleshooting or
testing purposes, create a subset of addresses to intercept.

n "General Proxy Settings" on page 206

Configure global settings for all proxies, such as tunnel-on-protocol error. Enable Cachepulse to optimize HTTP
traffic. Configure parallel connections for all transactions (SGOS 7.3.4+).

n "Manage the SSL Proxy" on page 217

Configure the SSL proxy and HTTPS traffic interception.

n "Configure theUDP Tunnel Proxy" on page 232

Configure settings for UDP Tunnel flows.
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About Management Services
You can configure administrative access to the appliance throughmanagement services. The followingmanagement
services are supported.

HTTPS Console

Use to securely access the Admin Console through theHTTPS protocol. TheHTTPS console is created and enabled by
default. The default port is 8082.

You can createmultiplemanagement HTTPS consoles, allowing you to simultaneously access the Admin Console using
any IP address belonging to the appliance as well as any of the appliance’s virtual IP (VIP) addresses. The default is HTTPS
over port 8082.

Administrative access to the appliance for theHTTPS console can be controlled with the following authentication types:

n The predefined admin account

n Local authentication realm

n Certificate authentication realm (refer to the Common Access Card Solutions Guide for information)

n IWA authentication realm (with basic authentication, secured with TLS)

n LDAP authentication realm (secured with TLS)

Configuring theHTTPS console service requires three steps:

1. Selecting a keyring (a key pair and a certificate that are stored together). The appliance ships with a default keyring
that can be reused with each secure console that you create. You can also create your own keyrings.

Note: If you get “host mismatch” errors or if the security certificate is invalid, create a
different certificate and use it for theHTTPS console.

2. Selecting an IP address and port on the system that the servicewill use, including VIPs. You can use any IPv4 or
IPv6 address on the appliance for theHTTPS console service, including VIPs. Note that when IPv6 addresses are
specified, they must be global (not linklocal). For information on how to create a virtual IP address, see "Configure
VIPs" on page 165.

3. Enabling theHTTPS Console service.

SSH Console

Use to access the command line interface via an SSH client. The SSH console is created and enabled by default. The
default port is 22.

Formore information, see "Manage the SSH Console" on page 408.
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SNMP 

Set up theUDP and TCP ports the appliance uses to listen for SNMP commands. The SNMP console is created by default,
but disabled. The default port is 161.

The SNMP console supports passphrase authentication. Other authentication types are not supported.

HTTP and Telnet Consoles

Less-secure services are supported but not recommended:

n HTTP: Use to access to theManagement Console. TheHTTP console is created by default, but disabled. It is less
secure than HTTPS. The default port is 8081. Administrative access to the appliance for theHTTP console can be
controlled with the authentication types listed for theHTTPS console.

n Telnet: The Telnet console not created by default because the passwords are sent unencrypted from the client to
the appliance, which is less secure than the othermanagement services. The default port for a Telnet shell proxy is
23. By default, a Telnet shell proxy service exists on the default Telnet port (23). Since only one service can use a
specific port, youmust delete the shell service if you want to create a Telnet console. Be sure to apply any changes
before continuing. If you want a Telnet shell proxy service in addition to the Telnet console, you can recreate it
later on a different port.

To use the Telnet shell proxy (to communicatewith off-proxy systems) and retain the Telnet Console, youmust
either change the Telnet shell proxy to use a transparent destination IP address, or change the destination port on
either the Telnet Console or Telnet shell proxy. Only one service is permitted on a port.

Note: Telnet is a clear-text protocol that provides no integrity protection. Using
Telnet for administrative access will result in administrative credentials being sent in
clear text. If you enable the Telnet console, be aware that you cannot use Telnet to
access all options available in the CLI. Somemodules, such as SSL, respond with the
errormessage: Telnet sessions are not allowed access to ssl commands.

To create or edit amanagement service, see "Configure aManagement Service" on page 172.

Review Management Services
To review themanagement services configured on the appliance, in the Admin Console, select Configuration >
Services > Management Services.

In theManagement Services section, each configured service shows the following information:

n Name: System- or user-defined name of themanagement service.

n IP Address: IP address: IndicatesAll for all IP addresses,Multiple formore than one IP address, or a specific IP
address if only one is specified.

n Port: IndicatesMultiple formore than one port or a specific port number if only one is specified.
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n Service Type: One of the supportedmanagement service types.

n Protocol: Indicates the supported protocol(s) for the service type. All services support TCP; SNMP supports TCP
and UDP.

You can expand a service to display its listeners and their statuses. In the previous example, the HTTPS console service
has a listener enabled for all IP addresses and port 8082 (the default).
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Configure a Management Service
To configure amanagement service:

1. In the Admin Console, select Configuration > Services > Management Services.

2. In Management Services:

n To add a service: Select Add Service.

n To edit a service: Select the existing service.

The Add New/Edit Management Service page displays service and listener settings.

3. Enter or edit the following settings as needed:

Setting
or field

Description

Name Name for the management service. The name can't be changed after it is saved.

Service
Type

Select a service type.

HTTPS
Console
settings

If you selected the HTTPS Console service type, the following settings are available:

n Keyring: Select from a list of existing keyrings on the appliance. The system ships with a default keyring
that is reusable for each HTTPS service. You can't use the application-key or configuration-passwords-
key keyring for console services. In addition, you should removed unwanted cipher suites from the
keyring used to make SSL connections. See "About SSL Device Profiles" on page 285.

n CCL: Select the CA Certificate List (CCL) you want to use so that the appliance knows which CA
certificates to use when validating the trust of any received certificates.

n SSL Versions: Select SSL/TLS versions. Less-secure options are automatically not selected.

n Service Settings: (If configuring Common Access Card authentication or a certificate realm) Select
Verify Client to enable mutual SSL authentication for the Management Console.

Listener
settings

See "Configure Management Service Listeners" on the facing page.
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Configure Management Service Listeners
You can configure listeners for amanagement service.

1. In the Admin Console, select Configuration > Services > Management Services.

2. In Management Services, select the existing service.

The Edit Management Service page displays service and listener settings.

3. In Listeners:

n To add a listener, select Add Listener.

n To edit a listener, select the existing listener.

The Add/Edit Listener dialog opens.

4. Enter or edit the following settings as needed:

Setting or
field

Description

Enable
Listener

Select to enable or disable the listener.

IP
Address

The client addresses to which the service applies. The most common selection is All, which means the
service applies to requests from any client (IPv4 and IPv6).

You can also restrict this listener to a specific IP address (IPv4 or IPv6) or user subnet (for IPv4) or prefix
length (for IPv6).

Port The port number on which this service listens.

Create or edit asmany listeners as needed.

See Also:

n "Configure aManagement Service" on the previous page
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About Proxy Services 

Note: By default, the Admin Console opens theConfiguration > Services > Proxy
Services pagewith Proxy Services selected for Interception. In normal operations, you
should not need to change this setting. Set Interception to Force Bypass or Restricted
Intercept List for troubleshooting only. See "Troubleshooting: Bypass All Proxy Services
or Restrict Interception" on page 201 for details.

In Symantec terminology, proxy service defines:

n The combinations of IP addresses and ports that the proxy matches against.

n Whether to intercept or bypassmatched traffic; if intercepted, which proxy to use to process the traffic.

o When a service is set to Intercept, the Edge SWG (ProxySG) appliance listens on the port for traffic and
upon detection, terminates the connection, performs an action (such as a policy check), and initiates a new
connection to the traffic destination.

o When a service is set to Bypass, the traffic pass through the appliance. By default, services are set to
Bypass.

n A collection of attributes that control what type of processing the appliance performs on the intercepted traffic.

See Also:

n "Change the State of a Proxy Service" on page 178

About Proxy Service Groups
The Edge SWG (ProxySG) appliance groups services into predefined service groups based on the type of traffic that
service carries. Service groups enable you to:

n Quickly locate a specific service and view its attributes.

n Create a custom service group and add custom services or existing services to that group.

Predefined Service Groups and Services

The following table lists all service groups and their associated services. This list applies to new installations or the result
of restoring the appliance to factory defaults after an upgrade. Upon upgrading to the current version, the Admin
Console retains existing services, service group names, and policies.

For a complete list of supported proxy services and listeners, see "Reference: Proxy Services, Proxy Configurations, and
Policy" on page 203.
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Services Group Description
Predefined Service Types or
Examples

Standard The most commonly intercepted services. n HTTP/HTTPS—external
(transparent and explicit)
and internal

n Endpoint Mapper (for MAPI
protocol—Microsoft
Exchange)

n CIFS (file sharing)

n Streaming (MMS, RTSP)

n FTP

n DNS

n SOCKS

Bypass
Recommended

Services that contain encrypted data and therefore recommended to
not be ADN-optimized; also includes other interactive services.

n Cisco VPN

n Symantec ADN

n Symantec management

n Oracle over SSL

n Other encrypted services

Tunnel
Recommended

Services that employ the TCP Tunnel proxy to provide basic application-
independent acceleration.

Citrix, IMAP, LDAP, and various
other common business
applications.

Default See "Default Listener" on the next page.

Tomove a service to another group, edit the service. See "Configure a Proxy Service" on page 180.

See Also:

n "Configure an HTTPS Reverse Proxy" on page 185

n "Manage Service Groups" on page 194

Note: TheHTTPS Reverse Proxy service is available but not created by default. For
information about configuring the service, see "Configure an HTTPS Reverse Proxy" on
page 185.
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About Proxy Service Listeners
A proxy service listener specifies where an Edge SWG (ProxySG) appliance service listens for traffic. The listener
comprises four attributes:

n Source address: Most of the time, this attribute is set to all source addresses, whichmeans any IPv4 or IPv6
address that originates the request. You can also specify specific IP addresses and subnets. For example, you
want to exclude a network segment, so you specify a subnet and set to Bypass.

n Destination address: All addresses, whichmeans any IPv4 or IPv6 destination.

o Transparent—Acts on connections without awareness from the client or server. Only connections to IPv4
or IPv6 destination addresses that do not belong to the appliance are intercepted. This setting requires a
bridge, such as that available in the appliance; a Layer-4 switch, or aWCCP compliant router. You can also
transparently redirect requests through an appliance by setting theworkstation’s gateway to the appliance
IP address.

o Explicit—Requires web browser and service configuration. It sends requests explicitly to a proxy instead of
to the origin content servers. Only destination addresses that match one of the IPv4 or IPv6 addresses on
the appliance are intercepted.

o Destination IP address or subnet/prefix length—This listener type ensures that only destination addresses
matching the IPv4/IPv6 address or subnet/prefix length are intercepted.

n Port: A specific port or port range. All default appliance services configured to their industry-standard ports. For
example, the explicit HTTP service is configured to listen on ports 80 and 8080.

n Action: The aforementioned action to take on traffic detected by this service: Intercept or Bypass.

For a complete list of supported proxy services and listeners, see "Reference: Proxy Services, Proxy Configurations, and
Policy" on page 203.

Default Listener

TheDefault listener detects any traffic that does not match any other listeners on any of the services.

Multiple Listeners

A listener identifies network traffic based on a source IP address or range, destination IP address or range, or both.
Multiple listeners can be defined for a proxy service or console service. Each service has a set of default actions to apply
to the traffic identified by the listeners it owns.

The destination IP address of a connection canmatchmultiple proxy service listeners. Multiplematches are resolved
using themost-specific match algorithmused by routing devices. A listener ismore specific if it has a larger Destination
IP subnet prefix. For example, the subnet 10.0.0.0/24 ismore specific than 10.0.0.0/16, which ismore specific than
10.0.0.0/8.
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When a new connection is established, the Edge SWG (ProxySG) appliance first finds themost specific listener
destination IP. If amatch is found, and the destination port also matches, the connection is then handled by that
listener. If the destination port of the listener with themost specific destination IP does not match, the next most
specific destination IP is found; this process continues until either a completematch is found or nomorematching
addresses are found. If a destination IP address is not specified, the closest matching explicit proxy service listener has
priority over a subnet match. In that instance, the explicit proxy service listener handles the connection instead of the
subnet listener. Explicit port 80 listeners with a destination host IP identical to the appliance have priority over other
explicit listeners.

For example, assume the following services were defined as given in the following table.

Proxy Service Name and Type Listener Source IP Address Listener Destination IP Address Listener Port Range

New York Data Center, HTTP proxy 192.168.20.22 10.167.10.0/24 80

New York CRM, HTTP proxy All 10.167.10.2 80

HTTP Service, HTTP proxy All transparent 80

An HTTP connection initiated to server 10.167.10.2 couldmatch any of the three listeners in the previous table. The
most specific match algorithm finds that a listener in theNew York CRM service is themost specific and since the
destination port of the connection and the listenermatch, the connection is handled by this service. The advantage of
themost specific match algorithmbecomes evident when at some later point another server is added in theNew York
Data Center subnet. If that server needs to be handled by a different service from theNew York Data Center service, a
new servicewith a listener specific to the new server would be added. The administrator does not need to be concerned
about rule order in order to intercept traffic to this particular server using the new,most specific service listener.

See Also:

n "Configure Proxy Service Listeners" on page 193
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Change the State of a Proxy Service
A proxy service can be in one of two states:

n Bypass: Traffic for this service passes through the Edge SWG (ProxySG) appliancewithout receiving an
optimization or policy checking (as applicable).

n Intercept: The appliance intercepts traffic for this service and applies optimization or policy checks (as applicable).

The state of a service depends on whether the appliancewas upgraded:

n Upon upgrade from a previous release, supported services remain in their original service groups and retain their
bypass/intercept states.

n On a new installation or a re-initialization, all services are set to Bypass unless otherwise specified during the
installation/re-initialization process.

You cannot change the state of entire predefined group; youmust set each service required for your deployment to
Intercept.

Changing the state of a service to Intercept is only the first step in configuring a protocol proxy. To achieve your
corporate deployment goals, youmust also configure the proxy settings and define policy, both of which determine how
the appliance processes the intercepted traffic. These aspects are discussed in each proxy section later in this guide.

Formore conceptual information about services, see "Manage Edge SWG (ProxySG) Services" on page 168.

To change the state of a service:

1. In the Admin Console, select Configuration > Services > Proxy Services.

2. In Proxy Services, select the arrow beside a service name. The row expands to display more information about
the selected service.

3. For each configured listener, set the Action to Intercept orBypass.

In the following example, both listener ports for the Explicit HTTP service are set to Intercept.

You can also change the Intercept/Bypass action when you edit a service. See "Configure a Proxy Service" on page 180.
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Tip: Setting a service to Intercept is one step in controlling specific traffic types. There are
other options for the services themselves, plus proxy configurations and policy
definitions. You can also create custom services and service groups.

See Also:

n "Configure a Proxy Service" on the next page

n "Manage Service Groups" on page 194

n "Reference: Proxy Services, Proxy Configurations, and Policy" on page 203

n Content Policy Language Reference
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Configure a Proxy Service
You can configure settings for a predefined proxy service, an imported proxy service, or a new proxy service that you
created for a custom application.

n Predefined services: Services that were defined on the systemupon installation.

n Imported services: Import a proxy service if you delete a default service and want to re-add it. If you import an
existing service, you are prompted to confirm the replacement of a service. Existing service settings are
overwritten with the default settings.

Note: After an SGOS upgrade, youmust import any services added to the service
library in order to use them.

n Custom services: You can create customproxy service groups and populate themwith custom services ormove
default services to them. For example, this Edge SWG (ProxySG) appliance serves a specific purpose and you want
a custom group that contains only those services.

Before proceeding, make sure that you understand the goal of your deployment, how the application proxy operates,
and the IP addresses (source and/or destination) and ports to intercept. Some proxy services, such as DNS, are simple—
composed only of IP addresses and ports. Others, such as HTTP, havemore attributes to consider. For a high-level
description of these options, see "About Proxy Service Attributes" on page 182.

To configure a proxy service:

1. In the Admin Console, select Configuration > Services > Proxy Services.

2. In Proxy Services:

n To add a service: Select New Service.

n To edit a service: Select the existing service.

n To import a service: Select Import Service.

The Add New/Edit Proxy Service page displays service and listener settings.
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3. Enter or edit the following settings as needed:

Setting or
field

Description

Name (Creating new or editing existing services) Name for the proxy service.

Service to
Import

(Importing services) Service to import from library.

Service
Group

Select a predefined service group or a custom group.

Predefined services are not anchored to their default groups. You canmove a service to any other
predefined or custom group.

Note: The entire service is moved; you can't move individual listeners.

Proxy
Settings

The selected proxy type determines what, if any, proxy-specific fields are available:

n CIFS: See "ADN Optimizations" on the next page and "Early Intercept" on page 183.

n DNS: No other settings are needed.

n Endpoint Mapper: See "ADN Optimizations" on the next page.

n FTP: See "ADN Optimizations" on the next page.

n FTPS: See "ADN Optimizations" on the next page.

n HTTP: See "ADN Optimizations" on the next page, "Authenticate-401" on page 183, and
"Protocol Detection" on page 184.

n HTTPS reverse proxy: See "ADN Optimizations" on the next page and "Configure
an HTTPS Reverse Proxy" on page 185.

n MMS: No other settings are needed. 

n RTMP: No other settings are needed.

n RTSP: No other settings are needed.

n SOCKS: See "Protocol Detection" on page 184.

n SSL: See "ADN Optimizations" on the next page and "Protocol Detection" on page 184.

n TCP Tunnel: See "ADN Optimizations" on the next page, "Early Intercept" on page 183, and
"Protocol Detection" on page 184.

n Telnet: No other settings are needed.

n UDP Tunnel: (SGOS 7.3.2 and later) No other settings are needed.

4. To add or edit listeners, see "Configure Proxy Service Listeners" on page 193.
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About Proxy Service Attributes
In addition to the listener information, each service contains one ormore settings that affect how the appliance proxies
the traffic. The following sections provide an overview of those settings. The proxy configuration topics providemore
information about these attributes.

ADN Optimizations

Applies to theHTTP, HTTPS, CIFS, Endpoint Mapper, FTP, FTPS, SSL, and TCP Tunnel proxies in supported deployments.

Controls whether ADN optimizations—byte caching and/or compression—are enabled on a specific service. Note that
enabling these ADN optimizations does not guarantee accelerated connections. It depends on ADN routing (for explicit
deployments) and network configuration (for transparent deployments).

Byte caching is an optimization that replaces byte sequences in traffic flows with reference tokens. The byte sequences
and the token are stored in a byte cache on a pair of Edge SWG (ProxySG) appliances (for example, one at the branch,
the other at the data center). When amatching byte sequence is requested or saved, the Edge SWG (ProxySG) appliance
transmits the token instead of the byte sequence.

GZIP compression removes extraneous/predictable information from traffic before it is transmitted. The information is
decompressed at the destination’s Edge SWG (ProxySG) appliance.

The ADN settings are:

n Enable ADN: This setting does not guarantee acceleration for this service—it also depends on ADN routing (for
explicit deployments) or networksetup (for transparent deployments).

n Enable byte caching: This acceleration technique replaces byte sequences in traffic flows with reference tokens
and stores them in a byte cache on a pair of Edge SWG (ProxySG) appliances at each end of theWAN. When a
matching byte sequence is requested again, the Edge SWG (ProxySG) appliance transmits a token instead of the
byte sequence.

n Enable compression: Uses a variety of algorithms to remove extraneous/ predictable information from the
traffic before it is transmitted. The information is reconstituted at the destination based on the same algorithms.

To get themaximumbenefit of ADN, both byte caching and compression should be enabled. In cases where byte
cachingmay be causing issues for an ADN deployment, you can turn off the Enable byte caching option and just
use compression (or vice versa). If you know the traffic for this proxy is already compressed or encrypted, you can
conserve resources by clearing the Enable byte caching and Enable compression options.

n Enable thin client processing: Applies special treatment to application traffic from thin client applications
(such as RDP, VNC, and Citrix). This processing improves responsiveness of thin client actions. For example, end-
users will notice that the desktop displays significantly faster. In addition, thin client data is not retained in the
byte cache as long as other types of data because this data is aremore temporal in nature; the byte cache,
therefore, can be usedmore efficiently for other types of traffic that can better leverage it.
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This option is available for TCP Tunnel proxies only, and is only available when ADN is enabled and byte caching
and/or compression is enabled. Retention priority and thin client processing aremutually exclusive settings; you
cannot enable both options for a service.

For thin client processing to bemost effective, youmust deactivate the thin client’s software-based encryption
and compression.

n Retention priority: You can control how long data is stored in the byte cache dictionary by assigning a retention
priority to a particular service. If you want to keep certain types of data in the dictionary for as long as possible,
set a high retention priority for the service. Or for data that isn’t likely to get much benefit frombyte caching, you
can set a low retention priority for the related service. Most services are set to normal priority by default. This
option is available only if byte caching is enabled for the service.

You can use this option to preserve themost relevant content in the byte cache in the face of continually
incoming, competing byte cache data. For example, when an application is being used for backup, youmay want
to set the retention priority to high so that competing traffic doesn’t evict the backup data. However, if an
application is being used for data replication, youmay want to set the service’s retention priority to low as the
datamost likely will only be hit in the next short duration.

Authenticate-401

Available on the Explicit HTTP and External HTTP services.

When this option is selected, all transparent and explicit requests received on the port always use transparent
authentication (cookie or IP, depending on the policy configuration).

If you have configured authentication where only the Edge SWG (ProxySG) appliance nearest the user performs the
authentication tasks—configuring Authenticate-401 is not necessary. However, multiple explicitly-configured appliances
in a proxy chain are all attempting to perform authentication tasks can cause issues with browsers. By forcing one of the
proxies (recommended: the one furthest away from the client) to use 401-style authentication instead of the standard
proxy 407-style authentication, the browser can better handle themultiple authentication challenges.

Early Intercept

Applies to the CIFS and TCP Tunnel services.

Opening a TCP connection involves a three-way handshake involving packets: the client contacts the server, the server
acknowledges the client, and the client acknowledges the server.

n With early intercept, the appliance returns a server acknowledgment back to the client and waits for the client
acknowledgment, which completes the TCP three-way handshake, before the appliance connects upstream to the
server. Furthermore, proxies that support object caching (such as HTTP), the appliance serves from the cache—a
server connection is not necessary.

n With delayed intercept, the appliance attempts to connect upstream immediately after receiving the client's initial
connection request, but waits to return the server acknowledgment until determining whether or not the
upstream connection succeeds. This provides greater transparency, as the client receives either an RST or no
response, whichmirrors what is sent from a server when connections fail.
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For every proxy listener except CIFS and TCP Tunnel services, early intercept is hard-coded to enabled.

n For CIFS, the listener is hard-coded as delayed intercept because of a specific issuewith theway clients attempt to
connect to ports 139 and 445 simultaneously. Without a full transparency in our response to the TCP three-way
handshakes, client connectionsmight break.

n For TCP Tunnel, you have the option to select either (disabled by default). For the TCP Tunnel service, the Early
Intercept option is selectable and disabled by default. When this option is disabled, the proxy delays responding
to the client until after it has attempted to contact the server. Formaximum transparency, disable this option. If
reduced latency ismore important, enable it.

Protocol Detection

Applies to theHTTP, HTTPS, SOCKS, and TCP Tunnel services.

Protocol detection identifies HTTP, SOCKS CONNECT requests, and TCP tunnels. You can enable protocol detection on
the aforementioned services or implement it using policy. Policy can further be used to negate protocol detection for
SSL requests. Defining a policy for protocol detection enhances granularity by matching on a richer set of conditions
rather than the specific service; policy always overridesmanual settings.

If protocol detection is enabled, the appliance inspects the first bytes sent from the client and determines if a
corresponding application proxy is available to hand off the connection. For example, an HTTP request identified on a
TCP tunnel has full HTTP policy applied to it, rather than just simple TCP tunnel policy. In particular, thismeans that:

n The request arrives as a client protocol HTTP rather than a TCP Tunnel.

n TheURL used while evaluating policy is an http:// URL of the tunneled HTTP request, not a tcp:// URL to which the
tunnel was connecting.

n Forwarding policy is applied based on the newHTTP request; therefore, the selected forwarding host selected
support HTTP. A forwarding host of type TCP cannot handle the request, which forces the request to be blocked.

Enabling protocol detection helps accelerate the flow of traffic. However, the TCP sessionmust be fully established with
the client before either the application proxy or the TCP tunnel proxy contacts the origin server. In some cases, like in the
active-mode FTP data connections, enabling protocol detectionmight cause a delay in setting up the connection.

To avoid this connection delay, either use a protocol specific proxy, such as the FTP proxy, or disable protocol detection.

If protocol detection is disabled, traffic flows over a TCP tunnel without acceleration provided by a protocol-specific
proxy. The setting is disabled by default.

See Also:

n "Configure an HTTPS Reverse Proxy" on the facing page

n "Configure Proxy Service Listeners" on page 193
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Configure an HTTPS Reverse Proxy
The Symantec HTTPS Reverse Proxy implementation:

n Combines hardware-based SSL acceleration with full caching functionality.

n Establishes and services incoming SSL sessions.

n Provides TLS v1.2, TLS v1.1, TLSv1, SSL v3.0, and SSL v2.0 support. In version 7.2 and later, supports TLS 1.3.

n Supports IPv6 connections.

n (In version 7.3 and later) Supports theHTTP/2 protocol (TLSmust be enabled).

Note: Refer to the Reverse Proxy andWeb Application Firewall solution documentation
for additional solutions, workflows.

Prerequisite Tasks
Before creating an HTTP reverse proxy service, youmust:

n Create or import a keyring (Configuration > SSL > Keyrings and Keylists).

n (If necessary) Create a CSR that can be sent to a CA. After the CSR has been signed and the certificate has been
created, import the certificate to the keyring you created or imported.

Alternatively:

n Create a certificate for internal use and associate it with the keyring.

n (Optional, if using server certificates fromCAs) Import Certificate Revocation Lists (CRLs) so the Edge SWG
(ProxySG) appliance can verify that certificates are still valid. When these steps are complete, you can configure
theHTTPS reverse proxy service.

Creating an HTTPS Reverse Proxy Service

Note: One common scenario in using HTTPS reverse proxy, which connects the client to
the Edge SWG (ProxySG) appliance, is in conjunction with HTTPS origination, which is used
to connect to theOCS. Formore information on this option, see "Configure HTTP or
HTTPS Origination to theOCS" on page 189.

The Edge SWG (ProxySG) appliance does not create an HTTPS Reverse Proxy service by default. (The Edge SWG
(ProxySG) appliance has an HTTPS proxy service configured on port 443.)
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To create an HTTPS reverse proxy service:

1. In the Admin Console, select Configuration > Services > Proxy Services.

2. In Proxy Services:

n To add a service: Select New Service.

n To edit a service: Select the existing service.

n To import a service: Select Import Service.

The Add New/Edit Proxy Service page displays service and listener settings.
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3. Enter or edit the following settings as needed:

Setting
or field

Description

Name (Creating new or editing existing services) Name for the proxy service.

Service
to
Import

(Importing services) Service to import from library.

Service
Group

Select a predefined service group or a custom group.

Predefined services are not anchored to their default groups. You canmove a service to any other predefined
or custom group.

Note: The entire service is moved; you can't move individual listeners.

Proxy
Settings

n Keyring: Select a keyring. The system ships with a default keyring that is reusable for each HTTPS
service. The list also includes keylists configured on the appliance.

Note: The configuration-passwords-key keyring that shipped with theEdge S
WG (ProxySG) appliance does not contain a certificate. The appliance-key ke
yring does contain a certificate if you have Internet connectivity, but it cannot
be used for purposes other than appliance authentication.

n CCL: Select a CA certificate list.

n SSL Versions: Select the version(s) to use for this service from the list.

n Verify Client: Select to enable mutual SSL authentication. See "About Mutual SSL Authentication "
below for information.

n Forward Client Cert: (Available if Verify Client is selected) Select this option to put the extracted
client certificate information into the Client-Cert header that is included in the request when it is
forwarded to the origin content server. The header contains the certificate serial number, subject,
validity dates, and issuer (all as name=value pairs). The actual certificate itself is not forwarded.

n ADN options: See "ADN Optimizations" on page 182.

4. To add or edit listeners, see "Configure Proxy Service Listeners" on page 193.

About Mutual SSL Authentication
During an SSL handshake, the client and server negotiate themode of operation, the type of authentication required by
both parties, the cryptographic and hashing algorithms to use for providing confidentiality and integrity, and the
compression algorithm to use for the session.

SSL authentication can use the followingmodes of operation:

187 of 676



SGOS Administration (Admin Console Edition)

n Typical SSL authentication: Thismode provides confidentiality and integrity of the data sent between the client
and the server, and requires the server to authenticate to the client using an X.509 certificate.

n Mutual SSL authentication: In thismode, the server authenticates to the client using an X.509 certificate and the
client must authenticate to the server with a separate X.509 certificate.

When a Common Access Card (CAC) is used, the certificate identifies the user who owns the CAC. For information
on CAC authentication, refer to the Common Access Card Solutions Guide.

In mutual SSL authentication, an SSL connection between a client and a server is established only if the client and server
validate each other’s identity during the SSL handshake. Both the server and the client must have their own valid
certificate and the associated private key in order to authenticate.

Note: TLS is supported based on the server and client in use. For brevity, this section
refers only to SSL; however, SSL can be used interchangeably with TLS.

Typical SSL Authentication

In this scenario, the user logs in to the Edge SWG (ProxySG) appliance (server) using a browser (client). During this
process, the client (browser) validates the server (Edge SWG (ProxySG) appliance ) certificate. This includes the following
checks:

n The certificate subject must match the server’s hostname.

n The certificatemust be issued by a CA listed in the browser’s Trusted Root Certificate store.

n The client confirms that the server has the certificate's private key by challenging the server to sign randomdata.
The client validates the signature using the server's certificate.

188 of 676



SGOS Administration (Admin Console Edition)

Mutual SSL Authentication

In this scenario, the user logs in to the Edge SWG (ProxySG) appliance usingmutual SSL authentication. During this
process:

1. The client (browser) validates the server (Edge SWG (ProxySG) appliance) certificate. This includes the following
checks:

n The certificate subject must match the server’s hostname.

n The certificatemust be issued by a CA listed in the browser’s Trusted Root Certificate store.

n The client confirms that the server has the certificate's private key by challenging the server to sign random
data. The client validates the signature using the server's certificate.

2. The server (Edge SWG (ProxySG) appliance ) validates the client certificate that the browser presents. This includes
the following checks:

n The certificatemust be issued by a CA in the CCL for the Edge SWG (ProxySG) appliance service that is
performing the validation.

n The server confirms that the client has the certificate's private key by challenging the client to sign random
data. The server validates the signature using the client's certificate.

n The certificatemust be valid; it must have a valid signature and not be expired.

n (If using a CRL) The certificatemust not have been revoked.

Configure HTTP or HTTPS Origination to the OCS
In previous procedures, you configured HTTPS Reverse Proxy to the Edge SWG (ProxySG) appliance. In two common
termination scenarios, youmust also configure HTTPS origination to theOCS.
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The first two scenarios are used to provide a secure connection between the proxy and server, if, for example, the proxy
is in a branch office and is not co-located with the server.

Scenario 1: HTTPS Reverse Proxy with HTTPS Origination
HTTPS Reverse Proxy HTTPS Origination

Client > HTTPS >Edge SWG (ProxySG) appliance Edge SWG (ProxySG) appliance > HTTPS > OCS

Steps:

n Configure a keyring.

n Configure the SSL client.

n Configure the HTTPS service.

Steps (optional):

n Add a forwarding host.

n Set an HTTPS port.

n Enable server certificate verification.

Scenario 2: HTTP Termination with HTTPS Origination
HTTPS Reverse Proxy HTTPS Origination

Client > HTTPS > Edge SWG (ProxySG) appliance Edge SWG (ProxySG) appliance > HTTPS > OCS

Steps:

n Client is explicitly proxied.

Steps:

n Server URL rewrite.

OR

n Add a forwarding host.

n Set an HTTPS port.

n (Optional) Enable server certificate verification.

Using server URL rewrite is the preferredmethod. For information on rewriting the server URL, refer to the Content
Policy Language Reference.

To configure HTTPS origination, use the following CLI command:

# (config forwarding) create host_alias host_name https[=port_number] server ssl-verify-server=yes

where:

n host_alias:  Specifies the alias name of theOCS.

n host_name: Specifies the host name or IPv4/IPv6 address of theOCS, such as www.broadcom.com.

n port_number: Specifies the port number on which theOCS is listening.
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n server:  Specifies to use the relative path for URLs in theHTTP header because the next hop is aWeb server, not a
proxy server. Proxy is the default.

n ssl-verify-server:  Specifies whether the upstream server certificate should be verified. You can only enable
this command if the upstreamhost is a server, not a proxy.

The next scenario is useful when the appliance is deployed as a reverse proxy. This scenario is used when it is not
necessary for a secure connection between the proxy and server.

Scenario 3: HTTP Reverse Proxy with HTTPS Origination
HTTPS Reverse Proxy HTTPS Origination

Client > HTTPS > Edge SWG (ProxySG) appliance Edge SWG (ProxySG) appliance > HTTPS > OCS

Steps:

n Configure a keyring.

n Configure the SSL client.

n Configure the HTTPS service.

Steps:

n Server URL rewrite.

OR

n Add a forwarding host.

n Set an HTTP port.

Using server URL rewrite is the preferredmethod. For information on rewriting the server URL, refer to the Content
Policy Language Reference.

To configure HTTP origination, use the following CLI command:

# (config forwarding) create host_alias host_name http[=port_number] server

where:

n host_alias: Specifies the alias name of theOCS.

n host_name: Specifies the host name or IPv4/IPv6 address of theOCS, such as www.symantec.com.

n port_number: Specifies the port number on theOCS in which HTTP is listening.

n server: Specifies to use the relative path for URLs in theHTTP header because the next hop is a web server, not a
proxy server. Proxy is the default.

Create Policy for HTTP and HTTPS Origination
Forwarding hostsmust be already created on the appliance before forwarding policy can be created.

To create policy using CPL:

<Forward>
url.host=host_name forward(host_alias)
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To create policy using the VPM:

1. In the VPM, add a Forwarding layer.

2. Set the Destination to be theURL of theOCS.

3. Set the Action to forward to the forwarding host and configure parameters to control forwarding behavior.

For specific instructions for the legacy VPM or theweb VPM, refer to the respective documentation.
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Configure Proxy Service Listeners
You can configure listeners for a proxy service. For details, see "About Proxy Service Listeners" on page 176

1. In the Admin Console, select Configuration > Services > Proxy Services.

2. In Proxy Services, select the existing custom service.

The Edit Proxy Service page displays service and listener settings.

3. In Listeners:

n To add a listener: Select New.

n To edit a listener: Select the existing listener.

The Add/Edit Listener dialog opens.

4. Enter or edit the following settings as needed:

Setting or
field

Description

Source
Address

The client addresses to which the service applies. The most common selection is All, which means the
service applies to requests from any client (IPv4 and IPv6).

You can also restrict this listener to a specific IP address (IPv4 or IPv6) or user subnet (for IPv4) or prefix
length (for IPv6).

Destination
Address

The correct selectionmight depend on network configuration. See "About Proxy Services " on page 174.

Port Range A single port number or a port range on which this application protocol broadcasts. For a port ranges, type
a hyphen between the start and end ports, such as: 8080-8085

Action The default action for the service:

n Bypass: Ignores any traffic matching this listener.

n Intercept: Intercepts and proxies the associated traffic.

n Drop: (Added in version 7.3.2) Silently drops matching incoming packets.

n Reject: (Added in version 7.3.2) Responds to the sender indicating that the packet was rejected. For
UDP, the proxy sends an ICMP unreachable message; for TCP, it sends a TCP reset (RST) packet.

Create or edit asmany listeners as needed.

See Also:

n "Configure a Proxy Service" on page 180
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Manage Service Groups
The Edge SWG (ProxySG) appliance groups services into predefined service groups based on the type of traffic that
service carries.

To manage service groups:

1. In the Admin Console, select Configuration > Services > Proxy Services.

2. In Proxy Services, selectManage Groups.

TheManage Service Groups dialog displays the configured service groups, including the predefined
groups Standard, Bypass Recommended, and Tunnel Recommended. The Service Count column shows the
number of services in each group.

3. Do the following as needed:

n To add a new service group, select New and specify a name for the group.

n To rename a service group, select it and type the name.

n To remove a service group, delete it. A service groupmust be empty before it is deleted. If a service group
contains services, the delete icon is unavailable.
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Exempt Requests From Specific Clients
The bypass list contains IP addresses/subnet masks of client and server workstations. Used only in a transparent proxy
environment, the bypass list allows the appliance to skip processing requests sent from specific clients to specific
servers. The list allows traffic between protocol non-compliant clients and servers to pass through the appliancewithout
a disruption in service.

Note: This prevents the appliance from enforcing any policy on these requests and
disables any caching of the corresponding responses. Because bypass entries bypass
Symantec policy, use bypass sparingly and only for specific situations.

Create static and dynamic bypass entries prevent the appliance from intercepting requests from specified systems. You
can add static bypass entries in the Admin Console, but dynamic bypass entries can be configured through CLI or policy.

Configure Static Bypass
To configure static bypass

1. Select Configuration > Services > Proxy Services.

2. Under Static Bypass:

n To add a new entry, select New.

n To edit an existing entry, select Edit underActions.

3. Specify the following information:

Field or
Value

Description

Client/Prefix IPv4 address with subnet mask or IPv6 address with prefix length.

Server/Prefix IPv4 address with subnet mask or IPv6 address with prefix length.

Comment (Optional) Comment that indicates why you are creating the static bypass rule for the specific
source/destination combination. This is useful if another administrator needs to tune the settings later.

Configure Dynamic Bypass
Dynamic bypass is disabled by default. Enabling and fine-tuning dynamic bypass is a two-step process:
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n Set the desired dynamic bypass timeout and threshold parameters.

n Use policy (recommended) or the CLI to enable dynamic bypass and set the types of errors that cause dynamic
bypass to add an entry to the bypass list.

Dynamic bypass keeps its own (dynamic) list of which connections to bypass, where connections are identified by both
source and destination. Dynamic bypass can be based on any combination of policy triggers. In addition, some global
settings can be used to selectively enable dynamic bypass based on specific HTTP response codes. After an entry exists
in the dynamic bypass table for a specific source/destination IP pair, all connections from that source IP to that
destination IP are bypassed in the sameway as connections that match against the static bypass list.

For a configured period of time, further requests for the error-causing URLs are sent immediately to theOCS, bypassing
the appliance. The amount of time a dynamic bypass entry stays in the list and the types of errors that cause the
appliance to add a site to the list, as well as several other settings, are configurable from the CLI.

After the dynamic bypass timeout for a client and server IP address entry ends, the appliance removes the entry from
the bypass list. On the next client request for the client and server IP address, the appliance attempts to contact the
OCS. If theOCS still returns an error, the entry is again added to the local bypass list for the configured dynamic bypass
timeout. If the entry does not return an error, entries are again added to the dynamic list and not the local list.

Note: Dynamic bypass entries are lost when the appliance is restarted. No policy
enforcement occurs on client requests that match entries in the dynamic or static bypass
list. If a site that requires forwarding policy to reach its destination is entered into the
bypass list, the site is inaccessible.

Caution: Dynamic bypass policy can automatically compile a list of responseURLs that
return various types of errors. Because bypass entries bypass Symantec policy, the feature
should be used sparingly and only for specific situations.

Adding Dynamic Bypass Parameters to the Local Bypass List

The first step in configuring dynamic bypass is to set the server-threshold, max-entries, or timeout values in the CLI.

Note: This step is optional because the appliance uses default configurations if you do not
specify them. Use the default values unless you have specific reasons for changing them.
Contact Symantec Support for detailed advice on customizing these settings.

n The server-threshold value defines themaximumnumber of client entries before the appliance consolidates
client–server pair entries into a single server entry that then applies to all clients connecting to that server. The
range is 1 to 256. The default is 16. When a consolidation occurs, the lifetime of the consolidated entry is set to
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the value of timeout.

n Themax-entries defines themaximumnumber of total dynamic bypass entries. The range is 100 to 50,000. The
default value is 10,000. When the number of entries exceeds themax-entries value, the oldest entry is replaced
by the newest entry.

n The timeout value defines the number of minutes a dynamic bypass entry can remain unreferenced before it is
deleted from the bypass list. The range is 1 to 86400. The default value is 60.

Enabling Dynamic Bypass and Specifying Triggers

Enabling dynamic bypass and specifying the types of errors that causes a URL to be added to the local bypass list are
donewith the CLI.

Using policy to enable dynamic bypass and specify trigger events preferable to using the CLI, because the CLI supports a
limited set of HTTP responses. For information about available CLI triggers, refer to the Content Policy Language
Reference. For information about using policy to configure dynamic bypass, refer to theWeb Visual Policy Manager
Reference.

Bypassing Connection and Receiving Errors

In addition to setting HTTP code triggers, you can enable connection and receive errors for dynamic bypass.

If connect-error is enabled, any connection failure to theOCS, including timeouts, inserts theOCS destination IP address
into the dynamic bypass list.

If receive-error is enabled, when the cache does not receive an HTTP response on a successful TCP connection to the
OCS, theOCS destination IP address is inserted into the dynamic bypass list. Server timeouts can also trigger receive
error.

The default timeout value is 180 seconds, which can be changed.

CLI Syntax to Enable Dynamic Bypass and Trigger Events

To enter configurationmode for the service:

# (config) proxy-services
# (config proxy-services) dynamic-bypass

The following subcommands are available:

# (config dynamic-bypass) {enable | disable}
# (config dynamic-bypass) max-entries number
# (config dynamic-bypass) server-threshold number
# (config dynamic-bypass) [no] trigger {all | connect-error | non-http | receive-error | 400 | 401 |
403 | 405 | 406 | 500 | 502 | 503 | 504}
# (config dynamic-bypass) timeout minutes
# (config dynamic-bypass) clear
# (config dynamic-bypass) view
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Static Bypass and Dynamic Bypass
Create static and dynamic bypass entries prevent the appliance from intercepting requests from specified systems. You
can add static bypass entries in the Admin Console, but dynamic bypass entries can be configured through CLI or policy.

Configure Static Bypass
To configure static bypass

1. Select Configuration > Services > Proxy Services.

2. For Interception, select Restricted Intercept.

3. In Static Bypass:

n To add a new entry, select New.

n To edit an existing entry, select Edit underActions.

4. Specify the following information:

Field or
Value

Description

Client/Prefix IPv4 address with subnet mask or IPv6 address with prefix length.

Server/Prefix IPv4 address with subnet mask or IPv6 address with prefix length.

Comment (Optional) Comment that indicates why you are creating the static bypass rule for the specific
source/destination combination. This is useful if another administrator needs to tune the settings later.

Configure Dynamic Bypass
Dynamic bypass is disabled by default. Enabling and fine-tuning dynamic bypass is a two-step process:

n Set the desired dynamic bypass timeout and threshold parameters.

n Use policy (recommended) or the CLI to enable dynamic bypass and set the types of errors that cause dynamic
bypass to add an entry to the bypass list.

Learn more

Dynamic bypass keeps its own (dynamic) list of which connections to bypass, where connections are identified by both
source and destination. Dynamic bypass can be based on any combination of policy triggers. In addition, some global
settings can be used to selectively enable dynamic bypass based on specific HTTP response codes. After an entry exists
in the dynamic bypass table for a specific source/destination IP pair, all connections from that source IP to that
destination IP are bypassed in the sameway as connections that match against the static bypass list.
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For a configured period of time, further requests for the error-causing URLs are sent immediately to theOCS, bypassing
the appliance. The amount of time a dynamic bypass entry stays in the list and the types of errors that cause the
appliance to add a site to the list, as well as several other settings, are configurable from the CLI.

After the dynamic bypass timeout for a client and server IP address entry ends, the appliance removes the entry from
the bypass list. On the next client request for the client and server IP address, the appliance attempts to contact the
OCS. If theOCS still returns an error, the entry is again added to the local bypass list for the configured dynamic bypass
timeout. If the entry does not return an error, entries are again added to the dynamic list and not the local list.

Note: Dynamic bypass entries are lost when the appliance is restarted. No policy
enforcement occurs on client requests that match entries in the dynamic or static bypass
list. If a site that requires forwarding policy to reach its destination is entered into the
bypass list, the site is inaccessible.

Caution: Dynamic bypass policy can automatically compile a list of responseURLs that
return various types of errors. Because bypass entries bypass Symantec policy, the feature
should be used sparingly and only for specific situations.

Adding Dynamic Bypass Parameters to the Local Bypass List

The first step in configuring dynamic bypass is to set the server-threshold, max-entries, or timeout values in the CLI.

Note: This step is optional because the appliance uses default configurations if you do not
specify them. Use the default values unless you have specific reasons for changing them.
Contact Broadcom Support for detailed advice on customizing these settings.

n The server-threshold value defines themaximumnumber of client entries before the appliance consolidates
client–server pair entries into a single server entry that then applies to all clients connecting to that server. The
range is 1 to 256. The default is 16. When a consolidation occurs, the lifetime of the consolidated entry is set to
the value of timeout.

n Themax-entries defines themaximumnumber of total dynamic bypass entries. The range is 100 to 50,000. The
default value is 10,000. When the number of entries exceeds themax-entries value, the oldest entry is replaced
by the newest entry.

n The timeout value defines the number of minutes a dynamic bypass entry can remain unreferenced before it is
deleted from the bypass list. The range is 1 to 86400. The default value is 60.
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Enabling Dynamic Bypass and Specifying Triggers

Enabling dynamic bypass and specifying the types of errors that causes a URL to be added to the local bypass list are
donewith the CLI.

Using policy to enable dynamic bypass and specify trigger events preferable to using the CLI, because the CLI supports a
limited set of HTTP responses. For information about available CLI triggers, refer to the Content Policy Language
Reference. For information about using policy to configure dynamic bypass, refer to theWeb Visual Policy Manager
Reference.

Bypassing Connection and Receiving Errors

In addition to setting HTTP code triggers, you can enable connection and receive errors for dynamic bypass.

If connect-error is enabled, any connection failure to theOCS, including timeouts, inserts theOCS destination IP address
into the dynamic bypass list.

If receive-error is enabled, when the cache does not receive an HTTP response on a successful TCP connection to the
OCS, theOCS destination IP address is inserted into the dynamic bypass list. Server timeouts can also trigger receive
error.

The default timeout value is 180 seconds, which can be changed.

CLI Syntax to Enable Dynamic Bypass and Trigger Events

To enter configurationmode for the service:

# (config) proxy-services
# (config proxy-services) dynamic-bypass

The following subcommands are available:

# (config dynamic-bypass) {enable | disable}
# (config dynamic-bypass) max-entries number
# (config dynamic-bypass) server-threshold number
# (config dynamic-bypass) [no] trigger {all | connect-error | non-http | receive-error | 400 | 401 |
403 | 405 | 406 | 500 | 502 | 503 | 504}
# (config dynamic-bypass) timeout minutes
# (config dynamic-bypass) clear
# (config dynamic-bypass) view
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Troubleshooting: Bypass All Proxy Services or Restrict
Interception
Refer to the following topics to troubleshoot issues with traffic interception.

Bypass All Proxy Services
As an interim solution, you can bypass all proxy services while troubleshooting problems. When this feature is enabled,
transparent proxy connections are bypassed and explicit proxy connections are rejected.

To bypass all proxy services:

1. In the Admin Console, select Configuration > Services > Proxy Services.

2. For Interception, select Force Bypass.

Tip: When you are done troubleshooting, select Configuration > Services > Proxy
Services and select Proxy Services for Interception. Save the setting to disable
Force Bypass and resume normal operation of proxy services.

Restrict Interception From Clients or To Servers
By default, all clients and servers evaluate the entries in Proxy Services where the decision ismade to intercept or bypass
a connection. To restrict or reduce the clients and servers that can be intercepted by proxy services, create restricted
intercept lists. A restricted intercept list is useful in a rollout, before entering full production—you only want to intercept
a subset of the clients. After the appliance is in full productionmode, you can disable the restricted intercept list.

A restricted intercept list is also useful when troubleshooting an issue because you can reduce the set of systems that are
intercepted.

Note: Restricted intercepts lists are only applicable to transparent connections.

if an entry exists in both the static bypass list and restricted intercept list, the static bypass
entry overrides the restricted intercept entry. See "Static Bypass and Dynamic Bypass" on
page 198.

To restrict interception from clients or to servers:

1. In the Admin Console, select Configuration > Services > Proxy Services.

2. For Interception, select Restricted Intercept List.
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3. In Restricted Interceptions:

a. To add entries, select Add.

b. To edit entries, select the edit icon.

The Add/Edit Intercept List Entry dialog appears.

4. Enter or edit the following settings as needed, selectingApply to save each entry in the list:

Area
Setting or
field

Description

Client
Address

All Restrict interception from all clients.

Specific Host
or Subnet

Restrict interception from specific clients.

Enter an IPv4 or IPv6 address in the IP Address field and enter the subnet mask (for IPv4
addresses) or prefix length (IPv6) in the Prefix Length/Subnet Mask field.

Server
Address

All Restrict interception to all servers.

Specific Host
or Subnet

Restrict interception to specific servers.

Enter an IPv4 or IPv6 address in the IP Address field and enter the subnet mask (for IPv4
addresses) or prefix length (IPv6) in the Prefix Length/Subnet Mask field.
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Reference: Proxy Services, Proxy Configurations, and Policy
Refer to the following descriptions of proxies on the appliance, proxy configurations, and policy. Access log fields are also
included.

Proxy Types
Descriptions of proxies on the Edge SWG (ProxySG) appliance.

Proxy Capabilities and Benefits

CIFS n Optimizes/accelerates file sharing across the WAN to users in branch offices.

DNS n Speeds up domain name resolution by looking up domain names in the appliance's DNS cache. If the name
isn't found in the cache, the appliance forwards the request to the configured DNS server list.

n Ability to rewrite DNS requests and responses.

Flash n Live streaming: The appliance fetches the live Flash stream once from the OCS and serves it to all users
behind the appliance.

n Video-on-demand: As Flash clients stream pre-recorded content from the OCS through the appliance, the
content is cached on the appliance. After content gets cached on the appliance, subsequent requests for the
cached portions are served from the appliance; uncached portions are fetched from the OCS.

FTP n Controls, secures, and accelerates file transfer requests.

n Caches FTP objects.

HTTP n Controls, secures, and accelerates Web traffic.

n Caches copies of frequently requested web pages and objects.

HTTPS
Reverse
Proxy

n A proxy positioned in front of an HTTPS server that answers secure web requests from clients (using the
appliance's local cache when possible).

n Accelerates secure web requests, improving the response time to clients.

n Because the Reverse Proxy is processing the requests, it allows the HTTPS server to handle a heavier traffic
load.

MAPI n Accelerates the following Outlook processes: sending/ receiving e-mail, accessing message folders, changing
calendar elements.

MMS n Monitors, controls, limits, or blocks streaming media traffic that uses Microsoft's proprietary streaming
protocol.

n Reduces stutter and improves the quality of streaming media.

n Logs streaming connections.
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Proxy Capabilities and Benefits

RTSP n Monitors, controls, limits, or blocks streaming media traffic that uses the Internet standard RTSP protocol.

n Reduces stutter and improves the quality of streaming media.

n Logs streaming connections.

Shell n A proxy that allows a client to connect to other destinations via Telnet, after the client has created an
authenticated Telnet connection to the appliance

n Monitors, controls, limits, or blocks outbound Telnet connections.

n Enforces access control to a group of users and destinations via policy.

n Logs all connections.

SOCKS n A proxy that allows a client to connect to other destination servers/ports in a SOCKS tunnel, after the client's
connection to the SOCKS proxy is authenticated.

n Monitors, controls, limits, or blocks outbound client connections requested using the SOCKS protocol.

n Through policy, enforces access control to a group of users and destinations.

n SOCKS traffic can be passed to other proxies (such as HTTP) for acceleration.

n Logs all connections.

SSL n Allows authentication, virus scanning and URL filtering of encrypted HTTPS content.

n Accelerates performance of HTTPS content, using HTTP caching.

n Validates server certificates presented by various secure websites at the gateway.

TCP
Tunnel

n A tunnel for any TCP-based protocol for which a more specific proxy is not available.

n Compresses and accelerates tunneled traffic.

UDP
Tunnel

n A tunnel for any UDP-based protocol for which a more specific proxy is not available.

Service/Policy Matrix
The table below provides a list of the pre-defined proxy services and listeners that the proxy can accelerate and
interpret.

Service Name Proxy Destination IP Address Port Range

CIFS CIFS Transparent 445, 139

DNS DNS All 53

Endpoint Mapper Endpoint Mapper All 135

Explicit HTTP HTTP Explicit 8080, 80
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Service Name Proxy Destination IP Address Port Range

External HTTP HTTP Transparent 80

FTP FTP All 21

HTTPS SSL All 443

Internal HTTP TCP-Tunnel 192.168.0.0/16

10.0.0.0/8

172.16.0.0/16

169.254.0.0/16

192.0.2.0/24

80

MMS MMS All 1755

MS Terminal Services TCP-Tunnel Transparent 3389

SOCKS SOCKS Explicit 1080

Access Log Fields
The following access log fields apply to service name and service group name.

n Nameof the service used to intercept this connection:

x-service-name (ELFF token)

service.name= (CPL token)

n Service group name:

x-service-group (ELFF token)

service.group= (CPL token)

See "Configure an Access Log Format" on page 593 and "About Access Log Formats" on page 580 for detailed
information about creating and editing log formats.
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General Proxy Settings
The following optional settings apply to multiple or all proxy services when configured:

Tunnel on Protocol Error
Configure this setting for HTTP and HTTPS traffic. When enabled:

n TheHTTP proxy tunnels the connection when it receives non-HTTP traffic or broken HTTP request.

n The SSL proxy tunnels the connection when non-SSL traffic arrives at the SSL port (443 by default).

See Also:

n "Ensure Application Availability (Tunnel-on-Protocol Error)" on page 209

Reflect Client IP
Configure the Edge SWG (ProxySG) appliance to use the IP address of the client to connect to destination servers instead
of using the appliance address. By default, the appliance uses its own IP address as the source IP address for requests
(when connecting to servers).

See Also:

n "Use the Client IP Address for Server Connections" on page 211

Trust Destination IP
You can configure the appliance to trust a client-provided destination IP address in transparent proxy deployments. This
can be useful if the client provides a destination IP address that the Edge SWG (ProxySG) appliance can't identify. In this
case, configure the appliance to not perform aDNS lookup and allow that IP address. This can improve performance, but
potentially presents a security issue.

See Also:

n "Improve Performance by Not Performing a DNS Lookup" on page 211

Licensed User Connection Limits
You can enable license-enforced user limits and configure the Edge SWG (ProxySG) appliance behavior when a limit is
breached.

If you havemore users connecting through the system than is coded by themodel license, you have an option to
configure the overflow behavior (after a permanent model license has been applied to the system). The enforcement
options are queue the connections or bypass through the appliance and proceed directly to the server.
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Only unique IP addresses of connections intercepted by proxy services are counted toward the user limit; furthermore,
the number of users depends on the hardwaremodel and whether or not ADN is enabled.

License-enforced user connection limits are advisory and are based on optimal performance for each appliance. The
default setting is to not enforce user limits; however, when a user connection limit is breached, the appliance logs the
event and the license health indicator changes to Critical.

For VA user connection limits, refer to the appropriate deployment guide for your version. Refer to Edge SWG (ProxySG)
VA documentation at Tech Docs.

See Also:

n "Manage Licensed User Connection Limits (Appliance to Server)" on page 214

Configure Global Parallel Connections
Starting in version 7.3.4, the Edge SWG (ProxySG) appliance supports theHappy Eyeballs algorithm to improve user
experience for all connections or when requesting specified URL domains. The algorithm allows parallel connections,
which avert delays that might occur with serial connection attempts.

To configure parallel connections globally:

1. In the Admin Console, select Configuration > Services > General Proxy Settings.

2. In the Parallel Connect section, select the Enable Parallel Connect switch.

3. ForAttempt Delay, specify the number of milliseconds to wait before the appliance tries to connect using
resolved IP addresses; the default setting is 100 milliseconds.

The Show Statistics link shows statistics available for global parallel connections.

To override the global enable/disable setting, use the following CPL to set the behavior for specific transactions:

server.connection.parallel_connect(yes|no)

See Also:

n Content Policy Language Reference

Use a Caching Service
CachePulse is a caching service that provides you with optimal bandwidth gains for popular or high-bandwidth websites.
Utilizing highly effectiveWeb caching technology, CachePulse saves bandwidth on expensive international links and
backhaul traffic, thereby improvingWeb experience for users.

CachePulse accelerates the delivery of richWeb 2.0 content, video, and large files such as:
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n YouTube videos

n Netflix streamingmedia

n Microsoft Windows updates

Subscribing to the CachePulse service eliminates the need to maintain caching policy; when you first enable the service, it
downloads the latest version of the caching policy database. CachePulse periodically updates the database as long as the
service is enabled and an Internet connection exists.

See Also:

n "Optimize HTTP Traffic using CachePulse" on page 215
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Global Settings for Proxy Services
The following optional settings apply to all proxy services when configured:

n "Ensure Application Availability (Tunnel-on-Protocol Error)" below

n "Use the Client IP Address for Server Connections" on page 211

n "Improve Performance by Not Performing a DNS Lookup" on page 211

n "Manage Licensed User Connection Limits (Appliance to Server)" on page 214

n "Optimize HTTP Traffic using CachePulse" on page 215

Ensure Application Availability (Tunnel-on-Protocol Error)
This section discusses configuring the Tunnel-on-Protocol Error setting for HTTP and HTTPS traffic.

HTTP Proxy

In many networks, business-critical applications send traffic over port 80—the default HTTP port—because it is used as a
generic route through the firewall. However, the Edge SWG (ProxySG) applianceHTTP proxy encounters problemswhen
it receives non-HTTP requests from clients or browsers. The client receives an exception page and the connection closes.
The following deployment operations create this situation:

n The client request from an application or browser is not HTTP.

n The request is HTTP but also contains components that are not HTTP.

n The request contains an unexpected formatting error in a line or header.

The appliance provides an option that enables theHTTP proxy to tunnel the connection when it receives non-HTTP
traffic or broken HTTP request. This allows application traffic to continue and employee production to continue. The
transactions remain labeled as HTTP; therefore, the access logs and the Traffic Mix and Active Sessions statistics display
TCP_TUNNELED to indicatewhen a connection passed through theHTTP proxy. TheHTTP proxy cannot apply security
policies; however, benefits provided by ADN configurationsmight occur. The TCP Tunnel on Error option is viable with
the following deployments:

n Applies only to HTTP traffic; HTTPS is not supported in either forward or reverse proxy modes.

n Applies only to errors in requests from the client browser or application to the appliance. Any issues that arise
from server responses are not accommodated by this feature.

SSL Proxy

For the SSL proxy, the Tunnel on Protocol Error option applies when non-SSL traffic arrives at the SSL port (443 by
default).A common scenario that causes this is having peer-to-peer applications (such viz, Skype, BitTorrent, and
Gnutella) configured to enable port 443 for peer-to-peer traffic without SSL set as the transport protocol. An appliance
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transparently intercepting all 443 traffic cannot process these connections, rendering the application unusable. With an
explicit proxy deployment, SSL errors during the initial handshake causes the same issue. The following example
illustrates this:

n The appliance is configured to have an explicit HTTP service on port 8080.

n TheHTTP service is configured with detect protocol enabled, which hands off SSL traffic to the SSL proxy from an
HTTP CONNECT request. Detect Protocol is set to OFF by default.

Note: The same applies to an explicit SOCKS proxy deployment with protocol detection
enabled or an explicit TCP listener.

Considerations for Forwarding

Enabling the TCP Tunnel on Error optionmight cause issues if the appliance has forwarding rules that direct traffic to
upstreamproxies or other devices:

n Forwarding hosts are not viewed as HTTP proxies (even if they are). The initial HTTP proxy connects with a TCP
tunnel to the forwarding host. If the appliance has a policy to forward and tunnels on error, the forwarding rule
might not match if the forwarding rule has a condition based on information that is not present—any HTTP
conditions, such as:

o Request method

o Request URL

o Request headers

n In the case of tunnel on error with explicit proxy, HTTPmust match a forwarding host for the connection of a
successful TCP tunnel to occur. If no forwarding host matches, HTTP will not tunnel on error.

To ensure application availability by enabling TCP tunnel on HTTP protocol errors:

1. In the Admin Console, select Configuration > Services > General Proxy Settings.

2. In Settings, switch the TCP tunnel request when a protocol error is detected toggle.

Related Policy

The VPM provides theClient Certificate Requested object (SSL Intercept > Service).Use this policy in conjunction
with an ssl.intercept(no) action, or a Do Not Intercept SSL action in the VPM, to minimize traffic disruption when the
SSL proxy intercepts secure traffic where theOCS requests a client certificate. When Tunnel on Error is enabled, the first
detection of a client certificate request from an OCS causes the connection to fail. The appliance adds the details for that
exchange to an internal list of connections for which SSL interception should be negated. Subsequent requests function
as expected.
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Use the Client IP Address for Server Connections
This section discusses configuring the Edge SWG (ProxySG) appliance to use the IP address of the client to connect to
destination servers rather than use the appliance address.

Reflect the Client Source IP when Connecting to Servers

By default, the Edge SWG (ProxySG) appliance uses its own IP address as the source IP address for requests (when
connecting to servers). If Reflect Client IP is enabled, the appliance uses the client IP address for all requests. Enabling
this option is not an arbitrary decision; it depends on the deployment and role of the appliance. For example, if this Edge
SWG (ProxySG) is acting as a branch peer in an ADN deployment, enable client IP address reflection. This provides
maximum visibility for network usage statistics and enables user-based access control to network resources.

Note: The Reflect Client IP option is only supported in transparent deployments.

You can globally enable the Reflect Client IP option for all services that will be intercepted. To apply Reflect Client IP
option to only a few services, first enable this option globally and then create policy to disable the Reflect Client IP option
for the exceptions. Or, disable the option globally and create policy to enable it.

To reflect client IP:

1. In the Admin Console, select Configuration > Services > General Proxy Settings.

2. In Settings, switch theReflect client's source IP when connecting to servers toggle.

Note: If you enable Reflect Client IP and want the appliance to preserve persistent client
connections, youmust also add policy. In the VPM, in theWeb Access Layer, use the
Support Persistent Client Requests static action object, or use the following CPL:

<proxy>
http.client.persistence(preserve)

Improve Performance by Not Performing a DNS Lookup
This section describes how to improve performance by configuring the appliance to trust the destination IP address
provided by the client.

Trust the Destination IP Address Provided by the Client

If, in your environment, a client sometimes provides a destination IP address that the Edge SWG (ProxySG) appliance
cannot identify, you have the option to configure the appliance to not perform aDNS lookup and allow that IP address.
This can improve performance, but potentially presents a security issue.
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You can configure the appliance to trust a client-provided destination IP address in transparent proxy deployments
where:

n DNS configuration on the client is correct, but is not correct on the appliance.

n The client obtains the destination IP address usingWindows Internet Name Service (WINS) for NetBIOS name
resolution.

n DNS imputing on the appliance is not configured correctly. On the appliance, you can configure a list of suffixes to
help with DNS resolution. In the event that the host name is not found, these suffixes are appended to the host
name provided by the client. For information on DNS imputing, see "Resolve Hostnames Using Name Imputing
Suffixes" on page 111.

In each of the cases above, the appliance cannot obtain the destination IP address to serve client requests. When you
enable the appliance to trust a client-provided destination IP address, the appliance uses the IP address provided by the
client and does not perform aDNS lookup.

In the following example, no DNS lookup occurs; the transactions goes straight to theOCS.

In the following example, the appliance initiates a DNS lookup and initiates a new connection to the server.
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The appliance cannot trust the client-provided destination IP address in the following situations if the appliance:

n receives the client requests in an explicit proxy deployment.

n has a forwarding rule configured for the request.

n has a SOCKS gateway rule configured for the request.

n has policy that rewrites the server URL.

A transproxy deployment is onewhere a client is configured to contact an appliance explicitly, and a new appliance is
deployed between the client and its explicit proxy. The new appliance, now transparently intercepts the traffic between
the client and its explicit proxy. In a transproxy deployment, the destination IP address used by the client does not
match the host header in theHTTP request, since the client is configured to use the explicit proxy. The path that the
client request takes in a transproxy deployment depends on whether or not Trust Destination IP is enabled on the
transparently deployed appliance.

n When Trust Destination IP is enabled on the transparent appliance, the transparent proxy trusts the destination
IP included in the request and forwards the request to the explicit proxy which is serviced either from cache or
from theOCS.

n When Trust Destination IP is disabled on the transparent appliance, the transparent proxy performs aDNS
resolution on the host header in the request. The request is then completed based on the configured policy—
forwarding rules, SOCKS gateway policy, and server URL rewrite policy.
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Note: If a client gives the destination address of a blocked site but the host name of a
non-blocked site, with Trust Destination IP enabled, the appliance connects to the
destination address. Thismight allow clients to bypass the configured security policy for
your environment.

About the Default Settings

During the initial Edge SWG (ProxySG) configuration tasks, the administrator determined the default Trust Destination IP
setting. In most deployments, the role of the appliance determines the setting:

n Acceleration role: enabled.

n Most other proxy deployments: disabled for tighter security.

You can change these defaults through the Admin Console, the CLI, or through policy. If you use policy, however, be
aware that it overrides the setting in the in Admin Console. For information about using the trust_destination_ip
(yes|no) CPL property, refer to the Content Policy Language Reference.

To trust the destination IP address provided by the client:

1. In the Admin Console, select Configuration > Services > General Proxy Settings.

2. In Settings, switch the Trust client-provided destination IP when connecting to servers toggle.

Manage Licensed User Connection Limits (Appliance to Server)
This section describes how to enable license-enforced user limits, describes how tomonitor user numbers, and describes
how to configure the Edge SWG (ProxySG) appliance to behavewhen a limit is breached.
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Note: If your platform and license support unlimited user connections, you do not have
to configure user limit notifications because the thresholds cannot be exceeded. See
"General Proxy Settings" on page 206.

Modify User Limits Notifications

You can set andmonitor user limit thresholds of themodel license. A threshold breach triggers a notification and/or
event log entry. Frequent breaches indicate that constant user connections to this particular Edge SWG (ProxySG) model
are exceeding the optimal design.

To specify what happens when overflow connections occur:

1. In the Admin Console, select Configuration > Services > General Proxy Settings.

2. In Settings, select an option for User Overflow Action:

Setting Description

Do not
enforce
licensed user
limit

(Default behavior) Unlimited user connections are possible. If the limit is exceeded, the appliance health
changes to CRITICAL. This option is not available on the Edge SWG (ProxySG) VA because licensed user
limits are always enforced.

Bypass
connections
from users
over license
limit

Any transaction from a user whose connection exceeds the licensed limit is not susceptible to policy
checks or any other Edge SWG (ProxySG) benefit, such as acceleration. This option provides the best
user experience (with the caveat of potentially slower performance), but presents a Web security risk.
This is the default option for the Edge SWG (ProxySG) VA.

Queue
connections
from users
over license
limit

Any transaction from a user whose connection exceeds the licensed limit must wait (in order) for an
available Edge SWG (ProxySG) connection. This option provides the lowest user experience (and users
might become frustrated and, perceiving a hang, might attempt request refreshes), but preserves Web
security policies.

Optimize HTTP Traffic using CachePulse

Note: Before you can use CachePulse, youmust have a valid license for the feature. Refer
to your Symantec point of contact formore information. If you do not have a valid license,
the Admin Consolemight display Health Monitoring errors. The event logmight also
contain errormessages about the subscription.

To optimize HTTP traffic using CachePulse:
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1. In the Admin Console, select Configuration > Services > General Proxy Settings.

2. In CachePulse, switch the Enable toggle to enable the service.

When you save the changes, the appliance attempts to download the database. The License and Download Status
field shows download progress and information about the license and database.

Download the Database

You can download the CachePulse database at any time if the feature is enabled. If the initial download failed, and you
resolved the issue that caused the failure, you can select Download Now to download database updates.
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Manage the SSL Proxy
HTTPS traffic poses amajor security risk to enterprises. Because the SSL content is encrypted, it cannot bemonitored by
normalmeans. This enables users to bring in viruses, access forbidden sites, or leak confidential business information
over theHTTPS connection on port 443.

The SSL proxy intercepts, decrypts and re-encrypts HTTPS traffic (in explicit and transparent modes) so that security
measures such as authentication, virus scanning, and URL filtering, and performance enhancements such as HTTP
caching can be applied to HTTPS content. Additionally, the SSL proxy validates server certificates presented by various
HTTPS sites at the gateway and offers information about theHTTPS traffic in the access log.

The SSL proxy tunnels all HTTPS traffic by default unless there is an exception, such as a certificate error or a policy
denial. In such cases, the SSL proxy intercepts the SSL connection and sends an error page to the user. The SSL proxy
also enables interception of HTTPS traffic formonitoring purposes.

The SSL proxy can perform the following operations while tunneling HTTPS traffic:

n Validate server certificates, including revocation checks using CRLs.

n Check various SSL parameters such as cipher and version.

n Log useful information about theHTTPS connection.

When the SSL proxy is used to intercept HTTPS traffic, it can also:

n CacheHTTPS content.

n Apply HTTP-based authenticationmechanism.

n Send decrypted data to a configured ICAP scanning appliance for virus scanning and URL filtering. Apply granular
policy (such as validatingmime type and filename extension).

IPv6 Support
The SSL proxy is able to communicate using either IPv4 or IPv6, either explicitly or transparently.

In addition, for any service that uses the SSL proxy, you can create listeners that bypass or intercept connections for
IPv6 sources or destinations.

Validating the Server Certificate
The SSL proxy can perform the following checks on server certificates:

n Verification of issuer signature.

n Verification of certificate dates.
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n Host names in server certificates are important because the SSL proxy can identify aWeb site just by looking at the
server certificate if the host name is in the certificate. Most content-filtering HTTPS sites follow the guideline of
putting the name of the site as the common name in the server's certificate.

Comparison of host name in theURL and certificate (intercepted connections only).

n Verification of revocation status.

To mimic the overrides supported by browsers, the SSL proxy can be configured to ignore failures for the
verification of issuer signatures and certificate dates and comparison of the host name in theURL and the
certificate.

Checking CRLs

An additional check on the server certificate is done through CRLs. CRLs showwhich certificates are no longer valid; the
CRLs are created andmaintained by Certificate Signing Authorities that issued the original certificates.

Only CRLs that are issued by a trusted issuer can be used by the appliance. The CRL issuer certificatemust exist as CA
certificate on the appliance before the CRL can be imported.

The appliance allows:

n One local CRL per certificate issuing authority.

n An import of a CRL that is expired; a warning is displayed in the log.

n An import of a CRL that is effective in the future; a warning is displayed in the log.

See Also:

n "Configure Server Certificate Validation" on page 230

Working with SSL Traffic

The STunnel (SSL interception and tunnel) configuration intercepts all SSL traffic, handing HTTPS traffic off to theHTTPS
forward proxy for compression and acceleration. STunnel decrypted traffic may be tapped and read by a third-party
application such asWireshark or Snort.

Recommendations for intercepting traffic include:

n Intercept non-HTTPS traffic for acceleration.

n Intercept any SSL traffic for tap, when you don’t know the application protocol over SSL.

n TheHTTPS information in the next section, "DeterminingWhat HTTPS Traffic to Intercept" below.

DeterminingWhat HTTPS Traffic to Intercept

The SSL proxy tunnels HTTPS traffic by default; it does not intercept HTTPS traffic.
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Many existing policy conditions, such as destination IP address and port number, can be used to decidewhich HTTPS
connections to intercept.

Additionally, the SSL proxy allows the host name in the server certificate to be used to make the decision to intercept or
tunnel the traffic. The server certificate host name can be used as is to make intercept decisions for individual sites, or it
can be categorized using any of the various URL databases supported by Symantec.

Categorization of server certificate host names can help place the intercept decision for various sites into a single policy
rule.

Recommendations for intercepting traffic include:

n Intercept Intranet traffic.

n Intercept suspicious Internet sites, particularly those that are categorized as none in the server certificate.

Recommendations for traffic to not intercept includes sensitive information, such as personal financial information.

Managing Decrypted Traffic

After theHTTPS connection is intercepted, you can do:

n Anti-virus scanning over ICAP

n URL filtering

n Filtering based on the server certificate host name

Caching

HTTPS applications that require browsers to present client certificates to secureWeb servers do not work if you are
intercepting traffic. To address this, you can create a policy rule to prevent the interception of such applications, or add
client certificates to the appliance, and write policy to present the correct certificate.

If you configure the appliance to intercept HTTPS traffic, be aware that local privacy lawsmight require you to notify the
user about interception or obtain consent prior to interception. You can option to use theNotify User object to notify
users after interception or you can use consent certificates to obtain consent before interception. TheNotify User is
the easiest option; however, the appliancemust decrypt the first request from the user before it can issue an HTML
notification page.

Using the SSL Proxy with ADN Optimization

The SSL proxy itself can be used as a split proxy, which requires two SSL proxies, one at the branch and one at the core,
working together. A split proxy can be configured (see below) to implement functionality that is not possible in a
standalone proxy.

In this configuration, the SSL proxy supports ADN optimization onWAN networks, and SSL traffic performance can be
increased through the byte caching capability offered. The branch proxy, whichmakes the decisions, is configured with
both ADN optimization and SSL proxy functionality.
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The Concentrator proxy (a Edge SWG (ProxySG) appliance that provides access to data center resources) does not
require any configuration related to the SSL proxy. It only requires the necessary ADN configuration for applying byte
caching capabilities to intercepted SSL content.

No special configuration is required to the SSL proxy.

Notes on Pipelining
n Pipelining configuration for HTTP is ignored for HTTPS requests intercepted by the SSL proxy. When the SSL proxy

intercepts an HTTPS request, and the response is an HTML pagewith embedded images, the embedded images
are not pre-fetched by the appliance.

n If the appliance and the origin content server cannot agree on a common cipher suite for intercepted connections,
the connection is aborted.

Note: Pipelining configuration for HTTP is ignored for HTTPS requests intercepted by
the SSL proxy. When the SSL proxy intercepts an HTTPS request, and the response is
an HTML pagewith embedded images, the embedded images are not pre-fetched by
the appliance.

n Server-Gated Cryptography and step-up certificates are treated just as regular certificates; special extensions
present in these certificates are not be copied into the emulated certificate. Clients relying on SGC/step-up
certificates continue using weaker ciphers between the client and the appliancewhen the SSL proxy intercepts the
traffic.

See Also:

n "Intercept HTTPS" on the facing page

n "Configure SSL Proxy" on page 223

n "Configure SSL Rules through Policy" on page 229
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Intercept HTTPS
Intercepting HTTPS traffic (by decrypting SSL connections at the appliance) allows you to apply security measures like
virus scanning and URL filtering.

Note: An SSL license is required before you canmake use of the SSL proxy for
interception. Verify the license at theAdministration > Licensing page in the Admin
Console.

Configuration to intercept HTTPS traffic requires the following tasks:

n Determinewhether you are using transparent or explicit mode.

n Create an SSL service or HTTP/SOCKS services with protocol detection enabled, depending on whether you are
using transparent or explicit mode. TheDetect Protocol setting is disabled by default. Formore information on
creating an SSL service, skip to "Configure the SSL Proxy in Transparent Proxy Mode" on page 223.

n Create or import an issuer keyring, which is used to sign emulated server certificates to clients on the fly, allowing
the SSL proxy to examine SSL content. Formore information on creating an issuer keyring, see "Specify an Issuer
Keyring and CCL for SSL Interception" on page 224.

n (Optional) Use theNotify User object or client consent certificates to notify users that their requests are being
intercepted andmonitored. Whether this is required depends on local privacy laws. The appliance has to decrypt
the first request from the user to issue an HTML notification page. If this is not desirable, use client consent
certificates instead. Formore information on configuring theNotify User policy, refer to theWeb Visual Policy
Manager Reference. For information onmanaging client consent certificates, see "Configure Client Consent
Certificates" on page 231.

n Download CA certificates to desktops to avoid a security warning from the client browsers when the appliance is
intercepting HTTPS traffic. For information, see "Download an Issuer Certificate" on page 225.

n Using policy (VPM or CPL), create rules to intercept SSL traffic and to control validation of server certificates. By
default, such traffic is tunneled and not intercepted. Youmust create suitable policy before intercepting SSL
traffic. Formore information on using policy to intercept SSL traffic, see "Configure SSL Rules through Policy" on
page 229.

n (Version 7.1 and later) Enabled Policy Services. Refer to the SGOS Administration Guide for details.

n Configure a content filtering service. Formore information, see "Configure Data Services" on page 490.

n Configure access logging. Formore information on configuring access logging, see "General Logging
Configuration" on page 560.
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n Customize exception pages: Formore information, see "About Policy Exception Pages" on page 25. To customize
exception pages (in case of server certificate verification failure), refer to "Advanced Policy Tasks" in theWeb Visual
Policy Manager Reference.
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Configure SSL Proxy
Refer to the appropriate steps to configure SSL proxy in your deployment:

n "Configure the SSL Proxy in Transparent Proxy Mode" below

n "Configure the SSL Proxy in Explicit Proxy Mode" below

Configure the SSL Proxy in Transparent Proxy Mode
You can configure the SSL proxy service in the Admin Console. This procedure applies if you are running the SSL proxy in
transparent mode.

If you are using the SSL proxy in explicit mode, youmight need an HTTP proxy or a SOCKS proxy. For information on
configuring an SSL proxy in explicit mode, see "Configure the SSL Proxy in Explicit Proxy Mode" below.

You can use a TCP Tunnel service in transparent mode to get the same functionality. A TCP tunnel service is useful when
you have a combination of SSL and non-SSL traffic going over port 443 and you do not want to break the non-SSL
traffic. The SSL service requires that all requests to its port be SSL.

To configure an SSL service in transparent proxy mode, add an SSL proxy servicewith the following Proxy Settings:

n Enable ADN: Select this option to configure this service to use ADN. Enabling ADN does not guarantee the
connections are accelerated by ADN. The actual enable decision is determined by ADN routing (for explicit
deployment) or network setup (for transparent deployment).

n Optimize Bandwidth: Selected by default if you enabledWAN optimization during initial configuration. Clear the
option if you are not configuringWAN optimization.

See "Configure a Proxy Service" on page 180 for instructions.

Continuewith "Specify an Issuer Keyring and CCL for SSL Interception" on the next page.

Configure the SSL Proxy in Explicit Proxy Mode
The SSL proxy can be used in explicit mode in conjunction with theHTTP Proxy or SOCKS Proxy. Youmust create an
HTTP Proxy service or a SOCKS Proxy service and use it as the explicit proxy fromdesktop browsers. Youmust also
ensure that Detect Protocol attribute is enabled for these services. See "Configure a Proxy Service" on page 180 for
instructions.

When requests for HTTPS content are sent to either a SOCKS proxy or an HTTP proxy, the proxies can detect the use of
the SSL protocol on such connections and enable SSL proxy functionality.

Continuewith "Specify an Issuer Keyring and CCL for SSL Interception" on the next page.
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Specify an Issuer Keyring and CCL for SSL Interception
The SSL proxy can emulate server certificates; that is, present a certificate that appears to come from the origin content
server. In actuality, Symantec has emulated the certificate and signed it using the issuer keyring. By default only the
subjectName and the expiration date from the server certificate are copied to the new certificate sent to the client. The
appliance supports the following key sizes when it emulates server certificates:

n DSA and ECDSA certificates: Key size up to 2048 bits

n RSA certificates: Key size up to 4096 bits

Note: Only keyrings with both a certificate and a keypair can be used as issuer keyrings.

You can also change the CCLs that contain the CAs to be trusted during client and server certificate validation. The
appliance can verify DSA, RSA, and ECDSA signed client and server CA certificates. The defaults are adequate for the
majority of situations.

To specify an issuer keyring and CCLs:

1. In the Admin Console, select Configuration > Services > SSL Proxy Settings.

2. InGeneral Settings, specify the following settings:

Setting or
field

Description

Issuer
Keyring

Select the keyring to use as the issuer keyring. Any keyring with both a certificate and a keypair can be
used.

If configured, HSM keyrings and keylists are also listed here.

CCL for
Client
Certificates

Specify which CAs are trusted when the SSL proxy validates client certificates. By default, all CA
certificates are selected.

CCL for
Server
Certificates

Specify which CAs are trusted when the SSL proxy validates server certificates. The CCL for server
certificates is relevant even when SSL proxy is tunneling SSL traffic. The default is browser-trusted.

It is possible to set the CCL to validate client or server certificates from within policy on a per-request
basis. For details, see the client.certificate.validate.ccl() and
server.certificate.validate.ccl() properties in the Content Policy Language Reference.

To configure policy, see "Configure SSL Rules through Policy" on page 229.
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Configure OCSP Stapling and CRLs for Emulated Certificates
OCSP stapling (RFC 6066) and CRLs allow you to obtain the revocation status of an X.509 digital certificate. The Edge
SWG (ProxySG) appliance supports configuring these options for emulated certificates that the SSL forward proxy
delivers.

Note: Youmight want to configure both OCSP stapling and a CRL if some clients only
support one of themethods.

To enable or disable OCSP stapling, use the following command:

# (config ssl) proxy ocsp-stapling {enable | disable}

OCSP stapling is enabled by default.

To configure the appliance to provide a CRL for the emulated certificates:

1. In the Admin Console, select Configuration > Services > SSL Proxy Settings.

2. InGeneral Settings, switch the Enable CRL on emulated certificates toggle.

3. In theCRL distribution point host name field, enter the host name that is used to reach the Edge SWG
(ProxySG) appliance for CRL downloads.

Download an Issuer Certificate
When the SSL proxy intercepts an SSL connection, it presents an emulated server certificate to the client browser. The
client browser issues a security pop-up to the end-user because the browser does not trust the issuer used by the
appliance. This pop-up does not occur if the issuer certificate used by SSL proxy is imported as a trusted root in the client
browser's certificate store.

The appliancemakes all configured certificates available for download via Admin Console. You can ask end users to
download the issuer certificate through a browser and install it as a trusted CA in their browser of choice. This eliminates
the certificate pop-up for emulated certificates.

To download an issuer certificate:

1. In the Admin Console, select Dashboard > Advanced URLs.

2. Select SSL.

3. Select Download a Certificate as a CA Certificate to display a list of certificates on the system. Continuewith
downloading the certificate.
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Specify SSL/TLS Versions to Use for Transactions
You can specify a range of SSL/TLS versions to use on the client side and on the server side for all intercepted
connections.

1. In the Admin Console, select Configuration > Services > SSL Proxy Settings.

2. Under Client Connection, you can select aMinimum Version and aMaximum Version. By default, each
version is set to Preserve, whichmeans that the appliance uses theminimumormaximum client-offered version
that the appliance supports as theminimumormaximum supported version when accepting the client SSL
connection.

To change theminimumormaximum version, select another option from themenu: SSLv3, TLSv1, TLSv1.1,
TLSv1.2, or TLSv1.3.

For example, selecting aminimum version of TLSv1.1 and amaximum version of TLSv1.3 forces the appliance to
accept only TLSv1.1, TLSv1.2, and TLS1.3 on the client side.

3. Under Server Connection, you can select aMinimum Version and aMaximum Version. By default, each
version is set to Preserve, whichmeans that the appliance uses theminimumormaximum client-offered version
that the appliance supports as theminimumormaximum supported version when connecting upstream to the
OCS.

To change theminimumormaximum version, select another option from themenu: SSLv3, TLSv1, TLSv1.1,
TLSv1.2, or TLSv1.3.

For example, leaving theminimum setting of Preserve and selecting amaximum version of TLSv1.2 forces the
appliance to accept theminimum server-offered version, to amaximumof TLS1.2.

Tip: To control the SSL/TLS versions used for specific transactions instead of using these
global settings, add the Server Min SSL Version and Server Max SSL Version web
VPM objects to policy. Refer to theWeb Visual Policy Manager Reference formore
information.
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Warn Users When Accessing Websites with Untrusted Certificates
The Preserve untrusted certificate issuer setting allows the appliance to present the browser with a certificate that
is signed by its untrusted issuer keyring. The browser displays certificate information to the user, and lets the user accept
the security risk of an untrusted certificate and proceed to thewebsite.

The default-untrusted keyring has been added to the appliance to usewith the Preserve untrusted certificate
issuer setting. The default-untrusted keyring should not be added to any trusted CA lists.

Note: This only applies to SSL forward proxy transactions with HTTPS interception
enabled.

To display awarning to users about untrusted certificates on website, complete the following tasks:

n "Present Untrusted Certificates to a Browser" below

n "Set the Behavior when Encountering Untrusted Certificates" below

Present Untrusted Certificates to a Browser

Configure the appliance to act as a certificate authority and present a certificate signed by a specific keyring for all traffic.
The default is the default-untrusted keyring.

1. In the Admin Console, select Configuration > Services > SSL Proxy Settings.

2. In Preserve Untrusted Issuer Settings, specify the following settings:

Setting or field Description

Preserve untrusted certificate
issuer

Enable to have the appliance act as a CA and present the browser with an untrusted
certificate.

Untrusted Issuer Keyring Select a keyring to use for signing untrusted server certificates presented by the
appliance.

Set the Behavior when Encountering Untrusted Certificates

In theweb VPM or CPL, definewhat the appliance should do for specific traffic if the user tries to access awebsite with
an untrusted certificate.

Define Behavior in the VPM

Override the Admin Console settings for specific traffic, to specify whether the users should be prompted when a
certificate that has not been signed by a trusted CA is encountered.

In the SSL Intercept Layer, add one of the following actions:
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n Do not Preserve Untrusted Issuer

If an OCS presents a certificate to the appliance that is not signed by a trusted CA, the appliance either sends an
errormessage to the browser, or ignores the error and processes the request, based on the configuration of the
Server Certificate Validation object.

n Preserve Untrusted Issuer

If an OCS presents a certificate to the appliance that is not signed by a trusted CA, the appliance acts as a CA and
presents the browser with an untrusted certificate. A warningmessage is displayed to the user, and they can
decide to ignore thewarning and visit thewebsite or cancel the request.

n Use Default Setting for Preserve Untrusted Issuer

The Preserve untrusted certificate issuer configuration setting in the Admin Console is used to determinewhether
or not untrusted certificate issuer should be preserved for a connection. This is the default behavior.

Define Behavior in CPL

Include the following syntax in policy to specify the behavior of the appliancewhen users encounter a website with an
untrusted certificate:

ssl.forward_proxy.preserve_untrusted(auto|yes|no)

where:

n auto: Uses the Preserve untrusted certificate issuer configuration setting in the Admin Console to determine
whether untrusted certificate issuer should be preserved for a connection. This is the default.

n yes: Preserves untrusted certificate issuer is enabled for the connection.

n no: Preserves untrusted certificate issuer is disabled for the connection.

For example, to use the enable using the preserve untrusted certificate issuer, use the following syntax:

<ssl-intercept>
ssl.forward_proxy.preserve_untrusted(yes)
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Configure SSL Rules through Policy
SSL interception and access rules, including server certificate validation, are configured through policy—either the VPM
or CPL. In the VPM, use the SSL Intercept Layer to configure SSL interception; use the SSL Access Layer to control other
aspects of SSL communication such as server certificate validation and SSL versions.

The policy examples in this section are for in-path deployments of appliances:

n "Configure SSL Interception " below

n "Configure Server Certificate Validation" on the next page

Configure SSL Interception 
The SSL Intercept layer in theweb VPM allows you to set intercept options:

n "Intercept HTTPS " below

n "Intercept HTTPS Requests to Specific Sites" on the next page

n "Categorize Host Names in Server Certificates" on the next page

n "Configure Client Consent Certificates" on page 231

For detailed instructions on using the VPM, refer to theWeb Visual Policy Manager Reference.

Intercept HTTPS

1. In theweb VPM, add an SSL Intercept layer (select Add Layer > SSL Intercept).

2. Add an Enable SSL Interception action object. The Enable HTTPS interception option is selected by default.

3. Select the following settings and configure as needed

Setting or
field

Description

Issuer
Keyring

If you selected an issuer keyring previously, the keyring is displayed. If you did not select an issuer keyring
previously, the default keyring is displayed. You can change the keyring that is used as the issuer keyring.

Hostname Host name in the emulated certificate.

Splash
Text

The splash text is added to the emulated certificate as a certificate extension. You are limited to a
maximum of 200 characters.

Splash
URL

The splash URL is added to the emulated certificate as a certificate extension.
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4. Configure STunnel policy.

a. Enable STunnel Interception: Establish a policy where configured STunnel services (such as POP3S and
SMTPS) are terminated and accelerated.

b. Enable SSL interception with automatic protocol detection: In addition to STunnel interception as described
above, discovered HTTPS is handed off to theHTTPS proxy. Otherwise, SSL traffic continues in STunnel
mode.

Intercept HTTPS Requests to Specific Sites

1. In theweb VPM, add an SSL Intercept layer (select Add Layer > SSL Intercept).

2. Add an Server Certificate destination object. 

3. Select one of the following settings:

Setting or
field

Description

Hostname Host name of the server whose traffic you want to intercept.

Enter text for the host name and specify how to match: Exact Match, Contains, At Beginning, At End,
Domain, or Regex.

Subject Subject field in the server's certificate. After you

Enter text for the subject and specify how to match: Exact Match, Contains, At Beginning, At End,
Domain, or Regex.

Categorize Host Names in Server Certificates

1. In theweb VPM, add an SSL Intercept layer (select Add Layer > SSL Intercept).

2. Add an Server Certificate Category destination object. 

3. Add categories as needed to the selected list.

Configure Server Certificate Validation
For detailed instructions on using VPM, refer to theWeb Visual Policy Manager Reference. For a list of the conditions,
properties, and actions that can be used in the SSL Access Layer, refer to the Content Policy Language Reference.

Note: The CPL property server.certificate.validate(), if set, overrides the ssl-
verify-server command for either HTTP or for forwarding hosts.

To configure server certificate validation:
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1. In theweb VPM, add an SSL Access layer (select Add Layer > SSL Access).

2. Add a Set Server Certificate Validation action object. 

3. Select Enable server certificate validation and configure the following as needed

Setting or field Description

Behavior when server
certificate validation is
enabled

Select one of:

n Ignore hostname mismatch

n Ignore expiration

n Ignore untrusted issuer

These options mimic the overrides supported by most browsers.

Whether or not to check
certificate revocation status

Select one of:

n Use only local certificate revocation check: Uses the CRL configured on the
appliance to perform the revocation check for a server certificate.

n Do not check certificate revocation: Does not check the revocation status of the
server certificate; however it still carries out the other certificate validation
checks.

Configure Client Consent Certificates
The SSL proxy, in forward proxy deployments, can specify whether a client (typically a browser) certificate is required.
These certificates are used for user consent, not for user authentication. Whether they are needed depends upon local
privacy laws.

With client consent certificates, each user is issued a pair of certificates with the corresponding private keys. Both
certificates have ameaningful user-readable string in the common name field. One certificate has a string that indicates
grant of consent something like: “Yes, I agree to SSL interception”. The other certificate has a common name indicating
denial of consent, something like: “No, I do not agree to SSL interception”.

Policy is installed on the appliance to look for these common names and to allow or deny actions. For example, when the
string “Yes, I agree to SSL interception” is seen in the client certificate common name, the connection is allowed;
otherwise, it is denied.

To configure client consent certificates:

1. Install the issuer of the client consent certificates as a CA certificate.

2. In theweb VPM, add an SSL Access layer (select Add Layer > SSL Access).

3. Add aRequire Client Certificate action object (it is a static object).

4. Add a Client Certificate source object to common names.
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Configure the UDP Tunnel Proxy
Starting in version 7.3.4, the appliance can intercept UDP connections. You can configure a UDP tunnel proxy service,
which will be used for any UDP-based protocol for which amore specific proxy is unavailable. TheUDP tunnel proxy
allows you to intercept and forward UDP packets in client requests, and return UDP packets in responses from theOCS.
You can specify the following proxy settings to control UDP flows through the appliance.

To configure theUDP tunnel proxy:

1. In the Admin Console, select Configuration > Services > UDP Tunnel Proxy Settings.

2. In Settings, specify the following settings:

Setting or field Description

Idle Timeout Specify the timeout period for inactive UDP connections. Accepted values are between 1 and 3600
seconds. The default is 60 seconds.

Allow Upstream
Fragmented
Packets

When enabled, allows upstream fragmented UDP packets. When disabled, fragmented packets are
not allowed and the Don't fragment  (DF) flag is set in the IP header. Enabled by default.

Reflect ICMP
Messages From
Server To Client

If the server does not have a listening socket, it terminates the UDP connection. When this occurs
and reflect-icmp  is enabled, the proxy sends a message to the client to indicate that the ICMP
port was unreachable. Disabled by default.

Configure Malicious Content Scanning Services
Refer to the following topics to configuremalicious content scanning services:

n Malicious Content Scanning Services

Enable access logging globally or for specified logs. Associate logs with upload clients and configure log formats.
Specify whether to upload a log periodically or continuously, and configure settings such as log file limits and early
upload.

Malicious Content Scanning Services
You can configure the Edge SWG (ProxySG) appliance to interact with ICAP servers to provide content scanning. The
appliance supports ICAP connections with external Content Analysis and other third party ICAP services. For ease of use,
use the Policy Services subscription for content scanning policy.

About Content Scanning
ICAP is an open standard protocol that allows content engines to send HTTP based content to an ICAP server for
performing value added services.
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An ICAP server can filter, modify, or adapt web content to meet the needs of your enterprise. The appliance, when
integrated with a supported ICAP server such as Content Analysis, provides content scanning, filtering, and repair service
for Internet-basedmalicious code, in addition to reducing bandwidth usage and latency.

To eliminate threats to the network, the Edge SWG (ProxySG) appliance forwards aweb request and/or the response to
the ICAP server. The ICAP server filters and adapts the requested content, based on your needs, then returns the
content to the Edge SWG (ProxySG) appliance. The scanned and adapted content is then served to the user who
requested the content, and stored on the Edge SWG (ProxySG) appliance object store. For frequently accessed web
content, this integrated solution provides defense against malware, along with the benefits of limiting bandwidth usage
and latency in the network.

Plain ICAP and Secure ICAP

The transaction between the Edge SWG (ProxySG) appliance and the ICAP server can be executed using plain ICAP,
secure ICAP or both. Plain ICAP is useful for scanning non-confidential data (HTTP).

Secure ICAP is SSL encrypted ICAP and requires an SSL license; both the Edge SWG (ProxySG) appliance and the ICAP
servermust support secure ICAP. While Secure ICAP can be used for both HTTP and HTTPS traffic, plain ICAP is faster
than secure ICAP because it does not have to deal with any encryption overhead. Use secure ICAP when scanning
confidential data.

Note: The appliance does not support secure ICAP for the internal Content Analysis
service.

n "ICAP Configuration Overview" on page 243

Request Modification and Response Modification
An ICAP server processes web content that is directed to it during proxy policy evaluation. The content that the ICAP
server receives can be processed in twomodes: request modification and responsemodification.

See Also:

n "Content ProcessingModes " on page 235

Cache and Serve the Object
After an object has been scanned and is determined to be cacheable, the Edge SWG (ProxySG) appliance caches it and
serves it for a subsequent request. When the appliance detects that the cached content has changed on the origin
server, it fetches a fresh version, then forwards it to the ICAP server for scanning. If the Edge SWG (ProxySG) appliance
uses policies in the ICAP configuration, the policy applies to content fetches, distributions, refreshes, and pipelined
requests. Formore information on the <Cache> layer, refer to the Content Policy Language Reference.

ICAP v1.0 Features
This section describes the options for the ICAP v1.0 protocol that are provided on the Edge SWG (ProxySG) appliance.
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Sense Settings

The Sense Settings feature allows the Edge SWG (ProxySG) appliance to query any identified ICAP server running v1.0,
detect the parameters, and configure the ICAP service as appropriate. See "Configure an ICAP Service" on page 244.
ISTags ISTags eliminates the need to designate artificial pattern version numbers, as was required in v0.95.

Every response from an ICAP v1.0 servermust contain an ISTag value that indicates the current state of the ICAP server.
For instance, when the pattern/ scanner version of a virus scanner on the ICAP server changes, the ISTag value changes.
This change invalidates all content cached with the previous ISTag value and a subsequent request for any content in
cachemust be refetched from the origin content server and scanned by the ICAP server.

Backing out a virus pattern on the ICAP server can revert ISTags to previous values that are ignored by the Edge SWG
(ProxySG) appliance. To force the appliance to recognize the old values, use the Sense Settings option. See "Configure an
ICAP Service" on page 244.

Persistent Connections

New ICAP connections are created dynamically as ICAP requests are received (up to the definedmaximum connection
limit). The connection remains open to receive subsequent requests. If a connection error occurs, the connection closes
to prevent more errors.

Determine Which Files to Scan
In determining which files to scan, this integrated solution uses the content scanning server’s filtering in addition to
proxy capabilities. The following table describes the supported content types and protocols.

ICAP Server supported content types Proxy supported protocols
Unsupported content
protocols

All or specified file types, based on the file extension,
as configured on the server.

Examples: .exe (executable programs), .bat (batch
files), .doc and .rtf (document files), and .zip (archive
files); or specific MIME types.

n All HTTP objects (uploaded or
downloaded)

n All FTP over HTTP (webftp) objects
(uploaded or downloaded)

n All native FTP objects (uploaded or
downloaded) The above is true for
both transparent and explicit
proxies.

n Streaming content
(for example, RTSP
andMMS)

n Live HTTP streams
(for example, HTTP
radio streams)

n CIFS

n MAPI

n IM

n TCP tunnel traffic

HTTPS connections terminated at a Edge
SWG (ProxySG) appliance

HTTPS connections
tunneled through a Edge
SWG (ProxySG) appliance
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Whenever an object is requested or being refreshed and it was previously scanned, the appliance verifies whether the
pattern file has been updated since it was last scanned. If it was, the object is scanned again, even if the content has not
changed. If the content has changed, the object is rescanned.

With the appliance, you can define flexible, yet enterprise-specific content scanning policies, which are discussed in the
following two sections.

Content Processing Modes
An ICAP server processes web content that is directed to it during proxy policy evaluation. The content that the ICAP
server receives can be processed in twomodes— request modification and responsemodification.

n Request modification (REQMOD): Allowsmodification of outbound client requests. These requests are sent from
the Edge SWG (ProxySG) appliance to the ICAP server on their way to the origin content server. This is represented
in the VPM as Perform Request Analysis.

n Responsemodification (RESPMOD): Allowsmodification of inbound client requests. These requests are sent from
the Edge SWG (ProxySG) appliance to the ICAP server after the requested content is retrieved from theOCS.

n REQMOD or RESPMOD is an attribute that is specified in the ICAP service, which is configured between the Edge
SWG (ProxySG) appliance and the ICAP server. This is represented in the VPM as Perform Response Analysis.

About Response Modification
The Edge SWG (ProxySG) appliance sends the first part (a preview) of the object to the ICAP server that supports
responsemodification. The object preview includes theHTTP request and response headers, and the first few bytes of
the object. After checking those bytes, the ICAP server either continues with the transaction (that is, asks the Edge SWG
(ProxySG) appliance to send the remainder of the object for scanning) or sends a notification to the appliance that the
object is clean and opts out of the transaction.

The responsemodificationmode enables scanning of HTTP responses, remote system file retrieval or FTP RETR
responses, FTP over HTTP, and SSL-intercepted response data.

Returning the Object to the Edge SWG (ProxySG) Appliance

For responsemodification, the returned object can be the original unchanged object, a repaired version of the original
object minus a virus, or an errormessage indicating that the object contained a virus. Each of these responses is
configured on the ICAP server, independent of the appliance and the ICAP protocol. If the appliance receives the error
message, it forwards the errormessage to the client and does not save the infected file.

The following diagram illustrates the responsemodification process flow.
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Process flow:

1. (Blue arrow) Client requests a web page.

2. The Edge SWG (ProxySG) appliance retrieves the page from an OCS.

3. The appliance forwards theweb page to the ICAP server for content scanning. The contents (typically modified if
exceptions occur) is returned to the appliance. Clean content is stored in the cache, fromwhich future requests
are served.

4. Policy check evaluates how exceptions and other errors are processed.

5. (Blue arrow) The content is clean and allowable. The request is allowed to continue to its destination for full
retrieval.

6. (Red arrow) A virus or other exception occurred and the client is notified with an HTTPmessage.

About Request Modification
Request modificationmeans the ICAP server scans contents that a client is attempting to send outside the network. This
prevents unaware users from forwarding corrupted files or webmail attachments. Request modification is also amethod
of content filtering and request transformation, which is used to protect network identification. Based on the results of
the scan, the servermight return an HTTP response to the client (for example, sports not allowed); or the client request
might bemodified, such as stripping a referer header, before continuing to the origin content server. Request
modificationmode enables scanning of HTTP GET requests, PUT requests and POST requests, FTP upload requests and
outgoingWebmail.
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Note: Some ICAP servers do not support virus scanning for request modification, but
support only content filtering.

The following diagram illustrates the request modification process flow.

Process flow:

1. (Blue arrow) Client requests a web page.

2. TheEdge SWG (ProxySG) appliance forwards content to the ICAP server for scanning services (which can vary
depending on ICAP server configuration). The ICAP server identifies a virus in an attachment and returns the
results to the Edge SWG (ProxySG) appliance.

3. (Red arrow) Client receives an exceptionmessage that a infected attachment was identified and stripped.

Improve User Experience
Object scanning adds another operation to the user process of requesting and receiving web content. Therefore, the
usermight experience extremely slight noticeable delays during web browsing as ICAP servers scan content. The Edge
SWG (ProxySG) appliance allows you to mitigate slower browse times and educate your users about what is occurring on
their systems.
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About Patience Pages
Patience pages are HTML pages displayed to the user if an ICAP content scan exceeds the specified duration (seconds).
You can configure the content of these pages to include a custommessage and a help link. Patience pages refresh every
five seconds and disappear when object scanning is complete.

Notes

n Patience pages are not compatible with infinite stream connections—or live content streamed over HTTP—such
as a camor video feed. ICAP scanning cannot begin until the object download completes. Because this never
occurs with this type of content, the Edge SWG (ProxySG) appliance continues downloading until themaximum
ICAP file size limit is breached. At that point, the Edge SWG (ProxySG) appliance either returns an error or
attempts to serve the content to the client (depending on fail open/closed policy). However, even when
configured to fail open and serve the content, the delay added to downloading this large amount of data is often
enough to cause the user give up before reaching that point.

n Patience pages are limited to web browsers.

See Also:

n "Configure ICAP Feedback and Patience Pages" on page 254

About Data Trickling
Patience pages provide a solution to appease users during relatively short delays in object scans. However, scanning
relatively large objects, scanning objects over a smaller bandwidth pipe, or high loads on serversmight disrupt the user
experience because connection time-outs occur. To prevent such time-outs, you can allow data trickling to occur.
Depending on the tricklingmode you enable, the Edge SWG (ProxySG) appliance either trickles—or allows at a very slow
rate—bytes to the client at the beginning of the scan or near the very end.

The appliance begins serving server content without waiting for the ICAP scan result. However, to maintain security, the
full object is not delivered until the results of the content scan are complete (and the object is determined to not be
infected).

Note: This feature is supported for theHTTP proxy only; FTP connections are not
supported.

Trickling Data From the Start

In trickle from start mode, the Edge SWG (ProxySG) appliance buffers a small amount of the beginning of the response
body. As the ICAP server continues to scan the response, the appliance allows one byte per second to the client.
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After the ICAP server completes its scan:

n If the object is deemed to be clean (no responsemodification is required), the Edge SWG (ProxySG) appliance
sends the rest of the object bytes to the client at the best speed allowed by the connection.

n If the object is deemed to bemalicious, the Edge SWG (ProxySG) appliance terminates the connection and the
remainder of the response object bytes—which in this case are themajority of the bytes—are not sent to the
client.

Deployment Notes

n Thismethod is themore secure option because the client receives only a small amount of data pending the
outcome of the virus scan.

n One drawback is that usersmight become impatient, especially if they notice the browser display of bytes
received. They might assume the connection is poor or the server is busy, close the client, and restart a
connection.

Trickling Data at the End

In trickle at endmode, the Edge SWG (ProxySG) appliance sends the response to the client at the best speed allowed by
the connection, except for the last 16 KB of data. As the ICAP server performs the content scan, the appliance allows one
byte per second to the client.
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After the ICAP server completes its scan, the behavior is the same as described in "Trickling Data From the Start " on
page 238.

Deployment Notes

n Symantec recommends thismethod formedia content, such as flash objects.

n Thismethod ismore user-friendly than trickle at start. This is because users tend to bemore patient when they
notice that 99% of the object is downloaded versus 1%, and are less likely to perform a connection restart.
However, network administratorsmight perceive thismethod as the less securemethod, as amajority of the
object is delivered before the results of the ICAP scan.

Deciding between Data Trickling and Patience Pages

Edge SWG (ProxySG) appliance configuration options plus policy allow you to provide different ICAP feedback actions
depending upon the type of traffic detected:

n Symantec defines interactive as the request involving aweb browser. Web browsers support data trickling and
patience pages.

n Non-interactive traffic originates fromnon-browser applications, such as automatic software download or update
clients. Such clients are not compatible with patience pages; therefore, data trickling or no feedback are the only
supported options.

Based on whether the requirements of your enterprise places a higher value either on security or availability, the Edge
SWG (ProxySG) appliance allows you to specify the appropriate policy. However, youmust also consider the user agents
involved when determining the appropriate feedback method. For example, streaming clients cannot deliver patience
pages, but they are susceptible to connection timeouts. Therefore, trickling is the suggestedmethod. The following
diagramprovides basic guidelines for deciding which feedback method to implement.
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Recommendations for Proxy Chaining Deployments

Proxy chaining deployments are common in enterprises, especially in core/ branch office scenarios. Data trickling is
achievable, but behavior is dependent upon how the Edge SWG (ProxySG) appliances are configured. The following are
common deployment scenarios.

n The downstream appliance is performing ICAP scanning, and the upstream appliance is not: Data trickling and
patience pages are not affected in this scenario.

n The upstream appliance is performing ICAP scanning, and the downstream appliance is not: The only issuewith
this deployment is that user agent-specific policy cannot be applied at the core Edge SWG (ProxySG) appliance
because the branch appliance consolidatesmultiple client requests in one out-going request to the upstream
appliance. If data trickling is employed at the upstream appliance and if ICAP scanning detects a virus, the
upstream appliance resets the client connection. This also deletes the corrupted object from the downstream
appliance cache.

n Both Edge SWG (ProxySG) appliances (upstream and downstream) are scanning: Behavior ismostly determined
by the configuration of the upstream Edge SWG (ProxySG) appliance.

o If the upstream appliance is configured to deliver patience pages, then the downstream appliance also
attempts to serve patience pages, including to non-graphical user agents. Therefore, thismethod is not
recommended.

o If the upstream appliance employs data trickle from start, the downstream appliance is not able to send
any bytes to the client for a long period of time. If a patience page is not configured on the downstream
appliance, usersmight experience connection time-outs.
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o If the upstream appliance employs trickle at end, the downstream appliance allows for all options of
patience page and data trickling.

Avoid Network Outages due to Infinite Streaming Issues
Infinite streams are connections such as web cams or flashmedia—traffic over an HTTP connection—that conceivably
have no end. Characteristics of infinite streamsmay include no content length, slow data rate and long response time.
Because the object cannot be fully downloaded, the ICAP content scan cannot start; however, the connection between
the Edge SWG (ProxySG) appliance and the Content Analysis appliance remains, which wastes finite connection
resources.

The deferred scanning feature (enabled by default) solves the infinite streaming issue by detecting ICAP requests that
are unnecessarily holding up ICAP connections and defers those requests until the full object has been received.

HowDeferred ScanningWorks

Deferred scanning detects the possibility of infinite streams by the fact that the number of ICAP resources in use has
reached a certain threshold. It then defers the scanning of those streams by deferring the oldest, outstanding ICAP
requests first. For every new ICAP request, the Edge SWG (ProxySG) appliance does the following:

n If the total number of outstanding ICAP actions for the current server has reached the defer threshold, the Edge
SWG (ProxySG) appliance defers the oldest ICAP connection that has not yet received a full object.

n The defer threshold is specified by the administrator as a percentage. For example, if the defer threshold is set to
70 percent and themaximum connections are set to 100, then up to 70 connections are allowed before the Edge
SWG (ProxySG) appliance begins to defer connection which have not finished downloading a complete object.

Note: See "Configure an ICAP Service" on page 244 for information about setting the
defer scanning threshold value in the Admin Console.

n When an ICAP connection is deferred, the connection to the ICAP server is closed. The application response
continues to be received and when the download is complete the ICAP request is restarted. The new ICAP request
may still be queued if there are no available ICAP connections. After a request is deferred, ICAP waits to receive
the full object before restarting the request. If there is a queuewhen a deferred action has received a complete
object, that action is queued behind other deferred actions that have finished. However it will be queued before
other new requests.

Deferred Scanning and Setting the Feedback Options

Depending on how you configure the ICAP feedback option (patience page or data trickling) and the size of the object,
deferred scanningmight cause a delay in ICAP response because the entire responsemust be sent to the ICAP server at
once. The feedback option allows you to specify the type of feedback you want to receive during an ICAP scan. For
information about setting feedback options, see "Configure ICAP Feedback and Patience Pages" on page 254.

If a patience page is configured, the browser continues to receive a patience page until the object is fully received and the
outstanding ICAP actions have completed.
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If the data trickle options are configured, the object continues to trickle during deferred scanning. However, because of
the trickle buffer requirement, theremight be a delay, with or without deferred scanning, before the Edge SWG
(ProxySG) appliance starts sending a response.

About ICAP Server Failover

When creating an ICAP action, you can specify a list of ICAP servers or groups to use, in order of preference. If the first
server or group in the list does not pass the health checks, the Edge SWG (ProxySG) appliancemoves down the list until it
finds a server or group that is healthy and uses that to perform the scanning. The primary server resumes ICAP
processing when the next health check is successful; the standby server or server group does not retain the primary
responsibility.

Notes

n Failover is configured as part of the ICAP policy definition.

n You cannot configure failover policy until ICAP services are configured on the Edge SWG (ProxySG) appliance.

n To avoid errors, ICAP service names cannot be named fail_open or fail_closed (the CLI commands prevent these
names frombeing created).

ICAP Configuration Overview
Configuring ICAP on the appliance consists of the following tasks:

Task Description

Install and configure the ICAP server. Follow the manufacturer instructions for installing the ICAP server,
including any configuration necessary to work with the Edge SWG
(ProxySG) appliance.

Based on your network environment, youmight use the Edge SWG
(ProxySG) appliance with multiple ICAP servers or multiple scanning
services on the same server.

Configure options as needed, including the exceptionmessage displayed
to end users when a requested object is modified or blocked.

Determine whether to scan data using plain ICAP or
secure ICAP.

Scan data using the plain ICAP method, secure ICAP method, or both.

n Plain ICAP should be used only for non-confidential data. In
particular, if plain ICAP is used for intercepted HTTPS traffic, then
data intended to be cryptographically secured would be
transmitted in plain text on the local network.

n Secure ICAP send data through a secure data channel. This
method protects the integrity of messages that are sent between
the Edge SWG (ProxySG) appliance and the ICAP server while it
allows users to authenticate ICAP servers by enabling certificate
verification.
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Task Description

(Optional; secure ICAP only) Select the default SSL
profile or create an SSL device profile on the Edge
SWG (ProxySG) appliance.

An SSL device profile is required to authorize the ICAP server, if you use
secure ICAP.

Note: If you create an SSL device profile, instead of
using a built-in device profile, ensure that the ICAP
server certificate is installed as trusted under
External certificates. Otherwise, when the Verify Peer
option is enabled, the Edge SWG (ProxySG) appliance
fails to verify the ICAP server as a trusted server.

Create and configure new or existing ICAP services
on the Edge SWG (ProxySG) appliance. For
information on ICAP content processing modes, see
"Content Processing Modes " on page 235.

Create an ICAP service that specifies the ICAP server IP address,
supported connectionmethod, content processing mode and select
deferred scanning, if desired. See "Configure an ICAP Service" below.

Specify the feedback method. Select patience pages or data trickling for feedback method. See
"Configure ICAP Feedback and Patience Pages" on page 254.

Add ICAP rules to policy. Depending on your network needs, add ICAP rules to policy and install the
policy file on the Edge SWG (ProxySG) appliance.

Configure an ICAP Service
An ICAP service is a collection of attributes that defines the communication between the Edge SWG (ProxySG) appliance
and the external ICAP server. It includes the server IP address or hostname, ICAP scanningmethod, and a host of other
options including the supported number of connections.

Youmust create an ICAP service for each ICAP server or scanning service. For example, if you are using the appliancewith
multiple ICAP servers ormultiple scanning services (RESPMOD or REQMOD) on the same server, add an ICAP service for
each server and RESPMOD or REQMOD service.

Similar ICAP scanning services can then be grouped together to create a service group that helps distribute and balance
the load of scanning requests. Further, each ICAP service or service group can be accessed through VPM or CPL to
configure policy for better administrative control.

The following instructions describe how to create an ICAP service for any supported third-party ICAP server.

To configure an ICAP service:

1. In the Admin Console, select Configuration > Content Analysis > ICAP.

2. In ICAP Services, select Add > ICAP Service to add a new service, or select an existing ICAP service to edit.

3. On the Add/Edit Service page, enter or edit the following settings as required:
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Task Setting or
field

Description

Configure
ICAP communication
settings

Service Name Unique name for the ICAP service.
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Task Setting or
field

Description

Service URL ICAP server URL, which includes the URL schema, ICAP server hostname, or IP
address. For example, the ProxyAV and Content Analysis appliances support this
type of URL:

icap://10.x.x.x/avscan

If your ICAP server is something other than ProxyAV or Content Analysis, check
with your ICAP vendor for the appropriate URL format.

ICAP Version The default ICAP version is 1.0 and can't be changed.

Service Type Identify the ICAP service type as being Threat Protection, DLP, or Other. Use
this service if you are migrating appliance policy to the Symantec Web Security
Service; however, policy rules that reference an Other service are not
enforceable in the Web Security Service, with the exception of rules that
reference an Other service that has the name ProxyAV. Services with the name
ProxyAV are Threat Protection policy and can be migrated.

Maximum
number of
connections

Maximum possible connections at any given time that can occur between the
Edge SWG (ProxySG) appliance and the ICAP server.

The range is a number from 5 to 4096. The default is 25.

The number of recommended connections depends on the capabilities of the
ICAP server. Refer to the vendor’s product information.
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Task Setting or
field

Description

Connection
timeout

Number of seconds the Edge SWG (ProxySG) appliance waits for replies from
the ICAP server.

This timeout is the duration for which the TCP connection between the Edge
SWG (ProxySG) appliance and the ICAP server is maintained. It helps verify the
responsiveness of the ICAP server and prevents users from experiencing
unnecessary delays.

The default timeout is 70 seconds, and you can enter a value in the range of 5 to
4096.

Note: The connection timeout value does not measure
howmuch of the scanning process is complete, it is a
mechanism for ensuring that the communication between
the appliances is alive and healthy. The details of the
interaction between the Edge SWG (ProxySG) appliance
and the ICAP server can only be viewed through a packet
capture.

If the ICAP server does not respond within the configured
timeout value, by default, the user will not receive the
requested content.

Defer
scanning at
threshold

Switch the toggle to set the threshold at which the Edge SWG (ProxySG)
appliance defers the oldest ICAP connection that has not yet received a full
object.

In the Threshold field, enter a range between 0 and 100 percent. The default is
80 percent.

By default, the deferred scanning threshold is enabled when an ICAP service is
created.

Notify
administrator
when virus
detected
(Email msg)

Switch the toggle to notify the administrator when a virus is found.
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Task Setting or
field

Description

"Virus found"
page

Page to show the client when a virus is detected:

n Use vendor's "virus found" page from the ICAP server: Display the
default vendor error exception page.

n Use ProxySG's exception page: Display the appliance's exception page.

Configure ports

At least one of these
options must be
selected.

Support plain
ICAP
connections

Service supports plain ICAP connections to use plain ICAP. Use plain ICAP when
you are scanning plain data (HTTP). In this case, if the HTTPS proxy is enabled
on the Edge SWG (ProxySG) appliance, the data is decrypted first on the Edge
SWG (ProxySG) appliance and then sent to the ICAP server.

In the Plain ICAP port field, enter a port number. The default port is 1344.

Support
secure ICAP
connections

Service supports secure ICAP connections to use secure ICAP. Use secure ICAP
when you are scanning sensitive or confidential data (HTTPS).

In the Secure ICAP port field, enter a port number. The default port is 11344.

For secure ICAP, a valid SSL profile is required. Select one in the SSL Device
Profile field. This associates an SSL device profile with the secure ICAP service.

Note: If you do not select an SSL device profile you cannot
use secure ICAP connections. The SSL device profile can
be customized for your environment.
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Task Setting or
field

Description

Configure server
settings

Sense Settings Automatically configure the ICAP service using the ICAP server parameters. If
communication with the ICAP service is successful, the ICAP Server Tag
displays the ICAP service identifier.

Note: This function assumes a deployment with one Edge
SWG (ProxySG) appliance sending data to one ICAP server.
If your deployment has multiple proxies using one
ICAP server, youmight have to modify theMaximum
number of connections value accordingly.

Notification
method

Select the ICAP method: Responsemodification or Requestmodification.

An ICAP server might have separate URLs for response modification and
request modification services.

Enable
Preview

Enable only in one of the following situations:

n (Only for RESPMOD service) If you are using file scanning policies based
on file extensions on the ProxyAV appliance, enter 0 in the Preview size
field, and select enabled. With a 0 bytes preview size, only response
headers are sent to the ICAP server; more object data is only sent if
requested by the ICAP server.

n If you have enabled the Kaspersky Apparent Data Types feature on the
ProxyAV appliance, enter a value (512 is recommended) in the Preview
size field, and select enabled. The ICAP server reads the object up to the
specified byte total. The ICAP server either continues with the transaction
(that is, receives the remainder of the object for scanning) or opts out of
the transaction.
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Task Setting or
field

Description

Send (Optional) Include additional HTTP headers with files forwarded to the ICAP
server. Select the header information to send to the ICAP server:

n Authenticated Groups: Group name.

n Authenticated User: Fully-distinguished username (X-SYMC-User) and
email address (X-SYMC-User-Email-Address).

n Client Address: Client IP address.

n Server Address Server IP address.

n Server Country: Name of the country, or special values such as none.

n Threat Risk Level: Numeric threat risk level from 1 to 10. Refer to the
SGOS Administration Guide for more information Threat Risk Levels.

n URL Categories: Semicolon-delimited list of qualified category labels of
the form category_name[@category_source].

Perform health
check

Perform
health check

Perform an immediate health check on this service.

See Also:

n "Configure an ICAP Service Group" on page 253

About ICAP Service Groups
You can create andmanage external ICAP service groups. In high-traffic network environments, a service group
accelerates response time by a performing a higher volume of scanning.

An Edge SWG (ProxySG) ICAP service is a named entity that identifies the ICAP server, the ICAPmethod, and the
supported number of connections. A service group is a named set of ICAP services. You will need to create service groups
when you are usingmultiple ICAP servers to process a large volume of scanning requests. The following example shows a
service group of three ICAP servers:
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In the previous example:

a. ICAP server has amaximumof 10 connections and a specified weight of 1.

b. ICAP server has amaximumof 10 connections and a specified weight of 1.

c. ICAP server has amaximumof 25 connections and a specified weight of 3.

d. Edge SWG (ProxySG) appliance has a Service Group that contains ICAP servers A, B, and C.

To help distribute and balance the load of scanning requests when the Edge SWG (ProxySG) is forwarding requests to
multiple services within a service group, the Edge SWG (ProxySG) uses an intelligent load balancing algorithm. When
deciding which service in the service group to send a scanning request, this algorithm takes into consideration the
following factors:

n Number of requests that are in awaiting state on each service (a request is in this statewhen it has been sent to
the service but the response hasn’t been received)

n Number of unused connections available on each service (calculated by subtracting the number of active
transactions from the connectionmaximumon the server)

n The user-assigned weight given to each server (see below)

Weighting
Weighting determines what proportion of the load one server bears relative to the others when transactions arewaiting
to be scanned. (Thewaiting transactions are typically large file downloads.) If all servers have either the default weight (1)
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or the sameweight, each share an equal proportion of the load when transactions arewaiting. If one server has weight
25 and all other servers haveweight 50, the 25-weight server processes half asmuch as any other server.

Before configuring weights, consider the capacity of each server. The processing capacity of the server hardware in
relationship to other servers (for example, the number and performance of CPUs or the number of network interface
cards) could affect assigned weight of a ICAP server.

Having appropriate weights assigned to your services is critical when all servers in a service group havewaiting
transactions. As servers reach their capacity, proper weighting is important because requests are queued according to
weight.

One technique for determining weight assignments is to start out by setting equal weights to each service in a group;
then, after several thousand requests, make note of howmany requests were handled by each service. For example,
support there are two services in a group: Service A handled 1212 requests, Service B handled 2323. These numbers
imply that the second service is twice as powerful as the first. So, theweights would be 1 for Service A and 2 for Service
B.

Setting theweight value to 0 (zero) disables weighted load balancing for the ICAP service. Therefore, if one ICAP server of
a two-server group has aweight value of 1 and the second aweight value of 0, should the first server go down, a
communication error results because the second server cannot process the request.

Load Balancing Examples

When load balancing between services, how does the Edge SWG (ProxySG) appliance decidewhich ICAP service to send a
scanning request to? For each service, it calculates an index by dividing the number of waiting transactions by the server
weight (think of this as wait/weight). The ICAP servicewith the lowest index value handles the new ICAP action, assuming
that the service has an available connection to use. If it does not, it sends the request to the servicewith the next lowest
index value that has a free connection.

Note: If there are no transactions waiting, load balancing using the assigned weights does
not take effect.

Load will be distributed among services proportionally according to their configured weights until themaximum
connection limit is reached on all services.

Example 1

Service A and B are in the same service group.

n Service A can handle up to 50 connections, is assigned aweight of 1, has 17 active transactions, with 5
transactions in thewaiting state. The index is calculated by dividing thewait by theweight: 5/1 = 5.

n Service B can handle up to 100 connections, is assigned aweight of 2, has 17 active connections, with 15 waiting
transactions. The index is 15/2 = 7.5.

The appliance assigns the next ICAP action to Service A because it has a lower index.
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Example 2

Service C and D are in the same service group.

n Service C can handle up to 5 connections, is assigned aweight of 1, has 5 active transactions, with 1 transaction in
thewaiting state. The index is 1/1=1.

n Service D can handle up to 10 connections, is assigned aweight of 1, has 7 active transactions, with 5 waiting
transactions. The index is 5/1=5.

Although Service C has a lower index than Service D, it does not have any available connections; therefore, the appliance
assigns the next ICAP action to Service D which has several free connections.

Configure an ICAP Service Group
You can create a service group and add the relevant ICAP services to the group. When instructed by configured ICAP
policies, the appliance sends ICAP responsemodification requests to ICAP servers in the service group. The load carried
by each service in the group is determined by theweight values.

To configure an ICAP service group:

1. In the Admin Console, select Configuration > Content Analysis > ICAP.

2. In ICAP Services:

n To add a new group, select Add > ICAP Service Group.

n To edit an existing group, select it in the list. Group names are in the format "Group: name".

Note: You can expand a group to show the services that aremembers of it.

3. (If editing a service group) In ICAP Services, theGroup Members section shows all ICAP services that belong to
the group. Edit the group as needed:

n In theWeight field of each ICAP service, assign aweight value. The valid range is 0-255.

See "Weighting" on page 251 for information on using weight to configure load balancing.

n Select Remove to remove a service from the group.

4. (When editing a group or adding a new one) On the Add/Edit Service page, enter or edit the following settings as
required:

253 of 676



SGOS Administration (Admin Console Edition)

Task Setting or field Description

Set group properties Group Name Unique name for the group. On the ICAP Services page, the group
name is displayed as "Group: name", where name is the group name
specified here.

Configure group
membership

Select Services Selecting this option opens the Select ICAP Services dialog. The
dialog displays all configured services on the appliance.

n To remove a service from the group, clear its checkbox.

n To add a service to the group, select its checkbox.

Display Content Analysis and Group Information
After configuring a service group, you can display aggregate service group (and other Content Analysis) information.

To display information about all Content Analysis services and groups, use the following CLI commands:

# (config) content-analysis
# (config content-analysis) view

Individual service information is displayed first, followed by service group information, such as:

; Content Analysis
ICAP-Version: 1.0
URL: icap://10.9.59.100/
Plain-ICAP-enabled: yes
Plain-ICAP-port: 1344
Secure-ICAP-enabled: no
Secure-ICAP-port: none
Ssl-device-profile: none
Max-conn: 25
Timeout(secs): 70
Defer-threshold: 80%
Notification: virus-detected
Use ICAP Vendor's virus page: disabled
Event-log: connection-failure
Methods: RESPMOD
Preview-size: 0
Send: nothing
ISTag:
Last-ISTag-change: never

Configure ICAP Feedback and Patience Pages
You can specify what type of feedback is provided to users during an ICAP scan and customize patience pages, as
described in "ImproveUser Experience" on page 237.
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Configure ICAP Feedback for Interactive and Non-Interactive Traffic
To configure ICAP feedback:

1. In the Admin Console, select Administration > ICAP > ICAP Services.

2. In ICAP Feedback, enter or edit the following settings as required. These options apply to both interactive and
non-interactive traffic.
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Setting or
field

Description

Provide
ICAP
feedback
during ICAP
scanning
for
interactive
traffic

and

Provide
ICAP
feedback
during ICAP
scanning
for non-
interactive
traffic

If this option isn't selected, users are not notified that delays in receiving content are due to ICAP
scanning.

When this option is selected, the following fields become available:

n Provide feedback after: Amount of time to wait before notifying client. Range is between 5 and
65535 seconds. If youmake the value too large, users might become impatient andmanually close
the client, believing the connection has stopped responding. Default is 5 seconds.

n Feedback type: One of the following feedback methods:

o Return patience page: (Available for interactive feedback only) The client displays a web
page to the user providing a description of the delay (ICAP scanning). This page is
customizable, as described in "Customize Patience Pages" on the facing page.

Note: When the deferred scanning option is enabled and a
patience page is configured, the browser continues to receive a
patience page until the object is fully received and the outstanding
ICAP actions have completed.

o Trickle object data from start: The client receives 1 byte per second, which should
prevent connection time-outs while the ICAP server performs the scan. If the response
from the ICAP server is clean, the client receives the rest of the object data at the best
connection speed possible. If the scan detects malicious content, the connection is
dropped. This is the more secure method

o Trickle object data at end: The client receives most (99%) of the object data, but the final
bytes are sent at the rate of one per second while the ICAP scanner performs the scan. If
the response from the ICAP server is clean, the client receives the rest of the object data at
the best connection speed possible. If the scan detects malicious content, the connection is
dropped. This is the least secure method, as most of the data has already been delivered to
the client. However, this method provides the best user experience because there most of
the object is already delivered.

Note: When deferred scanning is enabled and the data trickle
options are configured, the object continues to trickle during
deferred scanning. However, due to the trickle buffer requirement,
there may be a delay before the Edge SWG (ProxySG) appliance
begins sending a response.
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Note: These configurations are global. You can define further feedback policy that applies
to specific user and conditional subsets. In the VPM, the object is located in theWeb
Access Layer: Return ICAP Feedback.

Customize Patience Pages
This section describes how to customize text displayed during ICAP scanning. Patience pages are displayed if the
appropriate option is selected, as described in "ImproveUser Experience" on page 237.

To customize HTTP/FTP patience pages:

1. In the Admin Console, select Administration > ICAP > ICAP Services.

2. In ICAP Patience Page, you can edit the FTP and HTTP patience pages. Select an element and edit it as follows:

Patience page
element

Example

FTP Patience Page For content over FTP, the patience text displayed to FTP clients during an ICAP scan can be
modified.

HTTP Patience
Page - Header

Contains HTML tags that define what displays in the dialog title bar.

HTTP Patience
Page - Summary

HTML and text that informs users that a content scan is occurring.

HTTP Patience
Page - Details

Uses data to indicate scanning progress. The information includes the URL currently being
scanned, the number of bytes processed, and the elapsed time of the scan.

HTTP Patience
Page - Help

Displays instructions for users should they experience a problem with the patience page.

Interactivity Notes

n When ICAP scanning is enabled and a patience page is triggered, a uniqueURL is dynamically generated and sent
to the browser to access the patience page. This uniqueURL might contain amodified version of the original URL.
This is expected behavior.

n Patience pages and exceptions can only be triggered by left-clicking a link. If a user right-clicks a link and attempts
to save it, it is not possible to display patience pages. If this action causes a problem, the usermight see browser-
specific errors (for example, an Internet site not found error); however, ICAP policy is still in effect.
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n A patience page is not displayed if a client object request results in an HTTP 302 response and the Edge SWG
(ProxySG) appliance pipelines the object in the Location header. After the appliance receives the client request for
the object, the client enters a waiting state because a server-side retrieval of the object is already in progress. The
wait status of the client request prevents the patience page fromdisplaying. To prevent the appliance from
pipelining these requests (which decreases performance) and to retain the ability to provide a patience page,
configure HTTP as follows:

# (config) http no pipeline client redirects

n The status bar update does not work if it is disabled or if the JavaScript does not have sufficient rights to update
it.

n Looping: Certain conditions cause browsers to re-spawn patience pages. For example, a site states it will begin a
download in 10 seconds, initiates a pop-up download window, and returns to the root window. If the download
window allows pop-ups, the patience page displays in a separatewindow. The automatic return to the root
window initiates the download sequence again, spawning another patience page. If unnoticed, this loop could
cause a systemhang. The same behavior occurs if the user clicks the back button to return to the root window.
For known and used download sites, you can create policy that redirects the page so that it doesn’t return to the
root window after a download starts.
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Configure SSL and Device Authentication
Refer to the following to configure SSL and device authentication:

n "Manage SSL Keyrings and Keylists" on page 264

Configure keyrings and associate themwith self-signed certificates or create certificate signing requests (CSRs) to
import certificates signed by a certificate authority (CA).

n "Manage CA Certificates" on page 276

Import a server certificate or certificate chain to associate with a keyring. Create CA Certificate Lists (CCLs) and
manage the CA certificates in CCLs. Manage the appliance's cache of unrecognized intermediate CA certificates or
disable intermediate certificate caching.

n "Manage External Certificates" on page 283

Import external certificates to the Edge SWG (ProxySG) appliance. External certificates are certificates for which
Symantec does not have the private key.

n "About SSL Device Profiles" on page 285

The appliance's default SSL device profile can't bemodified. You canmanage additional device profiles with
different settings: specify the SSL versions to use, and associate the keyrings, CA certificate list (CCL), and ciphers.

n "Manage SSL Traffic" on page 288

The appliance's SSL client profile includes default SSL versions and a CCL. The SSL versions that are available
depend on your SGOS version. If your environment requires it, you can change the protocol and CCL selections,
and also specify a keyring.

n "About Certificate Revocation Lists" on page 293

Import Certificate Revocation Lists (CRLs) to check server and client certificates against CA lists of expired and
invalid certificates.

n "Check Certificate Revocation Status in Real Time" on page 297

Online Certificate Status Protocol (OCSP) is used to obtain the revocation status of an X.509 digital certificate. Add
existing OCSP responders to perform real-time certificate revocation checks and send responses to the appliance.
Based on the certificate status in theOCSP response, the appliance denies or allows access to secure content.

n "Integratewith an HSM Appliance" on page 310

Add a configured Thales LunaNetwork Hardware Security Module (HSM) to store cryptographic keys and
certificates. Import theHSM keyring or keygroup to create trust between theHSM and the Edge SWG (ProxySG)
appliance.
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Note: Youmust install the Symantec HSM Agent to allow the LunaHSM to
interoperatewith the Edge SWG (ProxySG) appliance.

n "Offload SSL Traffic to an SSL Visibility Appliance" on page 317

Offload processing of SSL/TLS traffic to a configured SSLV device. Manage allowed SSLV devices. Specify an SSL
device profile for authenticating the connection between the Edge SWG (ProxySG) appliance and SSLV.
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PKI Concepts
X.509 certificates are a cryptographic standard for PKI that specifies standard formats for public key certificates. Several
RFCs and books exist on the public-key cryptographic system. This discussion of the elements of public-key
cryptography system is relevant to their implementation in SGOS. Symantec uses certificates for various applications,
including:

n authenticating the identity of a server

n authenticating the Edge SWG (ProxySG) appliance

n securing an intranet

n encrypting data

The following sections describe the concepts of PKI youmust understand in order to use certificate authentication on
the Edge SWG (ProxySG) appliance. The concepts included are the following:

Public Keys and Private Keys
In public-key cryptography systems, the intended recipient of encrypted data generates a private/public keypair, and
publishes the public key, keeping the private key secret. The sender encrypts the data with the recipient's public key, and
sends the encrypted data to the recipient. The recipient uses the corresponding private key to decrypt the data.

For two-way encrypted communication, the endpoints can exchange public keys, or one endpoint can choose a
symmetric encryption key, encrypt it with the other endpoint's public key, and send it.

Certificates
Certificates are encrypted files that contain a public/private keypair. They can be used to verify the identity of a server, a
website or to encrypt files. The SGOS software uses:

n SSL certificates

n CA certificates

n External certificates

n Certificate chains

You can also usewildcard certificates during HTTPS termination. Microsoft’s implementation of wildcard certificates is as
described in RFC 2595, allowing an * (asterisk) in the leftmost-element of the server's common nameonly.

For information on wildcards supported by Internet Explorer, refer to article 258858 at theMicrosoft Knowledge Base.
Any SSL certificate can contain a common namewith wildcard characters.
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SSL Certificates
SSL certificates are used to authenticate the identity of a server or a client. A certificate is confirmation of the association
between an identity (expressed as a string of characters) and a public key. If a party can prove they hold the
corresponding private key, you can conclude that the party is who the certificate says it is. The certificate contains other
information, such as what functions the certificate can be used for, and the time rang it is valid.

The association between a public key and a particular client or server is done by generating a certificate signing request
using the server's or client’s public key. A CA verifies the identity of the server or client and generates a signed certificate.
The resulting certificate can then be offered by the server to clients (or from clients to servers) who can recognize the
CA's signature. Such use of certificates issued by CAs has become the primary infrastructure for authentication of
communications over the Internet.

CA Certificates
CA certificates are certificates that belong to certificate authorities. Edge SWG (ProxySG) appliances use CA certificates to
verify certificates presented by a client or a server during secure communication. There can bemultiple levels of CA
certificates, with a client or server certificate being signed by an intermediate CAwhich has a certificate signed by a
parent CA, and so on, ending in a trusted root CA that must be installed on the appliance for the validation to succeed.
Browsers offer a certificate if the server is configured to ask for one and an appropriate certificate is available to the
browser.

The appliance trusts all root CA certificates trusted by browsers. The list is updated periodically to be in sync with the
latest browser versions. You can delete some of these pre-installed certificates if you decide you don't want to trust
them. You can also add your own root and intermediate CA certificates for your own internal certificate authorities.

External Certificates
An external certificate is any X.509 certificate for which the appliance does not have the private key. The certificate can
be used to encrypt data, such as access logs, with a public key so that it can only be decrypted by someonewho has the
corresponding private key. See "Encrypt the Access Log " on page 564 for information about encrypting access logs.

Using Keyrings and SSL Certificates
Keyrings are virtual containers. Each keyring holds a public/private key pair and a customized key length. You can
associate certificates, certificate chains or certificate signing requests with keyrings. In general, SSL certificates involve
three parties:

n The subject of the certificate.

n The CA, which signs the certificate, attesting to the binding between the public key in the certificate and the
subject.

n The relying party, which is the entity that trusts the CA and relies on the certificate to authenticate the subject.

Keyrings and certificates are used in:
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n Encrypting data

n Digitally signing access logs

n Authenticating end users

n Authenticating an appliance

Youmust perform these steps using a secure connection such as HTTPS, SSH, or a serial console:

n Create a keyring. A default keyring is shipped with the system and is used for accessing the Admin Console,
although you can use others. You can also use the default keyring for other purposes. You can create other
keyrings for each SSL service. (See "Configure a Keyring" on page 266.)

Note: You can also import keyrings. For information on importing keyrings, see
"Configure a Keyring" on page 266.

n (Optional) Create CSRs to be sent to CAs. Refer to the SGOS Administration Guide.

n Import X.509 certificates issued by trusted CA authorities for external use and associate themwith the keyring.
(See "Managing SSL Certificates" on page 1283.) Alternatively, create certificates and associate themwith the
keyring. You can also associate a certificate chain with a keyring.

n (Optional, if using SSL certificates fromCAs) Import CRLs so the appliance can verify that certificates are still valid.
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Manage SSL Keyrings and Keylists
The appliance ships with several keyrings already created:

n default: The default keyring contains a certificate and an automatically generated keyring and a self signed
certificate which can be used for accessing the appliance through HTTPS.

n configuration-passwords-key: The configuration-passwords-key keyring contains a keypair but does not contain a
certificate. This keyring is used to encrypt passwords in the show config command and should not be used for
other purposes.

n appliance-key: The appliance-key keyring contains an internally-generated keypair. If the appliance is
authenticated (has obtained a certificate from the Symantec CA appliance-certificate server), that certificate is
associated with this keyring, which is used to authenticate the device.

n passive-attack-protection-only-key: The passive-attack-protection-only-key keyring allows data to be encrypted,
but with no endpoint authentication. Although the traffic cannot be sniffed, it can be intercepted with aman-in-
the-middle attack. The passive-attack-protection-only-key keyring is NOT considered secure; therefore, it should
not be used on production networks.

If an OCS requires a client certificate and no keyring is associated with the Edge SWG (ProxySG) SSL client, the HTTPS
connections fails.

To view the properties of the keyrings, in the Admin Console, select Configuration > SSL > Keyrings and Keylists. In
Keyrings, refer to the following details:

Field or
Setting

Description

Name Unique name of the keyring. If a pre-defined keyring, one of the names listed above.

Referenced Indicates whether the keyring is associated with a client certificate.

Show
Private Key

Indicates whether Allow the key to be viewed and exported is enabled. See "Configure a Keyring" on
page 266 for details.

CSR Indicates whether a certificate signing request was created for the keyring.

Certificate
Expiry

If the keyring is associated with a client certificate, shows an expiry date. If the keyring is not associated with a
client certificate, shows "No certificate".

View Certificate Details

If a keyring is associated with a client certificate, you can select View in the Actions column to see the certificate details
and PEM file data. To associate a client certificate with a keyring, see "Associate a Certificate with the Keyring" on
page 268.
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Group Related Keyrings into a Keylist
To easily reference client certificate keyrings in policy, use keylists to group them together. For example, it is often useful
to group certificates into keylists bundled by:

n all client certificates for a specific web address

n all client certificates for a group of users

n all client certificates for a specific user

All keyrings in the keylist must have the same extractor, but each certificatemust have a unique value for the extractor.
The evaluation of the keylist extractor stringmust be unique across the client certificates in the keylist, otherwise
changes being applied to the keylist will fail with an error.

To view the properties of the keylists, in the Admin Console, select Configuration > SSL > Keyrings and Keylists. In
Keylists, refer to the following details:

Field or
Setting

Description

Name Unique name of the keylist.

Keyring
Count

Number of keyrings in the keylist.

Extractor
Extractor used for the keyrings in the keylist. For more information, see "Configure a Keylist" on page 271.

All keyrings in the keylist must have the same extractor, but each certificate must have a unique value for the
extractor. The evaluation of the keylist extractor string must be unique across the client certificates in the keylist;
otherwise, changes being applied to the keylist will fail with an error.

To create or edit a keylist, see "Configure a Keylist" on page 271.
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Configure a Keyring

Note: To import keyring data from a file, see "Import Keydata" on page 273.

To configure a keyring:

1. In the Admin Console, select Configuration > SSL > Keyrings & Keylists.

2. In Keyrings, select an existing keyring to edit it, or select Add Keyring > Keyring to add a new keyring.

3. On the Add/Edit Keyring page, specify the following settings:

Setting or field Description

Keyring Name Unique name for the keyring.

Spaces in keyring names are not supported. Including a space can cause unexpected errors while
using the keyrings.

Private Key
Visibility

If Allow the key to be viewed and exported is enabled, the private keys can be viewed and
exported.

Private Key Create a new private key or import an existing one.

To create a new key:

1. Select Generate new.

2. In Private Key Length, specify a key length from 384 to 4096 bits. If needed, determine the
maximum key length allowed for export.

To import and existing key:

1. Select Import.

2. Copy the key and select Paste From Clipboard. The key is pasted into the field as obfuscated
text.

3. (If needed) Select Show in plain text to display the key in plain text.

4. (If applicable) If the private key that is being imported is encrypted with a password, enter the
password in the Private key password field.

Note: The only way to retrieve a keyring's private key from the appliance is
through the CLI.
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See Also:

n "Associate a Certificate with the Keyring" on the next page

n "Import Keydata" on page 273
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Associate a Certificate with the Keyring
You can associate a client certificate with the keyring using the followingmethods:

n Create a self-signed certificate on the appliance. See "Create a Self-Signed Certificate" below.

n Obtain a CA-signed certificate by creating a CSR. See "Obtain a CA-Signed Certificate" below.

Create a Self-Signed Certificate
The appliance ships with a self-signed certificate, which is associated with the default keyring. Only one certificate can be
associated with a keyring. If you havemultiple uses, use a different keyring and associated certificate for each one. Self-
signed certificates are generally meant for intranet use, not Internet.

1. In the Admin Console, select Configuration > SSL > Keyrings & Keylists.

2. Select an existing keyring or select Add Keyring to add a new keyring.

3. On the Add New/Edit Keyring page, in Certificate, do one of the following:

n Select Create. In the Create Certificate dialog, enter all applicable information. See "Certificate Fields" on
the facing page.

n Select Paste from Clipboard and paste the certificate you created off-box.

After you create the certificate:

n In Keyrings (select Configuration > SSL > Keyrings & Keylists), theCertificate Expiry column shows
an expiration date and theActions column has aView icon.

n You can copy the certificate from the Certificate field by selecting Copy to clipboard.

The certificate consists of data between -----BEGIN CERTIFICATE----- and -----END CERTIFICATE-----
statements.

Obtain a CA-Signed Certificate
CSRs are used to obtain a certificate signed by a CA. You can create CSRs off-box. If you have already done so, be ready
to copy the CSR while performing the following steps.

To create a CSR:

1. In the Admin Console, select Configuration > SSL > Keyrings & Keylists.

2. Select an existing keyring or select Add Keyring to add a new keyring.
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3. On the Add New/Edit Keyring page, in Certificate Signing Request, do one of the following:

n Select Create. In the Create Certificate Signing Request dialog, enter all applicable information. See
"Certificate Fields" below.

n Select Paste from Clipboard and paste the CSR you created off-box.

After you create the CSR:

n Youmust submit it to a CA in the format the CA requires. You can copy the CSR from the Certificate Signing
Request field by selecting Copy to clipboard.

The CSR consists of data between -----BEGIN CERTIFICATE REQUEST----- and -----END CERTIFICATE
REQUEST----- statements.

n In Keyrings (select Configuration > SSL > Keyrings & Keylists), theCSR column indicates that a CSR
exists for the keyring.

Certificate Fields
Most field limits are counted in terms of bytes rather than characters. The number of non-ASCII characters a field can
accommodatewill be less than the size limit because non-ASCII characters can occupy more than one byte, depending on
the encoding. The only exception is the Challenge field, which is counted in terms of characters.

Field Description

State/Province State or province where the appliance is located.

Country Code Two-character ISO code of the country.

City/Locality City or locality where the appliance is located.

Organization Organization name.

Unit Name of the group that is managing the appliance.

Common
Name

Name containing an URL with client access to the specific OCS.

Challenge A 4-20 character alphanumeric challenge.

E-mail E-mail address for the organization.

Company Company name.

Digest Type Signing hash used to create the certificate; default is SHA256.

Subject
Alternative
Name

(Added in version 7.3.8.1) An additional host name that can be DNS, IP or email address. Type names are
case-sensitive. In the CLI, you can additionally specify URI type.

The meaning and usage of each value is defined in RFC5280.
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Field Description

Basic
Constraints

(Added in version 7.3.8.1) A multi-valued extension that indicates whether a certificate is a CA certificate. The
first value is CA followed by TRUE or FALSE separated by a colon. If CA is TRUE, you can optionally specify a
pathlen followed by a value.

The meaning and usage of each value is defined in RFC5280.

Key Usage (Added in version 7.3.8.1) A multi-valued extension consisting of a list of names of the permitted key usages.

The meaning and usage of each value is defined in RFC5280.

Extended Key
Usage

(Added in version 7.3.8.) A list of values indicating purposes for which the certificate public key can be used.

The meaning and usage of each value is defined in RFC5280.
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Configure a Keylist

Note: To import keylist data from a file, see "Import Keydata" on page 273.

To configure a keylist:

1. In the Admin Console, select Configuration > SSL > Keyrings and Keylists. In Keylists, select Add Keylist.

2. On the Add/Edit Keylist page, under Properties, specify the following settings:

Setting
or field

Description

Keylist
Name

Unique name for the keylist.

Extractor String that identifies which certificate field attribute value to extract to determine a policy match. Enter the
string in $(field.attribute) format. For example, to extract the value of the CN attribute from the Subject
field of the certificate, you would enter $(subject.CN).

Alternatively, select values from the Field, Attribute, and Group Name drop down lists to build an extractor
string, and click Add to extractor. The new extractor string is appended to any existing text in the Extractor
field. The Group Name drop down list only appears for IssuerAltName and SubjectAltName fields.

The Extractor field can have a maximum of 255 characters. The extractor supports substitutions from all
attributes of Subject, Issuer, SubjectAltName, IssuerAltName, SerialNumber, and ServerName certificate
fields. The default extractor value is $(Subject.CN); many other subject attributes are recognized, among
them OU, O, L, ST, C, and DC. Field indexes can be used in substitutions on a group name or attribute; for
example $(SubjectAltName.DNS.1).

3. Under Selected Keyrings, specify the following settings:

Setting
or field

Description

Default
Keyring

(Applicable to SNI in reverse proxy mode) Select an option for Default keyring to ensure that a keyring is
used if the client has not implemented SNI or sends incompatible SNI information.

Note: You can't remove the default keyring from a keylist. Select a different
keyring as default or disable Default Keyring before attempting to remove the
keyring from the keylist.
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Setting
or field

Description

Keyrings
selection

On the list of available keyrings, select keyrings to add to the list. To remove keyrings, clear the selection.

Use the Show Selected Only toggle to show only the keyrings in the keylist or all keyrings.

If errors occur while saving the keylist, possible causesmight be:

n The included keyring does not contain the specified extractor pattern or substitution variable.

n Multiple keyrings have the same value for the specified extractor. The extracted value in the keyring allows the
policy action object to find the appropriate keyring certificate to use. Only one keyring can be utilized by each
policy transaction; thus, the extractor string evaluationmust be unique across the certificates in the keylist. A
keyring whose extractor valuematches the extractor value of any existing keyring in the keylist will not be added
to the keylist. For example, if the extractor $(Subject.DC) is selected, and all keyrings have the same value in the
certificate for that extractor, the policy would not be able to determinewhich keyring to select.

See Also

n "Configure a Keyring" on page 266

n "Associate a Certificate with the Keyring" on page 268

n "Import Keydata" on the facing page
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Import Keydata
You can import keyrings and keylists from a file on a server that the appliance can access. A keydata file can consist of
keyrings, keylists, or both. Make sure that the file is correctly formatted; see "Create a Keydata File" below.

Note: If you are importing a keyring and one ormore certificates onto an appliance, first
import the keyring, followed by the related certificates. The certificates contain the public
key from the keyring, and the keyring and certificates are related.

To import a keyring or keylist:

1. In the Admin Console, select Configuration > SSL > Keyrings and Keylists. In Keyrings or Keylists, select
Import.

2. Specify the following on the Import Keyrings, Keylists dialog:

n URL: Enter the URL for the file that contains the keyrings/keylists information.

n Passphrase: (If applicable) If the keypair that is being imported has been encrypted with a passphrase,
enter it.

3. Select Import to import the data.

Create a Keydata File
Bundlemultiple keyrings and keylists into a single keydata file for simple importing into the Edge SWG (ProxySG)
appliance. The keydata file does not need to include both keyring and keylist information.

Note: All keyrings or keylists being importedmust have the same passphrase for the
import to be successful.

To create a keydata file:

1. Open a new text file.

2. Add keyring information to the keydata file in the following format:

#keyring: <keyring_id>
#visibility: {show | show-director | no-show}
<Private_Key>
<Certificate>
<CSR>
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where:

n keyring_id: Name of the keyring.

n visibility: How the keyring is displayed in the show configuration output. Options include:

o show: Private keys associated with keyrings created with this attribute can be displayed in the CLI or
included as part of a profile or overlay pushed by Director.

o show-director: Private keys associated with keyrings created with this attribute are part of the
show configuration output if the CLI connection is secure (SSH/RSA) and the command is issued
fromDirector.

o no-show: Private keys associated with keyrings created with this attribute are not displayed in the
show configuration output and cannot be part of a Director profile. The no-show option is provided
as additional security for environments where the keys will never be used outside of the particular
Edge SWG (ProxySG).

n Private_Key, Certificate, and CSR—Paste the contents of the key, certificate or CSR into the text file,
including the ---Begin and ---End tags.

In the following example, the private key and certificate has been truncated.

#keyring:Keyring1
#visibility:no-show
-----BEGIN RSA PRIVATE KEY-----
MIIEpAIBAAKCAQE...KvBgDmSIw6dTXxAT/mMUHGRd7cRew==
-----END RSA PRIVATE KEY-----
-----BEGIN CERTIFICATE-----
MIIDdjCCAl4CCQC...TjUwxwboMEyL60z/tixM=
-----END CERTIFICATE-----
#keyring:Keyring2

3. Add keylist information to the file in the following format:

#keylist: <keylist_name>
#extractor: <extractor>
<keyring_id>
<keyring_id>
...

where:

n keylist_name: Name of the keylist.

n extractor: String that identifies which certificate field attribute value to extract to determine a policy
match, using the $(field.attribute) syntax. Substitutions from all attributes of Subject, Issuer,
SubjectAltName, IssuerAltName, and SerialNumber certificate fields are supported.
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n keyring_id: Keyrings to include in the keylist. The keyringsmay be included in the keydata file, ormay be
keyrings that already exist on the Edge SWG (ProxySG) appliance.

See the example:

#keylist:mylist
#extractor: $(Subject.CN)
Keyring1
Keyring2

4. Save the file as .txt on aweb server that the Edge SWG (ProxySG) appliance can access.
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Manage CA Certificates
The appliance is pre-installed with browser-trusted root CA certificates; the list is updated periodically to be in sync with
the latest browser versions.

You can also import non-standard third-party CA certificates into the appliance CA certificate store, including root and
intermediate CA certificates. CA certificates added to the CA certificate store are available for use by the CA certificate
lists (CCL) for validating the security of connections.

View Installed CA Certificates
To view a CA certificate, select View Certificate.

To search for specific certificate(s), enter text in theName field filter.

Use the options at the bottomof the section to search formore certificates:

n Certificates per page: Select a number to decrease or increase the number of certificates displayed per page.

n Back and forward arrows: Use the arrows to go back or forward one page, or to go to the first or last page of
certificates.

Import a CA Certificate
Before proceeding, copy the file contents of the certificate to import to clipboard.

To import a CA certificate:

1. In the Admin Console, select theConfiguration > SSL > CA Certificates.

2. In Certificates, select Import.

3. In the Import CA Certificate dialog, enter a unique name for the certificate. Do not include spaces in the name.

4. Select Paste from Clipboard. Certificate contents should appear in the dialog.

5. Select OK to save changes.

About CA Certificate Lists
A CA certificate list (CCL), which contains some of the CA certificates available on the appliance, allows the administrator
to control the set of CA certificates trusted for a particular set of SSL connections. A CCL contains a subset of the
available CA certificates on the appliance, and restricts trust to those certificates. The CCL referenced by the profile or
service configuration is used when an SSL connection is established to that service or using that profile. Three CCLs are
created by default on the appliance:
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n appliance-ccl: This CCL is used for authenticating connections among devicesmanufactured by Symantec. By
default it contains the Symantec ABRCA root certificate (ABRCA_root). This list is used by default in the bluecoat-
appliance-certificate SSL device profile. This CCL can be edited but not deleted.

n browser-trusted: This CCL includesmost of thewell-known CAs trusted by common browsers. This CCL can be
edited but not deleted. You canmanually add CAs to this list. In addition, the appliance automatically retrieves an
updated browser-trusted CCL from Symantec every seven days. The browser-trusted CCL is used by default
during certificate verification by the SSL client and by the default SSL device profile.

n image-validation: This CCL is used to validate signed SGOS images.

You can customize the CCLs available on the appliance to ensure that the appliance has the CA certificates it needs to
handle HTTPS requests. You can create your own CA certificate lists ormodify the default CCLs by adding or removing
trusted CAs.

See Also:

n "Manage CA Certificate Lists" on page 279

Manage the Certificate Cache
The appliance automatically stores unrecognized intermediate CA certificates that are included with validated CA
certificate chains whenever an SSL connection is established. These intermediate CA certificates are stored within a
separate cache on the appliance and are used to validate SSL connections when an incomplete certificate chain is
encountered. For security purposes, OCSP and CRL validation checks are performed to confirm the safety of the
certificate chain. As an additional layer of security, the intermediate CA certificates in the chainmust end with a trusted
root certificate from the CCL (CA certificate list) that is associated with the connection. If a compatible certificate is not
found, the connection is considered insecure and the user will be given a security warning.

Turn off Intermediate Certificate Caching
Turning off caching automatically clears the existing cache of intermediate CA certificates and prevents any validated
intermediate certificates frombeing added to the cache. To turn off intermediate certificate caching:

1. In the Admin Console, select theConfiguration > SSL > CA Certificates.

2. In Cached Intermediate Certificates, select the Enable Caching toggle.

3. On the dialog that appears, select Disable to confirm your choice.

View Cached Intermediate Certificates
You can view information about the CA certificates, which conform to, at aminimum, the standards established within
the PKI ITU-T X.509 standard.

To view the details of a specific cached intermediate certificate:
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1. In the Admin Console, select theConfiguration > SSL > CA Certificates.

2. In Cached Intermediate Certificates, select View Certificate.

The appliance does not allow automatic retrieval of issuing certificates for Intermediate certificates that include an
AIA (Authority Information Access) entry.

n General: Includes top level information about a digital certificate, including theDN (distinguished name)
identifying the owner and issuer, the dates when the certificate is valid, and the public key fingerprints
usingMD5 and SHA-1 cryptographic hash functions.

n Details: Includes certificate field information as defined in the ITU-T X.509 public key certificate standard.

n PEM (Privacy-enhancedmail): Displays the certificate contents in a Base64 encoded format.

Clear Cached Intermediate Certificates
Clearing the CA certificate cache removes all stored intermediate CA certificates.

1. In the Admin Console, select theConfiguration > SSL > CA Certificates.

2. In Cached Intermediate Certificates, select Clear Cache.

3. On the dialog that appears, select Clear to confirm your choice.

Note: The appliance retains the list of cached intermediate CA certificates even after the
appliance is shut down and restarted. The only way to delete the cache is to manually clear
or turn off certificate caching.
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Manage CA Certificate Lists
Because the list of trusted CAs changes over time, youmay want to update your CCLs to ensure that they contain the
most up-to-date list of CA certificates. You canmanually edit the default appliance-ccl and browser-trusted CCLs as well
as any custom-produced CCL. The bluecoat-services and image-validation CCLs are read-only and cannot bemodified;
however, you can still view the contents.

Keep inmind that if you plan to add a CA to a CCL, youmust first import the corresponding CA certificate as described in
"Import a CA Certificate" on page 276.

For the browser-trusted CCL, you also have the option to configure the appliance to download an updated browser-
trusted list of CAs on demand or automatically on a schedule. This smart download compares the existing browser-
trusted list on the appliance to the new list and only adds those CA certificates that are new since the last update. Any
manual changes that you havemade to the file are preserved.

To manage a CCL:

1. In the Admin Console, select theConfiguration > SSL > CA Certificates.

2. In CA Certificate Lists:

n Select Add List to add a CCL.

n Select an existing CCL to edit it.

3. On the Add CA Certificate List page, enter a Certificate List Name.

If you are editing a CCL, the name can't be changed.

4. The Selected Certificates section shows CA certificates that currently belong to the list. For each certificate in the
list, you can select View to display the certificate contents, and Remove to remove the certificate from the list.

5. To manage the certificates to the current list, click Select Certificates. A Select Certificates dialog opens.

6.  On the Select Certificates dialog, mark checkboxes to add certificates and clear checkboxes to remove certificates.

Currently selected certificates are highlighted. Select the Show Selected Only toggle to filter the view to show
only selected certificates.
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Tip: To preserve the current CCL, make sure that the appropriate certificates are
selected. If needed, search for certificates and select them so they appear to be
highlighted. Clearing a selected (highlighted) certificate will remove it from the CCL
when you save changes.

Configure Download of CCL Updates from Symantec
By default, the appliancewill automatically download and install a package containing the updated CA Certificates and
CCL updates—called a trust package—from Symantec every seven days. This trust package contains any updates to the
browser-trusted and image-validation CCLs and their associated CA certificates since the last update, based on the
timestamp at the time the trust packagewas created. Note that any manual changes you havemade to the CCLs and CA
certificates will be preserved.

You can customize the CA download list updates as described in the following sections.

Change the Download Location

The downloadable CA list—called a trust package—is hosted at the following URL:

http://appliance.bluecoat.com/sgos/trust_package.bctp

By default, the appliance is configured to download the trust package directly from this URL. As an alternative you can
set up your own download site on premise. To do this, youmust download the trust package from theURL to your
download server and then configure the download path on the appliances in your network.

After you determine the download location, youmust configure the appliance to point to the location using the
following command:

#(config) security trust-package download-path <URL>

For example, to configure the appliance to download the trust package from a bluecoat folder on your
download.acme.com server, you would enter the following command:

#(config) security trust-package download-path http://downloads.acme.com/bluecoat/trust_package.bctp

Configure Automatic Updates

By default, the appliance automatically downloads and installs the latest trust package every seven days by default. You
can disable automatic updates ormodify the update interval as follows:

To disable automatic updates:

If you prefer to manually download and install the trust package, you can download automatic updates as follows:

#(config) security trust-package auto-update disable

To change the update interval:
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#(config) security trust-package auto-update interval <days>

where <days> is the number of days between updates. This value can be from 1 to 30 inclusive. For example, to set the
auto-update interval to 10 days, you would enter the following command:

#(config) security trust-package auto-update interval 10

If you previously disabled automatic updates, you can re-enable themusing the following command:

#(config) security trust-package auto-update enable

Note: The appliance can only download and install a trust_package.bctp trust package
created by Symantec.

Note that if you previously modified the automatic update interval, your settings will be preserved.

Load the Trust Package

If you want to manually download and install the trust package—either because you have disabled automatic updates or
you want to force an update before the next automatic update—enter the following command:

# load trust-package
Downloading from "http://appliance.bluecoat.com/sgos/trust_package.bctp"
The trust package has been successfully downloaded.
trust package successfully installed

Verify Trust Package Downloads

Use the following command to view the status of the trust package downloads:

# show security trust-package
Download url: http://appliance.bluecoat.com/sgos/trust_package.bctp
Auto-update: enabled Auto-update interval: 7 days
Previous (success) install via manual
Creation time: Saturday October 1 2011 00:26:43 UTC
CA Certificate List changes:
browser-trusted: CAs - 3 added, 4 deleted, 0 modified
image-validation install: Tuesday October 11 2011 00:26:27 UTC
Download log:
Downloaded at: Tuesday October 11 2011 00:26:27 Success
Downloaded from: http://appliance.bluecoat.com/sgos/trust_package.bctp
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Manage External Certificates
External certificates are certificates for which Symantec does not have the private key. To use external certificates,
import the certificates to the appliance.

To import an external certificate ormodify an existing one:

1. Copy the certificate to the clipboard.

2. In the Admin Console, select Configuration > SSL > External Certificates.

3. Under External Certificates, select Import to import a certificate or select an existing one to edit it.

4. (Import only) Enter the name of the external certificate into the External Certificate Name field.

5. Select Paste From Clipboard to paste the contents into the certificate field. The browsermight prompt you to
allow the operation.

Youmust include the -----BEGIN CERTIFICATE----- and -----END CERTIFICATE----- statements. The
certificatemust be in a valid format for you to save it.

6. Select OK.

7. Select Save to save the certificate. The certificate is saved successfully if it is valid. Otherwise, check the format
and try to import or update the certificate again.

To delete an imported external certificate, select Delete beside it in the External Certificates list.

283 of 676



SGOS Administration (Admin Console Edition)

Manage External Certificate Lists
Tomanage external certificate lists (ECLs):

1. In the Admin Console, select Configuration > SSL > External Certificates.

2. In External Certificate Lists:

n Select Add List to add an ECL.

n Select an existing ECL to edit it.

3. (If adding an ECL) On the Add External Certificate List page, enter a unique External Certificate List Name.

If you are editing an ECL, the name can't be changed.

4. The Selected External Certificates section shows external certificates that currently belong to the list. For each
certificate in the list, you can select View to display the certificate contents, and Remove to remove the certificate
from the list.

5. To manage the certificates to the current list, click Select Certificates. A Select External Certificates dialog opens.

6.  On the Select External Certificates dialog, mark checkboxes to add certificates and clear checkboxes to remove
certificates.

Currently selected certificates are highlighted. Select the Show Selected Only toggle to filter the view to show
only selected certificates.

Tip: To preserve the current ECL, make sure that the appropriate certificates are
selected. If needed, search for certificates and select them so they appear to be
highlighted. Clearing a selected (highlighted) certificate will remove it from the ECL
when you save changes.
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About SSL Device Profiles
An SSL device profile contains the following information required for device authentication:

n The name of the keyring that contains the private key and certificate this device uses to authenticate itself. The
default keyring is appliance-key.

n The name of the CA Certificate List (CCL) that contains the names of certificates of CAs trusted by this profile. If
another device offers a valid certificate signed by an authority in this list, the certificate is accepted. The default is
appliance-ccl. For information on CCLs, see "Manage CA Certificate Lists" on page 279.

n Verification of the peer certificate (enabled by default).

When the appliance is participating in device authentication as an SSL client, the peer certificate verification option
controls whether the server certificate is validated against the CCL. If verification is disabled, the CCL is ignored.

When the appliance is participating in device authentication as an SSL server, the peer certificate verification
option controls whether to require a client certificate. If verification is disabled, no client certificate is obtained
during the SSL handshake.

n The format of device ID authorization data extracted from the certificate. The default is $(subject.CN).

n SSL cipher settings. The default is SHA256.

For an overview of these device profile properties, in the Admin Console, select Configuration > SSL > Device
Profiles. In Device Profiles, refer to the details for each installed device profile.

Each Symantec appliance has a built-in profile called bluecoat-appliance-certificate that can be used for device-to-
device authentication. This profile cannot be deleted or edited. If you cannot use the built-in profile (for example, if you
are using your own appliance certificates) youmust create a different profile that references the keyring containing your
certificate.

If you create your own profile, it must contain the same kind of information that is contained in the Symantec profile. To
create your own profile, see "Configure SSL Device Profiles for Device Authentication" on the next page.

Note: If you do not want to use peer verification, you can use the built-in passive-
attack-detection-only profile instead of the bluecoat-appliance-certificate profile.
This profile uses a self-signed certificate and disables the verify-peer option, so that no
authentication is done on the endpoints of the connection. The traffic is encrypted, but is
vulnerable to active attacks. This profile can be used only when there is no threat of an
activeman-in-the-middle attack. Like the bluecoat-appliance certificate profile, the
passive-attack-detection-only profile cannot be edited or deleted.

See Also:

n "Configure SSL Device Profiles for Device Authentication" on the next page
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Configure SSL Device Profiles for Device Authentication
You can use the built-in bluecoat-appliance-certificate profile, which can't be deleted or edited, for device
authentication. If the built-in profile does not meet your needs, you can create a new profile to meet your specific
requirements.

To configure an SSL device profile:

1. In the Admin Console, select theConfiguration > SSL > Device Profiles.

2. In Device Profiles, select an existing (non-read-only) device profile to edit it, or select Add Profile to add a new
device profile.

3. On the Add/Edit Profile page, specify the following settings:

Setting
or field

Description

Device
Profile
Name

Unique name for the device profile. The only valid characters are alphanumeric, the underscore, and hyphen,
and the first character must be a letter.

SSL
Versions

Select SSL/TLS versions for the device profile.

Keyring If the OCS requires a client certificate, select the keyring used to negotiate with the OCS through an
encrypted connection. Only keyrings with certificates can be associated with the SSL client.

Note: Youmust create a new keyring for device authentication if you do not use
the appliance-key keyring. The other keyrings shipped with the appliance are
dedicated to other purposes. For information on creating a new keyring, see
"Configure a Keyring" on page 266.

CCL Select the CA Certificate List (CCL) you want to use so that the appliance knows which CA certificates to use
when validating the trust of any received certificates.

Verify
Peer

When verification enabled, the appliance performs a set of checks to ensure any received certificates are
both trusted (as determined by the CA certificates contained within the specified CCL) and valid (that is, not
expired, hostname matches, etc.). Enable this setting to aid in troubleshooting.

If peer verification is not enabled, theEdge SWG (ProxySG) appliance doesn't actupon any verification failures
it finds when checking the received certificate.
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Setting
or field

Description

Device
ID
Extractor

How device ID information is extracted from a presented certificate.

The string contains references to the attributes of the subject or issuer in the form $(subject.attr[.n]) or
$(issuer.attr[.n]), where attr is the short-form name of the attribute and n is the ordinal instance of that
attribute, counting from 1 when the subject is in LDAP (RFC 2253) order. If n is omitted, it is assumed to be 1.
The default is $(subject.CN); many other subject attributes are recognized, among them OU, O, L, ST, C, and
DC.

Select Cipher Suites
The Selected Ciphers displays cipher suites selected by default when you create the device profile.

To configure the ciphers list, select:

n Select Ciphers to add ciphers to the list. On the Select Ciphers dialog that opens, add ciphers and save your
changes. For improved security, select only ciphers with High strength.

n Remove to remove a cipher from the list.

Formore information on cipher suites supported on the appliance, refer to
https://knowledge.broadcom.com/external/article/170130.

See Also:

n "About SSL Device Profiles" on page 285
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Manage SSL Traffic
You can configure the SSL client and SSL device profiles, which are required for secure connections. These profiles are
configured to group together the collection of settings required for an SSL connection. The include:

n Keyrings

n Certificate authority (CA) certificates

n CA certificate list (CCL)

n Cipher suites

CA certificates, keyrings, CCLs, and cipher suitesmust be configured individually before being added to an SSL client
profile or an SSL device profile.

Note: To select cipher suites, use the CLI. See "Select Cipher Suites for the SSL Client" on
page 291.
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About the SSL Client
The SSL client profile comprises the settings needed to make an SSL connection; this profile can be used by any HTTP or
HTTPS proxy service that needs to make an upstream SSL connection.

Note:  The SSL proxy, also known as the SSL forward proxy, uses parameters taken from
the SSL connectionmade by the client when originating SSL connections to the server. As a
result, settings in the default SSL client profile are not applied to these connections.

To modify any parameters for SSL connections, change the corresponding SSL device-
profile. You will need to modify the SSL client profile settings in the reverse proxy scenario
only. This is because the reverse proxy uses the SSL client, instead of the SSL device profile,
when connecting to the upstreamOCS using HTTPS.

The SSL client is configured with default settings. To change the SSL client options, see "Configure the SSL Client" on the
next page.
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Configure the SSL Client
The SSL client settings are global, affecting all services that use it. Unless required by your environment, you do not need
to change any settings.

To configure the SSL client:

1. In the Admin Console, select theConfiguration > SSL > SSL Client.

2. In SSL Client Settings, specify the following settings:

Setting
or field

Description

Keyring If the server in question requires a client certificate, select the keyring used to negotiate with origin content
servers through an encrypted connection. Only keyrings with certificates can be associated with the SSL client
and are available in the list. By default, no keyring is selected.

SSL
Versions

Select one or more of the following protocols:

n TLSv1.3 (available in versions 7.2.x and later)

n TLSv1.2

n TLSv1.1

n TLSv1

n SSLv3

n SSLv2 (available in versions 6.7.x and 7.1.x, not recommended)

CCL Select the CCL that the appliance uses to determine which CA certificates are trusted during server certificate
validation. By default, the browser-trusted CCL is selected.
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Select Cipher Suites for the SSL Client
The cipher suite sets the encryptionmethod for the appliance. Changing the cipher suite can be done only through the
CLI.

Some cipher suites that Symantec considers to be insufficiently secure are disabled by default for the SSL client. If you
enable insecure cipher suites, you can use the #(config ssl ssl-client default)restore-settings command to
restore the default settings, including the originally disabled ciphers. To identify disabled ciphers, look for no in the Use
column in CLI output, as shown below.

Select cipher suites for the SSL client:

1. Log in to the CLI and enter configurationmode.

2. Select the ciphers you want to use at the prompt.

#(config ssl) edit ssl-client default
#(config ssl ssl-client default) cipher-suite
Cipher# Use Description Strength
------- --- --------------------------- --------
1 yes ECDHE-RSA-AES256-SHA384 High
2 yes ECDHE-RSA-AES128-SHA256 High
3 yes ECDHE-RSA-AES256-GCM-SHA384 High
4 yes ECDHE-RSA-AES128-GCM-SHA256 High
5 yes ECDHE-RSA-AES128-SHA High
6 yes ECDHE-RSA-AES256-SHA High
7 no ECDHE-RSA-RC4-SHA Medium
8 yes AES128-SHA256 High
9 yes AES256-SHA256 High
...
Select cipher numbers to use, separated by commas: 1,3,4
ok

3. (Optional) Verify current settings.

#(config ssl ssl-client default) view
SSL-Client: default
Keyring: <None>
CCL: browser-trusted
Protocol: tlsv1 tlsv1.1 tlsv1.2 tlsv1.3
Cipher suite: ecdhe-rsa-aes256-sha384 ecdhe-rsa-aes256-gcm-sha384 ecdhe-rsa-aes128-gcm-sha256

To change the cipher suite non-interactively, enter the following commands:

#(config) ssl
#(config ssl) edit ssl-client default
#(config ssl ssl-client default) cipher-suite cipher

where cipher is a cipher on the appliance.
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Note: If you do not specify any attributes, the cipher suite cannot be used. Multiple
ciphers can be specified on the command line, separated by blank spaces.

Example
#(config ssl ssl-client default) cipher-suite rc4-sha
ok

#(config ssl ssl-client default) view
SSL-Client: default
Keyring: <None>
CCL: browser-trusted
Protocol: tlsv1 tlsv1.1 tlsv1.2 tlsv1.3
Cipher suite: rc4-sha
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About Certificate Revocation Lists
Use Certificate Revocation Lists (CRLs) to check server and client certificates against lists provided andmaintained by
Certificate Authorities (CAs) that show certificates that are no longer valid. Only CRLs that are issued by a trusted issuer
can be successfully verified by the appliance. The CRL can be imported only when the CRL issuer certificate exists as a CA
certificate on the appliance.

Tip: You can determine if the appliance SSL certificates are valid by checking CRLs that are
created and issued by trusted CAs. If a certificate is on the list, it is no longer valid.

The Edge SWG (ProxySG) appliance allows only one local CRL per CA. You can also import CRLs that are expired or that
will take effect in the future; in these cases, the log displays awarning.

CRLs can be used for the following purposes:

n Checking revocation status of client or server certificates with HTTPS Reverse Proxy.

n Checking revocation status of client or server certificates with SSL proxy. (Formore information on using CRLs
with the SSL proxy, see "Validating the Server Certificate" on page 217.)

n Edge SWG (ProxySG) appliance-originated HTTPS downloads (secure image download, content filter database
download, and the like).

n PEM-encoded CRLs, if cut and pasted through the inline command. Refer to the Command Line Interface
Reference formore information.

n DER-format (binary) CRLs, if downloaded from aURL.

To import a CRL, see "Manage Certificate Revocation Lists" on page 295.

As an alternative to using CRLs, useOCSP. Formore information, see "Check Certificate Revocation Status in Real Time"
on page 297.

Troubleshoot Certificate Problems
Two common certificate problems are discussed below.

n If the client does not trust the CA that signed the appliance’s certificate, an errormessage similar to the following
appears in the event log:

2004-02-13 07:29:28-05:00EST "CFSSL:SSL_accept error:14094416:SSL routines:SSL3_READ_BYTES:sslv3
alert certificate unknown" 0 310000:1 ../cf_ssl.cpp:1398

This commonly occurs when you use theHTTPS-Console service on port 8082, which uses a self-signed certificate
by default. When you access the Admin Console over HTTPS, the browser displays a pop-up that says that the
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security certificate is not trusted and asks if you want to proceed. If you select No instead of proceeding, the
browser sends an unknown CA alert to the appliance.

You can eliminate the errormessage in one of two ways:

o If this was caused by the Symantec self-signed certificate (the certificate associated with the default
keyring), import the certificate as a trusted CA certificate. See "Manage Certificate Revocation Lists" on the
facing page formore information.

o Import a certificate on the appliance for usewith HTTPS-Console that is signed by a CA that the browser
already trusts.

n If the appliance’s certificate is not accepted because of a host namemismatch or it is an invalid certificate, you can
correct the problemby creating a new certificate and editing theHTTPS-Console service to use it. For information
on editing theHTTPS-Console service, see "Configure aManagement Service" on page 172.
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Manage Certificate Revocation Lists
You can import Certificate Revocation Lists (CRLs) to the appliance andmodify existing CRLs.

Note: You can import a CRL only when the CRL issuer certificate exists as a CA certificate
on the appliance. In addition, only one CRL per CA can be imported.

Formore information on CRLs, see "About Certificate Revocation Lists" on page 293.

Manage CRLs:

1. In the Admin Console, select Configuration > SSL > CRL.

2. Do one of the following:

n To add a CRL: Select Add CRL. The Add CRL dialog opens.

n To edit an existing CRL: Select Edit beside a CRL in the list. The Edit CRL dialog opens.

3. Specify aName for the CRL.

4. Use one of the followingmethods to import the CRL; if you are editing the CRL, using Local file orRemote URL
will overwrite the entire contents.

Method Instructions

Text
editor

1. Select Install from Text Editor.

2. In the Load Edit and Install from text editor dialog, enter the contents manually or copy and paste the
contents from another file.

3. Select Install.

Local file 1. Select ... > Local File.

2. In the Load Edit and Install from local file dialog, browse to the directory of the file on the local
system.

3. Select Install.

Remote
URL

1. Select ... > Remote URL.

2. In the Load Edit and Install from remote URL dialog, enter the fully-qualified URL, including the
filename, where the file is located.

3. Select Download.
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5. Select Add to add the CRL.

6. To add or edit more CRLs, repeat the previous steps.
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Check Certificate Revocation Status in Real Time
OCSP (RFC 2560) allows you to obtain the revocation status of an X.509 digital certificate. OCSP provides the same
revocation functionality as the local Certificate Revocation List (CRL) configured on the appliance.

Managing large CRLs poses scalability challenge due to highmemory consumption on the appliance associated with
storing revocation lists. OCSP overcomes these limitations by checking certificate status in real time using off-box OCSP
responders.

How the Appliance Uses OCSP
The appliance can act as an OCSP client and issueOCSP queries to remoteOCSP responders located on the intranet or
the Internet. OCSP configuration and administration is usually performed by the administrator whomanages theweb
access policy for an organization.

The appliance supports OCSP based revocation checks for:

n SSL proxy

n HTTPS reverse proxy

n SSL health checks

n secure image downloads

n secure URL database downloads

n secure heartbeats

OCSP-based revocation checks are performed on client or server certificates by the above applications where suitable. In
this section, these client or server certificates are referred to as subject certificates. The appliance acts as an OCSP client
and sends OCSP queries to an OCSP responder for the given certificate. An OCSP responder is a server for OCSP request
processing and response building functions.

TheOCSP responder sends status of the certificate back to the appliance (OCSP client). Status can be good, revoked or
unknown. Goodmeans that the certificate is not revoked and valid at the time of the query. Revokedmeans that the
certificate has been revoked either permanently or temporarily. Unknownmeans that the responder does not know
about the revocation status of the certificate being requested.

The appliance can also cacheOCSP responses and has the ability to respect, override or ignore the timestamps related to
cacheability in theOCSP response. If the certificate status is valid, the end user (in cases of SSL proxy or HTTPS reverse
proxy) can access the securewebsite. If the status is revoked, an error is flagged and the end user is denied access to the
securewebsite. If status is unknown, the appliance has the ability to treat it as an error or ignore it based on the
administrator’s discretion; see "Configure an OCSP Responder" on page 303 for details.

Review Configured OCSP Responders
To review theOCSP responders configured on the appliance, in the Admin Console, select Configuration > SSL > OCSP.

297 of 676

https://datatracker.ietf.org/doc/html/rfc2560


SGOS Administration (Admin Console Edition)

In theOCSP Responders section, each configured responder shows the following information:

n Name: Name of theOCSP responder.

n Default Responder: When selected, the responder is the default. See "Specify a Default Responder" below
below.

n URL: Location of the responder, either a specific IP address or "from-certificate".

n Issuer CCL: If selected, the CCL used for the responder.

For information on these settings, see "Configure an OCSP Responder" on page 303. As an alternative to OCSP, you can
"Manage Certificate Revocation Lists" on page 295.

To remove a configured responder, select Delete under Actions.

Specify a Default Responder
Whenmore than responder is configured, you can designate one of them as the default.

TheUse Default Responder option is enabled if a responder is selected as the default, as in the following example. (If
no responders are configured on the system yet, theUse Default Responder option is not visible.)

If a subject certificate is not associated with any responder (via the Issuer CCL setting), the request for this certificate is
sent to the default responder.

Note: If the default responder has a URL that is set to From certificate (see "Configure
an OCSP Responder" on page 303), all appliance components which are capable of
performing OCSP checks generateOCSP requests to responders that may be anywhere on
the Internet depending on where the certificate’s AIA extension URL is pointing. Use a
default responder that has its URL set to From certificate with caution.

298 of 676



SGOS Administration (Admin Console Edition)

OCSP Setup Scenarios
This section describes three general OCSP setup scenarios which are based on the relationship between the subject
certificate (the certificate whose revocation status is queried, for example, client or server certificate) and the responder
certificate (the certificate that signed theOCSP response).

In the following scenario illustrations, the subject certificate chain comprises certificates shown on the left and the
responder certificate chain comprises certificates shown on the right.

Scenario A

TheOCSP response is signed by a root CA that also issued the subject certificate.

Scenario B

TheOCSP response is signed by a delegated certificate and both the responder certificate and the subject certificate are
issued by the same root CA. The root CA in this scenario delegates the job of the signing OCSP responses to theOCSP
responder by adding theOCSP signing purpose to the extendedKeyUsage extension of the responder's certificate (see
section 4.2.2.2 of RFC 2560).
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This denotes that the certificate has been delegated for the purpose of signing OCSP responses by the root CA
certificate.

Scenario C

TheOCSP response is signed by a certificate having no common issuer with the subject certificate. Thus, the root CA
certificates signing the subject certificate and OCSP response are different. This only works if the responder certificate’s
root CA is trusted by the administrator for theOCSP signing. The administrator can denote this trust by adding theOCSP
Signing trust setting in the Trusted Uses section of the root CA. OpenSSL provides a command line tool to add this trust
setting to a traditional root CA certificate.

Here is an example of how to create a root CA trusted for OCSP signing from an existing root:

openssl x509 -in <root CA file> -addtrust OCSPSigning -out
<trusted root CA>

A trusted certificate is an ordinary certificate that has several additional pieces of information attached to it. Information
can include the permitted and prohibited uses of the certificate and an alias. Trust settings are a non-standard way to
override the purposes present in the keyUsage or extendedKeyUsage extensions of a certificate.

By default, a trusted certificatemust be stored locally andmust be a root CA. Trust settings currently are only used with
a root CA. They allow finer control over the purposes for which the root CA can be used for. For example, a CAmay be
trusted for an SSL client but not SSL server use. Other trust values that are supported by OpenSSL include:

n clientAuth (SSL client use)

n serverAuth (SSL server use)

n emailProtection (S/MIME email)

Notes

The keyword TRUSTED is denoted in the certificate header and footer:
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-----BEGIN TRUSTED CERTIFICATE-----
-----END TRUSTED CERTIFICATE-----

The Ignore OCSP Signing Purpose Check option (see "Configure an OCSP Responder" on page 303) lists the errors
that are related to theOCSP signing delegation. This applies to Scenarios B and C only.

Reverse Proxy Scenario
The following diagram shows how the appliance uses OCSP in a typical HTTPS reverse proxy scenario.

Data Flow

1. The user accesses a securewebsite that is fronted by an Edge SWG (ProxySG) appliance.

2. The appliance requests a client certificate from the browser.

3. The browser sends a client certificate, based on the user’s choice, to the appliance.

4. The appliance sends an OCSP query for the revocation status of the client certificate to the responder.

5. The responder returns the revocation status in an OCSP response.

6. The status in the response determines the next step:

a. If the status is good, the request is allowed and the content is displayed.

b. If the status is revoked, the user is denied access to the content.
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SSL Proxy Scenario
In a common SSL proxy scenario, the appliance reads in the server certificate and sends an OCSP request to the
responder to validate the certificate. Then, based on the certificate status in theOCSP response, the appliance denies or
allows user access to content on theOCS.
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Configure an OCSP Responder
To enableOCSP revocation checks, configure a profile for an off-box OCSP responder.

1. In the Admin Console, select Configuration > SSL > OCSP.

2. In theOCSP Responders section:

n To add a responder, select Add Responder.

n To edit an existing responder, select Edit.

3. On the Add/Edit OCSP Responder page, specify the following settings under Properties:

Setting or field Description

Name Enter a descriptive name for the OCSP responder.

URL Location of the OCSP responder. The appliance needs this URL
to locate the responder. This location can be obtained from the
certificate’s Authority Information Access (AIA) extension or
from a user-defined configuration.

n From certificate: (Default) Select to have the appliance
look up the OCSP server location from the subject
certificate’s AIA extension.

n Specific URL: If you know the location of the designated
OCSP responder, enter the specific responder HTTP or
HTTPS URL.
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Setting or field Description

Issuer CCL Select a CA Certificate List (CCL) that contains the CA certificate
names for which this is the designated responder. Each CA may
only appear in one responder’s Issuer CCL. For a given
certificate, this CCL is used to determine which responder to
use when doing an OCSP check.

Determine which responder is contacted for a given client or
server certificate. Typically, each certificate issuer uses a
designated OCSP responder for all the certificates it issues. The
issuer CCL attribute allows the administrator to specify the
certificate authorities (issuers) for which the responder in
question is the designated responder. This means that when a
certificate is signed by one of the CAs in this CCL, the OCSP
query for that certificate will be sent to this responder.

Note: In "OCSP Setup Scenarios" on
page 299, the entire certificate chain shown
on the left (including the root CA certificate)
in each figure (except for the certificate
appearing lowest in the chain) must be part
of the issuer CCL. The certificate chain on the
left represents the subject certificate chain,
that is, certificates on which an OCSP query is
done. OCSP revocation check happens for
each certificate in the chain, including the
root CA. If any CA in that chain is absent from
the issuer CCL this responder will not be
used to query the missing CA's OCSP status.

304 of 676



SGOS Administration (Admin Console Edition)

Setting or field Description

Response CCL Use the selected CCL during verification of OCSP responses.

The default value is browser-trusted.

Note: In "OCSP Setup Scenarios" on
page 299, the entire certificate chain shown
on the right (including the root CA certificate)
in each figure (except for the certificate
appearing lowest in the chain) must be part
of this CCL. The certificate chain on the right
represents all certificates in the signing
hierarchy of the OCSP responder certificate.
If any CA in that chain is absent from this
CCL, then response verification fails and an
untrusted-responder error is stored in the
appliance event log.

For Scenarios A and B, this CCL must contain
the Root CA as depicted in the respective
figures. For Scenario C, the CCL must contain
at least the Root CA. The root CA must be
imported on the appliance using the trusted
certificate format (with OCSP Signing trust
enabled). If OCSP responder does not chain
all intermediate CAs, then this CCL must also
include all those intermediate CAs, otherwise
an untrusted-responder error is stored in the
event log.

Device Profile Use the selected device profilewhen the responder URL is an
HTTPS URL. From the drop-down list, select the device profile
you want to use when connecting to the OCSP server via SSL. All
existing profiles on the appliance appear. The device profile is a
unique set of SSL cipher-suites, protocols, and keyrings. When
the responder URL is HTTPS the appliance makes the HTTPS
connection with this responder using its device profile. If the
URL is HTTP the device profile is not used. The default value for
the device profile attribute is default.
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Setting or field Description

Response Cache TTL This option indicates howmany days an OCSP response is
cached on the appliance. The default is to use TTL from OCSP
response.

n From OCSP response: Select this option to use the value
of nextUpdate timestamp (see section 2.2 of RFC 2560)
in the OCSP response. If this timestamp is not set or is in
the past, the OCSP response is not cached on the
appliance. The appliance permits a clock skew of up to
five minutes with the responder's clock when validating
the nextUpdate timestamp.

n Specific TTL: Enter the length of time (in days) you want
the OCSP response to be cached regardless of
nextUpdate timestamp in the OCSP response. If TTL is
set to 0, the response is not cached.

Enable Forwarding Enable to send OCSP requests through a forwarding host, if
configured. The default is to have forwarding enabled. Based on
whether the responder URL is HTTP or HTTPS the usual
forwarding rules apply.

4. Under Extensions, specify the following settings:

Setting or field Description

Enable Nonce Enable to avoid replay attacks. A nonce is a random sequence
of 20 bytes places in an OCSP response.

Request Signing Keyring Use the selected keyring when an OCSP request is required to
be signed.

In this case, the appliance includes the certificate chain (minus
the root CA) that is associated with this keyring to help the
OCSP responder verify the signature. When a valid keyring is
selected, OCSP request signing is enabled. When no keyring is
selected, no request signing occurs.

5. Under Ignore Settings, specify the following settings:
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Setting or field Description

Ignore Request Failures Ignore the following connection errors:

n Responder’s URL is set to from-certificate and the URL in
the certificate’s AIA extension is neither HTTP or HTTPS,
or is not a valid URL.

n TCP layer fails to connect with the responder.

n Responder URL is HTTPS and the initial SSL connection
fails with the responder.

n TCP connection times out while reading the response
from the responder.

n TCP connection fails for any reason not already listed.

n Responder URL is HTTPS and a hostname mismatch
error occurs on the responder’s certificate.

n Responder URL is HTTPS and an error occurs while
analyzing the response. Any other error not caught is
covered by the following ignore settings.

n OCSP responder returns an error message that is
described in section 2.3 of RFC 2560. For instance, when
an OCSP query is sent to a responder that is not
authorized to return an OCSP status for that certificate,
the responder returns and unauthorized error, that
appears as Responder error (unauthorized) in event-log
of the appliance. Enabling this setting causes this error
to be ignored as well as other errors described in the
RFC.

n OCSP responder returns a response that is not a basic
OCSP response (see section 4.2.1 of RFC 2560).

Ignore Expired Responder Certificate Ignore invalid dates in the responder certificate. By default,
invalid responder certificate dates cause the subject certificate
verification to fail.

Ignore Untrusted Responder Certificate Ignore the response validation error that occurs when the
responder's certificate cannot be trusted. By default, any
untrusted certificate failure is an error and causes subject
certificate verification to fail.
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Setting or field Description

Ignore OCSP Signing Purpose Check Ignore the response validation error that occurs when the
responder's certificate cannot be trusted. By default, any
untrusted certificate failure is an error and causes subject
certificate verification to fail.

Ignore Unknown Revocation Status Ignore unknown revocation status as an error. By default,
unknown status is an error and causes subject certificate
verification to fail.
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OCSP Policy
The following policy properties extended for revocation check under the SSL layer:

<ssl>
server.certificate.validate.check_revocation(auto|local|ocsp|no)
<ssl>
client.certificate.validate.check_revocation(auto|local|ocsp|no)

For detailed information about CPL policy configuration and revocation check, refer to the Content Policy Language
Reference.

OCSP Listed Exceptions
When a certificate state is revoked, the following predefined exceptions are sentdepending on which certificate is
revoked:

n ssl_client_cert_revoked

n ssl_server_cert_revoked

When a certificate status is unknown and the responder is configured to not ignore it, the following predefined
exceptions are sent depending on which certificate is revoked:

n ssl_client_cert_unknown

n ssl_server_cert_unknown

For detailed information about defining exceptions, refer to theWeb Visual Policy Manager Reference.
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Integrate with an HSM Appliance
AHardware Security Module (HSM) provides additional security for storing cryptographic keys and certificates, which is
required in some highly regulated industries. The appliance is able to use a network-attached HSM appliance to store
resigning CA keys, and to perform digital signature operations. The appliance exchanges signing requests and responses
with the attached HSM appliance, overmutually authenticated HTTPS requests. The appliance sends certificate data to
theHSM.

The appliance can work withmultiple HSM appliances, andmultiple appliances can work with the sameHSM. In the
event that a policy rule using an HSM to sign cannot work due to lack of response from theHSM, the attempt is logged,
and the appliance responds with an exception. In addition to the resigning certificates, amutually authenticated
connection (communication pipeline) must be set up by verified certificates.

Configure a Thales Luna HSM
The Thales HSMmust be configured separately. Additionally, Symantec provides an agent to install on the Thales Luna
HSM, which will be used to interact with Symantec appliances. A certificate to authorize the agent is included. The
Symantec HSM Agent operates on top of a secure session. It communicates to the external Symantec entity (Edge SWG
(ProxySG) appliance), and is used remotely.

In order for the appliance to trust theHSM, youmust import the server certificate for theHSM, and put it in to a CA
Certificate List. In the Admin Console, select Configuration > SSL > CA Certificates, and import the certificate. Name
the certificate and paste the .PEM data in to the appropriate field. For further information, see "Manage CA Certificates"
on page 276.

An HSM requires a linked device profile (in the Admin Console, select SSL > Device Profiles). See "ManageHSMs" on
page 313.
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See Also:

n Symantec HSM Agent for the Thales Luna 7 HSM documentation at Tech Docs

View Added HSMs
TheHSM section (Configuration >SSL > HSM) lists all added HSMs and displays information about each one:

Setting or field Description

Name Name of the HSM.

Referenced Whether or not the HSM is referenced in Edge SWG (ProxySG) policy.

Hostname/IP Address Configured hostname or IP address of the HSM.

Port Configured port of the HSM.

Device Profile Linked device profile.

See Also:

n "ManageHSMs" on page 313

View Added HSM Keyrings
TheHSM Keyrings section (Configuration >SSL > HSM) lists all added HSM keyrings and displays information about
each one:

Setting or field Description

Name Name of the HSM keyring.

Referenced Whether or not the keyring is referenced in Edge SWG (ProxySG) policy.

HSM Name of the HSM.

Key Label Name of the private key in HSM configuration.

Certificate Expiry HSM certificate expiration date.

View Certificate (under
Actions)

View certificate details and PEM file data. On the Certificate dialog, select PEM to copy the
certificate.

See Also:

n "ManageHSM Keyrings" on page 314
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View Added HSM Keylists
TheHSM Keylists section (Configuration >SSL > HSM) lists all added HSM keylists and displays information about each
one:

Setting or field Description

Name Name of the HSM keylist.

Referenced Whether or not the keylist is referenced in Edge SWG (ProxySG) policy.

HSM Keyring Count Number of HSM keyrings in the list.

See Also:

n "ManageHSM Keylists" on page 315
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Manage HSMs

Note: A supported HSMmust be configured separately. To configure a Thales LunaHSM,
refer to HSM documentation at Tech Docs.

To add or edit an HSM:

1. In the Admin Console, select Configuration > SSL > HSM.

In theHSM section, select Add HSM to add an HSM or select an existing HSM to edit it.

2. On the Add/Edit HSM page, specify the following settings:

Setting or
field

Description

Name Unique name for the HSM.

Hostname
or
IP address

Hostname or IP address of the HSM.

Port Port of the HSM.

Device
Profile

Select a device profile.

To have an appropriate device profile in the list, in the Admin Console, select SSL > Device Profiles.
Create a FIPS-compliant or non-compliant profile as required, and then enter the HSM credentials. For
more information, see "Configure SSL Device Profiles for Device Authentication" on page 286.
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Manage HSM Keyrings
TheHSM keyring is used for certificate emulation when intercepting SSL with theHSM. The keyringmust contain a
certificate for which theHSM has the private key.

Adding an HSM keyring follows the same steps as adding any SSL keyring. Configured HSM keyrings are also available in
Configuration > Services > SSL Proxy Settings > General Settings.

Tip: Before creating the keyring, make sure that you can access theHSM's certificate file.
You will copy and paste it in the keyring configuration.

Note: You can't edit or remove a keyring if it is referenced in policy. Remove the
references in policy before attempting to make changes to existing keyrings. See
"Configure HSM Policy" on page 316 for details.

To add or edit an HSM keyring:

1. In the Admin Console, select Configuration > SSL > HSM.

In theHSM Keyings section, select Add HSM Keyring to add a keyring or select an existing keyring to edit it.

2. On the Add/Edit HSM Keyring page, specify the following settings:

Setting or field Description

Name Unique name for the HSM keyring.

HSM Select an HSM from the list.

Key label Name associated with the private key created on the HSM.

3. To enter or update the certificate, copy the contents of the PEM file including -----BEGIN CERTIFICATE----- and
-----END CERTIFICATE-----.

 Then, in the Certificate section, select Paste From Clipboard.

See Also:

n "Configure HSM Policy" on page 316
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Manage HSM Keylists
Keylists, rather than individual keyrings, can be referenced in policy. When a keylist is used, the SSL connections are load
balanced, either within oneHSM or across an HSM cluster.

Adding an HSM keylist follows the same steps as adding any SSL keylist. Configured HSM keylists are also available in
Configuration > Services > SSL Proxy Settings > General Settings.

To add or edit an HSM keylist:

1. In the Admin Console, select Configuration > SSL > HSM.

In theHSM Keylists section, select Add HSM Keylist to add a keylist or select an existing keylist to edit it.

2. On the Add/Edit HSM Keylist page, in the Properties section, specify the name of the keylist.

3. In the Select HSM Keyrings section, select Select HSM Keyrings to add or remove configured keyrings. The
Select HSM Keyrings dialog opens.

The Select HSM Keyrings option does not appear if no keyrings are configured yet.

4. On the Select HSM Keyrings dialog:

n Select keyrings to add them to the keylist.

n Clear keyring selections to remove them from the list.

If Show Selected only is enabled, only keyrings that have been added to the keylist are displayed. If Show
Selected only is disabled, all keyrings available are displayed.

See Also:

n "Configure HSM Policy" on the next page
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Configure HSM Policy
Use policy to direct the SSL proxy to use an HSM keyring or keylist to sign an emulated certificate from an intercepted
authenticated SSL connection. The following procedure uses theWeb Visual Policy Manager (VPM):

1. Launch theWeb VPM.

2. In theWeb VPM, select Add Layer. In the dialog, select SSL Intercept.

3. In the layer you added, add a new Action object:

a. Under action, select New > Enable SSL Interception.

b. The Issuer Keyring list displays configured HSM keyrings and keylists. Select the keyring or keylist to use
for HSM signatures.

c. Apply your changes.

4. Select Apply Policy to install the HSM policy.
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Offload SSL Traffic to an SSL Visibility Appliance
You can connect one ormore Edge SWG (ProxySG) appliances to the SSL Visibility (SSLV) appliance to offload SSL/TLS
traffic processing.

To use SSLV offload, you require the following:

n SSLV 4.0.1

n SSLV serial number(s)

n Edge SWG (ProxySG) appliance serial number(s)

n If using the Edge SWG (ProxySG) command line interface (CLI), the enable password

Configuring SSLV offload requires that you identify the Edge SWG (ProxySG) and SSLV appliances to each other using
their respective serial numbers. In addition to the completing the following steps on the Edge SWG (ProxySG) appliance,
youmust add the Edge SWG (ProxySG) appliance’s serial number to the SSLV appliance(s).

See Also:

n "Configure SSLV Offload" on the next page

n SSL Visibility Appliance Administration and Deployment
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Configure SSLV Offload
Configure SSLV offload settings.

1. In the Admin Console, select Configuration > SSL > SSLV Offload.

2. In the SSLV Offload Settings section, select the Enable SSLV Offload toggle to enable or disable SSLV offload on
the appliance.

3. (Optional) Select an SSL device profile for authentication. From the SSL Device Profilemenu, select an existing
SSL device profile. By default, bluecoat-appliance-certificate is selected.

4. To manage the list of allowed SSLV devices:

n Add an SSL device. Select Add Device to add an SSLV device. On the Add new SSLV Device dialog, enter the
Device ID (serial number).

n Remove an SSLV device. Under Actions, select Delete to remove an SSLV device from the list.
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Authenticate Administrators and Users
Refer to the following topics to learn about authenticating Edge SWG (ProxySG) administrators and users:

n " Secure Access to the Appliance" on the next page

Manage administrator access to the appliance, including login credentials and serial console access. Create an
access control list (ACL) to control who can access the Admin Console and CLI.

n "Control User Access with Identity-based Access Controls" on page 331

Configure certificate, IWA-BCAAA, IWA-Direct, LDAP, RADIUS, and SAML authentication realms. Configure
Windows Domains to integratewith the appliance.

n "Manage the SSH Console" on page 408

Specify host keys, client keys, ciphers, and HMACs to use for inbound SSH connections. Configure the SSH console
welcome banner.

n "Authenticate Outbound SSH Client Connections" on page 420

Specify known hosts, client keys, ciphers, and HMACs to use for outbound SSH connections.
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Secure Access to the Appliance
You can limit access to the appliance by configuring Admin Console and CLI console account settings. You can also
specify read-only or read-write access to admins as required.

Configure Login Parameters
You can change the console username and password, the console realm namewhich displays when you log in to the
appliance, and the auto-logout time. The default value is 900 seconds. The Admin Console requires a valid administrator
username and password to have full read-write access; you do not need to enter a privileged-mode password as you do
when using the CLI. A privileged-mode password, however, must already be set.

Note: To prevent unauthorized access to the Edge SWG (ProxySG) appliance, only give the
console username and password to thosewho administer the system.

Change Admin Account Credentials

During the initial configuration of your Edge SWG (ProxySG) appliance, a console administrator username and password
was created. This is a special account that can always be used to administer the appliance from either the Admin Console
or the CLI. You can change the username and the password of this administrator account.

Edit the username of the administrator who is authorized to view and revise console properties. Only one console
account exists on the Edge SWG (ProxySG) appliance. If you change the console account username, that username
overwrites the existing console account username. The console account username can be changed to anything that is
not null and contains nomore than 64 characters.

After changing the username and password, you can further restrict access by creating an access control list or by
creating a policy file containing <Admin> layer rules. See "Limit Access to the Appliance" on page 325.

Note: Changing the console account’s username or password causes the Admin Console
to refresh, requiring you to log in again using the new credentials. Each parametermust be
changed and individually refreshed. You cannot change both parameters at the same
time.

To change the username:

1. In the Admin Console, select Configuration > Authentication > Console Access.

2. In the Console Account section, enter a new name in theUsername field.

After you save changes, if you refresh the browser page, the console prompts you to re-enter your credentials.
Enter the new username,
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To change the password:

Note: The console password and privileged-mode password were defined during initial
configuration of the system. The console password can be changed at any time. The
privileged-mode, or enabled-mode, password can only be changed through the CLI or the
serial console.

1. In the Admin Console, select Configuration > Authentication > Console Access.

2. In the Console Account section, select Change Password.

3. In the Change Password dialog, enter the current password. Enter and confirm the new password.

The passwords are obscured by asterisks. You can select the eye icon to display the passwords.

The passwordmust be from 1 to 64 characters long.

After you save changes, the console prompts you to re-enter your credentials. Enter the new password.

Identify the ProxySG Appliance on the Browser Challenge

Note: This feature is supported only when accessing theManagement Console directly in
Internet Explorer (not the Launcher using a JNLP file).

You can configure the browser challenge to display a string that identifies the Edge SWG (ProxySG) appliance that you
are accessing. This feature is useful you havemultiple ProxySG appliances in your network.

When you log in to theManagement Console, the browser displays a login dialog. By default, this dialog shows the IP
address of the Edge SWG (ProxySG) appliance that is requesting the username and password. You can configure the
dialog to display a descriptive name for the appliance in addition to the IP address.

To specify a display name on the browser challenge:

1. In the Admin Console, select Configuration > Authentication > Console Access.

2. In the Console Account section, enter a description or name in theConsole realm name field.

The next time that you log in to theManagement Console, the browser challenge displays the description that you
entered.

Change the Edge SWG (ProxySG) Appliance Timeout

The timeout is the length of time an Admin Console or CLI session persists before you are logged out. The default
timeout for these options is as follows:
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n EnforceWeb auto-logout—15 minutes

n Enforce CLI auto-logout—5 minutes

To change the timeout:

1. In the Admin Console, select Configuration > Authentication > Console Access.

2. In the Console Account section:

n To enable an Admin Console timeout, switch the Enforce Web auto-logout toggle and specify the
number of minutes in theWeb auto-logout (minutes) field.

n To enable a CLI timeout, switch the Enforce CLI auto-logout toggle and specify the number of minutes in
theCLI auto-logout (minutes) field.

Control Access to the Appliance
n Restricting physical access to the system and by requiring a PIN to access the front panel.

n Restricting the IP addresses that are permitted to connect to the Edge SWG (ProxySG) CLI.

n Requiring a password to secure the setup console.

Formore information, see "Limit Access to the Appliance" on page 325.

Refer to the following to determine how to give other users read-only or read-write access to the Edge SWG (ProxySG)
appliance.

Note: If Telnet Console access is configured, Telnet can be used to manage the appliance
with behavior similar to SSH with password authentication. SSL configuration is not
allowed through Telnet, but is permissible through SSH. Behavior in the following sections
that applies to SSH with password authentication also applies to Telnet. Use of Telnet is
not recommended because it is not a secure protocol

n Limit access to the console account (minimum security)

The console account username and password are evaluated when the Edge SWG (ProxySG) appliance is accessed
from the Admin Console through a browser and from the CLI through SSH with password authentication. The
Enable (privilegedmode) password is evaluated when the console account is used through SSH with password
authentication and when the CLI is accessed through the serial console and through SSH with RSA authentication.
The simplest way to give access to others is sharing this basic console account information, but it is the least
secure and is not recommended.

To give read-only access to the CLI, do not give out the Enable (privilegedmode) password.
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n Create an ACL (moderate security)

Using the ACL allows you to further restrict use of the console account and SSH with RSA authentication to
workstations identified by their IP address and subnet mask. When the ACL is enforced, the console account can
only be used by workstations defined in the console ACL. Also, SSH with RSA authentication connections are only
valid fromworkstations specified in the console ACL (provided it is enabled).

After setting the console account username, password, and Enable (privileged-mode) password, use the CLI or the
Admin Console to create a console ACL. See "Moderate Security: Restrict Access Using the ACL" on page 327.

n Per-user RSA public key authentication (moderate security)

Each administrator’s public keys are stored on the appliance. When connecting through SSH, the administrator
logs in with no password exchange. Authentication occurs by verifying knowledge of the corresponding private
key. This is secure because the passwords never go over the network.

This is a less flexible option than CPL because you cannot control level of access with policy, but it is a better
choice than sharing the console credentials.

n Use CPL to control access (maximum security)

CPL allows you to control administrative access to the Edge SWG (ProxySG) appliance through policy. If the
credentials supplied are not the console account username and password, policy is evaluated when the appliance
is accessed through SSH with password authentication or the Admin Console.

Policy is never evaluated on direct serial console connections or SSH connections using RSA authentication.

o Using the CLI or the Admin Console, create an authentication realm to be used for authorizing
administrative access. For administrative access, the realmmust support BASIC credentials—for example,
LDAP, RADIUS, Local, or IWAwith BASIC credentials enabled.

o Using the VPM, or by adding CPL rules to the Local or Central policy file, specify policy rules that meet both
criteria:

l Require administrators to log in using credentials from the previously-created administrative realm:

l Specify the conditions under which administrators are either denied all access, given read-only
access, or given read-write access.

Authorization can be based on IP address, groupmembership, time of day, andmany other conditions. For
more information, refer to theWeb Visual Policy Manager Reference.

o To prevent anyone fromusing the console credentials to manage the Edge SWG (ProxySG) appliance, set
the console ACL to deny all access (unless you plan to use SSH with RSA authentication). Formore
information, see "Moderate Security: Restrict Access Using the ACL" on page 327. You can also restrict
access to a single IP address that can be used as the emergency recovery workstation.

For details on using policy to limit access, see "MaximumSecurity: Administrative Authentication and
Authorization Policy" on page 328.
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The following chart details the various ways administrators can access the Edge SWG (ProxySG) console and the
authentication and authorizationmethods that apply to each.

Security Measures Available
Serial
Console

SSH with Password
Authentication

SSH with RSA
Authentication

Admin Console

Username and password evaluated
(console-level credentials)

X X

Console Access List evaluated X (if console credentials
are offered)

X X (if console
credentials are
offered)

CPL <Admin> Layer evaluated X 1 X 2

Enable password required to enter
privilegedmode 2

X X X

CLI line-vty timeout command applies. X X X

Admin Console Login/Logout X

1When using SSH (with a password) and credentials other than the console account, the enable password is actually the
same as the login password. The privilegedmode password set during configuration is used only in the serial console,
SSH with RSA authentication, or when logging in with the console account.

2 In this case, user credentials are evaluated against the policy before executing each CLI command. If you log in using
the console account, user credentials are not evaluated against the policy.
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Limit Access to the Appliance
Limit access to the appliance using the followingmethods:

n (If applicable) "Specify a PIN for the Front Panel" below

n "Limit Workstation Access" below

n "Secure the Serial Port" below

Specify a PIN for the Front Panel
On systems that have a front-panel display, you can create a four-digit PIN to protect the system fromunauthorized
use. The PIN is hashed and stored. You can only create a PIN from the command line.

To create a front panel PIN, after initial configuration is complete, type

# (config) security front-panel-pin PIN

where PIN is a four-digit number.

To clear the front-panel PIN, enter:

# (config) security front-panel-pin 0000

Limit Workstation Access
During initial configuration, you have the option of preventing workstations with unauthorized IP addresses from
accessing the Edge SWG (ProxySG) appliance for administrative purposes. This covers all accessmethods - Telnet, SNMP,
HTTP, HTTPS and SSH. If this option is not enabled, all workstations are allowed to access the appliance administration
points. You can also add allowed workstations later to the ACL.

Formore information on limiting workstation access, see "Moderate Security: Restrict Access Using the ACL" on
page 327.

Secure the Serial Port
If you choose to secure the serial port, youmust provide a setup console password that is required to access the Setup
Console in the future.

After the secure serial port is enabled:

n The setup console password is required to access the setup console.

n An authentication challenge (username and password) is issued to access the CLI through the serial port.

To recover from a lost setup console password, you can:
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n Use the front-panel display to either disable the secure serial port or enter a new setup console password.

n Use the restore-defaults factory-defaults CLI command to delete all system settings.

n (If the appliance has a reset button) Use the reset button to delete all system settings. Otherwise, reset the
appliance to its factory settings by holding down the left arrow key on the front panel for five seconds. The
appliancewill be reinitialized.

To reconfigure the appliance or secure the serial port, refer to the hardware guides for your appliance.
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Moderate Security: Restrict Access Using the ACL
The Edge SWG (ProxySG) appliance allows you to limit access to the Admin Console and CLI through the console ACL. An
ACL, once set up, is enforced only when console credentials are used to access either the CLI or the Admin Console, or
when an SSH with RSA authentication connection is attempted. The following procedure specifies an ACL that lists the IP
addresses permitted access.

To restrict Admin Console Access using the ACL:

To create an ACL:

1. In the Admin Console, select Configuration > Authentication > Console Access.

2. (Optional) In Console Access, modify the list of IP addresses in the ACL. Select Add and specify the following:

Field or Value Description

Source Address Static IP address.

Prefix Length (Subnet Mask) Subnet mask.

To restrict access to an individual workstation, enter 255.255.255.255

Select Apply after each entry.

Caution: Before you enforce the ACL, verify the IP address for theworkstation you
are using is included in the list. If you forget, or you find that youmistyped the IP
address, youmust correct the problemusing the serial console.

3. To enable ACL, switch the Enforce ACL for built-in administrators toggle.

See Also:

n "MaximumSecurity: Administrative Authentication and Authorization Policy" on the next page
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Maximum Security: Administrative Authentication and
Authorization Policy
The Edge SWG (ProxySG) appliance permits you to define a rule-based administrative access policy. This policy is
enforced when accessing:

n the Admin Console through HTTP or HTTPS

n the CLI through SSH when using password authentication

n the CLI through telnet

n the CLI through the serial port if the secure serial port is enabled

These policy rules can be specified either by using the VPM or by editing the Local policy file. Using policy rules, you can
deny access, allow access without providing credentials, or require administrators to identify themselves by entering a
username and password. If access is allowed, you can specify whether read-only or read-write access is given. You can
make this policy contingent on IP address, time of day, groupmembership (if credentials were required), andmany other
conditions.

Serial-console access is not controlled by policy rules. Formaximum security to the serial console, physical accessmust
be limited.

Define Administrator Authentication and Authorization Policies
Administrative authentication uses policy, (either VPM or CPL in the local policy file) to authenticate administrative users
to the appliance. This is donewith two layers in policy: one to define the realm that is used to authenticate users (Admin
Authentication layer) and the other to define security rights for authenticated users or groups (Admin Access layer).

Note: If you choose a realm that relies on an external server and that server is unavailable,
the appliancewill not be able to authenticate against that realm. For best security,
Symantec recommends the following authentication realms for administrative
authentication to the appliance.

n IWA-BCAAA (with TLS -- not SSL) with basic credentials

n Local

n .509 certificate based (including certificate realms; refer to the Common Access Card Solutions Guide for
information)

n LDAP with TLS (not SSL)

n IWA-Direct with basic credentials RADIUS
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The following realms can be configured for administrative authentication, but pass administrative credentials in clear
text. These realms should not be used for administrative authentication:

n Windows SSO

n IWA-BCAAAwithout SSL or TLS

n LDAP without SSL or TLS

The following realms do not support administrative authentication:

n IWA-BCAAA/IWA-Direct realms that do not accept basic credentials

n SAML (Policy Substitution)

n XML

Note: Other authentication realms can be used, but will result in administrative
credentials being sent in clear text.

Configure Administrative Authentication with a Local Realm
The process to provide read-only access for administrators includes the following steps:

n Create a local authentication realm.

n Create a list that includes usernames and passwords formembers whom you wish to provide read-only access in
the Admin Console.

n Connect the list to the local realm.

n Create policy to enforce read-only access to members included in the list.

To configure administrative authentication with a local realm:

1. Create a local realm. Refer to the Command Line Interface Reference documentation.

2. Using the CLI, create a list of users who need read-only access. The list must include a username and password for
each user.

a. Enter configurationmode in the CLI; this example creates a list called Read_Access:

# (config) security local-user-list create Read_Access

b. Edit the list to add user(s) and to create usernames and passwords. See the following example:

# (config) security local-user-list edit Read_Access
# (config) user create Bob_Kent
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# (config) user edit Bob_Kent
# (config) password 12345

3. Connect the user list (created in step 2) to the local realm (created in step 1). Refer to the Command Line Interface
Reference documentation.

4. Use the for creating policy to enforce read-only access to the users in your list:

a. In theWeb VPM, create an Admin Authentication layer (or add a new rule in an existing layer). This layer
determines the authentication realm that will be used to authenticate users who access the appliance
Admin Console.

b. Add an Authentication action object.

c. In the Authentication object, select the local realm you created in step 1.

d. Add an Admin Access layer.

e. Add aUser source object.

f. In the User object, enter the name of the user for whom you want to provide read-only access.

g. Add an Allow Read-only Access action object.

After you save all changes and apply policy, the user can log into the Admin Console with read-only access.

Note: Use the previous steps, with an Allow Read/Write Access action object, to
define user access with read-write access.
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Control User Access with Identity-based Access Controls
Enterprise-wide security begins with security on the Edge SWG (ProxySG) appliance, and continues with controlling user
access to the Intranet and Internet. SSH and HTTPS are the recommended (and default) methods formanaging access to
the appliance. SSL is the recommended protocol for communication between the and a realm's off-box authentication
server.

You can control access to the appliance in several ways: by limiting physical access to the system, by using passwords,
restricting the use of console account, through per-user RSA public key authentication, and through CPL. How secure the
systemneeds to be depends upon the environment. See " Secure Access to the Appliance" on page 320 for details.

By using every possiblemethod (physically limiting access, limiting workstation IP addresses, and using passwords), the
appliance is very secure. After the appliance is secure, you can limit access to the Internet and intranet. It is possible to
control access to the network without using authentication. You only need to use authentication if you want to use
identity-based access controls.

View Configured Realms
The appliance provides a flexible authentication architecture that supportsmultiple services withmultiple backend
servers (for example, LDAP directory servers together with NT domains with no trust relationship) within each
authentication schemewith the introduction of the realm.

A realm authenticates and authorizes users for access to Edge SWG (ProxySG) services using either explicit proxy or
transparent proxy mode, discussed in "About Proxy Services " on page 174.

Multiple authentication realms can be used on a single appliance. Multiple realms are essential if the enterprise is a
managed provider or the company hasmerged with or acquired another company. Even for companies using only one
protocol, multiple realmsmight be necessary, such as the case of a company using an LDAP server withmultiple
authentication boundaries. You can use realm sequencing to search themultiple realms all at once.

To display the list of realms on the appliance, in the Admin Console, select Configuration > Authentication > Realms
and Domains. The Realms section displays realms configured on the appliance and indicates the Type/Protocol of each
one.

Realm configuration includes:

n Unique realm name.

n Authentication service.

n External server configuration: Back-end server configuration information, such as host, port, and other relevant
information based on the selected service.

n Authentication schema: The definition used to authenticate users.

n Authorization schema: The definition used to authorize users formembership in defined groups and check for
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attributes that trigger evaluation against any defined policy rules.

n One-time passwords (supported for RADIUS realms only).

Integration with the Windows Domain
The following configurations require that you join your Edge SWG (ProxySG) appliance to yourWindows Domain:

n To accelerate encryptedMAPI traffic, the appliance at the branch officemust join the same domain as the
Exchange server.

n To configure an IWADirect realm, youmust first join the appliance to yourWindows domain. If you want to
authenticate users in different AD domains that do not have trust relationships, youmust join the appliance to
each domain.

To integrate the Edge SWG (ProxySG) appliance into one ormoreWindows domains:

1. Synchronize the appliance and DC clocks.

The appliance can't join aWindows domain unless its internal clock is in sync with theDC. To ensure that the
clocks are synchronized with theDC clock, specify the sameNTP servers for theDC as theNTP source server. To
configure the applianceNTP servers, select Configuration > General > Time. SeeManageNTP Servers .

2. Join the appliance to theWindows domain. See "Join aWindows Domain" on page 361.

Certificate Realm Authentication
Configure the appliance to authenticate users based on their X.509 certificates.

If you have a Public Key Infrastructure (PKI) in place, create a certificate realm on the appliance to authenticate users
based on their X.509 certificates. Additionally, if the users aremembers of an LDAP, XML, or Local group, you can
configure the certificate realm to forward the user credentials to the LDAP, XML, or Local realm for authorization. X.509
Use certificate authentication realms to authenticate administrative users (read-only and read/write) to the Admin
Console. To ensure that credentials are not sent in clear text, configure the Certificate realm to use TLS to secure the
communication with the authorization server.

How a Certificate Realm Works
After an SSL session has been established, the user is prompted to select the certificate to send to the appliance. If the
certificate was signed by a Certificate Authority (CA) that the appliance trusts, the user is considered authenticated. The
appliance then extracts the username for that user from the certificate. At this point the user is authenticated. If an
authorization realm has been specified, such as LDAP, XML or Local, the certificate realm then passes the username to
the specified authorization realm, which figures out which groups the user belongs to.
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Note: If you authenticate with a certificate realm, you cannot also challenge for a
password.

Certificate realms do not require an authorization realm. If no authorization realm is configured, the user cannot be a
member of any group. You do not need to specify an authorization realm if:

n The policy does not make any decisions based on groups.

n The policy works as desired when all certificate realm-authenticated users are not in any group.

Steps to Configure a Certificate Realm
To configure a certificate realm, youmust:

n Configure SSL between the client and the appliance. 

n Configure a customCCL to use to validate the certificate. Define the CCL in a keyring object that is used in the
HTTPS Reverse Proxy service that performs the certificate authentication. Enable verify-client on the HTTPS
Reverse Proxy service to be used. See "Manage CA Certificate Lists" on page 279 and "Configure an HTTPS Reverse
Proxy" on page 185.

n Verify that the certificate authority that signed the client's certificates is in the Edge SWG (ProxySG) trusted
list. See "Manage CA Certificates" on page 276.

n Create the certificate realm. See "Configure a Certificate Realm " below. 

n Specify the fields to extract from the client certificate. See "Extract Certificate Fields for Authentication" on
page 338. 

n Customize the certificate realm properties. See "Configure Certificate Realm Details" on the next page.

n (Optional) Authorize users who are part of an LDAP, XML, or Local group. See "Configure Authorization for the
Certificate Realm " on page 340.

Configure a Certificate Realm 
To configure a certificate authentication realm:

1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. In theRealms section:

n Select Add Realm > Certificate to add a realm.

n Select an existing realm to edit it.

3. On the Add New/Edit Certificate Realm page, enter or edit the following as needed:
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Setting or
field

Description

Realm
Name

Unique name for the realm. The name can be 32 characters long and composed of alphanumeric
characters and underscores. The name must start with a letter.

Advanced
Settings

Select Show to specify custom settings:

n "Configure Certificate Realm Details" below

n "Extract Certificate Fields for Authentication" on page 338

Configure Certificate Realm Details
Configure the behavior of certificate authentication transactions, such as inactivity timeout, refresh intervals, and cookie
usage. You also configure the Virtual URL for transparent authentication requests.

Configure certificate realm details:

1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. In theRealms section:

n Select Add Realm > Certificate to add a realm.

n Select an existing realm to edit it.

3. On the Add/Edit Realm page, in Advanced Settings, select Show.

4. In the sections that appear, specify the following settings:

Task Setting or field Description

Set display name Display Name (Optional) By default, the
appliance displays the
authentication realm name when
prompting the user for
authentication credentials.
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Task Setting or field Description

Configure refresh
times for Basic
credentials

Use the same refresh time for all Select to use the same time for
the credential refresh and the
surrogate refresh.

Authorization refresh time Specify, in seconds, how often
the authorization data is verified
with the authentication realm. It
has a default setting of 900
seconds (15 minutes). You can
configure this in policy for better
control over the resources as
policy overrides any settings
made here.

Surrogate refresh time (Unavailable if set to use the
same refresh time for all) After
the appliance successfully
authenticates a client, it caches
the client’s IP address or a cookie
(depending on the authentication
mode that is in use) in its
surrogate cache. If it receives
subsequent requests from the
same client during the surrogate
refresh time, it uses the IP
address or cookie in its cache to
authenticate the user instead of
sending a request to the
authentication server. By default,
the surrogate credential is good
for 900 seconds (15 minutes).
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Task Setting or field Description

Configure the
inactivity timeout

Inactivity timeout When a client request is
successfully authenticated, the
appliance establishes an active
session with the client and as
long as that session stays active,
the appliance will not attempt to
reauthenticate requests from
that client. This setting specifies
how long the client session can
be inactive before the appliance
terminates the session;
subsequent requests from that
client require authentication. By
default, the client can be inactive
for 900 seconds (15 minutes).

Note: If the
Challenge user
after logout option
is selected, the
appliance will
automatically
challenge the client
for credentials when
the session becomes
inactive. If you are
using a challenge
method that
prompts the user for
credentials, you
might want to clear
this option.
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Task Setting or field Description

Configure cookie
settings to specify
how the appliance
uses cookie
surrogates

Applicable if you
plan to use an
authenticationmode
that uses cookie
surrogates.

Use persistent cookies By default, this option is not
selected, which means that the
appliance uses session cookies
when creating a cookie
surrogate for a client. Session
cookies are only valid during the
current browser session and are
deleted when the user closes the
browser.

The appliance must re-
authenticate the client each time
the user starts a new browser
session. If you select this option,
the appliance uses persistent
cookies instead of session
cookies. Persistent cookies are
stored on the client system and
are therefore not deleted at the
end of the browser session.
When using persistent cookies,
the appliance must only re-
authenticate a client when the
cookie in its surrogate credential
database expires.

Use persistent cookies By default, this option is selected,
which means that the appliance
only accepts a cookie from a
client if the client IP matches the
IP address in the surrogate
cookie. To enable the appliance
to accept cookies from IP
addresses that do not match the
address in the cookie—for
example, if you use DHCP—clear
this option.
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Task Setting or field Description

Set virtual URL Virtual URL (Transparent proxy only) Specify
the URL to which to redirect
client requests that require
authentication in the Virtual URL
field. For best results, the virtual
URL you specify must:

n Contain a simple
hostname that does not
contain any dots (for
example, use
http://myproxy rather
than
http://myproxy.acme.com.

n Resolve to the IP address
of the appliance. To
accomplish this, youmust
add an "A" record to your
internal DNS server that
associates the Virtual URL
with the IP address of the
appliance.

Extract Certificate Fields for Authentication
Define the substitutions to use to extract user data from a user certificate. You can also specify values for the Extended
Key Usage extension in client certificates.

When you use the certificate to identify users, the username and full username data can come from almost any field of a
certificate; however, the username can only reference data within the field, not the field as awhole. Supported fields
include: serialNumber, issuer, subject, issuerAltName, and subjectAltName fields. Specify the certificate fields to use:

1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. In theRealms section:

n Select Add Realm > Certificate to add a realm.

n Select an existing realm to edit it.

3. On the Add/Edit Realm page, in Advanced Settings, select Show.

4. In the Identification section, specify the following settings:
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n Username: Enter the substitution that specifies the common name in the subject of the certificate.
$(CN.1) is the default. To build complex substitutions, you can entermultiple attributes into the field.

n Full Username: (Optional) Enter the substitutions used to construct the user's full username. For
example, enter the user principal name (UPN) or LDAP distinguished name (DN).

The substitutions used to construct the username use the following parser format:

$([attributename=][field][.generalName[.generalNameindex]][.attribute[.attribute index]])

To see how the parser works, see the following Example.

5. In the Extended Key Usage section, select Add OID  to add an OID. In the field that appears, enter an OID value (a
dot-separated series of numbers) for the extension.

TheOID values you definemust be in the “Extended Key Usage” portion of client certificates in order for the
certificates to be valid for authentication in this certificate realm. For example, to enforce aMicrosoft
SmartCardLogon OID, add a valid OID such as 1.3.6.1.4.1.311.20.2.2.

To edit an existing OID, modify it in the list. To delete an OID, select Remove  in the list

Client Certificate Example
Refer to the following example of a client certificate:

subject: CN=John,OU=Auth,OU=Waterloo,O=Symantec
subjectAltName:
-otherName: john.doe@symantec.com
-otherName: john.doe@department.symantec.com
-DN: CN=Doe,john,CN=Users,DC=internal,DC=com

The client certificate is parsed as follows:

Parser Function Format Example

1 Multiple instances of an attribute/general name results in
an attribute/ general name list.

$(<attribute value>)
and
$(<subjectAltName.
general name
value>) and
$(issuerAltName.<
general name
value>)

$(OU) = AuthWaterloo

2 An individual instance of a multiple valued field is
selected using its index (1- based). This works for
attribute and general name fields.

$(<field
name>.index#)

$(OU.2) = Waterloo
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Parser Function Format Example

3 The subjectAltName and issuerAltName fields support
general name types that can be specified in the
substitution. If multiple values of the same general name
are found, all values are substituted in a list. Supported
general names types are: otherName email DNS
dirName URI IP RID

$(subjectAltName.<
general name
value>) or
$(issuerAltName.<
general name
value>)

$(subjectAltName.othername) =
john.doe@symantec.com
john.doe@department.broadcom.com

4 A modifier that enables the LDAP style expansion of
attributes.

attribute name= $(OU=subject.OU) =
OU=Auth,OU=Waterloo

5 Text that is not part of a substitution is directly placed
into the username.

$(any value),text $(OU),o=example becomes
AuthWaterloo,o=example

Configure Authorization for the Certificate Realm 
Specify an authorization realm for the certificate realm and determine the authorization username.

Configure authorization for the certificate realm:

1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. In theRealms section:

n Select Add Realm > Certificate to add a realm.

n Select an existing realm to edit it.

The browser opens the Add/Edit Certificate Realm page.

3. In the Authorization section, select the realm to use for authorization fromAuthorization Realm Name. You
can use an LDAP, local, or XML realm to authorize the users in a certificate realm. If no LDAP, local, or XML realm is
configured, this option cannot be selected.

4. ForAuthorization Username, specify how to determine usernames for authorization. See the following
section.

Determine the Authorization Username
In the Authorization Username section, specify how to determine the username for authorization.

Use Policy Substitutions

Select Custom username and enter the substitution to use to identify the user. The default authorization username is
$(csusername). You can use any policy substitutions.
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Use FQDN

Select Use FQDN to use the fully-qualified domain name (FQDN) or full username determined while identifying the user
during authentication.

Search LDAP

Select Determine by search. Use the following fields to focus the search:

1. Select a configured LDAP Search Realm Name. In most cases, this is the same as the LDAP realm used for
authorization.

2. Enter a Search filter. The filter can include a policy substitution such as $(cs-username).

3. Select a searchmethod:

n Use FQDN: Use the FQDN or full username determined while identifying the user during authentication.

n Attribute: Use an attributematching the substitution or filter.

4. (Optional) Select Add User to Ignore to specify users to exclude from the search.

Create Certificate Authorization Policy 
Write CPL policy after the certificate realm is created.

When you complete Certificate realm configuration, you can create CPL policies. The following examples are just part of a
comprehensive authentication policy. By themselves, they are not adequate.

Note: Refer to the Content Policy Language Reference for details about CPL and how
transactions trigger the evaluation of policy file <Proxy> and other layers.

The default policy condition for these examples is allow. On new SGOS systems, the default policy condition is deny.

n Every certificate realm authenticated user is allowed access to the appliance.

<Proxy>
authenticate(CertificateRealm)

n A subnet definition specifies themembers of a group. In the following example, the subnet specifiesmembers of
theHuman Resources department. They are allowed access to the two URLs listed. Everyone else is denied
permission.

<Proxy>
authenticate(CertificateRealm)
<Proxy>
define subnet HRSubnet
192.168.0.0/16
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10.0.0.0/24
end subnet HRSubnet
[Rule] client_address=HRSubnet
  url.domain=monster.com
  url.domain=hotjobs.com
deny
. . .
[Rule]
deny

Revoke User Certificates
Revoke certain certificates by writing policy that denies access to users who have authenticated with a certificate you
want to revoke. Youmust maintain this list on the appliance; it is not updated automatically.

Note: Thismethod of revoking user certificates ismeant for thosewith a few certificates
to manage. For information on using automatically updated lists, see "Manage Certificate
Revocation Lists" on page 295. 

A certificate is identified by its issuer (the Certificate Signing Authority that signed it) and its serial number, which is
unique to that CA. Using that information, you can use the following strings to create a policy to revoke user certificates: 

n user.x509.serialNumber—This is a string representation of the certificate’s serial number in HEX. The string is
always an even number of characters long, so if the number needs an odd number of characters to represent in
hex, there is a leading zero. Comparisons are case-insensitive. 

n user.x509.issuer—This is an RFC2253 LDAP DN. Comparisons are case-sensitive. 

n (Optional) user.x509.subject: This is an RFC2253 LDAP DN. Comparisons are case-sensitive.

For example, if you have only one Certificate Signing Authority signing user certificates, you do not have to test the
issuer. Add the following policy in the <Proxy> layer of the Local Policy file: 

<Proxy>
deny user.x509.serialnumber=11
deny user.x509.serialNumber=0F

If you havemultiple Certificate Signing Authorities, test both the issuer and the serial number. Add the following policy
in the <Proxy> layer of the Local Policy file:

<Proxy>

deny user.x509.issuer="Email=name,CN=name,OU=name,O=company,L=city,ST=state or province,C=country" use
r.x509.serialnumber=11
deny user.x509.issuer="CN=name,OU=name,O=company, L=city,ST=state or province,C=country"
deny user.x509.serialnumber=2CB06E9F00000000000B
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Certificate Realm Example
Refer to the following example of a certificate realm configuration.

The following example has the characteristics:

n Reverse proxy deployment.

n User authentication and authorization from the appliance.

n LDAP server and an end-user PKI certificate.

n The subject of the certificate includes the e-mail address of the user.

Configuration
1. Configure an HTTPS reverse proxy. See "Configure an HTTPS Reverse Proxy" on page 185. Be sure to enable the

Verify Client option.

2. Configure SSL between the client and appliance.

3. Verify that the certificate authority that signed the client's certificates is in the appliance trusted list.

4. Make sure that the appliance CRL is correct. See "Manage Certificate Revocation Lists" on page 295.

5. Create a Certificate Authority Certificate List (CCL) and add the CA that created the certificate to the CCL.
See "Manage CA Certificates" on page 276.

6. Configure the certificate realm. See "Configure a Certificate Realm " on page 333. 

Behavior
n The appliance retrieves the end-user PKI certificate from the browser when an HTTP request is received for the

domain.

n The user enters the smart card and pin code information into the browser.

n The browser retrieves the certificate from a smart card or fromwithin aweb browser's certificate store and sends
it to the appliance.

o For a specific destination, the certificatemust be a validate certificate from a specific Certificate Authority
and the certificatemust not be revoked.

o The e-mail address being used as the usernamemust be retrieved from the certificate as a unique ID for
the user.

n The appliance does an LDAP search operation with the retrieved username from the certificate. If only one entry
in the LDAP server exists with this e-mail address, the user is authenticated. If the user has the correct group
attributes, the user is authorized to access thewebsite.
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Troubleshooting
Youmight see the following errormessage:

Realm configuration error for realm "cert": connection is not SSL.

The errormeans that certificate authentication was requested for a transaction, but the transaction was not done on an
SSL connection, so no certificate was available. This can happen in threeways:

n The authenticatemode is either origin-IP-redirect/origin-cookie-redirect or origin-IP/origin-cookie,
but the virtual URL does not have an https: scheme. This is likely if authentication through a certificate realm is
selected with no other configuration, because the default configuration does not use SSL for the virtual URL.

n In a server accelerator deployment, the authenticatemode is origin and the transaction is on a non-SSL port.

n The authenticatemode is origin-IP-redirect/origin-cookie-redirect, the user has authenticated, the credential cache
entry has expired, and the next operation is a POST or PUT from a browser that does not handle 307 redirects
(that is, from a browser other than Internet Explorer). Theworkaround is to visit another URL to refresh the
credential cache entry and then try the POST again.
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Authentication with Active Directory Using IWA
IntegratedWindows Authentication (IWA) is an authentication scheme that allows you to authenticate and authorize
users against yourWindows AD. One of themain benefits of IWA is that it can provide a single sign-on experience for
your users. When configured properly, the user agent or browser will automatically provide the users' domain
credentials to the appliancewhen challenged without prompting the end users.

Another benefit of IWA is that it provides authorization without any additional configuration because it automatically
returns groupmembership information for the user as part of the authentication response. The Edge SWG (ProxySG)
appliance can then use this groupmembership information to enforce its authorization policies.

Symantec supports twomethods to integrate the appliancewith Active Directory using IWA:

n IWA BCAAA: Connect via an authentication agent running on aWindows server in your domain.

For instructions, refer to the BCAAA Service Requirements documentation at Tech Docs.

n IWADirect: Connect the appliance directly to your AD domains onWindows Server 2008, 2012, or 2016. Refer to
the following sections.

Note: You can configure IWADirect authentication with both IPv4 and IPv6 network
addresses.

You can authenticate administrative users to the appliancewith IWA realms. IWADirect, though less secure than IWA
BCAAA, is compatible with administrative authentication. Formaximum security, Symantec recommends using an IWA
BCAAA configuration, where the communication between the appliance and BCAAA is secured with TLS.

About IWA Challenge Protocols
When configured for IWA, the Edge SWG (ProxySG) appliance determines which of the following protocols to use to
obtainWindows domain login credentials each time it receives a client request that requires authentication:

n Kerberos: This is themost secure protocol because it establishesmutual authentication between the client and
the server using an encrypted shared key. This protocol requires additional configuration and the appliancewill
silently downgrade to NTLM if Kerberos is not set up properly or if the client cannot do Kerberos. Formore
information, see "Prepare for a Kerberos Deployment" on page 348.

n NTLM: Uses an encrypted challenge/response that includes a hash of the password. NTLM requires two trips
between theworkstation and the appliance, and one trip between the appliance and theDC. It therefore puts
more load on the network than Kerberos, which only requires one trip between theworkstation and the
appliance, and doesn’t require a trip between the appliance and theDC.

n Basic: Prompts the user for a username and password to authenticate the user against theWindows Active
Directory.
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When the appliance receives a request that requires authentication, it consults the IWA configuration settings you have
defined to determinewhat type of challenge to return to the client. It will try to use the strongest authentication
protocol that is configured and, if the browser cannot use that protocol or if it is not configured properly, the appliance
will downgrade to the next authentication protocol. For example, if you configure the IWA realm to allow Kerberos and
NTLM authentication, but the user agent/browser does not support Kerberos, the appliancewill automatically
downgrade to NTLM. IWA authentication realms (with basic credentials) can be used to authenticate administrative users
(read only and read/write) to the Admin Console. To ensure that credentials are not sent in clear text, configure the IWA
realm to use TLS to secure the communication with the BCAAA server, or in the case of IWA direct, secure the
communication from the appliance to the domain.

About IWA Failover
Theway IWA failover works depends on your deployment:

n "IWADirect Failover" below

n "IWA BCAAA Failover " below

IWA Direct Failover

For IWADirect, the realm is considered “healthy” if the appliance is able to establish a connection to theWindows
domain to which it is amember. As with any other device in theWindows domain, the appliancewill establish a
connection with the closest Windows DC upon successful domain login. If the DC to which the appliance is connected
goes down, the appliancewill send an LDAP ping to locate and connect to the next closest DC.

Because communication between the appliance and theWindows Active Directory relies on DNS, youmust make sure
that the appliance is configured to usemore than oneDNS server to ensure proper failover. This will ensure that the
appliancewill still be able to communicatewith AD, should the primary DNS server go offline. For instructions, see
Configure the Primary or Alternate Group.

IWA BCAAA Failover

For IWA BCAAA, the realm is considered “healthy” (and thereforewon’t fail over) if the appliance is able to establish a
connection to the BCAAA service. Thismeans that the appliance is able to complete the TCP handshakewith BCAAA on
port 16101 (or whichever port the BCAAA service is configured to use), and the appliance has been able to send BCAAA
its “login” message. There are several different failover scenarios in a BCAAA deployment:

Each time an appliance connects to BCAAA, the BCAAA service (bcaaa.exe) spawns a new BCAAA process (such as bcaaa-
130.exe). If the BCAAA process crashes, the TCP connection with the corresponding appliancewill be reset and the
appliancewill attempt to reconnect to the BCAAA service. Other appliances that are connected to other instances of the
BCAAA process will be unaffected.

n If the BCAAA service (bcaaa.exe) crashes or is stopped, but theWindows systemon which it is running remains
available, any appliance that is already connected to the BCAAA process will have their connections reset. The
appliances will not be able to reconnect to BCAAA because the service is no longer running, and will instead fail
over to the secondary BCAAA server.
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n If theWindows server on which BCAAA is running crashes or becomes unavailable, it cannot reset the TCP
connection. In this case, BCAAAmust wait for the appliance’s TCP connection to theWindows server to time out.
This can take a couple of minutes, and won’t occur until the appliance attempts to send a new authentication
request.

n If the BCAAA server loses its connection to theWindows DC, it will automatically fail over to a different DC. Keep in
mind that BCAAA cannot detect whenWindows fails to connect to any DCs in a particular domain. In this case all
authentication requests will fail, but because the connection between the BCAAA service and the appliance is still
considered healthy, the appliancewill not fail over to the secondary BCAAA service.

In addition, authentication requests can be slowed significantly if BCAAA is querying a slowDC. However, this will not
cause the appliance to fail over to the secondary BCAAA server. By default, BCAAAwill query whichever DC is chosen at
boot time by the server it is installed on, and it only changes if the DC goes down or the server reboots. You can see
and/ormodify what DC the BCAAA server is communicating with using the nltest.exe utility, which is part of the
Windows Support Tools.

To seewhich DC the BCAAA server is communicating with:

nltest /sc_query:internal.domain.com

To switch to a different DC:

nltest /sc_reset:internal.domain.com\new_dc_name
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Prepare for a Kerberos Deployment
Kerberos is the recommended authentication protocol for IWA because it ismore secure than NTLM or Basic and it puts
the least load on your network. To ensure that IWA uses the Kerberos protocol rather then downgrading to NTLM, you
just need to make sure that authentication requests are directed to the Kerberos service associated with the appliance.
Theway you do this depends on how your IWA realm is connecting to the Active Directory as follows:

n "Enable Kerberos in an IWADirect Deployment" below

n "Enable Kerberos in a BCAAADeployment " below

Enable Kerberos in an IWA Direct Deployment
In an IWADirect realm, Kerberos configuration isminimal because the appliance has its ownmachine account in Active
Directory and it uses its account password to decrypt service tickets from clients. Therefore, there is no need for you to
create a privileged Active Directory account or generate an SPN for the appliance as is required with an IWABCAAA
realm.

To ensure that IWA uses the Kerberos protocol rather then downgrading to NTLM, you just need to make sure that
authentication requests are directed to theDNS name of the appliance’s Active Directory machine account name as
follows:

1. Create a DNS “A” record for the appliance that resolves to theDNS name of the appliance’s Active Directory
machine account name. For example, if you have an appliance named 1 with IP address 1.2.3.4 in the blue9
Active Directory domain at acme.com, you would create the following DNS record:

Proxy1.blue9.acme.com Host(A) 1.2.3.4

2. Ensure that client requests are directed to theDNS name for the appliance’s Active Directory machine account:

n Explicit deployments: Configure the client browser explicit proxy settings to point to this DNS name.

n Transparent deployments: Set theVirtual URL in the general realm settings to this DNS name. In addition,
make sure that the DNS name for the appliance's Active Directory domain is either included in the
workstation's list of imputing DNS suffixes or explicitly specified as part of Internet Explorer's local intranet
zone. For example, if your AD domain DNS name is blue9.acme.com, then you would add
*.blue9.acme.com to IE's local intranet zone. See "Configure IWA Realm Details" on page 353.

Enable Kerberos in a BCAAA Deployment
For the BCAAA service to participate in an IWA Kerberos authentication exchange, it must share a secret with the
Kerberos server and have registered an appropriate SPN. To prepare for a BCAAA Kerberos deployment:
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1. Create a DNS “A” record for the appliance that resolves to the appliance’s FQDN. Keep inmind that theDNS name
you choosemust not match the Active Directory machine account name for the appliance. For example, rather
than using themachine name, youmight create a DNS entry for the appliance using a name such as bcaaaUser1.

Supposing the appliance is in the acme.comdomain and has an IP address of 1.2.3.4, you would create the
following DNS record:

bcaaaUser1.acme.comHost(A) 1.2.3.4

After you create theDNSmapping, make sure you can ping the appliance using the FQDN.

2. Create a domain user account for the BCAAA service in theWindows AD.

3. Install BCAAA. Refer to the BCAAA Service Requirements documentation on Tech Docs.

4. Configure the BCAAAWindows service on the systemwhere you just installed BCAAA to log on using the domain
user account you created for it in step 2 rather than using the local system account.

5. In the Local Security Policy of the server on which BCAAA is running, modify the user rights assignment for the
BCAAA domain user to have the following rights:

n Full access to the directory where you installed BCAAA

n Act as part of the operating system (not required for BCAAA 6.0)

n Log on as a service

6. Register the Kerberos SPN for the appliance:

a. Log in to theDC using an account with administrative access and open a command prompt.

b. Enter the following case-sensitive command:

setspn -A HTTP/<FQDN_of_Proxy> <AD_Account_Name>

where:

n <FQDN_of_Proxy> is the FQDN of the appliance as specified in the browser's explicit proxy
configuration (explicit deployments) or in theVirtual URL setting in the IWA realm configuration
(transparent deployments)

n <AD_Account_Name> is the name of the BCAAA domain service account, for example:

setspn -A HTTP/bcaaaUser1.acme.com AcmeDomain\BCAAAuser
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Note: Do not assign the same SPN tomultiple AD accounts or the browser will fall
back to NTLMwithout providing any warning or explanation. To list all SPNs that are
currently registered on an account, use the setspn -L <AD_Account_Name>
command. If you find a duplicate, remove the extraneous SPN using the setspn -D
<SPN> command.
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Configure an IWA Authentication Realm
You can configure an IWA realm in the Admin Console. See Authentication with Active Directory Using IWA for details.

Before you can create an IWA realm, youmust integratewith theWindows domain. Theway you do this depends on
how you plan to connect to your Active Directory:

n Direct: The appliancewill communicate directly with your DCs to obtain authentication information. Before you
can use this option, youmust join the appliance to theWindows domains that contain your users as described in
"Join aWindows Domain" on page 361.

Refer to the BCAAA Service Requirements document for up-to-date information on BCAAA compatibility.

Note: In theRealms list (Configuration > Authentication > Realms and
Domains), an IWA Direct realm says "IWAOn-box" under Type/Protocol.

n BCAAA: The appliancewill contact the BCAAA server when it needs to authenticate a user. To use this option, you
must first install BCAAA on a dedicated server in yourWindows domain and configure it to communicatewith
both theDC and with the appliance as an authentication agent. Use this option if you do not want to allow the
appliance to join yourWindows domain. Formore information, refer to the BCAAA Service Requirements
document.

Note: In theRealms list (Configuration > Authentication > Realms and
Domains), an IWA BCAAA realm says "IWA" under Type/Protocol.

To configure an IWA authentication realm:

1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. In Realms:

n Select Add Realm > IWA to add a new realm.

n Select an existing realm to edit it.

3. On the Add New /Edit IWA Realm page, enter or edit the following as needed:

Setting or
field

Description

Realm name Unique name for the realm.
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Setting or
field

Description

Active
Directory
connection

Select the type of Active Directory Connection you are using and then provide the appropriate
configuration information as follows:

n Direct: (Available if the appliance is joined to at least one Windows domain) Connect directly to
the Windows Domain to obtain authentication information.

n BCAAA: Connect via the BCAAA server. See below for additional settings.

Primary
Server

(BCAAA only) Hostname or IP address of the server where you installed BCAAA. If you plan to secure
communication between the appliance and BCAAA, use a host name rather than an IP address. The
DNS server that the appliance is configured to use must be able to resolve the hostname.

Port (BCAAA only) If you configured BCAAA to use a port other than the default (16101), specify it.

Advanced
Settings

Select Show to specify custom settings:

n "Configure IWA Servers " on page 356

n "Configure IWA Realm Details" on the facing page

Test
Configuration

(Only available when editing) Select to test the configuration.

When prompted, enter the username and password of a user in the Windows domain and selectOK.
The appliance sends an authentication request to the configured server and then displays a message
indicating whether the authentication succeeded or failed. If the test failed, go back andmake sure you
have configured the realm properly. If the test succeeds, the message also displays a list of any groups
of interest (that is, groups that are referenced in policy) to which the user belongs.
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Configure IWA Realm Details
You can configure the behavior of the authentication transaction, such as timeout and refresh intervals and cookie
usage. You also configure the Virtual URL for transparent authentication requests.

To configure IWA realm details:

1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. In Realms:

n Select Add Realm > IWA to add a new realm.

n Select an existing realm to edit it.

3. On the Add/Edit IWA Realm page, in Advanced Settings, select Show.

4. In the sections that appear, enter or edit the following as needed:

Task
Setting or
field

Description

Set display
name

Display
name

(Optional) By default, the appliance displays the authentication realm name when
prompting the user for authentication credentials.

Configure
refresh times
for Basic
credentials

Use the
same
refresh
time for
all

Select to use the same time for credential refresh and surrogate refresh.

Credential
refresh
time

Specifies the amount of time the appliance will cache Basic credentials (username and
password) and use these cached credentials to authenticate the user rather than sending
another request to the authentication server. By default, basic credentials are good for
900 seconds (15 minutes).

Surrogate
refresh
time

(Unavailable if set to use the same refresh time for all) After the appliance successfully
authenticates a client, it caches the client’s IP address or a cookie (depending on the
authenticationmode that is in use) in its surrogate cache. If it receives subsequent
requests from the same client during the surrogate refresh time, it uses the IP address or
cookie in its cache to authenticate the user instead of sending a request to the
authentication server. By default, the surrogate credential is good for 900 seconds (15
minutes).
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Task
Setting or
field

Description

Configure
timeouts

Inactivity
timeout

When a client request is successfully authenticated, the appliance establishes an active
session with the client and as long as that session stays active, the appliance will not
attempt to reauthenticate requests from that client. This setting specifies how long the
client session can be inactive before the appliance terminates the session; subsequent
requests from that client will require authentication. By default, the client can be inactive
for 900 seconds (15 minutes).

Note: If the Challenge user after logout option is selected, the
appliance will automatically challenge the client for credentials
when the session becomes inactive. If you are using a challenge
method that prompts the user for credentials, youmight want to
clear this option.

Rejected
credentials
timeout

Specifies whether to cache failed authentication attempts (bad password, expired account,
disabled account, old password, or server down). If the client attempts to connect again
during the rejected credentials time, the appliance will automatically reject the request for
the specified period of time. Enter a value from 1 second (the default) to 10 seconds. To
disable this option, enter 0.

Configure
cookie
settings to
specify how
the appliance
uses cookie
surrogates

Applicable if
you plan to
use an
authentication
mode that
uses cookie
surrogates.

Use
persistent
cookies

By default, this option is not selected, which means that the appliance will use session
cookies when creating a cookie surrogate for a client. Session cookies are only valid
during the current browser session and are deleted when the user closes the browser.

The appliance must re-authenticate the client each time the user starts a new browser
session. If you select this option, the appliance will use persistent cookies instead of
session cookies. Persistent cookies are stored on the client system and are therefore not
deleted at the end of the browser session. When using persistent cookies, the appliance
will only need to re-authenticate a client when the cookie in its surrogate credential
database expires.

Verify the
IP address
in the
cookie

By default, this option is selected, which means that the appliance will only accept a cookie
from a client if the client IP matches the IP address in the surrogate cookie. To enable the
appliance to accept cookies from IP addresses that do not match the address in the
cookie—for example, if you use DHCP—clear this option.
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Task
Setting or
field

Description

Set virtual
URL

Virtual
URL

(Transparent proxy only) Specify the URL to which to redirect client requests that require
authentication in the Virtual URL field. For best results, the virtual URL you specify must:

n Contain a simple hostname that does not contain any dots (for example, use
http://myproxy rather than http://myproxy.acme.com.

n Resolve to the IP address of the appliance. To accomplish this, youmust add an "A"
record to your internal DNS server that associates the Virtual URL with the IP
address of the appliance.

n (IWA Direct Kerberos only) If you’re using Kerberos in a non-load balancing IWA
Direct realm, the Virtual URL must be the DNS name of the appliance in the Active
Directory domain. Typically this will be the DNS name of the Active Directory
domain prefixed with the appliance machine account name. For example,
proxy.blue9.local. If you do not use the Active Directory DNS name of the appliance
as the Virtual URL, all authentication transactions will be downgraded to NTLM.

Configure re-
authentication
after timeout

Challenge
user after
logout

(Optional) Select to prompt the client for authentication credentials whenever the inactivity
timeout expires.
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Configure IWA Servers
You can configure the connection between the appliance and the authentication server (either directly or via BCAAA), as
well as failover servers for BCAAA. Also, specify the type of credentials to accept from the browser/user agent.

Theway you set up the configuration depends on whether you connecting directly to theDC or you are using BCAAA to
connect to the domain:

n "Configure Custom Settings for an IWABCAAA Realm" below

n "Configure Custom Settings for an IWADirect Realm" on page 358

Configure Custom Settings for an IWA BCAAA Realm
If you plan to use a BCAAA server to act as an intermediary between your appliance and your Active Directory, you can
configure and verify the authentication settings for connecting to theWindows domain using BCAAA.

To configure custom settings for an IWABCAAA realm:

1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. In Realms:

n Select Add Realm > IWA Realm to add a new realm.

n Select an existing realm to edit it.

3. On the Add/Edit IWA Realm page, in Advanced Settings, select Show.

4. In Servers, enter or edit the following as needed:

Task
Setting or field Description

Configure
failover

Alternative
Server Host

(Optional) Hostname or IP address of the secondary server where you installed BCAAA.
If you plan to secure communication between the appliance and BCAAA, use a host
name rather than an IP address. The DNS server that the appliance is configured to use
must be able to resolve the hostname.

Port (Optional) If you configured the secondary BCAAA server to use a port other than the
default (16101), specify it.
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Task
Setting or field Description

Specify
credentials
to use

Client
Authentication
Mode

Type of credentials to accept from the browser/user agent. By default, all credential
types are allowed and the appliance will try to use Kerberos (the default authentication
method for Windows clients), but will automatically downgrade to a different challenge
type depending on the browser/user agent capabilities.

n Allow Basic credentials: Prompts the user for a username and password to
authenticate the user against the Windows Active Directory.

Note: Basic credentials can't be disabled in the IWA realm
if the IWA realm is part of a sequence realm but is not the
first realm in the sequence with try IWA authentication only
once enabled.

n Allow NTLM credentials: Uses an encrypted challenge/response that includes a
hash of the password.

n Allow Kerberos credentials: Uses a ticket containing an encrypted session key
in place of a user name and password. This is the most secure method because it
establishes mutual authentication between the client and the server using an
encrypted shared key. However, if you select this option, NTLM is automatically
selected as well; in the event that the browser/user agent and/or the appliances
are not configured properly for Kerberos, the appliance will automatically
downgrade to NTLM. To use Kerberos, youmust complete some additional
configuration tasks. See "Enable Kerberos in a BCAAA Deployment " on
page 348.

Note: Forms authenticationmodes can't be used with an
IWA realm that allows only NTLM/Kerberos credentials. If a
formmode is in use and the authentication realm is an IWA
realm, you will receive a configuration error.

Configure
SSL options

Enable SSL Select to enable SSL.

Select Domain The SSL device profile that the realm uses to make an SSL connection to the BCAAA
server.

Configure
timeout

Timeout
request after

Amount of time the appliance waits for an authentication response before timing out.
Default value is 60 seconds.
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Configure Custom Settings for an IWA Direct Realm
If you have joined your appliance to yourWindows domain and created a realm for connecting to your Active Directory
directly, you can configure and verify the authentication settings for connecting to Windows domain directly.

To configure custom settings for an IWADirect realm:

1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. In Realms:

n Select Add Realm > IWA to add a new realm.

n Select an existing realm to edit it.

3. (If adding a new realm) On the Add New IWA Realm page, in Realm Config, select Custom Configuration.

4. On the Add New /Edit IWA Realm page, in Servers, enter or edit the following as needed:
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Task
Setting or field Description

Specify
credentials to
use

Client
Authentication
Mode

Type of credentials to accept from the browser/user agent. By default, all credential
types are allowed and the appliance will try to use Kerberos (the default authentication
method for Windows clients), but will automatically downgrade to a different challenge
type depending on the browser/user agent capabilities.

n Allow Basic credentials: Prompts the user for a username and password to
authenticate the user against the Windows Active Directory. Because the
username and password are sent in plaintext, it is important to enable SSL if
you allow Basic.

Note: Basic credentials can't be disabled in the IWA
realm if the IWA realm is part of a sequence realm but is
not the first realm in the sequence with try IWA
authentication only once enabled.

n Allow NTLM credentials: Uses an encrypted challenge/response that includes
a hash of the password. Because the plaintext username and password are not
sent across the wire, this method is more secure than Basic authentication.

n Allow Kerberos credentials: Uses a ticket containing an encrypted session
key in place of a user name and password. This is the most secure method
because it establishes mutual authentication between the client and the server
using an encrypted shared key. However, if you select this option, NTLM is
automatically selected as well; in the event that the browser/ user agent and/or
the appliance are not configured properly for Kerberos, the appliance will
automatically downgrade to NTLM. To use Kerberos, youmust complete some
additional configuration tasks. See "Enable Kerberos in an IWA Direct
Deployment" on page 348.

Note: Forms authenticationmodes can't be used with an
IWA realm that allows only NTLM/Kerberos credentials. If
a formmode is in use and the authentication realm is an
IWA realm, you will receive a configuration error.

Configure
timeout

Timeout
request after

Amount of time the appliance waits for an authentication response before timing out.
Default value is 60 seconds.
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Task
Setting or field Description

Verify the
configuration

Test
Configuration

Select to test the configuration.

When prompted, enter the username and password of a user in the Windows domain
and selectOK. The appliance sends an authentication request to the configured
server and then displays a message indicating whether the authentication succeeded
or failed. If the test failed, go back andmake sure you have configured the realm
properly. If the test succeeds, the message also displays a list of any groups of interest
(that is, groups that are referenced in policy) to which the user belongs.

Configure
load
balancing

Set
Credentials

(Optional) Select if you are sharing an SPN across multiple appliances in a load
balancing configuration. In the Enter Kerberos Credentials dialog, specify the
Username and Password for the AD account.

Clear
Credentials

(If needed) Select to disable load balancing.
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Join a Windows Domain
After you have synchronized the appliance’s internal clock with theDC, you can join the appliance to one ormore
Windows domains.

To edit a domain, see "Edit aWindows Domain (NTLM Authentication Only)" on the next page.

To join aWindows domain:

1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. InDomains, beside Hostname, specify the hostname to use:

n (Recommended) Select Default to use the default hostname.

n Select Custom to enter a hostname.

Note: Unless you have a specific need to use a particular hostname (for example, to
ensure correct DNS lookup), Symantec recommends that you use the default
hostname to guarantee that each appliance’s hostname is unique. In addition, you
must use unique hostnames formultiple appliances joined to the same domain.

3. To add a domain, select Add Domain.

On the Add Domain page, specify the following:

Section
Setting or
field

Description

Domain
Name

Domain
Name
Alias

Domain name alias

DNS
Domain
Name

DNS name for the Windows Active Directory domain. This is not the fully qualified domain
name of the appliance.

Note: The appliance must be able to resolve the DNS domain name
you supply for the Active Directory domain or the appliance will not
be able to join the domain. If DNS resolution fails, check your DNS
configuration.
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Section
Setting or
field

Description

Windows
Domain
Credentials
and Status

Username
and
Password

User name and password for the primary Windows domain. You can either enter the plain
user name (for example, administrator) or use the username@dnsname format
(administrator@acme.com). This account must have rights for joining the domain.

Join Select to join the appliance to the domain.

When joined, the domain State says "Joined" in the Domains list. Otherwise, the domain
State says "Not joined". If the domain is used in an IWA realm, the State says "Joined
& used".

This option is not available until all of the previous settings are specified.

Edit a Windows Domain (NTLM Authentication Only)
You can optionally configure aMaxConcurrentApi value for each of the joinedWindows domains on the appliance. The
default value is 2 (same as the default for aWindowsmember server). Theminimum value is 2 and themaximum value
is 150.

You can also specify a preferred Schannel DC and alternate Schannel DC for each domain. If the preferred Schannel DC is
available, the appliancewill always connect to it, even if it sees another DC that appears to be faster. That serves two
purposes:

n You need only increaseMaximumnumber of concurrent Schannel connections on the preferred and alternate
DCs, rather than on every DC in the domain.

n The preferred and alternate DCs can be read-only. Some customers arewilling to deploy a read-only DC that is
dedicated just to handling authentication requests for an appliance, whereas they would not bewilling to deploy a
regular “writable” DC for that purpose.

If the appliance can't connect to either of its preferred or alternate DCs, it connects to the fastest DC available. The
appliance periodically checks to see if the preferred or alternate DC comes back online, and reconnects to it if it does.

To edit aWindows domain:

1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. InNTLM Domain Controller, specify the following:

Setting or
field

Description

Preferred
domain
controller

Preferred DC.
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Setting or
field

Description

Alternate
domain
controller:

Alternate DC, used if the preferred one is not available.

Max
number of
Schannel
connections

Maximum number of Schannel connections. The range is 2-150.

In order for the maximum number of concurrent connections to take effect, youmust enter the same
number in the registry for the DC(s). The registry setting on the DC is MaxConcurrentAPI. If you change
the MaxConcurrent API setting, youmust restart the NetLogon service on the DC or reboot the DC after
changing the MaxConcurrent API setting.

Notes on Preferred and Alternate DCs

If the appliance cannot connect to either of its preferred or alternate DCs, it connects to the fastest DC available. The
appliance periodically checks to see if the preferred or alternate DC comes back online, and reconnects to it if it does.

The preferred and alternate DCs can be read-only. If you use a read-only DC, youmust replicate user passwords to that
domain controller. If the domain controller doesn’t have a copy of the user’s password, it must forward the request to a
writable domain controller that has a copy, which will diminish performance. Consult Microsoft documentation to
determine how to do this in your environment:

https://technet.microsoft.com/en-us/library/cc732801(v=ws.10).aspx

363 of 676

https://technet.microsoft.com/en-us/library/cc732801(v=ws.10).aspx


SGOS Administration (Admin Console Edition)

Authentication with Active Directory Using LDAP
Lightweight Directory Access Protocol (LDAP) is a client protocol used to access information stored in an LDAP-
compatible directory service. It is the vehicle by which LDAP-enabled applications speak to one another. As a shared
protocol, LDAP integrates compatible applications in your network to a single authentication interface. Any additions or
changesmade to information in the directory are available to authorized users, directory-enabled applications, devices,
and Edge SWG (ProxySG) appliances. This central control gives administrators simplified applicationmanagement.

LDAP authentication realms can be used to authenticate administrative users (read only and read/write) to the Admin
Console. To ensure that credentials are not sent in clear text, configure the LDAP realm to use TLS to secure the
communication with the LDAP server.

Note: To ensure that only TLS is used to communicatewith the LDAP Server, check
Enable SSL in the LDAP Server configuration page and edit the SSL device profile
configured on the LDAP Server configuration page in the Admin Console.

About the Symantec LDAP Solution
The appliance uses existing directory-based authentication by passing log in requests to the directory service. By keeping
authentication centralized on your directory, a security administrator will always knowwho is accessing network
resources and can easily define user/group-based policies to control access through the appliance.

Symantec supports both LDAP v2 and LDAP v3, but recommends LDAP v3 because it supports additional authentication
mechanisms. In LDAP v3, servers can return referrals to other servers back to the client, allowing the client to follow
those referrals if desired.

LDAP group-based authentication for the appliance can be configured to support any LDAP-compliant directory:

n Microsoft Active Directory Server

n Novell NDS/eDirectory Server

n Netscape/Sun iPlanet Directory Server

Configuring LDAP authentication on the appliance involves the following steps:

1. Create an LDAP realm on the appliance.

2. Configure LDAP properties on the appliance.

a. Configure LDAP server settings

b. Define LDAP BaseDistinguished Names

c. Define Authorization and Group information
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d. Define objectclass attributes on an LDAP entry

e. Configure general LDAP realm settings

3. Create policies on the appliance.

See Also:

n "Configure an LDAP Authentication Realm " on the next page
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Configure an LDAP Authentication Realm
You can configure an LDAP realm in the Admin Console. See "Authentication with Active Directory Using LDAP" on
page 364 for details.

An LDAP authentication realm authenticates and authorizes users to access services using either explicit proxy or
transparent proxy mode. These realms integrate third-party vendors, such as LDAP, Windows, and Novell, with the
operating system.

To configure an LDAP authentication realm:

Note: Realm creation requires knowledge of LDAP server type, server host information,
and attribute type. This section describes realm configuration options and how to set up
and add additional realms. Formore information, see "Authentication with Active
Directory Using LDAP" on page 364.

1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. In Realms:

n Select Add Realm > LDAP Realm to add a new realm.

n Select an existing realm to edit it.

3. On the Add New /Edit LDAP Realm page, enter or edit the following as needed:

Section Setting or
field

Description

Properties Realm name Unique name for the realm.

Server type Specify the server type:

n Microsoft Active Directory Server

n Novell NDS/eDirectory Server

n Netscape/Sun iPlanet Directory Server

Primary
server

Hostname or IP address of the primary server.

Port If you configured the primary server to use a port other than the default (389), specify
it. If you enable SSL, change the port to an SSL listening port, such as port 636.
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Section Setting or
field

Description

SSL Enable SSL (For LDAP v3 only) Select to enable SSL.

Device
Profile

Select the SSL device profile that this realm uses to make an SSL connection to a
remote system.

LDAP
Distinguished
Name (DN)

User
attribute
type

This field displays the default user attribute type for the type of LDAP server you
specified when creating the realm:

n Microsoft Active Directory Servers: sAMAccountName=

n Novell NDS/eDirectory Server/Other: cn=

n Netscape/iPlanet Directory Server: uid=

If you entered information correctly when creating the realm, you do not need to
change the User attribute type in this step. If you do need to change or edit the entry,
do so directly in the field.

Add as many Base DNs as required for the realm. To specify entries for the Base DNs
field, select Add DN and enter the Base DN(s). To search all of Sample_Company,
enter o values. To search the manufacturing organizations, rather than starting at the
top, enter ou and o values.

You can add, edit, and delete Base DNs for an appliance to search. The appliance
searches multiple DNs in the order listed, starting at the top and working down. To
promote or demote a DN, selectMove up orMove down in the Actions column.

Advanced
Settings

Advanced
settings

Select Show to specify custom settings:

n "Configure LDAP Realm Details" on page 369

n "Configure LDAP Servers " on page 373

n search

n group

n object classes
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Section Setting or
field

Description

Verify the
configuration

Test
Configuration

Select to test the configuration.

When prompted, enter the username and password of a user in the Windows domain
and selectOK. The appliance sends an authentication request to the configured server
and then displays a message indicating whether the authentication succeeded or
failed. If the test failed, go back andmake sure you have configured the realm
correctly. If the test succeeds, the message also displays a list of any groups of interest
(that is, groups that are referenced in policy) to which the user belongs.

You can also look up LDAP users and groups from the CLI using the lookup-user and
lookup-group commands. Refer to the Command Line Interface Reference for details.
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Configure LDAP Realm Details
You can configure the behavior of the authentication transaction, such as timeout and refresh intervals and cookie
usage. You also configure the Virtual URL and group comparisonmethod.

To configure LDAP realm details:

1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. In Realms:

n Select Add Realm > LDAP to add a new realm.

n Select an existing realm to edit it.

3. On the Add/Edit LDAP Realm page, in Advanced Settings, select Show.

4. In the sections that appear, enter or edit the following as needed:

Task
Setting or
field

Description

Set display name Display name (Optional) By default, the appliance displays the authentication realm name when
prompting the user for authentication credentials.
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Task
Setting or
field

Description

Configure refresh
times for Basic
credentials

Use the same
refresh time
for all

Select to use the same time for credential refresh and surrogate refresh.

Credential
refresh time

Specifies the amount of time the appliance will cache Basic credentials (username
and password) and use these cached credentials to authenticate the user rather
than sending another request to the authentication server. By default, basic
credentials are good for 900 seconds (15 minutes).

Before the refresh time expires, the appliance will authenticate the user supplied
credentials against the cached credentials. If the credentials received do not
match the cached credentials, they are forwarded to the authentication server in
case the user password changed. After the refresh time expires, the credentials
are forwarded to the authentication server for verification.

Surrogate
refresh time

Specifies a realm default for how often a user’s surrogate credentials are
refreshed. Surrogate credentials are credentials accepted in place of a user’s
actual credentials. The default setting is 900 seconds (15 minutes). You can
configure this in policy for better control over the resources as policy overrides any
settings made here.

Before the refresh time expires, if a surrogate credential (IP address or cookie) is
available and it matches the expected surrogate credential, the appliance
authenticates the transaction. After the refresh time expires, the appliance verifies
the user’s credentials. Depending upon the authenticationmode and the user-
agent, this may result in challenging the end user for credentials. The main goal of
this feature is to verify that the user-agent still has the appropriate credentials.

Authorization
refresh time

Specifies how often the authorization data is verified with the authentication realm.
It has a default setting of 900 seconds (15 minutes). You can configure this in policy
for better control over the resources as policy overrides any settings made here.
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Task
Setting or
field

Description

Configure
timeouts

Inactivity
timeout

When a client request is successfully authenticated, the appliance establishes an
active session with the client and as long as that session stays active, the appliance
will not attempt to reauthenticate requests from that client. This setting specifies
how long the client session can be inactive before the appliance terminates the
session; subsequent requests from that client will require authentication. By
default, the client can be inactive for 900 seconds (15 minutes).

Note: If the Challenge user after logout option is selected,
the appliance will automatically challenge the client for
credentials when the session becomes inactive. If you are
using a challenge method that prompts the user for
credentials, youmight want to clear this option.

Rejected
credentials
timeout

If you use Basic credentials and want to cache failed authentication attempts (to
reduce the load on the authentication service), enter the number of seconds. This
setting, enabled by default and set to one second, allows failed authentication
attempts to be automatically rejected for up to 10 seconds. Any Basic credentials
that match a failed result before its cache time expires are rejected without
consulting the back-end authentication service. The original failed authentication
result is returned for the new request. All failed authentication attempts can be
cached: Bad password, expired account, disabled account, old password, server
down. To disable caching for failed authentication attempts, set to 0.

Configure cookie
settings to specify
how the appliance
uses cookie
surrogates

Applicable if you
plan to use an
authentication
mode that uses
cookie
surrogates.

Use persistent
cookies

By default, this option is not selected, which means that the appliance will use
session cookies when creating a cookie surrogate for a client. Session cookies are
only valid during the current browser session and are deleted when the user
closes the browser.

The appliance must re-authenticate the client each time the user starts a new
browser session. If you select this option, the appliance will use persistent cookies
instead of session cookies. Persistent cookies are stored on the client system and
are therefore not deleted at the end of the browser session. When using persistent
cookies, the appliance will only need to re-authenticate a client when the cookie in
its surrogate credential database expires.

Verify the IP
address in the
cookie

By default, this option is selected, which means that the appliance will only accept
a cookie from a client if the client IP matches the IP address in the surrogate
cookie. To enable the appliance to accept cookies from IP addresses that do not
match the address in the cookie—for example, if you use DHCP—clear this option.
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Task
Setting or
field

Description

Set virtual URL Virtual URL (Transparent proxy only) Specify the URL to which to redirect client requests that
require authentication in the Virtual URL field. For best results, the virtual URL you
specify must:

n Contain a simple hostname that does not contain any dots (for example,
use http://myproxy rather than http://myproxy.acme.com.

n Resolve to the IP address of the appliance. To accomplish this, youmust
add an "A" record to your internal DNS server that associates the Virtual
URL with the IP address of the appliance.

Configure re-
authentication
after timeout

Challenge
user after
logout

(Optional) Select to prompt the client for authentication credentials whenever the
inactivity timeout expires.

Group
comparison
searchmethod

Group
comparison

Select the searchmethod:

n Local: The local method performs compare operations on the appliance
after retrieving the appropriate entries. Because the compares are
performed locally, this method typically reduces load on the LDAP server.

n Server: The server method queries the LDAP server for each compare
operation. If there are a large number of compares to perform, it can result
in significant server load.

There is a minute possibility that local compares can produce differing results
from server compares. If you suspect erroneous compare results, set to server.
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Configure LDAP Servers
After an LDAP authentication realm is created, youmust set LDAP realm properties according to your directory type.

To configure LDAP servers:

1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. In Realms:

n Select Add Realm > LDAP to add a new realm.

n Select an existing realm to edit it.

3. On the Add/Edit LDAP Realm page, in Advanced Settings, select Show.

4. In Servers, enter or edit the following as needed:

Setting or field Description

LDAP protocol
version

Select LDAP v3 or v2.

Follow
referrals

(LDAVP v3 only) Allow the client to follow referrals to other servers. (This feature is not available with
LDAP v2.) The default is Disabled.

Alternate
server

Specify the host and port for the alternate LDAP server.

Timeout
request after

Amount of time the appliance waits for an authentication response before timing out. Default value is
60 seconds.

Case sensitive Select if the LDAP server is configured to expect case-sensitive usernames and passwords.
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Define LDAP Authorization Properties
After creating an LDAP realm, providing at least the required fields of the LDAP server for that realm, and defining base
DNs for the realm, youmust define authorization properties for each LDAP realm you created.

Search Properties
You can enable the following types of LDAP searches:

n Anonymous searches, which allows a user to perform an LDAP search without entering a distinguished name.

The LDAP directory attributes available for an anonymous client are typically a subset of those available when a
valid user distinguished name and password have been used as search credentials.

n Authenticated searches, which require a search user DN to function properly.

ForMicrosoft Active Directory, youmust use the full name and not the login name.

Group Properties
Authorization decisions are completely handled by policy. The groups that the appliance looks up and queries are
derived from the groups specified in policy in group=, attribute=, ldap.attribute=, and has_attribute=- conditions. If
you do not have any of those conditions, then Symantec does not look up any groups or attributes to make policy
decisions based on authorization.

Objectclass Attribute Values
The objectclass attributes on an LDAP object define the type of object an entry is. For example, a user entry might
have an attribute value of person while a group entry might have an objectclass attribute value of group.

The objectclass attribute values defined on a particular entry can differ among LDAP servers. The attribute values are
not DNs of any kind.

Currently, the attribute values are used by Symantec during a VPM browse of an LDAP server. If an administrator wants
to browse the groups in a particular realm, the appliance searches the LDAP server for objects that have objectclass
attribute valuesmatching those in the group list and in the container list. The list of objectclass attribute values in the
container list is needed so that containers that contain groups can be fetched and expanded correctly.

Specify LDAP Authorization Properties
Define the search, group, and objectclass properties:
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1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. In Realms:

n Select Add Realm > LDAP Realm to add a new realm.

n Select an existing realm to edit it.

3. On the Add New /Edit LDAP Realm page, enter or edit the following as needed:
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Section Setting or
field

Description

Search Search Specify the type of search:

n Only authorized

To enforce user authentication before binding to the LDAP service, specify a user
distinguished name in the Search User DN field. This username can identify a single
user or a user object that acts as a proxy for multiple users (a pool of administrators, for
example). A search user distinguished name can be up to 512 characters long.

You can set a Password up to 64 alphanumeric characters long.

Note: Youmight want to create a separate user (such as
Symantec, for example) instead of using an Administrator
distinguished name and password.

n Anonymous search allowed

For example, with Netscape/iPlanet Directory Server, when anonymous access is
allowed, no username or password is required by the LDAP client to retrieve
information.

Some directories require a valid user to be able to perform an LDAP search; they do not
allow anonymous bind. (Active Directory is one such example.) For these directories,
youmust specify a valid fully-qualified distinguished username and the password that
permits directory access privileges. (For example,
cn=user1,cn=users,dc=symantec,dc=com is a possible fully-qualified distinguished
name.)

Dereference
aliases

Specify when to search for a specific object rather than search for the object’s alias:

n Always (default)

n Searching

n Finding

n Never
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Section Setting or
field

Description

Groups Membership
type and
Membership
attribute

The appliance enters defaults for the following LDAP directories:

n Microsoft Active Directory

Membership type: user

Membership attribute type: memberOf

n Netscape/Sun iPlanet

Membership attribute type: unique

Member Membership type: group

n Novell NDS eDirectory

Membership type: group

Membership attribute type: member

n Other

Membership type: user

Membership attribute type: member

Username
type to
lookup

(If membership type is Group) Select either FQDN or Relative. FQDN indicates that the lookup
is done only on the user object.

If membership type is User, FQDN is selected by default.

Nested
groups

Select if the LDAP server you use does not natively support groupmembership tests of nested
groups.

When a group of interest referenced within policy is part of a loop, User Authorization results in
Access Denied(policy_denied). For example, a loop forms if the groupmember Testgroup has
the nested groupmember Testgroup2, which in turn has the aforementioned Testgroup as a
nestedmember. When loops are removed from an LDAP server, the Nested Groups Support
optionmust be disabled and then re-enabled for the appliance to re-fetch the correct group
structure.Nested group attribute: For other, ad and nds, the default attribute is member. For
iPlanet, the attribute is uniqueMember.
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Section Setting or
field

Description

Group
constraint
filter

(Available if Nested groups is enabled) Enter a search limiting clause to reduce the number of
groups returned for an LDAP search. This feature is generally used only when the user wishes
to limit the scope of a comparison due to a very large number of groups. Constraints must be
valid LDAP search filters and are ANDed to the search filter when performing a group search.

Example 1: If you enter (cn=p*) into the Group constraint filter field, only groups starting with
the letter P are returned.

Example 2: If you enter (cn=proxy) into the Group constraint filter field, only the proxy group is
returned.

Note: The Group constraint filter functions only for local comparisons.
To enable local group comparisons, see "Configure LDAP Realm
Details" on page 369.

Object
Classes

Object type Select container, group, or user to display the defined object classes for the type.

You can edit an object class by updating its name and applying your changes.

Add Object
class

Select to add a new class to the selected type.
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RADIUS Realm Authentication and Authorization
RADIUS is often the protocol of choice for ISPs or enterprises with very large numbers of users. RADIUS is designed to
handle these large numbers through centralized user administration that eases the repetitive tasks of adding and
deleting users and their authentication information. RADIUS also inherently provides some protection against sniffing.

SomeRADIUS servers support one-time passwords. One-time passwords are passwords that become invalid as soon as
they are used. The passwords are often generated by a token or program, although pre-printed lists are also used. Using
one-time passwords ensures that the password cannot be used in a replay attack.

The Edge SWG (ProxySG) appliance’s one-time password support works with products such as Secure Computing
SafeWord synchronous and asynchronous tokens and RSA SecurID tokens.

The appliance supports RADIUS servers that use challenge/response as part of the authentication process. SafeWord
asynchronous tokens use challenge/ response to provide authentication. SecurID tokens use challenge/response to
initialize or change PINs.

The challenge is displayed as the realm information in the authentication dialog; Symantec recommends that you use
form authentication if you create a challenge/response realm, particularly if you use SecurID tokens.

If you set an authenticationmode that uses forms, the systemdetects what type of question is being asked. If it is a
yes/no question, it displays the query formwith a yes and no button. If it is a new PIN question, the systemdisplays a
formwith entry fields for the new PIN.

Using policy, you can fine-tune RADIUS realms based on RADIUS attributes. If you use the Symantec attribute, groups
are supported within a RADIUS realm. RADIUS authentication is compatible with administrative authentication for the
appliance Admin Console.

See Also:

n "Configure a RADIUS Authentication Realm " on the next page
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Configure a RADIUS Authentication Realm
To configure a RADIUS authentication realm:

1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. In Realms:

n Select Add Realm > RADIUS to add a new realm.

n Select an existing realm to edit it.

3. On the Add New/Edit IWA Realm page, enter or edit the following as needed:

Setting or
field

Description

Realm name Unique name for the realm. The name can be 32 characters long and composed of alphanumeric
characters and underscores. The name must start with a letter.

Primary
Server

Specify the IP address for the primary RADIUS server.

Port Specify the port for the primary RADIUS server. The default port is 1812.

Secret Specify the RADIUS secret. RADIUS secrets can be up to 64 characters long and are always case-
sensitive.

Advanced
Settings

Select Show to specify custom settings:

n "Configure RADIUS Servers " on page 384

n "Configure RADIUS Realm Details" on the facing page

Test
Configuration

(Only available when editing) Select to test the configuration.

When prompted, enter the username and password of a user in the Windows domain and selectOK.
The appliance sends an authentication request to the configured server and then displays a message
indicating whether the authentication succeeded or failed. If the test failed, go back andmake sure you
have configured the realm properly. If the test succeeds, the message also displays a list of any groups
of interest (that is, groups that are referenced in policy) to which the user belongs.
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Configure RADIUS Realm Details
Once you have created the RADIUS realm, you can change the primary host, port, and secret of the RADIUS server for
that realm.

To configure RADIUS realm details:

1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. In Realms:

n Select Add Realm > IWA to add a new realm.

n Select an existing realm to edit it.

3. On the Add/Edit IWA Realm page, in Advanced Settings, select Show.

4. In the sections that appear, enter or edit the following as needed:

Task
Setting or
field

Description

Set display
name

Display
name

(Optional) By default, the appliance displays the authentication realm name when
prompting the user for authentication credentials.

Configure
refresh times
for Basic
credentials

Use the
same
refresh
time for
all

Select to use the same time for credential refresh and surrogate refresh.

Credential
refresh
time

Specifies the amount of time the appliance will cache Basic credentials (username and
password) and use these cached credentials to authenticate the user rather than sending
another request to the authentication server. By default, basic credentials are good for
900 seconds (15 minutes).

Before the refresh time expires, the appliance authenticates the user supplied credentials
against the cached credentials. If the credentials received do not match the cached
credentials, they are forwarded to the authentication server in case the user password
changed. After the refresh time expires, the credentials are forwarded to the
authentication server for verification.

Surrogate
refresh
time

(Unavailable if set to use the same refresh time for all) After the appliance successfully
authenticates a client, it caches the client’s IP address or a cookie (depending on the
authenticationmode that is in use) in its surrogate cache. If it receives subsequent
requests from the same client during the surrogate refresh time, it uses the IP address or
cookie in its cache to authenticate the user instead of sending a request to the
authentication server. By default, the surrogate credential is good for 900 seconds (15
minutes).
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Task
Setting or
field

Description

Configure
timeouts

Inactivity
timeout

When a client request is successfully authenticated, the appliance establishes an active
session with the client and as long as that session stays active, the appliance will not
attempt to reauthenticate requests from that client. This setting specifies how long the
client session can be inactive before the appliance terminates the session; subsequent
requests from that client will require authentication. By default, the client can be inactive
for 900 seconds (15 minutes).

Note: If the Challenge user after logout option is selected, the
appliance will automatically challenge the client for credentials
when the session becomes inactive. If you are using a challenge
method that prompts the user for credentials, youmight want to
clear this option.

Rejected
credentials
timeout

Specifies whether to cache failed authentication attempts (bad password, expired account,
disabled account, old password, or server down). If the client attempts to connect again
during the rejected credentials time, the appliance will automatically reject the request for
the specified period of time. Enter a value from 1 second (the default) to 10 seconds. To
disable this option, enter 0.

Configure
cookie
settings to
specify how
the appliance
uses cookie
surrogates

Applicable if
you plan to
use an
authentication
mode that
uses cookie
surrogates.

Use
persistent
cookies

By default, this option is not selected, which means that the appliance will use session
cookies when creating a cookie surrogate for a client. Session cookies are only valid
during the current browser session and are deleted when the user closes the browser.

The appliance must re-authenticate the client each time the user starts a new browser
session. If you select this option, the appliance will use persistent cookies instead of
session cookies. Persistent cookies are stored on the client system and are therefore not
deleted at the end of the browser session. When using persistent cookies, the appliance
will only need to re-authenticate a client when the cookie in its surrogate credential
database expires.

Verify the
IP address
in the
cookie

By default, this option is selected, which means that the appliance will only accept a cookie
from a client if the client IP matches the IP address in the surrogate cookie. To enable the
appliance to accept cookies from IP addresses that do not match the address in the
cookie—for example, if you use DHCP—clear this option.

Set virtual
URL

Virtual
URL

(Transparent proxy only) Specify the URL to which to redirect client requests that require
authentication in the Virtual URL field. For best results, the virtual URL you specify must:

n Contain a simple hostname that does not contain any dots (for example, use
http://myproxy rather than http://myproxy.acme.com.

n Resolve to the IP address of the appliance. To accomplish this, youmust add an "A"
record to your internal DNS server that associates the Virtual URL with the IP
address of the appliance.
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Task
Setting or
field

Description

Configure re-
authentication
after timeout

Challenge
user after
logout

(Optional) Select to prompt the client for authentication credentials whenever the inactivity
timeout expires.
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Configure RADIUS Servers
After creating a RADIUS authentication realm, you can change the primary host, port, and secret of the RADIUS server
for the realm.

To configure RADIUS servers:

1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. In Realms:

n Select Add Realm > RADIUS to add a new realm.

n Select an existing realm to edit it.

3. On the Add/Edit RADIUS Realm page, in Advanced Settings, select Show.

4. In Servers, enter or edit the following as needed:

Setting or field Description

Alternate
server

Specify the host and port for the alternate RADIUS server.

Secret Specify the RADIUS secret. RADIUS secrets can be up to 64 characters long and are always case-
sensitive.

Encode
credentials
with character
set

Select the character set used for encoding credentials; the RADIUS server needs the same character
set.

A character set is a Multipurpose Internet Mail Extension (MIME) charset name. Any of the standard
charset names for encodings commonly supported by Web browsers can be used. The default is
Unicode:UTF8.

Timeout
request after

Enter the amount of time the appliance waits for an authentication response before timing out.
Default value is 10 seconds.

Retry Specify the number of attempts you want to permit before marking a server offline.

The client maintains an average response time from the server; the retry interval is initially twice the
average. If that retry packet fails, then the next packet waits twice as long again. This increases until it
reaches the timeout value. The default number of retries is 10.

One-time
passwords

Enable if you created a challenge/response realm.

Case sensitive Select if the RADIUS server is configured to expect case-sensitive usernames and passwords.
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SAML Realm Authentication and Authorization
SAML 2.0 was developed by theOASIS Security Services Technical Committee.

It is an industry standard for retrieving authorization and identity information in XML documents to facilitate single sign-
on (SSO) applications or services on the Internet. In SAML authentication, the exchange of information is performed by
the following entities:

n Identity providers (IDPs), which are identity stores. For example, an IDPmay have a back-end directory of users.
The IDP authenticates the users. Supported IDPs are listed in "Requirements for SAML Authentication" on the
next page.

n Service providers (SPs), which provide access to applications or services to users. It is the entity that creates an
authenticated session for the user.

With SAML authentication, the Edge SWG (ProxySG) appliance acts as the service provider. SAML realms are not
compatible with administrative authentication to the appliance Admin Console.

Note: This document assumes that you are familiar with SAML concepts and practices.

About SAML
The following sections provide conceptual information youmust understand before configuring SAML:

Federation and Metadata

The entities (IDP and SP) must federate before authentication can occur. During federation, configuration data is
exchanged inmetadata files. Each entity publishes information about itself in these files and publishes them to a specific
location, for example, on the internet or a network drive. When the entities sharemetadata, they establish and agree on
the parameters that they will use for authentication requests and responses. They also share information such as:

n Entity IDs, which entities use to identify themselves to each other. For example, the Entity ID tells the IDP if an
authentication request comes from a federated relying party.

n The SSO POST endpoint and SSO redirect endpoint to which entities send assertions during authentication. (See
"Assertions" on the next page formore information.)

n Each entity’s public key certificate, which is used to validate assertions.

n Whether each entity requires encryption. If one of the entities requires encrypted assertions, it will publish a
separate encryption certificate.
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Note: The appliancemay consume encrypted assertions from the IDP, but it does not
encrypt authentication requests that it sends to the IDP.

Assertions

The Edge SWG (ProxySG) appliance and the IDP exchange data in XML documents called assertions. After a user is
authenticated, the IDP sends an authentication assertion and the appliance establishes an authenticated session with
the appropriate authorization for the user.

The appliance processes SAML authentication responses from the IDP; these responsesmay contain assertion attributes
that describe the authenticated user.

For example, <saml:Attribute Name="mail"> is an assertion attribute that contains the user’s email address inside the
<saml:AttributeValue> element.

You can configure the appliance to use assertion attributes in authorization decisions. Formore information on
attributes, see "Configure SAML Attributes" on page 398.

Profiles and Bindings

A profile contains information about how SAML supports a defined use case. For example, theWeb Browser SSO Profile
enables single sign-on authentication for resources on the internet.

SAML 2.0 includes protocol-specific bindings, which describe how SAML data is exchanged over those protocols. SAML
authentication supports the following for theWeb Browser SSO Profile:

n TheHTTP POST binding for authentication responses

n TheHTTP POST binding and the redirect binding for authentication requests

Requirements for SAML Authentication
Setting up a SAML realm for the Edge SWG (ProxySG) appliance requires one of the following IDPs:

n Microsoft® Active Directory Federation Services (AD FS) 2.0

Note: ADFS 1.0 ships withWindows Server 2008. If you want to use the SAML realm
with AD FS, youmust download AD FS 2.0 from theMicrosoft website and install it.

n CA SiteMinder® Federation Partnership R12

n Oracle® Identity Federation 11g

n Shibboleth 2.3.5

386 of 676



SGOS Administration (Admin Console Edition)

Checklist: Preparing the IDP
Before you set up a SAML realm,make sure that you have done the following for your IDP:

n Installed and configured the administration software.

n Set up the identity store for authentication.

n Identified the default user attribute to be passed in SAML assertions, for example, the User Principal Name
attribute in LDAP.

n Identified any additional attributes that you want to be passed in assertions, for example, thememberOf
attribute, which identifies the groups of which a user is a direct member in LDAP.

n Determined the location (URL) of the IDP’smetadata file. This is needed to complete the steps in "Configure a
SAML Realm " on page 396. If you import metadata, the realm uses its preconfigured settings. See "SAML Realm
Authentication and Authorization" on page 385 for instructions on locating themetadata file for the IDP.

Note: To import SiteMinder and Oraclemetadata, use the #(config saml <realm_
name>)inline idp-metadata <XML> CLI command.
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SAML Authentication Process
After you have defined and configured a SAML realm, and both entities have federated and exchangedmetadata,
authentication can occur.

The following example is an overview of what happens when a user goes to awebsite that requires authentication.

Step 1: Initial user request

The appliance intercepts the user’s request and redirects theweb browser to the IDP. The redirect URL includes the
SAML authentication request that should be submitted to the IDP’s SSO service. If theDisable Client Redirects check
box is checked, the appliance does not redirect the client to the IDP.
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Step 2: Authentication request and response

The IDP asks the appliance for the user’s credentials, for example by asking for valid login credentials or checking for
valid session cookies for stored credentials. If the appliance responds with valid credentials, the IDP:

n Signs an authentication responsewith its private signing key. If the IDP has been configured to send encrypted
assertions, the IDP encrypts the assertion before sending it to the appliance.

n Sends the authentication response to the appliance, which contains the user's username (however, the appliance
is not aware of the user’s credentials).

Step 3: Assertion decryption and validation

If the assertion is encrypted, the appliance decrypts it. The appliance rejects any unsigned assertions.

The appliance validates the assertion and then retrieves the user’s name and groupmemberships (as specified in
assertion attributes) from the assertion using the private key.
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Step 4: User request validation

The appliance validates the user request using the corresponding public key, which is embedded in the IDP's signing
certificate. Then, the appliance redirects the user to thewebsite and creates an authenticated session for the user.
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Overview: SAML Realm Configuration
Perform the following steps to set up a SAML realm.

Task # Task Reference(s)

1 Save a local copy of the IDP's configuration data. "Export the IDP Metadata File" on the
next page

2 Prepare the appliance for SAML authentication:

n Import certificates to the CCL.

n Set up an HTTPS reverse proxy service.

Note: This is required only if the SAML realm is using an
HTTPS POST endpoint.

n (If needed) Define assertion attributes.

n Configure the SAML realm.

"Prepare the Edge SWG (ProxySG)
Appliance" on page 394

"Configure a SAML Realm " on page 396

"Configure SAML Attributes" on page 398

"Configure SAML Realm Details" on
page 400

3 (Optional) To authorize users through one or more SAML
realms, specify the criteria to use when searching for users.

"Configure SAML Authorization" on
page 404

4 Configure your specific IDP. Refer to the appropriate section in the
documentation at Tech Docs.

n "Configure AD FS"

n "Configure SiteMinder"

n "Configure Oracle"

n "Configure Shibboleth"

5 Include the SAML realm in your policy. Refer to "Add the SAML Realm to Policy"
in the documentation at Tech Docs.
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Export the IDP Metadata File
You can export the IDP metadata file and import it via local file or remote URL to the SAML realm configuration.

To export the IDPmetadata file, log in to the IDP’s administration software.

Exporting IDPmetadata entails saving the XML document to disk. It is important to save themetdata file without
opening it in a browser first. Browsers do not necessarily support XML file structure andmay change the XML tags.

If you use SiteMinder, Oracle, or Shibboleth, you will need to copy and paste themetadata file contents to the CLI using
the inline idp-metadata command.

Because XML files are text-based, it is best to use a text editor such as Notepad to open the file to copy its contents.

Note: To ensure that the SAML realm is configured correctly, import metadata instead of
entering the informationmanually. If there are issues with realm configuration, the
Authentication debug log shows the following error: The SAML realm configuration is
invalid.

Export Metadata from AD FS

To export metadata fromAD FS:

1. Log in to the AD FSMMC.

2. Select Endpoints and look underMetadata for theURL beside the FederationMetadata type.

3. Copy theURL and paste it into a browser address bar.

4. Save the XML file to a location that the appliance can access.

Export Metadata from SiteMinder

Before you can export metadata, make sure that you have created a SAML 2.0 IDP. This assumes that you have already
created the IDP (entity) in SiteMinder.

To export metadata from SiteMinder:

1. Log in to the CA FederationManager.

2. Select Federation > Entities.

3. Beside the entity you created, select Action > Export Metadata.

4. In the Partnership Name field, enter a name to identify the partnership between the appliance and SiteMinder.
You will refer to this partnership name later, when you configure the partnership in SiteMinder.
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5. Select Export. SiteMinder generates themetadata document.

6. Save the XML file to a location that the appliance can access.

Export Metadata fromOracle

To export metadata fromOracle:

1. Log in to theOracle EnterpriseManager.

2. In the navigation tree on the left, select Identity and Access > OIF.

3. On themain page, select Oracle Identity Federation > Administration > Security and Trust.

4. Select the Provider Metadata tab.

5. In theGenerateMetadata section, select Identity Provider from the Provider Typemenu.

6. Select SAML 2.0 from the Protocolmenu.

7. Select Generate. OIF generates themetadata document.

8. Save the XML file to a location that the appliance can access.

Export Metadata from Shibboleth

To export data from Shibboleth:

1. On the server where Shibboleth is installed, browse to the <shibboleth>/metadata folder.

2. Copy the idp-metadata.xml file.

3. Save the XML file to a location that the appliance can access.

See Also:

n "Configure a SAML Realm " on page 396
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Prepare the Edge SWG (ProxySG) Appliance
Complete the following steps to prepare the appliance for SAML authentication.

Configure the CCL
The appliance CCL must contain at least a root certification authority (CA) certificate, but depending on other
considerations, youmay requiremore certificates. Refer to the following list to determinewhich certificates youmust
import to the CCL.

n Root CA certificate: Required; add the certificate for the root CA that issued the IDP‘s signing certificate to the CCL.

n IDP’s signing certificate: Required if self-signed; if the IDP’s signing certificate is self-signed, add it to the CCL.
Certificates signed by the CA are included in SAML assertions.

n Intermediate CA certificate: Optional; youmust import intermediate CA certificates to the appliance, but it is not
necessary to add them to the CCL. For instructions on importing certificates to the appliance, see "Import
Keydata" on page 273.

Note: In explicit deployments, if you do not add the certificate for the CA that issued the
IDP’s certificate to the appliance's CCL, HTTPS connections to the IDP fail.

Create an HTTPS Reverse Proxy Service
You should create an HTTPS reverse proxy service only if the SAML realm uses an HTTPS, rather than HTTP, POST
endpoint.

Determinewhether to use an HTTP or HTTPS POST endpoint:

n If you use AD FS, the POST endpoint must useHTTPS. If you use SiteMinder or Oracle, the POST endpoint can use
either HTTPS or HTTP.

n For better security, use an HTTPS POST endpoint.

Note: Regardless of which IDP you use, use an HTTPS POST for best security.

Create an HTTPS reverse proxy service to act as the SAML realm’s HTTPS POST endpoint. The IDP redirects browsers to
this servicewhen it creates assertions. SSL connections require a certificate and a private key. Browsersmust trust the
certificate that theHTTPS reverse proxy service uses, and the certificate’s Subject valuemust match theVirtual URL
configured in the SAML realm (see "Configure a SAML Realm " on page 396). If the names do not match, SSL hostname
mismatch errors occur.

To create theHTTPS reverse proxy service, see "Configure an HTTPS Reverse Proxy" on page 185.

394 of 676



SGOS Administration (Admin Console Edition)

See Also:

n "Configure a SAML Realm " on the next page
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Configure a SAML Realm
Before proceeding, make sure you have saved a local copy of the IDP's configuration data (see "SAML Realm
Authentication and Authorization" on page 385) and prepared the Edge SWG (ProxySG) appliance (see "Prepare the Edge
SWG (ProxySG) Appliance" on page 394).

To configure a SAML authentication realm:

1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. In Realms:

n Select Add Realm > SAML to add a new realm.

n Select an existing realm to edit it.

3. On the Add New/Edit SAML Realm page, enter or edit the following as needed:

Setting or field Description

Realm name Unique name for the realm.

Virtual URL Specify the hostname for the SAML endpoint; in other words, point to the HTTPS reverse proxy
listener you set up.

Enter the host and port in format https://<hostname_or_IP_address>:<port_number>. The hostname
must match the name of the SSL certificate for the HTTPS reverse proxy service. See "Create an
HTTPS Reverse Proxy Service" on page 394.
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Setting or field Description

Federated IDP

Import IDP
metadata or
configure the IDP
manually

You can import IDP metadata from a file saved locally or on a remote server. Complete "Export
the IDP Metadata File" on page 392 before proceeding.

To import the IDP metadata file, save the current SAML realm first. Then, edit the realm and select
Import metadata from text.

n If you exported the IDP metadata file to the local computer, select Local File and browse to
the file

n If you exported the IDP metadata file to an FTP or HTTP server, select Remote URL and
enter the URL.

Note: Importing metadata will overwrite any manually-entered IDP
values.

To configure the IDP manually, specify the following settings:

n Entity ID: SAML entity ID.

n POST URL: SSO POST endpoint.

n Redirect URL: SSO redirect endpoint.

n CCL: Select the trusted CCL created in "Configure the CCL" on page 394.

n Allowed Signing ECL: (Optional) Select a configured external certificate list. See "Manage
External Certificate Lists" on page 284.

Attributes and
Attributes
Definitions

See "Configure SAML Attributes" on the next page.

Advanced Settings Select Show to specify realm details and authorization settings:

n "Configure SAML Realm Details" on page 400

n "Configure SAML Authorization" on page 404
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Configure SAML Attributes
The appliancemaps policy conditions to assertion attribute values. If you requiremore attributes than the ones included
in SAML assertions, you can define them in the SAML realm.

You can forward SAML assertion attributes via customheaders to back-end or front-end servers using the SAML
Attribute VPM object. Refer to the Visual Policy Manager Reference for instructions on using this object in policy.

To configure SAML attributes:

1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. In Realms:

n Select Add Realm > SAML to add a new realm.

n Select an existing realm to edit it.

The console displays the Add New/Edit SAML Realm page.

3. In the Attribute Definitions section, select Add Attribute. The console displays the Add Attribute dialog.

4. Enter ormodify your own attribute definitions:

n Attribute Name: The name of the attribute as it appears in the appliance and IDP configuration, and
when referring to the attribute in the attribute.<name>= policy condition. The namemust be unique.

n Attribute Data Type: Select String (Ignore Case) or Case (Exact Case). The appliance uses this setting
to match assertion attribute values with policy conditions.

n SAML Name: The name of the attribute as it will appear in assertions from the IDP, in theName= XML
attribute of the <Attribute> element. For example, an assertionmight include the line <saml:Attribute
Name="mail"> wheremail is the SAML attribute name.

Select Add orUpdate to save the attribute definition.

5. In the Attributes section, specify the attribute definition to use for the following attributes:

n User Attribute: Attribute containing the relative username. If you do not specify the attribute, the
appliance uses the SAML Name ID value for the username.

n Fullname Attribute:Attribute containing the full username.

n Group Attribute: Name of the groupmembership attribute. Values of this attributematch the group=
policy condition.

n Email Address Attribute: Attribute that represents the user's email address. Formore information, refer
to KB article 169260.
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See Also:

n "Configure a SAML Realm " on page 396

SAML Attribute Substitutions
You can forward SAML attributes, including the user name, in SAML 2.0 assertions through HTTP headers to back-end
servers by creating substitution policy. The SAML substitution uses the following CPL syntax:

$(saml.attribute.<name>)

To forward SAML attributes using substitution policy:

1. In the SAML realm configured on the appliance, define the attribute you want to forward.

Note: If you remove an attribute that is referenced in policy, the appliance issues a
warning the next time that policy is compiled.

2. In theWeb VPM, add aWeb Access layer.

3. In the Source column, add a SAML Attribute object that specifies the attribute to forward.

Note: If the attribute you specify does not exist in the SAML realm, the appliance
issues awarning when it compiles policy.

4. In the Action column, add a Control Request Header or Control Response Header object. Select Set Value
and enter the substitution:

$(saml.attribute.<name>)

where <name> is the name of the attribute to forward.

5. Install the policy.

6. After you install the substitution policy, the appliance evaluates the configured policy rules andmodifies theHTTP
request/response headers with the additional x-header fields corresponding to attribute nameswith the attribute
values. When the appliance compiles policy, it validates the field attribute <name> against configured SAML
attributes.

Note: You can alternatively add the substitution policy through the #inline policy
command or CPL. For information on thosemethods, refer to the Command Line
Interface Reference and the Content Policy Language Reference, respectively.
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Configure SAML Realm Details
To configure SAML realm details:

1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. In Realms:

n Select Add Realm > SAML to add a new realm.

n Select an existing realm to edit it.

3. On the Add/Edit SAML Realm page, in Advanced Settings, select Show.

4. In the sections that appear, enter or edit the following as needed:

Task
Setting or
field

Description

Set display name Display
Name

(Optional) By default, the appliance displays the authentication
realm name when prompting the user for authentication
credentials.

Configure refresh times for Basic
credentials

Use the Same
Refresh Time
For All

Select to use the same time for credential refresh and
surrogate refresh (in seconds). Otherwise, specify different
refresh times for credentials and surrogates.
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Task
Setting or
field

Description

Configure timeouts Inactivity
Timeout

When a client request is successfully authenticated, the
appliance establishes an active session with the client and as
long as that session stays active, the appliance will not attempt
to reauthenticate requests from that client. This setting
specifies how long the client session can be inactive before the
appliance terminates the session; subsequent requests from
that client will require authentication. By default, the client can
be inactive for 900 seconds (15 minutes).

Note: If this option is selected, the appliance
will automatically challenge the client for
credentials when the session becomes
inactive. If you are using a challenge method
that prompts the user for credentials, you
might want to clear this option.

Rejected
Credentials
Timeout

Specifies whether to cache failed authentication attempts (bad
password, expired account, disabled account, old password, or
server down). If the client attempts to connect again during the
rejected credentials time, the appliance will automatically reject
the request for the specified period of time. Enter a value from
1 second (the default) to 10 seconds. To disable this option,
enter 0.

Configure cookie settings to specify
how the appliance uses cookie
surrogates

Applicable if you plan to use an
authenticationmode that uses cookie
surrogates.

Use
Persistent
Cookies

Select to use persistent cookies.

Verify the IP
Address in
the Cookie

Select to enable verification of cookies' IP addresses.

Configure re-authentication after
timeout

Challenge
User After
Logout

(Optional) Select to enable challenging after logout. For
example, if this setting is enabled and a user logs out of a web
site, the user must enter credentials again the next time they
access the web site.
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Task
Setting or
field

Description

Define limits for assertions’
timestamps. Assertions with
timestamps that fall outside of these
limits are invalid.

Not Before (Optional) Specify an interval before the current time.
Assertions stamped before this interval are invalid. In the Not
before field, specify the number of seconds. The default value is
60.

Not After (Optional) Specify an interval after the current time. Assertions
stamped after this interval are invalid. In the Not after field,
specify the number of seconds. The default value is 60.

Manage encrypted assertions Encryption
Keyring

(Optional) Select the keyring to use for decrypting encrypted
assertions.

Require
Encryption

(Optional) Select to require that assertions from the IDP be
encrypted. If selected, the appliance rejects unencrypted
assertions.

Note: As long as the encryption keyring is
configured, the appliance attempts to decrypt
encrypted assertions whether or not the
Require encryption check box is marked.

Configure redirect behavior Disable
Client
Redirects

(Optional) If the client cannot be redirected to, or communicate
directly with, the IDP—for example, if a firewall exists between
users and the IDP—select this option to disable the appliance’s
ability to redirect the browser to the IDP for authentication.
When you disable client redirects, the appliance handles all
communication with the IDP and OCS on behalf of the client.

Prefix IDP
Cookies

(If you selectedDisable Client Redirects)  Determine if you
want to prevent the appliance from adding a BCSI-SWR- prefix
to IDP cookies; this prefix prevents IDP cookies and OCS cookies
from having the same name.

Clear the Prefix IDP Cookies option if you do not want to add
the prefix to cookies.

Specify SSL device profile for when
the redirect/POST URL uses HTTPS

SSL Device
Profile

(Optional) Select an SSL device profile to use to communicate
with the IDP when the redirect/POST URL uses HTTPS.
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See Also:

n "Configure a SAML Realm " on page 396
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Configure SAML Authorization
You can authorize users through one ormore SAML realms and specify the criteria to usewhen searching for users.

To configure SAML authorization:

1. In the Admin Console, select Configuration > Authentication > Realms and Domains.

2. In Realms:

n Select Add Realm > SAML to add a new realm.

n Select an existing realm to edit it.

The console opens the Add/Edit SAML Realm page.

3. In the Authorization section, the Authorization Realm option is set to Self by default. To authorize with the
current realm, leave this option selected. When set to Self, the authorization username is set automatically toUse
FQDN.

Note: If you use LDAP for authorization andUse FQDN is selected, ensure that the
SAML fullname attribute (see "Configure SAML Realm Details" on page 400) contains
the user's distinguished name. Later, youmust also configure the IDP to send the
distinguished name in assertions.

To authorize with another realm, select Selected. Enter or edit the following as needed:

Task Setting or field Description

Select the realm with which to
authorize.

Authorization
Realm Name

Select a configured authorization realm.
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Task Setting or field Description

Select one of the options for the
authorization username.

Custom username Enter the username in the Username field.

Use FQDN Use the fully-qualified domain name (FQDN).

Determine by
search

Determine the username by LDAP search. Specify the
following.

n LDAP Search Realm Name: Enter the name of the
LDAP search realm.

n Search Filter: Specify the LDAP search filter.

n User Attribute or FQDN: Specify either the LDAP
attribute name or the FQDN as the username
attribute for search results.

n Add User to Ignore: Add, edit, or remove
usernames from the list of users to ignore when
determining authorization.

See Also:

n "Configure a SAML Realm " on page 396

Policy Conditions
The appliance uses existing policy conditions to make authorization decisions for the user.

n group=

This conditionmaps to the values of the SAML group attribute setting specified in the realm.

n attribute.<name>=

This conditionmaps to the values of the Attribute name setting specified in the realm.

n saml.attribute.<saml_attribute_name>=

This condition compares strings with the value of the SAML assertion attribute obtained from the user's entry.

In the VPM, you can use the SAML Attribute and Control Request/Response Header objects in conjunction
to forward SAML assertion attributes via customheaders to back-end or front-end servers. Refer to "Configure
SAML Attributes" on page 398 for instructions.
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Considerations
Refer to the following considerations when using a SAML realm.

Preventing Dropped Connections When Policy is Set to Deny
Usersmight experience dropped connections if the appliance uses the default policy of Deny. When the policy is set to
Deny, the appliance intercepts and denies requests to the IDP.

To prevent dropped connections due to this limitation, install the following policy to allow requests to the IDP:

<Proxy>
authenticate(<realm-name>)

<Proxy>
allow group=saml_users

<Proxy>
allow url.host=<hostname>

In the policy example above, <realm-name> is the name of the SAML realm and <hostname> is the hostname of the
IDP.

Backing Up Configuration
Youmay need to back up the Edge SWG (ProxySG) configuration and save the backup file (called an archive) on a remote
system, which you can restore in the unlikely event of system failure or replacement. Formore information on
configuration backups, refer to "Backing Up the Configuration" in the SGOS Administration Guide.

Save Keyrings Before Backing up the Configuration

Backing up the configuration does not automatically save keyring data; thus, youmust save all keyrings and certificates
before creating a configuration archive.

To save keyrings before backup:

1. In the command line interface (CLI), enter configurationmode and issue the following command:

#(config ssl)show ssl keypair <keyring_name>

2. Copy and paste the output from the command into a text editor. You will copy and paste this text into the CLI
after you restore the appliance.

Import Saved Keyrings After Restoring the Configuration

After restoring the appliance, but before applying the archived configuration, issue the following CLI command:
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#(config ssl)inline keyring show <keyring_name> <eof marker>
<copy and paste text here>
<eof marker>

You should now be able to apply the archived configuration without having to create and import a new keyring.

Re-Import the Appliance Certificate to the Trust List (AD FS)

In order to establish an HTTPS connection to the appliance, AD FSmust trust the default certificate set in the Admin
Console; however, after you back up and restore a configuration archive, youmust re-import the certificate to AD FS. For
instructions, refer to "Import the Appliance Certificate to AD FS’s Trust List" in the SGOS Administration Guide.

407 of 676



SGOS Administration (Admin Console Edition)

Manage the SSH Console
By default, the appliance uses Secure Shell (SSH) and password authentication so administrators can access the CLI
securely. SSH is a protocol for secure remote logon over an insecure network.

Authentication for administrative users connecting to the appliance via SSH can be controlled with the following
authentication types:

n The predefined admin account

n Local authentication realm

n IWA authentication realm

n LDAP authentication realm

n Localized RSA key

Whenmanaging the SSH console, you can:

n Generate or re-generate SSH host keys

n Specify the SSHv2 algorithm

n Create or remove client keys and Director keys

n Specify a welcomemessage for clients accessing the appliance using SSHv2

See Also:

n "Manage theHost Key Pairs" on page 410

Manage Host Key Pairs for the SSH Console
You can create SSHv2 RSA, ECDSA, or Ed25519 keys to secure the SSH console. See "Manage theHost Key Pairs" on
page 410.

Create a Welcome Banner for SSH
Awelcome banner provides notice to users of computer networks, computers, and other systems and resources. Users
are required to accept the terms in the banner prior to authentication. The banner is often presented to users before a
login process, and it requires users to acknowledge and agree to themessage before they can log in or access resources
on the network.

To create awelcome banner for the SSH console, enter the text in theWelcome Banner field.

Refer to theNotice and Consent Banner documentation formore information, including samples of CPL that you can
use:
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https://techdocs.broadcom.com/us/en/symantec-security-software/web-and-network-security/proxysg/7-
3/main/create_banner.html

Manage Ciphers and HMACs
The Admin Console (select Configuration > Authentication > SSH Inbound Connections and go to Ciphers) shows
the current list of SSH ciphers for inbound connections, including any ciphers you added explicitly and excluding any you
removed explicitly. TheHMACs section shows the current list of Hash-basedMessage Authentication Code algorithms
(HMACs), including any HMACs you added explicitly and excluding any you removed explicitly.

To make add, remove, ormake other changes to the selected ciphers or HMACs, see "Manage SSH Ciphers for Inbound
Connections" on page 414 and "Manage SSH HMACs for Inbound Connections" on page 417.
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Manage the Host Key Pairs
Tomanage the SSH host, select Configuration > Authentication > SSH Inbound Connections, and go to theHost
Keys section.

Note: For best security, key pairs are SSHv2 only; make sure that port 22 is available. You
do not need to create a new host key unless you want to change the existing
configuration.

Create a Host Key Pair
To create an SSHv2 host key pair:

1. Select Generate. A Generate Host Key dialog appears.

2. In the dialog, select the key type and strength:

Host Key Type Strength

RSA Select one of:

n 2048 (default)

n 3071

n 4096

ECDSA Select one of:

n nistp256

n nistp384

n nistp521 (default)

Ed25519 N/A

3. Select Generate. The host key is created and saved immediately.

Note: If you receive an errormessagewhen attempting to log in to the system after
regenerating the host key pair, locate the ssh known hosts file and delete the previous
entry for the Edge SWG (ProxySG) appliance.

You can create a host key pair in the CLI using the #(config ssh-console) create host-keypair command. Refer to
the Command Line Interface Reference for details on this command.

410 of 676



SGOS Administration (Admin Console Edition)

Delete a Host Key Pair
To delete a host key pair, select the delete option in the respective section. On the dialog that appears, select Delete to
confirm the deletion. The key pair is deleted immediately.

Disabling all key pairsmight lock you out of the Edge SWG (ProxySG) CLI (for example you receive amessage such as
“could not agree on a host key algorithm”). If this occurs, re-create an SSH key pair through a serial connection or
through the Admin Console.
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Manage SSH Client Keys for Inbound Connections
You can import multiple RSA client keys on the appliance to provide public key authentication, an alternative to using
password authentication. An RSA client key can only be created by an SSH client and then imported onto the appliance.
Many SSH clients are commercially available for UNIX andWindows.

To import the client keys, copy them from your SSH client and import them to the appliance via the CLI. Refer to the
Command Line Interface Reference.

Note: The appliance cannot create client keys. Youmust use your SSH client to create a
key.

After you create an RSA client key following the instructions of your SSH client, you can import the key onto the
appliance using either the Admin Console or the CLI.

About the OpenSSH.pub Format
The Edge SWG (ProxySG) appliance consumes the client key in theOpenSSH.pub format.

The end of theOpenSSH.pub format has a space followed by the username andmachine in the form username@machine,
as shown below:

ssh-rsa AAAAB3NzaC1yc2EAAAABIwAAAIEAwFI78MKyvL8DrFgcVxpNRHMFKJrBMeBn
2PKcv5oAJ2qz+uZ7hiv7Zn43A6hXwY+DekhtNLOk3HCWmgsrDBE/NOOEnDpLQjBC6t/
T3cSQKZjh3NmBbpE4U49rPduiiufvWkuoEiHUb5ylzRGdXRSNJHxxmg5LiGEiKaoELJfs
DMc= username@machine

username@machine is the username and themachine fromwhich the client connects, and it is referred to as the key_id
on the Edge SWG (ProxySG) CLI. Each key_idmust be unique in the Edge SWG (ProxySG) configuration.

Notes

n If you created the key on Linux using the ssh-keygen -t rsa command, the key is likely already in the OpenSSH
format.

n 4096 bits is themaximum supported key size.

n The ssh-rsa prefix is required.

n When importing the client key, remove trailing newlines.

Viewing RSA Client Keys
You can view imported RSA client keys in the Admin Console. Client keys providemore secure authentication compared
to user name/password authentication.
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To view RSA client keys:

1. In the Admin Console, select Configuration > Authentication > SSH Inbound Connections.

2. The Client Keys section displays the following information:

n Username: The client key is associated with the specified user.

n Key ID: The ID is included in the imported RSA key.

n Fingerprint: The fingerprint is a unique ID of the imported key.
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Manage SSH Ciphers for Inbound Connections
Tomanage SSH ciphers for inbound connections, select Configuration > Authentication > SSH Inbound
Connections and go to theCiphers section.

The Ciphers section shows current list of ciphers, including any ciphers you added explicitly and excluding any you
removed explicitly.

To display all available ciphers that the SGOS version supports, select Select Ciphers. The Select Ciphers dialog shows all
ciphers; however, note that:

n Fewer ciphers are available when the appliance is in FIPSmode.

n Amarked checkbox indicates that the cipher is currently selected.

After an upgrade or downgrade, the selected ciphersmay change. If youmodify the selections, the changes persist after
systemupgrades, downgrades, and reboots; however, selections will not be identical to the list prior to
upgrade/downgrade if the systemmust consider deprecated ciphers. To understand the behavior after
upgrade/downgrade:

n Ciphers that were previously added explicitly are selected if they are supported after upgrade/downgrade. They
are not selected if they are deprecated in the current version.

n Ciphers that were previously removed explicitly are not selected even if they are supported in the current version.

n Ciphers that were neither added nor removed explicitly are selected if supported in the current version and not
selected if deprecated.

n If you upgrade to a release that supports only ciphers that you previously removed, resulting in no selected
ciphers, the appliancewarns you that the list is empty and event-logs the occurrence.

For example, if you upgrade to a version of SGOS in which an added cipher is deprecated, the cipher is not selected.
Downgrading to the previous SGOS version selects the cipher again.

Add Ciphers
The appliance selects a number of ciphers by default. You can addmore ciphers from a list of available ciphers, and also
specify the order in which the appliance should use ciphers for SSH connections.

1. In the Admin Console, select Configuration > Authentication > SSH Inbound Connections and go to the
Ciphers section.

2. Select Select Ciphers. The Select Ciphers dialog shows all available ciphers. If necessary, toggle the Show
selected only option.

3. Add ciphers by selecting the checkboxes beside them.

4. Use the Select option to save changes.
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Tip: The event log indicates when any ciphers are added.

Remove Ciphers
You can remove ciphers from the selections list. Removing a ciphermeans it will not be available for SSH connections
unless you add it again.

1. In the Admin Console, select Configuration > Authentication > SSH Inbound Connections and go to the
Ciphers section.

2. Do one of the following:

n Remove ciphers by selecting Remove beside them, and then save your pending changes to the list.

n Select Select Ciphers. The Select Ciphers dialog shows selected ciphers. Remove ciphers by clearing the
checkmarks beside them. Use the Select option to save changes.

Tip: The event log indicates when any ciphers are removed.

Set the Preferred Order of Ciphers
When the appliance sends its list of cipher suites for SSH connections, it uses the order specified on the Ciphers list. You
can change the preferred order of ciphers using the arrows to the right of the list.

1. In the Admin Console, select Configuration > Authentication > SSH Inbound Connections and go to the
Ciphers section.

2. To promote a cipher on the list, selectMove Up asmany times as required.

3. To demote a cipher on the list, selectMove Down asmany times as required.

4. Save your pending changes to the list.

Restore the Default List
You can restore the default list of ciphers that the SGOS version supports. Using this option resets both the default
cipher selections and the default preferred order.

1. In the Admin Console, select Configuration > Authentication > SSH Inbound Connections and go to the
Ciphers section.

2. Select Revert to Default.
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Note: If SSH connections fail and you receive an error stating that no ciphers are available,
refer to https://knowledge.broadcom.com/external/article/169231.
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Manage SSH HMACs for Inbound Connections
Tomanage SSH HMACs for inbound connections, select Configuration > Authentication > SSH Inbound
Connections and go to theHMACs section.

TheHMACs section shows current list of HMACs, including any HMACs you added explicitly and excluding any you
removed explicitly.

To display all available HMACs that the SGOS version supports, select Select HMACs. The Select HMACs dialog shows all
HMACs; however, note that:

n Fewer HMACs are available when the appliance is in FIPSmode.

n Amarked checkbox indicates that theHMAC is currently selected.

After an upgrade or downgrade, the selected HMACsmay change. If youmodify the selections, the changes persist after
systemupgrades, downgrades, and reboots; however, selections will not be identical to the list prior to
upgrade/downgrade if the systemmust consider deprecated HMACs. To understand the behavior after
upgrade/downgrade:

n HMACs that were previously added explicitly are selected if they are supported after upgrade/downgrade. They
are not selected if they are deprecated in the current version.

n HMACs that were previously removed explicitly are not selected even if they are supported in the current version.

n HMACs that were neither added nor removed explicitly are selected if supported in the current version and not
selected if deprecated.

n If you upgrade to a release that supports only HMACs that you previously removed, resulting in no selected
HMACs, the appliancewarns you that the list is empty and event-logs the occurrence.

For example, if you upgrade to a version of SGOS in which an added HMAC is deprecated, theHMAC is not selected.
Downgrading to the previous SGOS version selects theHMAC again.

Add HMACs
The appliance selects a number of HMACs by default. You can addmoreHMACs from a list of available HMACs, and also
specify the order in which the appliance should useHMACs for SSH connections.

1. In the Admin Console, select Configuration > Authentication > SSH Inbound Connections and go to the
HMACs section.

2. Select Select HMACs. The Select HMACs dialog shows all available HMACs. If necessary, toggle the Show
selected only option.

3. Add HMACs by selecting the checkboxes beside them.

4. Use the Select option to save changes.
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Tip: The event log indicates when any HMACs are added.

Remove HMACs
You can removeHMACs from the selections list. Removing an HMACmeans it will not be available for SSH connections
unless you add it again.

1. In the Admin Console, select Configuration > Authentication > SSH Inbound Connections and go to the
HMACs section.

2. Do one of the following:

n RemoveHMACs by selecting Remove beside them, and then save your pending changes to the list.

n Select Select HMACs. The Select HMACs dialog shows selected HMACs. RemoveHMACs by clearing the
checkmarks beside them. Use the Select option to save changes.

Tip: The event log indicates when any HMACs are removed.

Set the Preferred Order of HMACs
When the appliance sends its list of HMACs for SSH connections, it uses the order specified on theHMACs list. You can
change the preferred order of HMACs using the arrows to the right of the list.

1. In the Admin Console, select Configuration > Authentication > SSH Inbound Connections and go to the
HMACs section.

2. To promote an HMAC on the list, selectMove Up asmany times as required.

3. To demote an HMAC on the list, selectMove Down asmany times as required.

4. Save your pending changes to the list.

Restore the Default List
You can restore the default list of HMACs that the SGOS version supports. Using this option resets both the default
HMAC selections and the default preferred order.

1. In the Admin Console, select Configuration > Authentication > SSH Inbound Connections and go to the
HMACs section.

2. Select Revert to Default.
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Note: If SSH connections fail and you receive an error stating that no HMACs are available,
refer to https://knowledge.broadcom.com/external/article/169231.
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Authenticate Outbound SSH Client Connections
Youmust add SSH ciphers, Hash-basedMessage Authentication Code algorithms (HMACs), and known hosts before the
appliance canmake an outbound connection over SSH. As a best practice, make sure that the remote SSH server and the
appliance share at least one cipher and oneHMAC in common.

All ciphers, HMACs, and known hosts for outbound SSH connections stored on the appliance are available for selection
and review in the Admin Console (Configuration > Authentication > SSH Outbound Connections).

See Also:

n "ManageHost Keys for Outbound SSH Connections" on the facing page

n "Manage SSH Client Keys for Outbound Connections" on page 424

n "Manage SSH Ciphers for Outbound Connections" on page 425

n "Manage SSH HMACs for Outbound Connections" on page 427

420 of 676



SGOS Administration (Admin Console Edition)

Manage Host Keys for Outbound SSH Connections
The Edge SWG (ProxySG) appliance allows you to store the public keys of known hosts, which are used to uniquely
identify a server for authentication. When you add a host key to the appliance, the host key data is saved in OpenSSH
key file format.

Each configured known host has the following information in theKnown Hosts section (Configuration
> Authentication > SSH Outbound Connections). When you look up existing hosts on the appliance, the system
searches on the criteria specified in some of these fields.

Host
Entry
Field

Description

Host
pattern

Comma-separated list of canonical host name or IP address patterns.

This field accepts wildcard characters when you are adding a known host manually.

Unique
ID

A number that the system assigns upon host creation, used in the CLI for deleting specific hosts. ID numbers are
not reused when individual hosts are deleted; thus, an ID number can tell you when the host was added to the
system, relative to other existing entries.

For more information, refer to #(config ssh-client) known-hosts in the Command Line Interface Reference.

Key type The host key type (algorithm), such as ssh-rsa.

Marker (Optional) One of the following:

n @cert-authority: The key includes a certification authority (CA) key and is trusted by the CA to validate
signed certificates.

n @revoked: The key is revoked by a CA andmust never be accepted for authentication or certification. If no
marker is specified, the value is (None).

Comment (Optional) Enter your own details about the SSH host key.

Key The entire host key in OpenSSH format.

Add a Known Host
If the appliance has not yet connected to the host, or if an existing host has changed, you can add a new host. Use one
of the followingmethods:

n Obtain the host key from a remote host. See "Fetch host key" on the next page.

n Copy and paste entire host entries, for example, from an OpenSSH known_hosts file. See "Paste known hosts
entry" on the next page.
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Note: Use the copy-and-pastemethod if you want to add known hosts that are not
in use yet; however, you should exercise caution because the appliance does not
validate your entry using thismethod.

n Specify individual field values for the known host. See "Manually specify a known entry" on the facing page.

Note: If you attempt to add a known host entry that already exists on the appliance, you
receive a “Host key already stored” message. If you are copying and pasting a host or
specifying it manually, correct the entry before trying to add it again.

Fetch host key

Obtain the host key from a remote host:

1. In the Admin Console, select Configuration > Authentication > SSH Outbound Connections.

2. In the Known Hosts section, select Add Host. The console displays a Create Host Key dialog.

3. Select Fetch.

4. In theHost field, enter either the host name or the IP address.

5. In the Port field, enter the port number or accept the default (22).

6. Select Fetch Key From Server.The Key field shows the connection status.

7. Verify the information. TheComment field is optional but helpful for identifying hosts.

8. Select Create to confirm the host details. The host is added. To view the entry, locate it in the list (scroll down if
necessary). Select and expand the entry to see full details.

Paste known hosts entry

Copy and paste an entire host entry:

1. In the Admin Console, select Configuration > Authentication > SSH Outbound Connections.

2. In the Known Hosts section, select Add Host. The console displays a Create Host Key dialog.

3. Select Paste.

Add one host key entry or addmultiple entries one at a time. Copy and paste a single host key entry into the
field,.

A pasted host key entry must be in the following format:
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marker comma_separated_list_of_host_pattern(s) key_type key #comment

If the entry does not comply with this format, fieldsmight contain incorrect values or be empty.

Note: Themarker is optional, but if specified it must be@revoked or
@certauthority. The comment is optional but helpful for identifying hosts.

The following is an example of an entry with all values specified:

@cert-authority 10.169.2.228,symantec.* ssh-rsa AB3Nz...= #my_comment

Note: In this example, the host key is abbreviated. When you perform this step on
the appliance, paste the host key in its entirety.

4. Select Create to confirm the host details. The host is added. To view the entry, locate it in the list (scroll down if
necessary). Select and expand the entry to see full details.

Manually specify a known entry

Specify individual field values for the known host:

1. In the Admin Console, select Configuration > Authentication > SSH Outbound Connections.

2. In the Known Hosts section, select Add Host. The console displays a Create Host Key dialog.

3. SelectManual.

4. Specify known host settings; see the table at the top of this page for descriptions.

5. Select Create to confirm the host details. The host is added. To view the entry, locate it in the list (scroll down if
necessary). Select and expand the entry to see full details.

Delete a Known Host
You can delete a selected host entry, for example, if the appliance no longer needs to connect to the known host or an
entry has changed.

To delete a known host, select the check box for each host you want to delete. Then, select Delete under Actions.
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Manage SSH Client Keys for Outbound Connections
Tomanage SSH client keys for outbound client connections, in the Admin Console, select Configuration >
Authentication > SSH Outbound Connection and go to theClient Keys section.

Note: For best security, key pairs are SSHv2 only; make sure that port 22 is available. You
do not need to create a new host key unless you want to change the existing
configuration.

Creating a Client Key Pair
To create an SSHv2 client key pair:

1. Select Generate. A Generate Host Key dialog appears.

2. In the dialog, select the key type and strength:

Client Key Type Strength

RSA Select one of:

n 2048 (default)

n 3071

n 4096

ECDSA Select one of:

n nistp256

n nistp384

n nistp521 (default)

Ed25519 N/A

3. Select Generate. The client key is created and saved immediately.

You can create a client key pair in the CLI using #(config ssh-client client-keys) commands. Refer to the
Command Line Interface Reference for details.

Deleting a Client Key Pair
To delete a client key pair, select the delete option in the respective section. On the dialog that appears, select Delete to
confirm the deletion. The key pair is deleted immediately.
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Manage SSH Ciphers for Outbound Connections
Tomanage SSH ciphers for outbound connections, select Configuration > Authentication > SSH Outbound
Connections and go to theCiphers section.

The Ciphers section shows current list of ciphers, including any ciphers you added explicitly and excluding any you
removed explicitly.

To display all available ciphers that the SGOS version supports, select Select Ciphers. The Select Ciphers dialog shows all
ciphers; however, note that:

n Fewer ciphers are available when the appliance is in FIPSmode.

n Amarked checkbox indicates that the cipher is currently selected.

After an upgrade or downgrade, the selected ciphersmay change. If youmodify the selections, the changes persist after
systemupgrades, downgrades, and reboots; however, selections will not be identical to the list prior to
upgrade/downgrade if the systemmust consider deprecated ciphers. To understand the behavior after
upgrade/downgrade:

n Ciphers that were previously added explicitly are selected if they are supported after upgrade/downgrade. They
are not selected if they are deprecated in the current version.

n Ciphers that were previously removed explicitly are not selected even if they are supported in the current version.

n Ciphers that were neither added nor removed explicitly are selected if supported in the current version and not
selected if deprecated.

n If you upgrade to a release that supports only ciphers that you previously removed, resulting in no selected
ciphers, the appliancewarns you that the list is empty and event-logs the occurrence.

For example, if you upgrade to a version of SGOS in which an added cipher is deprecated, the cipher is not selected.
Downgrading to the previous SGOS version selects the cipher again.

Add Ciphers
The appliance selects a number of ciphers by default. You can addmore ciphers from a list of available ciphers, and also
specify the order in which the appliance should use ciphers for SSH connections.

1. In the Admin Console, select Configuration > Authentication > SSH Outbound Connections and go to the
Ciphers section.

2. Select Select Ciphers. The Select Ciphers dialog shows all available ciphers. If necessary, toggle the Show
selected only option.

3. Add ciphers by selecting the checkboxes beside them.

4. Use the Select option to save changes.
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Tip: The event log indicates when any ciphers are added.

Remove Ciphers
You can remove ciphers from the selections list. Removing a ciphermeans it will not be available for SSH connections
unless you add it again.

1. In the Admin Console, select Configuration > Authentication > SSH Outbound Connections and go to the
Ciphers section.

2. Do one of the following:

n Remove ciphers by selecting Remove beside them, and then save your pending changes to the list.

n Select Select Ciphers. The Select Ciphers dialog shows selected ciphers. Remove ciphers by clearing the
checkmarks beside them. Use the Select option to save changes.

Tip: The event log indicates when any ciphers are removed.

Set the Preferred Order of Ciphers
When the appliance sends its list of cipher suites for SSH connections, it uses the order specified on the Ciphers list. You
can change the preferred order of ciphers using the arrows to the right of the list.

1. In the Admin Console, select Configuration > Authentication > SSH Outbound Connections and go to the
Ciphers section.

2. To promote a cipher on the list, selectMove Up asmany times as required.

3. To demote a cipher on the list, selectMove Down asmany times as required.

4. Save your pending changes to the list.

Restore the Default List
You can restore the default list of ciphers that the SGOS version supports. Using this option resets both the default
cipher selections and the default preferred order.

1. In the Admin Console, select Configuration > Authentication > SSH Outbound Connections and go to the
Ciphers section.

2. Select Revert to Default.
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Manage SSH HMACs for Outbound Connections
Tomanage SSH HMACs for outbound connections, select Configuration > Authentication > SSH Outbound
Connections and go to theHMACs section.

TheHMACs section shows current list of HMACs, including any HMACs you added explicitly and excluding any you
removed explicitly.

To display all available HMACs that the SGOS version supports, select Select HMACs. The Select HMACs dialog shows all
HMACs; however, note that:

n Fewer HMACs are available when the appliance is in FIPSmode.

n Amarked checkbox indicates that theHMAC is currently selected.

After an upgrade or downgrade, the selected HMACsmay change. If youmodify the selections, the changes persist after
systemupgrades, downgrades, and reboots; however, selections will not be identical to the list prior to
upgrade/downgrade if the systemmust consider deprecated HMACs. To understand the behavior after
upgrade/downgrade:

n HMACs that were previously added explicitly are selected if they are supported after upgrade/downgrade. They
are not selected if they are deprecated in the current version.

n HMACs that were previously removed explicitly are not selected even if they are supported in the current version.

n HMACs that were neither added nor removed explicitly are selected if supported in the current version and not
selected if deprecated.

n If you upgrade to a release that supports only HMACs that you previously removed, resulting in no selected
HMACs, the appliancewarns you that the list is empty and event-logs the occurrence.

For example, if you upgrade to a version of SGOS in which an added HMAC is deprecated, theHMAC is not selected.
Downgrading to the previous SGOS version selects theHMAC again.

Add HMACs
The appliance selects a number of HMACs by default. You can addmoreHMACs from a list of available HMACs, and also
specify the order in which the appliance should useHMACs for SSH connections.

1. In the Admin Console, select Configuration > Authentication > SSH Outbound Connections and go to the
HMACs section.

2. Select Select HMACs. The Select HMACs dialog shows all available HMACs. If necessary, toggle the Show
selected only option.

3. Add HMACs by selecting the checkboxes beside them.

4. Use the Select option to save changes.
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Tip: The event log indicates when any HMACs are added.

Remove HMACs
You can removeHMACs from the selections list. Removing an HMACmeans it will not be available for SSH connections
unless you add it again.

1. In the Admin Console, select Configuration > Authentication > SSH Outbound Connections and go to the
HMACs section.

2. Do one of the following:

n RemoveHMACs by selecting Remove beside them, and then save your pending changes to the list.

n Select Select HMACs. The Select HMACs dialog shows selected HMACs. RemoveHMACs by clearing the
checkmarks beside them. Use the Select option to save changes.

Tip: The event log indicates when any HMACs are removed.

Set the Preferred Order of HMACs
When the appliance sends its list of HMACs for SSH connections, it uses the order specified on theHMACs list. You can
change the preferred order of HMACs using the arrows to the right of the list.

1. In the Admin Console, select Configuration > Authentication > SSH Outbound Connections and go to the
HMACs section.

2. To promote an HMAC on the list, selectMove Up asmany times as required.

3. To demote an HMAC on the list, selectMove Down asmany times as required.

4. Save your pending changes to the list.

Restore the Default List
You can restore the default list of HMACs that the SGOS version supports. Using this option resets both the default
HMAC selections and the default preferred order.

1. In the Admin Console, select Configuration > Authentication > SSH Outbound Connections and go to the
HMACs section.

2. Select Revert to Default.
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Monitor the Appliance
Refer to the following topics for Edge SWG (ProxySG) appliance statistics:

n "Statistics" on the next page

Display statistics reports to view the status of systemoperations.

n "Advanced Statistics" on page 436

Display advanced statistics information.
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Statistics
In the Admin Console, select Dashboard > Home to display statistics reports. These reports present a graphical view of
the status formany systemoperations.

Troubleshooting Statistics
View and change the status of troubleshooting tools from this report. The Troubleshooting report indicates the current
status of each troubleshooting tool. You can select a tool to change its status:

n Packet Capture: Select to go to theAdministration > Service Information > Packet Capture page.

n Global Policy Tracing: Select to go to theAdministration > Service Information > Policy Tracing page.

The previous example shows that Global Policy Tracing is currently enabled. To disable it from theDashboard report,
select theGlobal Policy Tracing link. On the Policy Tracing page that appears, disable global policy tracing.

Note: Global policy tracing affects Edge SWG (ProxySG) appliance performance. It is best
to enable it temporarily for troubleshooting only.

System Statistics
View information about how the CPU, disk space, andmemory are being used, and how disk andmemory space are
allocated for cache data. See "System Statistics" on page 433.

Traffic Mix
View traffic distribution and bandwidth statistics for traffic running through the Edge SWG (ProxySG) appliance. You can
break down the data according to proxy type or service name across various time periods. See "Traffic Statistics" on
page 435.
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Using Reports
n By default, the Homepage displays system statistics for the Last Hour. You can select a time period (Last Day,

Last Week, Last Month, or Last Year) from themenu in the top right corner.

n To refresh all statistics on the page, select the refresh icon in the top right corner. To refresh individual report
statistics, select the refresh icon in the lower right corner of the report.

n Hover over or select an area of a report to see specific data for a time period or component.

The following report shows the CPU andmemory utilization on the specified date:
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The following report shows the percentage of freememory:
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System Statistics
In the Admin Console, select Dashboard > Home to display system statistics reports. TheDashboard allows you to view
information about how the CPU, disk space, andmemory are being used, and how disk andmemory space are allocated
for cache data. You can view data allocation statistics through both the Admin Console and the CLI, but disk and
memory use statistics are available only through the Admin Console.

CPU, Memory Utilization
TheCPU, Memory Utilization report displays the average CPU utilization percentage and CPU usage for the Edge SWG
(ProxySG) appliance for the given time period.

Memory Usage
TheMemory Usage report shows the absolute values and percentages of RAM being used.

n Free: RAM that has no retention value.

n Applications: RAM required by system applications.

n System: RAM required for operating system.

n Reclaimable: Set of memory segments used to cache object data and accelerate performance. RAM has
retention value; cache buffers contain useful data.

n Cache buffers: RAM has been allocated and is still in use.

Note: The Kernel attempts to maximize the number and lifetime of cache buffers, but if
needed, it will recover cache buffers using the LRU replacement algorithm to satisfy a
memory allocation request.

Storage Usage
The Storage Usage report shows statistics about the appliance storage usage.

n Cache: Percentage of storage resources available for cache objects. This statistic represents both cache that is in
use and the remaining space for cache.

n System objects: Percentage of storage resources currently used for systemobjects.

n Access logs: Percentage of storage resources currently used for access logs.

The total storage usage is the sumof the first two statistics: systemobjects usage and the access logs usage. SNMP
monitoring reports on this total for storage usage alerts; formore information on SNMPmonitoring, refer to the
SGOS Administration Guide.
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The total storage is the sumof all three statistics: systemobjects usage, access logs usage, and available cache.

Concurrent Users
TheConcurrent Users report displays users (IP addresses) that are intercepted by the Edge SWG (ProxySG) appliance
for the given time period. Only unique IP addresses of connections intercepted by proxy services are counted toward
the user limit.

Traffic Rate
The rate in bits per second (bps) of client traffic during the selected time period.

Traffic Composition - Proxies
Traffic distribution for traffic running through the Edge SWG (ProxySG) appliance and applications running on the
network.

Traffic Composition - Proxy Services
The Composition report allows you to view traffic distribution for traffic running through the Edge SWG (ProxySG)
appliance and applications running on the network.
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Traffic Statistics
In the Admin Console, select Dashboards > Home to display traffic statistics. TheDashboard allows you to view
information about bandwidth usage and traffic distribution of proxies and services.

Traffic Rate
The Traffic Rate report displays bandwidth attributed to various proxies or services used on your network over the
selected time period. You can use this report to analyze howmuch bandwidth you are gaining fromoptimization of
proxy or service traffic. Depending on the fluctuation of data over the selected time period, the units in the report can
change (Gbps, Mbps).

n BW Usage - Client: Data rate calculated (to and from the client) on the client–side connection. Data rate is
represented by units of bits per second (bps) frommeasurements that are sampled at one-minute intervals. All
application protocol-level bytes are counted, including application-protocol overhead such as HTTP and CIFS
headers.

Traffic Composition - Proxies
The Traffic Composition - Proxies report shows the distribution of proxy traffic over the selected time period.
Depending on the fluctuation of data over the selected time period, the proxies shown in the report can change.

Traffic Composition - Proxy Services
The Traffic Composition - Proxy Services report shows the distribution of proxy service traffic over the selected time
period. Depending on the fluctuation of data over the selected time period, the services shown in the report can change.
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Advanced Statistics
In the Admin Console, select Dashboard > Advanced URLs to display a list of advanced statistics information:

n Groups: URL groups are listed in alphabetical order. Select a group to display theURLs.

n All URLs: All URLs are listed in alphabetical order.

Caution: Proceed with caution. Refer to Broadcom Support for assistancewith these
URLs. Support might direct you to these links to provide additional information during
troubleshooting.

To view an Advanced URL:

1. On the Advanced URLs page, select Groups orAll URLs.

2. Click a link to open an Advanced URL. The Advanced URL page opens in a new browser window.

3. (When needed) Enter the username and password for the Edge SWG (ProxySG) appliance.

Note: The browser prompt shows theManagement Center IP address, but the credentials
you require are for the Edge SWG (ProxySG) appliance.

The first time you open an Edge SWG (ProxySG) device link, the browser prompts you to log in. After a successful
authentication, you should not be prompted to enter credentials for the device again, unless they are changed or
removed in the Edge SWG (ProxySG) configuration. In this case, enter valid credentials.
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View System Reports
Refer to the following topics to view system statistics:

n View Traffic Details

View traffic rate, client bytes, and server bytes for all proxy services or proxies, or view the statistics for a specific
proxy service or type. Also view statistics for default service traffic.

n "View Protocol Statistics" on page 439

View statistics for HTTP/HTTPS/FTP, SSL, MAPI, and SOCKS traffic.

n "View Interface History Statistics" on page 441

View statistics for each interface, including VLAN traffic).

n "View Content Analysis Statistics" on page 441

View active ICAP requests, completed ICAP requests, ICAP connection history, and ICAP connection byte history
for all ICAP services or service groups, or view the statistics for a specific service or group.

n "View the Access Log Tail" on page 444

View recent access log events (log tail) in a browser tab and view access log statistics. You can change the refresh
interval of the log tail.

n "View the Event Log Tail" on page 445

View recent event log events (log tail) in a browser tab or download the events to a file. You can change the
refresh interval of the log tail.

n "View Active Sessions (Per-Session Connection Statistics)" on page 446

Display statistics for active sessions, bypassed connections, ADN connections, proxied connections, and all
sessions/connections.

n "ViewHealth Monitoring Statistics" on page 447

ViewGeneral, Licensing, Status, and Subscription healthmonitoringmetrics.

n "ViewHealth Checks Statistics" on page 447

View statistics for enabled health checks.

Refine Report Results
When viewing some reports, you can refine the view to display specific data.
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View Report Data for a Specific Period of Time
By default, the report shows data for the last hour. From themenu at the top right of the page, select an option to view
data for a different time period: Last Hour, Last Day, Last Week, Last Month, or Last Year (refer to the example
below in "Refresh the Report Data" below). The Admin Console refreshes the page.

Filter a Report
You can filter report data by omitting some statistics from the graph. To exclude a statistic, click its label in the graph. The
label is grayed out and any associated graph data is no longer visible.

For example, the following Active Requests report is filtered to show only Secure Requests.

Refresh the Report Data
You can refresh a single report or refresh all data on the page.

To refresh a single report, select the refresh icon on the bottom right.

To refresh all data on the page, select the refresh icon at the top right of the page:
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The Admin Console indicates howmuch time has elapsed since the report data was last refreshed. The report data
refreshes when you load the page, if you click the refresh icon at the top of the page, or if you select a different time
period for the reports.

View Protocol Statistics
You can view statistics for the protocols serviced by the appliance. Use these statistics to complement "Traffic Statistics"
on page 435.

View protocols statistics:

1. In the Admin Console, select Reports > Protocol Details. 

2. Above the Charts section, select a protocol for which to view statistics:

n HTTP/HTTPS/FTP 

n SSL

n MAPI

n SOCKS

The console opens the protocol report page. To view report data for a different time period, see "Refine Report Results"
on page 437

View Protocol Charts
On a Protocol Details report page, the Charts section displays graphical data for the selected protocol.

Graph Available for Protocols Description

Clients HTTP/HTTPS/FTP

SSL

MAPI

SOCKS

The number of clients with requests processed over the
last interval. This chart does not include idle client
connections (connections that are open but that have not
made a request).

In conjunction with the Objects, Client Bytes, and Server
Bytes charts, you can determine the number of clients
supported based on load, or load requirements for your
site based on a specific number of clients.

Bytes SSL The number of bytes on the client-side connection,
including both cache hits and cache misses.
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Graph Available for Protocols Description

Objects HTTP/HTTPS/FTP The number of objects served from the internet or from
the cache. The maximum number of objects that can be
stored on an appliance depends on a number of factors,
including the SGOS version it is running and the hardware
platform series.

Client Bytes HTTP/HTTPS/FTP

SOCKS

Client compression gain bytes.

Server Bytes HTTP/HTTPS/FTP

SOCKS

Server compression gain bytes.

Client Bytes Read MAPI Total number of bytes read by MAPI clients.

Client Bytes Written MAPI Total number of bytes written by MAPI clients.

View Protocol Statistics
On the Protocol Details report page, the Statistics section displays statistics for the selected protocol.

SSL Statistics

Below the charts, refer to the Statistics section for a breakdown of client connections and bytes for unintercepted SSL or
STunnel.

n Current Connections: The current number of unintercepted SSL or STunnel client connections.

n Total Connections: The cumulative number of unintercepted SSL or STunnel client connections since the
appliancewas last rebooted.

n Total Bytes Sent: The total number of unintercepted or STunnel bytes sent.

n Total Bytes Received: The total number of unintercepted or STunnel bytes received.

SOCKS Statistics

Below the charts, refer to the Statistics section for a breakdown of SOCKS connections and bytes.

Optionally, filter the statistics by SOCKS v4 or SOCKS v5 protocol.

n CONNECT requests: The current number of CONNECT requests.

n BIND requests: The cumulative number of BIND requests.

n UDP ASSOCIATE requests: The total number of UDP ASSOCIATE requests.

n UDP BIND requests: The total number of UDP BIND requests.
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View Interface History Statistics
As traffic flows to and from the appliance, you can review statistics for each interface (including VLAN traffic). This allows
you to verify your deployment is optimized. For example, if you notice that traffic flowing through the LAN interface is
consistently near capacity, youmight consider routing traffic differently or spreading the load to another appliance.

To view interface-specific statistics:

1. In the Admin Console, select Reports > Interface History.

2. In the Interfaces section at the bottomof the page, select an interface in the list and click Select Interface.

Select an interface to view. If an interface has attached VLANs, the tree expands to display the VLAN(s), which you
can select.

In the Charts section, the graphs are updated to display data for the selected interface or VLAN.

Note: Aggregate link members are visible as individual interfaces.

Graph Description

Bytes Sent The number of outgoing bytes sent from the selected interface or VLAN.

Bytes Received The number of inbound bytes received on the selected interface or VLAN.

Packets Sent The number of outgoing packets sent from the selected interface or VLAN.

Packets Received The number of inbound packets received on the selected interface or VLAN.

Input Errors The number of input errors that occurred on the selected interface (not applicable on VLANs).

This information provides details that Symantec Support uses to troubleshoot issues.

Output Errors The number of output errors that occurred on the selected interface (not applicable on VLANs).

This information provides details that Symantec Support uses to troubleshoot issues.

See Also:

n "Refine Report Results" on page 437

View Content Analysis Statistics
To view Content Analysis reports, in the Admin Console, select Reports > Content Analysis. By default, the Admin
Console displays reports for supported ICAP Services. Select Service Groups to show reports for supported ICAP
service groups.
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View the Content Analysis reports page for a history for all proxied traffic that matches ICAP policy. This includes request
and responsemodifications, internal and external Content Analysis appliances (internal Content Analysis is available only
in Advanced Secure Gateway appliance deployments), secure or plain requests, and deferred and queued connections.

This page allow you to examine Content Analysis traffic currently being processed, traffic that has completed processing,
as well as Connection and Byte history.

Graph information can report on individual Content Analysis services or service groups.

View Data for a Selected ICAP Service or Service Group
By default, the Services and Service Groups reports show statistics for all ICAP traffic. To view data for a specific ICAP
service or service group:

1. In the Admin Console, select Reports > Content Analysis.

2. In the Services or Service Groups section, select an ICAP service or service group in the list and click the Select icon
under Actions.

The Charts section displays data for the selection.

To clear the selection, click the label above the reports. In the previous example, click the "icap_82" label.

View Statistics for Services and Service Groups
To view statistics for services and service groups:

1. In the Admin Console, select Reports > Content Analysis.

2. Go to the Services or Services Groups section. The report shows the number of successful, failed, and abandoned
requests, as well as the total number of bytes sent and received for each service or service group.

3. Scroll to the bottomof the Services or Service Groups section.
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The report displays total numbers for the selected time period, as in the following example:

To view the statistics for a different time period, select a different option at the top right of the Content Analysis
reports page. See "Refine Report Results" on page 437 formore information.

Active ICAP Requests
The Active Requests report lists details for ICAP traffic that the appliance is currently processing:

n Plain Requests: Requests over non-secure services such as HTTP and FTP.

n Secure Requests: Requests over secure services such as HTTPS.

n Deferred Requests: Requests are deferred if they're in the process of being sent formore than 60 seconds and
the number of active ICAP connections/transactions exceeds the defer threshold which is 80% of themax-
connections by default.

n Queued Requests: Requests are queued when no connections are available to process an incoming ICAP
requests. A queued request is processed when a current connection is ready to take a new request.

ICAP Connection History
The Connections report lists statistics for plain ICAP connections and secure ICAP connections:

n Plain Connections: Connections that scanned non-secure services such as HTTP and FTP.

n Secure Connections: Secure connections that scanned secure services such as HTTPS.

Completed ICAP Requests
The Completed Requests report lists details for ICAP traffic that the appliance has finished processing:

n Successful Requests: Requests that were scanned successfully.

n Failed Requests: Requests that were not scanned due to an error from the ICAP service or other error codes.

n Abandoned Requests: Requests that were abandoned due to file scanning timeout.

ICAP Byte History
The Bytes report lists the bytes sent and bytes received :

n Bytes Sent: Request bytes sent to the ICAP server for scanning. 

n Bytes Received: Response bytes received from the ICAP server.
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See Also:

n "Refine Report Results" on page 437

View the Access Log Tail

Note: Youmust enable access logging before you can configure the access log tail.

You can view themost recent access log events (the log tail) in a new browser tab. By default, the log tail refresh interval
is 10 seconds.

View the access log tail:

1. In the Admin Console, select Reports > Access Logging. 

2. In the Access Logging section, beside Log Name, select the log for which you want to view recent events.

3. Select Show Log Tail. The browser shows the log tail in a new tab.

The browser refreshes the log tail events according to the specified refresh interval. The log tails shows events up
to amaximumof 500 lines.

View Access Log Statistics
View statistics for the selected log:

1. In the Admin Console, select Reports > Access Logging. 

2. In the Statistics section, look for information about the selected log.

If you change the log selection, the Statistics section refreshes the data.

Change the Refresh Interval
By default, the log tail refreshes automatically every 10 seconds.

Note: You can use the browser to manually refresh the log tail.

To change the refresh interval for the log tail:

1. In the Admin Console, select Reports > Access Logging. 

2. In the Access Logging section, beside Log Tail Refresh Interval, select a different value.
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If you select none, the browser does not automatically refresh the log tail.

Caution: If you select continuous, the log tail refreshes continuously. The tail can
grow very large and cause problems in the browser.

View the Event Log Tail
You can view themost recent event log events (the log tail) in a new browser tab or download them in a file. By default,
the log tail refresh interval is 10 seconds.

View the event log tail:

1. In the Admin Console, select Reports > Event Logging. 

2. In the Event Logging section, select Show Log Tail. The browser shows the log tail in a new tab.

The browser refreshes the log tail events according to the specified refresh interval. The log tails shows events up
to amaximumof 500 lines.

Download the Event Log Tail File
You can download the log tail in a text file:

1. In the Admin Console, select Reports > Event Logging. 

2. In the Event Logging section, select Download Log Tail. The browser downloads the log tail in a file named
event.log.

Change the Refresh Interval
By default, the log tail refreshes automatically every 10 seconds.

Note: You can use the browser to manually refresh the log tail.

To change the refresh interval for the log tail:

1. In the Admin Console, select Reports > Event Logging. 

2. In the Event Logging section, beside Log Tail Refresh Interval, select a different value.

If you select none, the browser does not automatically refresh the log tail.
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View Active Sessions (Per-Session Connection Statistics)
View active sessions for the following statistics:

n Active sessions memory statistics: View statistics formemory used by active sessions reports.

n Bypassed connections: View data for all unintercepted TCP traffic. When the appliance is first installed in an in-
path deployment, all services are bypassed by default. By analyzing the connection data in the Bypassed
Connections page, you can review the types of traffic flowing through the appliance to identify traffic flows that
would benefit fromoptimization. The Bypassed Connections page is also useful for identifying new types of
traffic flowing through the appliance.

n Proxied connections: View an immediate picture of the sessions and the protocol types, services, bytes, savings,
and other statistics. These statistics are derived fromWAN optimization and object caching and are associated
with client traffic.

n ADN connections: View inbound ADN connection data. These connections are not persistent. When a
connection completes, the statistics for the connection are no longer displayed.

n Active sessions: View all active sessions.

Tip: For detailed information about statistics, or to see graphical reports, refer to the
SGOS Administration documentation.

When you select an Active Session Link, enter the Edge SWG (ProxySG) username and password if the browser prompts
you to sign in.

Note: The browser prompt shows theManagement Center IP address, but the credentials
you require are for the Edge SWG (ProxySG) appliance.

The first time you open an Edge SWG (ProxySG) device link, the browser prompts you to log in. After a successful
authentication, you should not be prompted to enter credentials for the device again, unless they are changed or
removed in the Edge SWG (ProxySG) configuration. In this case, enter valid credentials.
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View Health Monitoring Statistics
While the Admin Console banner indicates any issues with the appliance’s health, theHealth Monitoring page provides
more information about the current state of themetrics.

To review the healthmonitoring statistics:

1. In the Admin Console, select Reports > Health Monitoring.

2. Go to one of the following sections:

n General: Lists the current state of CPU utilization, interface utilization, memory utilization, and (if
applicable) cloud common policy errors. See "Thresholds and Notifications for General Metrics" on
page 650 to determinewhat metric statesmean.

n Licensing: Lists the current state of license utilization and license expiration. See "Thresholds and
Notifications for LicensingMetrics" on page 652 to determinewhat metric statesmean.

n Status: Lists the current state of ADN status, hardware (including disk status, temperature, fan speed,
power supply) and health check status. See "Notifications for StatusMetrics" on page 654 to determine
what metric statesmean.

n Subscription: Lists the communication status of subscription services. See "Thresholds and Notifications
for SubscriptionMetrics" on page 658 to determinewhat metric statesmean.

Note: If you need assistancewith interpreting the healthmonitoring alerts you receive,
contact Broadcom Support.

Each section includes a link to theAdministration > Health Checks and Monitoring > Health Monitoring page,
where you canmodify the thresholds for ametric. Formore information, see "Configure Health Monitoring" on
page 645.

View Health Checks Statistics
In the Admin Console, theReports > Health Checks page provides a snapshot of all the health checks configured on
the device. The page allows you to glance at the health checks for routinemaintenance, to diagnose potential problems,
and to view health check failures.

TheHealth Checks section shows the following current system information:

n Current Time: The current date and time in UTC.

n Last Boot: Displays the date and timewhen the devicewas last booted.

The list of health checks shows the following information for each configured health check:
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n Name: The health check name.

n State: The health check state is represented by an icon and a statusmessage. If the health check is disabled, it
displays as Disabled: Healthy or Disabled: Unhealthy.

If the health check is enabled, the table below shows one of themessages in Statusmessages for enabled health
checks.

n Last Check Time: Information on the last completed health check probe.

n Last Check Duration: Response time of the last check.

n Duration Since Transition: Length of time since the last transition between healthy and unhealthy.

n # Checks Since Transition: Number of health checks performed since the last transition.

n Avg Since Transition: Themean response time since the last transition. This statistic is not displayed for a
health check reporting unhealthy.

n Min Since Transition: Minimum response time. This statistic is not displayed for a health check reporting
unhealthy.

n Max Since Transition: Maximum response time. This statistic is not displayed for a health check reporting
unhealthy.

Status messages for enabled health checks

Status Message Icon Description
Health
State

Unknown Health has not yet been tested successfully. Healthy

OK The target device or service is completely healthy. Healthy

OK with errors (multiple
IP addresses)

One or more IP addresses have errors but none are down. Healthy

OK for some IP
addresses (multiple IP
addresses)

One or more IP addresses are down, but not all of them. Healthy

OK on alt server The primary server has failed; the realm is functioning on the alternate
server.

Healthy

Functioning but going
down (single IP address)

Failures are occurring; but the IP address is still functioning. Healthy
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Status Message Icon Description
Health
State

Check failed Device or service cannot be used. Unhealthy

DNS failed The hostname cannot be resolved. Unhealthy

View Health Check Details and Events
You can view health check details and related event-log lines, which can be useful for troublehshooting unhealthy health
checks. For a configured health check:

n Select View Details. The browser displays details in a new tab, as in the following example:

Domain name: broadcom.com DNS status: query rejected
Enabled DNS failed DOWN
No IP addresses resolved.

n Select View Events. The browser displays events in a new tab, as in the following example:

2022-08-01 14:26:25+12:00+12 "Health check 'socks.e2e-gateway-edit' changed from: Unknown, to:
DNS failed, and has become sick. Status: Health check DNS resolution failed." 0 3A0003:96 hc_
container.cpp:384

If there are no events for the health check, the browser displays No events associated with the Health check
'<health_check_name>'.

Interpret Health Check Statistics
Refer to the following figure and description for an explanation of the health checks.

The current date and time stamp is August 15, 2022.
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n The authentication health checks have never tested successfully.

n TheDNS health checks failed because the services cannot be used.

n The forwarding group "fwd.e2e-host-group" is healthy.

n The other forwarding health checks failed because the hostname could not be resolved.

Use Health Check Results in Policy
The results of a health check can be affected through forwarding, SOCKS gateway, or SSL certificate policy. The health
check transactions execute the <Forward> layer and (for SSL or HTTPS tests) the <SSL> layer to determine applicable
policy. This allows health check behavior to match as closely as possible to that of the SSL traffic that the health check is
monitoring.

Health checks cannot be deleted while referenced in policy. If a health check is automatically deleted when its target is
deleted, a reference to the health check in policy can block deletion not only of the health check but of its target.

Two policy conditions exist for health checks:

n health_check= : This condition tests whether the current transaction is a health check transaction. Optionally,
the condition tests whether the transaction is that of a specific health check.

n is_healthy.health_check_name= : This condition tests whether the specified health check is healthy.

Health Check Policy Example

For a user-defined health check "user.internet" that gates access to a popularWeb site and tests for Internet connectivity
and responsiveness, define policy to redirect traffic through a forwarding host if the health check fails.

<Forward>
is_healthy.user.internet=no forward(alternate_route)

Formore information about using policy, refer to the Visual Policy Manager documentation and Content Policy
Language documentation.
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Administer the Appliance
Refer to the following topics to learn about Edge SWG (ProxySG) administration using the Admin Console.

n "Configure General Edge SWG (ProxySG) Settings" on page 453

View general system information, such as SGOS version and appliance serial number. Assign a name to the
appliance, configure system time, and specify NTP servers. Perform systemmaintenance tasks such as restarts,
shutdown, clearing DNS and object caches, and resetting the system. Back up and restore the appliance
configuration.

n "Configure Data Services" on page 490

Enable content filtering providers, including Blue Coat, YouTube, and a local database. Look up Blue Coat content
filtering categories for a URL. EnableWebPulse and Threat Risk Levels services for threat protection. Enable
Application Classification to review applications and operations fromweb requests. Enable Geolocation to identify
countries associated with inbound and outbound connections. Isolate browser requests through the Symantec
Web Isolation service or a configured external web isolation service (SGOS 7.3.1+).

n "Upgrade andManage Systems " on page 546

Install the appliance base license and view license status. View data feeds and expiration dates for Intelligence
Services subscriptions.

Note: These upgrade options are not available in the Admin Console launched from
Management Center. You can upgrade the Edge SWG (ProxySG) version using
Management Center jobs. Refer to theManagement Center documentation for
details.

Note: Before upgrading the appliance, refer to the SGOS Upgrade/Downgrade Guide
to determine your upgrade path:
https://techdocs.broadcom.com/us/en/symantec-security-software/web-and-
network-security/proxysg/7-3/c-determine-upgrade-downgrade-path.html

n "About Licensing" on page 550

Install the appliance base license and view license status. View data feeds and expiration dates for Intelligence
Services subscriptions.

n "Configure Edge SWG (ProxySG) Logging" on page 559
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Manage log facilities, set the log upload schedule, andmanage log formats. Configure event log levels. Specify the
maximum file size of the event log and what action to takewhen the log reaches themaximum size. Enable
sending event logs to specified recipients. Enable Syslogmonitoring.

n "Configure General SNMP Settings" on page 614

Specify general SNMP settings. Configure SNMPv1 and SNMPv2 communities. Configure SNMPv3 users.

n "Verify Health Check Settings" on page 643

Configure system-defined, user-defined and composite health checks. Specify global settings and notifications for
health checks. Override default settings and notifications explicitly per health check when needed.

n "Service Information" on page 661

Send service information to Symantec for troubleshooting. Specify whether to send service informationmanually
or automatically when the appliance stops responding. Configure snapshots and packet captures (PCAPs). Enable
or disable global policy tracing.
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Configure General Edge SWG (ProxySG) Settings
Refer to the following topics to learn about configuring general Edge SWG (ProxySG) appliance settings:

n "Identification and General Information" on the next page

View general system information, such as SGOS version and appliance serial number. Assign a name to the
appliance. Review third-party attributions and copyright information.

n "Configure System Time" on page 455

Configure system time, time zone, and specify NTP servers.

n "Perform Maintenance Tasks" on page 458

Restart the Edge SWG (ProxySG) operating system (SGOS) or restart the appliance software and hardware. Shut
down the appliance. Clear theDNS cache and the object cache. Reset the systemwhile keeping console settings
such as IP addresses.

n "Back Up the Configuration" on page 463

View and download the current appliance configuration. Install a previously archived configuration. Back up the
appliance configuration to a remote server.
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Identification and General Information
You can assign any name to the Edge SWG (ProxySG) appliance. A descriptive name helps identify the system, for
example, whenmanagingmultiple appliances from Symantec Management Center.

To set the appliance name:

1. In the Admin Console, select Administration > General > Identification.

2. In theDevice Information section, in theAppliance name field, enter a unique name for the appliance.

The section displays other basic information about the appliance.

Review Third-Party Software Attributions
To review the third-party software attributions used in the Edge SWG (ProxySG) Admin Console, select Administration
> General > Identification

In theOpen Source Attributions section, select the 3rd Party Copyright Attributions link. The list of attributions
opens in a new browser window.

Review Copyright Information
To review full product copyright information, see the "Documentation Legal Notice" on page 676.

454 of 676



SGOS Administration (Admin Console Edition)

Configure System Time
The Edge SWG (ProxySG) appliance uses NTP and theUTC to keep the system time accurate. To manage objects, the
Edge SWG (ProxySG) appliancemust know the current UTC, which is the international time standard and is based on a
24-hour clock. The Edge SWG (ProxySG) appliance accesses theNTP servers to obtain accurate UTC time and
synchronizes its time clock. You can also record time stamps in the current local time or use the browser's time.

Set Time Source
By default, the Edge SWG (ProxySG) appliance connects to an NTP server in the order they are listed underNTP Servers
and acquires theUTC. If the appliance cannot access any of the listed NTP servers, youmust manually set the UTC.

To set the time source:

1. In the Admin Console, select Administration > General > Time.

2. In Time Source, do one of the following:

n Select Acquire from NTP Server (default setting) to useNTP. See "ManageNTP Servers " on the next
page for information.

n Select Use Manual Setup to disable NTP.

Set Local Time
To record time stamps in current local time, youmust set the local time based on your time zone. You can set local time
using the time zone database, or by using browser time.

The Edge SWG (ProxySG) appliance ships with a limited list of time zones. If a specific time zone ismissing from the
included list, you can update the list at your discretion (see "Update the Time ZoneDatabase" on page 457). The time
zone databasemight need to be updated if the Daylight Savings rules change in your area.

To set local time :

1. In the Admin Console, select Administration > General > Time.

2. In Current Time:

n To set local time based on browser time, select Set to Browser Time. After the local time is set to browser
time, the option is unavailable (grayed out) unless youmake a change to the time source.

n To set local time using a time zone database:

a. Beside Local Timezone, select Edit.

b. On the dropdown, select Set Timezone. The Select Time Zone page opens.

c. Select a time zone. See "Select a Time Zone" on page 457.
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Manage NTP Servers
NTP is used to synchronize the time of a computer client or server to another server or reference time source, such as a
radio or satellite receiver ormodem. There aremore than 230 primary time servers, synchronized by radio, satellite and
modem.

The Edge SWG (ProxySG) appliance ships with a list of NTP servers available on the Internet, and attempts to connect to
them in the specified order in theNTP Servers section. You can add and remove entries on the list.

To manageNTP servers:

1. In the Admin Console, select Administration > General > Time.

2. InNTP Servers, select Add.

3. In the newName field, enter a newNTP server using one of the followingmethods:

n Domain name: Enter a domain name of an NTP server that resolves to an IPv4 or IPv6 address.

n IP address: Enter an IPv4 or IPv6 address of an NTP server.

To remove an NTP server, delete it in the Actions column.

Update NTP
To force an NTP update:

1. In the Admin Console, select Administration > General > Time.

2. InNTP Servers, select Query NTP. A dialog notifies you that the update is started and will continue in the
background.
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Select a Time Zone
The Select Time Zone page displays all time zones, organized by geographical region, in the currently installed time
zone database.

To addmore time zones to the list or update the appliance's time zone database, see "Update the Time ZoneDatabase"
below.

To select the time zone that represents your local time:

1. In the Admin Console, select Administration > General > Time.

2. In Current Time, under Local Timezone, select Edit.

3. On the dropdown, select Set Timezone. The Select Time Zone page opens.

4. (If needed) Select Go to Selection to locate the currently selected time zone.

5. Locate the country/region for the local time zone, expand it, and select the time zone. If needed, use Expand All
and Collapse All to expand and collapse the list of time zones, respectively.

After you select a time zone, event logs record the local time instead of GMT.

Update the Time Zone Database
The Edge SWG (ProxySG) appliance ships with a limited list of time zones. If a specific time zone ismissing from the
included list, you can update the list at your discretion.

Youmight also want to update the time zone database if the Daylight Savings rules change in your area. You can
download an updated database from the default Symantec URL, or specify a different URL for your database
downloads.

To update the time zone database:

1. In the Admin Console, select Administration > General > Time.

2. In Current Time, beside Local Timezone, select Edit.

3. On the dropdown, select Update Timezone Database. The Load new time zone database dialog opens.

4. Enter a URL fromwhich the databasewill be downloaded or accept the default URL
(http://download.bluecoat.com/release/timezones.tar).

5. Select Download.
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Perform Maintenance Tasks
Perform the following tasks for routinemaintenance and to help resolve potential issues, as needed.

Restart the Appliance
When you restart the appliance, you choose a software-only restart or a hardware and software restart.

1. In the Admin Console, select Administration > General > Tasks.

2. Under Restart and Shutdown, select one of the restart options:

n Software Only: (Default selection) Restart the operating system.

n Hardware and Software: Restart the appliance hardware and the operating system. The system set as
the default will boot upon restart.

See "Upgrade andManage Systems " on page 546 to change the default system image.

3. Select Shutdown. A System Shutdown dialog appears. Select Shutdown on the dialog to confirm the
shutdown. The appliancewill restart after shutdown.

Shut Down the Appliance
Some operations or configurationsmight require a system shutdown.

1. In the Admin Console, select Administration > General > Tasks.

2. Under Restart and Shutdown, select Shutdown.

A System Shutdown dialog appears. Select Shutdown on the dialog to confirm the shutdown.

Clear Caches
You canmanually clear theDNS cache or the object cache.

Note: After a cache is cleared, performancemight be slow until the cache is repopulated.

n Clear theDNS cache if you experience a problemwith DNS servers or if the DNS sever configuration on the
appliance has changed.

n Clear the object cache at any time.
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When you clear the cache, all objects in the cache are set to expired. The objects are not immediately removed
frommemory or disk, but a subsequent request for any object requested is retrieved from the source before it is
served.

To clear a cache:

1. In the Admin Console, select Administration > General > Tasks.

2. Under Clear Cache, select one of the following options:

n Clear DNS Cache

n Clear Object Cache

3. A Clear Cache dialog appears. Select Clear on the dialog to confirm the action.

Restore System Defaults
You can restore some or all of the systemdefaults . See "Restore SystemDefaults" on the next page.

459 of 676



SGOS Administration (Admin Console Edition)

Restore System Defaults
You can restore some or all of the systemdefaults using CLI commands. Use these commandswith caution. The
restore-defaults command deletesmost, but not all, systemdefaults:

n The restore-defaults command with the keep-console option restores the default settings without losing all IP
addresses on the system. This action is available in the Admin Console as well as the CLI. See "Keep Console
Settings" below.

n The restore-defaults command with the factory-defaults option reinitializes the appliance to the original
settings it had when it was shipped from the factory. See "Reset to Factory Defaults" on the facing page.

Restore Defaults
Settings that are deleted when you use the restore-defaults command include:

n All IP addresses (thesemust be restored before you can access the Admin Console again)

n DNS server addresses (thesemust be restored through the CLI before you can access the Admin Console again)

n Forwarding lists

n All custom configurations

n Symantec-trusted certificates

n Original SSH (v1 and v2) host keys (new host keys are regenerated)

You can use the force option to restore defaults without confirmation.

To restore defaults using the CLI, type the following command:

# restore-defaults

Keep Console Settings
Settings that are retained when you use the restore-defaults command with the keep-console option include:

n IP interface settings, including VLAN configuration (virtual IP addresses are not retained)

n Settings for all consoles

n Default gateway and static routing configuration

n Virtual IP address configuration

n Bridging settings

n Failover group settings
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n Ethernet maximum transmission unit (MTU) size

n TCP round trip time

n Static routes table information

Using the keep-console option retains the settings for all consoles (Telnet, SSH, HTTP, and HTTPS), whether they are
enabled, disabled, or deleted.

Administrative access settings retained using the restore-defaults command with the keep-console option include:

n Console username and password

n Console enable password

n SSH (v1 and v2) host keys

n Keyrings used by secure console services

n RIP configurations

You can also use the force option to restore defaults without confirmation.

To restore defaults and keep console settings using the CLI, type the following command:

# restore-defaults keep-console

To restore defaults and keep console settings using the Admin Console:

1. In the Admin Console, select Administration > General > Tasks.

2. Under SystemReset, select Restore Defaults.

A Restore Defaults dialog appears.

3. Select Restore Defaults to confirm the action.

Reset to Factory Defaults
All system settings are deleted when you use the restore-defaults command with the factory-defaults option.

The only settings that are retained are:

n Trial period information

n The last five installed appliance systems, fromwhich you can pick one for rebooting

The serial console password is also deleted if you use restore-defaults factory-defaults.

You can use the force option to restore defaults without confirmation.

To restore the system to the factory defaults using the CLI, type the following command:
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# restore-defaults factory-defaults
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Back Up the Configuration
You can back up your configuration and save it on a remote system so that you can restore it in the unlikely event of
system failure or replacement. Edge SWG (ProxySG) appliance configuration backups are called archives.

Caution: You should archive the system configuration before performing any software or
hardware upgrade or downgrade.

System archives can be used to:

n Restore the appliance to its previous state in case of error.

n Restore the appliance to its previous state because you are performingmaintenance that requires a complete
restoration of the system configuration. For example, upgrading all the disk drives in a system.

n Save the system configuration so that it can be restored on a replacement appliance. This type of configuration
archive is called a transferable archive.

n Propagate configuration settings to newly-manufactured appliances. This process is called configuration sharing.

About the Archive Types and Saved Information
Three different archive types are available. Each archive type contains a different set of configuration data:

n Configuration - post setup: Contains the configuration on the current system—minus any configurations
created through the setup console, such as the IP address. It also includes the installable lists but does not include
SSL private key data. Use this archive type to share an appliance’s configuration with another. See "Use the
Appliance Certificate to Sign the Archive" on page 471 formore information.

n Configuration - brief: Contains the configuration on the current system and includes the setup console
configuration data, but does not include the installable lists or SSL private key and static route information.

Note: An installable list is a list of configuration parameters that can be created
through a text editor or through the CLI inline commands and downloaded to the
appliance from an HTTP server or locally from your system.

n Configuration - expanded: Themost complete archive of the system configuration, it contains system-specific
settings that might not be appropriate if pushed to a new system. It also does not include SSL private key data. If
you are trying to create themost comprehensive archive, use the configuration-expanded archive. Do not use this
archive type to transfer a configuration fromone device to another.

You can use the Admin Console to create standard (unsigned), secure (signed), and transferable archives.
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About Archive Security
The Edge SWG (ProxySG) appliance provides twomethods for creating archives, signed and unsigned. A signed archive is
one that is cryptographically signed with a key known only to the signing entity—the digital signature guarantees the
integrity of the content and the identity of the originating device.

To create signed archives, your appliancemust have an SSL certificate guaranteed by a CA. You can then use a trusted CA
Certificate List (CCL) to verify the authenticity of the archive.

Use signed archives only when security is high priority. Otherwise, use unsigned archives. For information about creating
secure archives, see "Store Archives on a Local Systemor Remote Server" on page 471.

About Transferable Archives
To restore a configuration to another appliance, youmust save the SSL keyrings (the configuration-passwords-key in
particular). The configuration-passwords-keykeyring is used to encrypt and decrypt the passwords (login, enable, FTP,
etc.) and the passwords cannot be restored without it. This is because the purpose of public/private key authentication
is to disallow decryption by a device other than the devicewith the private key. To restore any encrypted data from an
archive, youmust have the corresponding SSL keyring.

See "Restore an Archive to Another Device" on page 479 formore information about creating transferable archives.

What is Not Saved in Archives
Archiving saves the Edge SWG (ProxySG) appliance configuration only. Archives do not save the following:

n Cache objects

n Access logs

n Event logs

n License data (youmight need to reapply the licenses)

n Software image versions

n SSL key data

n Content-filtering databases

n Exception pages

n (If the data source is set to Intelligence Services) SymantecWebFilter username and password. See "Configure the
Blue Coat Data Source" on page 509 for information on specifying the data source for content filtering and
application classification.

To archive theWebFilter username and password, switch the data source to Webfilter before saving the configuration
file.
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Overview of Archive Creation and Restoration
The following list describes all of the possible steps required to create and restore an unsigned, signed, or transferable
configuration archive. You do not have to perform all of these steps to complete a standard, unsigned archive.

1. Optional (for transferable archives only)—Record the configuration passwords-key data on the source Edge SWG
(ProxySG) appliance, as described in "Record SSL Keyring and Key Pair Information" on page 481. If you need to
restore the archive onto a different appliance, youmust have this data.

Do not lose the password used to encrypt the private key. If you do, you will not be able to recover your private
keys.

2. Optional (for transferable archives only)—Record any other SSL keyring data you want to save.

3. Determine the type of archive to create—secure or standard. See "About Archive Security" on the previous page.

If you are creating an standard archive, go to step 5. Otherwise, proceed to the next step.

4. Optional (for secure archives only)—Verify that the source appliance has an appliance certificate, as described in
"Use the Appliance Certificate to Sign the Archive" on page 471. If it does not have an appliance certificate:

a. Create a keyring on the appliance. A keyring contains a public/private key pair. It can also contain a
certificate signing request or a signed certificate.

b. Create a Certificate Signing Request (CSR) and send it to a Certificate Signing Authority (CA).

c. Have the CA sign the CSR. To get more information about appliance certificates, see "Configure SSL and
Device Authentication" on page 259.

5. Archive the configuration:

n Standard, unsigned archive. See "Store Archives on a Local Systemor Remote Server" on page 471.

n Secure archive. See "Store Archives on a Local Systemor Remote Server" on page 471.

n Transferable archive. See "Save and Restore a Transferable Archive" on page 481.

6. Store the archive in a secure location.

7. If you are restoring the archive to another device, import the configuration passwords-key onto the target device,
as described in "Restore an Archived Key Ring and Certificate" on page 477.

8. Restore the archive, as described in "Restore a Configuration Archive" on page 468.
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Create and Restore System Backups
You can create a standard (unsigned) archive or a signed archive of the system configuration and then restore it to the
same appliance or different appliances.

Note: An archive can't be transferred to another appliance unless you save the SSL
keyrings as described in "Restore an Archive to Another Device" on page 479.

View a Configuration Archive
The Edge SWG (ProxySG) appliance supports three types of archive configurations:

n Post Setup - Contains the configuration on the current systemminus any configurations created through the
setup console (such as IP address). It includes installable lists but does not include SSL private key data.

Tip: Use the post setup archive to share the configuration with another appliance.

n Brief - Contains the configuration on the current system and includes the setup console configuration data but
does not include the installable lists or SSL private key data and static route information.

n Expanded - This is themost complete archive of the system configuration, but it contains system-specific settings
that might not be appropriate if pushed to a new system. It also does not include SSL private key data.

Tip: Use the expanded archive for a comprehensive systembackup. It should not be
used to transfer a configuration fromone device to another.

View a configuration archive:

1. In the Admin Console, select Configuration > General > Archive.

In the Archive Configuration section, under View Configuration, the console displays options for the post setup,
brief, and expanded archives.

2. Select one of the Show <configuration_type> links to open the archive contents in a new browser tab.

Verify and Enforce Signed Archives
You can allow the appliance to restore both unsigned and signed archives, or enforce signed archives so that the
appliance can restore only archives that have been signed. Restoring signed archives requires that you verify themwith a
specified CCL. 
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To verify and enforce signed archives:

1. In the Admin Console, select Administration > General > Archive.

2. In the Signing section, select Verify Signed Archives With CCL and select a CCL from the list.

3. To have the appliance restore only signed archives, select Enforce Installation of Signed Archives.

If you select this option before specifying a CCL, the Admin Console displays awarning indicating that a CCL is not
selected.

Restore a Configuration Archive
To install a configuration archive, youmust:

n Perform pre-restoration tasks, for example, restoring the SSL configuration.

n (For signed archives) If the Edge SWG (ProxySG) appliance enforces signed configuration archives, youmust use a
CCL to verify signed archives before restoration. For information on signed archives, see "Store Archives on a
Local Systemor Remote Server" on page 471. Otherwise, you can restore a standard unsigned archive.

n Restore the archive.

Restore a configuration archive:

1. Download a content filter database, if you previously had one and it was lost.

If you restore the archive and it includes content filtering policy, the databasemust exist so that categories
referenced within policy can bematched with the currently-installed database.

2. Confirm that the appliance is running the same software version that was used to create the archive.

You can check the device information in Management Center or using the CLI command #show version.

3. Restore the configuration-passwords-key data and any other SSL key data.

4. Import the configuration-passwords-key keyring. See "Restore an Archived Key Ring and Certificate" on
page 477.

5. In the Admin Console, select Configuration > General > Archive.

6. (For signed archives only) Under Signing Options in the Archive Configuration section, verify that a CCL is selected
with theVerify Signed Archives With CCL option.

If the Enforce Installation of Signed Archivesoption is enabled, the appliance can restore only signed archives.
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Note: Depending on the CA that was used to sign the certificate used for the archive
signature, youmight have to import a CA certificate and create an appropriate CCL.
For details, see "Configure SSL and Device Authentication" on page 259.

7. Under Install Configuration, select Install.

8. In the Install Archive Configuration dialog that appears, select one of the following options:

Where the
configuration
archive is saved

Restoration method

Contents are copied to
clipboard

Restore using the text editor:

1. Select Text.

2. Enter the contents manually or copy and paste the contents from another file.

3. Select Install.

A file on the local
system

Restore from local file:

1. Select File.

2. Browse to the directory of the file on the local system.

3. Select Install.

A file on a remote
system

Restore from remote URL:

1. Select URL.

2. Enter the fully-qualified URL, including the filename, where the file is located.

3. Select Install.

The username and password used to connect to the server can be embedded into the URL. For
FTP, the format of the URL is:

ftp://username:password@ftp-server

where ftp-server is either the IP address or the DNS-resolvable hostname of the FTP server.

If you do not specify a username and password, the appliance assumes that an anonymous FTP
is desired and thus sends the following as the credentials to connect to the FTP server:

username: anonymous

password: proxy@
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Note: Amessage is written to the event log when you install a configuration on the
appliance.
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Store Archives on a Local System or Remote Server
Specify settings for current configuration archives. You can download them, restore them to other appliances, and
upload them to a configured remote server.

In addition, you can sign configuration archives and (in version 6.7.5.17+ and version 7.3.8.1+) include encrypted
private keys for SSH and SSL in archives.

Download Configuration Archives
Download a configuration archive:

1. In the Admin Console, select Configuration > General > Archive.

In the Archive Storage section, the console displays options for downloading the post setup, brief, and expanded
archives.

2. Select one of theDownload <configuration_type> links to download the archive in .txt (unsigned) or *.bcsc
(signed) format.

Use the Appliance Certificate to Sign the Archive
If your appliance has a built-in appliance certificate, you can use it, and the corresponding appliance-ccl CCL, to sign the
archive.

To determine if your device has an appliance certificate:

1. Use an SSH client to establish a CLI session with the appliance.

2. Enter enablemode:

# enable

3. Enter the following command:

# show ssl certificate appliance-key

The appliance certificate displays if the appliance has one. Otherwise, the following error is displayed:

Certificate "appliance-key" not found

4. If the appliance does not have an appliance certificate, create one as follows:

a. Create a keyring on the appliance.

A keyring contains a public/private key pair. It can also contain a certificate signing request or a signed
certificate.
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b. Create a Certificate Signing Request (CSR) and send it to a Certificate Signing Authority (CA).

c. Have the CA sign the CSR (this process results in a digital certificate).

d. Import the keyring and certificate as described in "Restore an Archived Key Ring and Certificate" on
page 477.

Formore information about appliance certificates, see "Configure SSL and Device Authentication" on page 259.

Sign Configuration Archives
Save a secure (signed) archive of the system configuration. A signed archive is signed with a digital signature that can
only be read by the device that created it, thus guaranteeing the integrity and authenticity of the archive. To create
signed archives, your appliancemust have an SSL certificate guaranteed by a CA.

Signed archives have a .bcsc extension and contain the following files:

n show configuration output

n PKCS#7 detached signature

If you are not familiar with SSL authentication, read the following before proceeding:

n "About Archive Security" on page 464

n The X.509, CCL, and SSL information in "Manage CA Certificates" on page 276.

To sign configuration archives:

1. In the Admin Console, select Administration > General > Archive.

2. In the Archive Storage section, under Signing Options, select Sign Archives With Keyring and select a
keyring from the list.

Tip: If you save a signed archive and thenmodify it, youmust subsequently restore
it as an unsigned archive. Because a signed archive contains the output of the show
configuration command, you can extract the command output, modify it as
required, and treat the archive as unsigned thereafter.

To verify the authenticity of a signed archive beforemodifying it, useOpenSSL or
another tool to verify the signature beforemakingmodifications. The use of
OpenSSL is beyond the scope of this documentation.

Encrypt Private Keys in Archives
(Available in version 6.7.5.17 and later, version 7.3.8.1 and later) Configuration archives can include SSH and SSL private
keys, whichmay be useful when restoring archives to another appliance. You can specify a passphrase and algorithm to
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encrypt the private keys; otherwise, the private keys are not included in the archive.

To encrypt private keys in archives:

1. In the Admin Console, select Administration > General > Archive.

2. In the Archive Storage section, under Private Key Encryption Options, select an algorithm: AES-128-CBC orAES-
256-CBC.

3. Select Change Passphrase. On the Change Private Key Encryption Passphrase dialog that appears, enter and
confirm the passphrase.

Upload an Archive to a Remote Server
You can upload an archive to a remote server via HTTP/S, T/FTP, or SCP. Formore information, see "Create and Upload
an Archive to a Remote Server" on the next page.
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Create and Upload an Archive to a Remote Server
Use the following procedure to create a signed or unsigned archive and upload it to a secure, remote host. This
procedure applies to HTTP, HTTPS, FTP, TFTP, and (in version 6.7.5.7 and later) SCP.

To create and upload an archive to a remote server:

Note: This procedure creates only Configuration - expanded archives. You cannot choose
another type.

1. (If you useHTTPS) Specify an SSL device profile to use for the SSL connection.

An SSL device profile, which can be edited, contains the information required for device authentication, including
the name of the keyring with the private key and certificate this device uses to authenticate itself. The default
keyring is appliance-key. (For information on private keys, public keys, and SSL device profiles, see "Configure SSL
and Device Authentication" on page 259.)

2. Obtain write permission to a directory on a secure, remote host. This is where the archivewill be stored.

3. In the Admin Console, select Configuration > General > Archive.

4. (If needed) Under Signing Options, verify that a keyring is selected with the Sign Archives With Keyring option.

5. (In versions 6.7.5.17 and later/7.3.8.1 and later) Under Private Key Encryption Options, specify AES-128-CBC or
AES-256-CBC for encrypting private keys. Then, select Change Passphrase to enter a passphrase. Select None
to clear all private key encryption options.
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6. Under Upload Configuration, configure the upload settings:

Setting or field Description

Protocol Protocol to use for uploads to the remote server: FTP, HTTP, HTTPS, and TFTP. In version 6.7.5.7
and later, SCP is also available.

Filename Prefix (Optional) Filename prefixes to identify the archive. The prefixes add unique, time-based
variables to the filename. The default filename is SG_%l_%Y%m%d%H%M.

SSL Device Profile (Optional, for HTTPS) SSL device profile to use for the SSL connection.

See "Create and Upload an Archive to a Remote Server" on the previous page for more
information about device profiles.

Host and Port Remote server host name or IP address and port number. The remote server can have an IPv4 or
IPv6 address, or be a domain name that resolves to an IPv4 or IPv6 address.

Path (Optional) Remote server upload path (not required for TFTP).

SCP Authentication (In version 6.7.5.7 and later) Upload the configuration archive to a secure, remote host using SCP.
Specify the authenticationmethod:

n None: Clear the configured SCP authentication settings.

n Client Key: Use the appliance's SSH client keys. Select the SSH Client Keys to configure
client keys. See "Manage SSH Client Keys for Outbound Connections" on page 424 for
more information.

n Password: Specify credentials for the remote host. Enter a username in the Username
field and select Change Password to enter the password.

n All: Try to authenticate with SSH client keys first. If unsuccessful, try with the username
and password. The event log shows which method was used successfully. To use this
setting, all Client Key and Password options must be specified.

Username User name associated with the remote host (not required for TFTP).

Change Password (Optional) Password associated with the remote host. On the Change Password dialog, enter and
confirm the password.

7. Select Upload. On theUpload Archive Configuration dialog that appears, select Upload to confirm the action.

Add Identifier Information to Archive Filenames
Use the following prefix substitutions to add unique ID information to archive filenames. Specify these prefixes when
using configuring remote upload in the Admin Console, and the #(config) archive-configuration filename-prefix
command.

Filename Specifier Description

%% Percent sign.
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Filename Specifier Description

%a Abbreviated weekday name.

%A Full weekday name.

%b Abbreviatedmonth name.

%B Full month name.

%C The appliance name.

%d Day of month as decimal number (01 – 31).

%H Hour in 24-hour format (00 – 23).

%i First IP address of the appliance, displayed in x_x_x_x format, with leading zeros
removed.

%I

(upper-case "i")

Hour in 12-hour format (01 – 12).

%j Day of year as decimal number (001 – 366).

%l

(lower-case "L")

The fourth (last) octet in the appliance IP address (for example, for the IP address
10.11.12.13, %l would be 13)

%m Month as decimal number (01 – 12).

%M Minute as decimal number (00 – 59).

%p Current locale’s A.M./P.M. indicator for 12-hour clock.

%S Second as decimal number (00 – 59).

%U Week of year as decimal number, with Sunday as first day of week (00 – 53).

%w Weekday as decimal number (0 – 6; Sunday is 0).

%W Week of year as decimal number, with Monday as first day of week (00 – 53).

%y Year without century, as decimal number (00 – 99).

%Y Year with century, as decimal number.

%Z Time-zone name or abbreviation; no characters if time zone is unknown.
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Restore an Archived Key Ring and Certificate
Use the following procedure to import key pair and certificate data (saved in "Record SSL Keyring and Key Pair
Information" on page 481) onto the target system (the system to which you are restoring the archive).

Note: You can also import a certificate chain containingmultiple certificates. Use the
inline certificate command to import multiple certificates through the CLI. See
"Example: Completed SSL Data Template" on page 484 formore information.

If you are importing a keyring and one ormore certificates onto an appliance, first import the keyring, followed by its
related certificate. The certificate contains the public key from the keyring, and the keyring and certificate are related.

Import an Archived Keyring
Import the configuration-passwords-key keyring:

1. Retrieve your saved configuration-passwords-key data.

2. In the Admin Console, select Configuration > SSL > Keyrings.

3. In the Keyrings section, examine the existing keyrings. If a configuration-passwords-key keyring already exists,
delete it and save the changes.

4. Select Add Keyring. The console opens an Add Keyring page.

5. Configure the keyring options:

a. In theKeyring Name field, type configuration-passwords-key.

b. Select Allow The Key To Be Viewed And Exported.

c. Select Import.

d. Under Paste Private Key, select Paste From Clipboard above the text field. The configuration-
passwords-key data is pasted into the field as obfuscated text.

e. Select Private Key Password and enter the configuration-passwords-key password in the field. This is
the password you saved when you archived the keyring.

The configuration-passwords-key does not have a certificate; however, if one ormore keyrings has a certificate, you
must import it and associate it with a keyring. Refer to the following instructions.

Import an Archived Certificate
Import a certificate and associate it with a keyring:
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1. Copy the certificate to the clipboard.

2. In the Admin Console, select Configuration > SSL > Keyrings.

3. Select the configuration-passwords-key keyring that you just added.

4. In the Certification section, select Paste From Clipboard. The certificate appears in the text field.

5. Make sure that the field includes the ----BEGIN CERTIFICATE---- and -----END CERTIFICATE---- statements.
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Restore an Archive to Another Device
Transfering a configuration archive to another device requires that you use theConfiguration - post setup type and
that you save the SSL keyrings on the appliance—especially the configuration-passwords-key keyring. The process of
creating the archive and saving the associated SSL keyrings is called creating a transferable archive.

Note: Youmust also save the SSL keyrings if you plan to restore an encrypted archive
after a reinitialization. When you reinitialize the appliance, new keys get created, and you
will therefore not be able to restore the configuration unless you first restore the
configuration-passwords-key.

About the configuration-passwords-key
The configuration-passwords-key is an SSL keyring. SSL is amethod of securing communication between devices. SSL
uses a public key to encrypt data and private key to decrypt data. These keys (stored in keyrings) are unique to the
device. This ensures that date encrypted with a device’s public key can only be decrypted by the corresponding private
key.

On Edge SWG (ProxySG) appliances, the configuration-passwords-key SSL keyring is used to encrypt and decrypt the
following passwords on the appliance:

n Administrator console passwords (not needed for shared configurations)

n Privileged-mode (enable) passwords (not needed for shared configurations)

n The front-panel PIN (recommended for limiting physical access to the system)

n Failover group secret

n Access log FTP client passwords (primary, alternate)

n Archive configuration FTP password

n RADIUS primary and alternate secret

n LDAP search password

n SNMP read, write, and trap community strings

n RADIUS secrets for splash pages

Because every appliance has a different configuration-passwords-key, you will receive a decryption error if you try to
restore an archive to another device.

To ensure that the archive can be transferred to another appliance, youmust do one of the following steps:

479 of 676



SGOS Administration (Admin Console Edition)

n Restore the original configuration-passwords-key keyring

While it is possible to reset each of the passwords using the Admin Console, it is easier to save the original keyring
so that you can import it to the new appliance (before restoring the configuration). Restoring the keyring allows all
previously configured passwords to remain valid after archive restoration.

n Change the encrypted passwords to clear text so that they can be regenerated.

Note: To save an SSL keyring, youmust be able to view it. If the key ismarked no-show,
you cannot save it.
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Save and Restore a Transferable Archive
You can save configuration archive and restore it on a different appliance. Use the following steps to create and restore a
transferable archive.

To save a transferable archive:

1. Record the configuration-passwords-key data on the source Edge SWG (ProxySG) appliance, as described in
"Record SSL Keyring and Key Pair Information" below. This data is required to restore the archive onto a target
appliance.

Caution: Keep the password used to encrypt the private key in a secure place. If you
misplace the password, you will not be able to recover your private keys.

2. Record any other SSL keyring data you want to save.

3. Store the keyring data and archive in a secure location.

4. Follow the steps to download an archive in "Create and Restore SystemBackups" on page 467.

To restore a transferable archive, see "Restore a Configuration Archive" on page 468.

Record SSL Keyring and Key Pair Information
For security reasons, do not change encrypted passwords to clear text. Instead, preserve the configuration-
passwords-key keyring on the source device (the appliance fromwhich you created the archive) and import that keyring
to the target device before you restore the archive. You can also use the following procedure to save any other keyrings
required to reload SSL-related configuration that references those keyrings.

To record the configuration-passwords-key keyring on the source appliance:

1. Copy the following template to a text file and use it to record the certificate information so that you can import
and restore it later. This template allows you to import a certificate chain containingmultiple certificates, from the
CLI.

Alternatively, you can simply copy the SSL data into a blank text file.

Note: The following example is shown in smaller text to preserve the structure of the
commands.

!
ssl ; switches from config mode to config ssl
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!
inline keyring show configuration-passwords-key "end-inline"
!
end-inline
inline keyring show default "end-inline"
!
end-inline
!
inline certificate default "end-inline"
!
end-inline
!
! repeat this process for each keyring. Be sure to import the private key first, then the
keyrings certificate
!
exit ; returns to config mode
!

Do not specify your passwords; the systemwill prompt you for themwhen you restore the keys. You canmodify
the template to include other keyrings and certificates.

2. From the CLI, access the config prompt (using the serial console or SSH):

# config terminal

3. Enter the following commands:

#(config) ssl
#(config ssl) view keyring

The console displays a list of existing keyrings (and certificates).

4. Enter the following command:

#(config ssl) view keypair configuration-passwords-key

Note: The aes128 and aes256 encryption options are also supported. If you use
these options, the CLI prompts you to enter a password. Do not lose the password
used to encrypt the private key. If you do, you will not be able to recover your private
keys.

Refer to the following example output:

#(config ssl)view keypair configuration-passwords-key
-----BEGIN RSA PRIVATE KEY-----
aFqxQNOD+321IXdQjCGmT+adeQqMiQDAyCOvWd+aJ+OmDjITpd7bwijcxWA89RB8
y65NSia0UmTClY9MM4j6T/fXhBspEu7Wyc/nM+005pJldxTmZgPig6TiIiOlXtMI
ymCLolxjAr+vFSx7ji6jUT13JxZHfksNd9DS06DHLr6hJNERDi9dGog561zlwBo8
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-----END RSA PRIVATE KEY-----

5. Copy the configuration-passwords-key and paste it into the template (copied in step 1) beneath the line inline
keyring show configuration-passwords-key "end-inline".

6. If a certificate is associated with a keyring, enter the following command:

#(config ssl) view certificate keyring-name

Refer to the following example output:

#(config ssl)view certificate appliance-key

-----BEGIN CERTIFICATE----------END CERTIFICATE-----

7. Copy the certificate and paste it into the template (copied in step 1) beneath the inline certificate cert_name "end-
inline" line).

8. (Optional) For each named keyring that you want to restore, repeat steps 4 to 7.

Note: The appliance-key keyring's private key is not viewable, and cannot be
transferred to another appliance. The default and passive-attack-protection-
only-key keys typically do not need to be restored either.

9. Save the templatewith the configuration-passwords-key and other SSL key data on a secure server.
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10. Save the password information (if you encrypted the keys) in a secure place.

After saving this data, create a configuration archive as described above. When you are ready to restore the
archive, youmust first restore the SSL data on the target appliance as described in "Restore an Archived Key Ring
and Certificate" on page 477.

Example: Completed SSL Data Template
The following example shows how the templatemight look after completing the steps in "Record SSL Keyring and Key
Pair Information" on page 481.

The template allows you to import a certificate chain containingmultiple certificates, from the CLI. When you restore the
data to the appliance, you will be prompted for the encryption password that you used to encrypt the keys.

!
ssl ; switches from config mode to config ssl
!
inline keyring show configuration-passwords-key "end-inline"
-----BEGIN RSA PRIVATE KEY----------END RSA PRIVATE KEY-----
end-inline
!
inline keyring show default "end-inline"
-----BEGIN RSA PRIVATE KEY----------END RSA PRIVATE KEY-----
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end-inline
!
inline certificate default "end-inline"
-----BEGIN CERTIFICATE----------END CERTIFICATE-----
end-inline
!
! repeat this process for each keyring. Be sure to import the private
key first, then the keyrings certificate
!
exit ; returns to config mode
!

Change Encrypted Passwords to Clear Text

Caution: Changing encrypted passwords to clear text is highly insecure. Use the following
procedure at your own risk. Record your SSL keyring and key pair data for safekeeping.

You can edit the configuration to change encrypted passwords to clear text if you choose to keep the existing
configuration-passwords-key keyring intact on the new appliance. You do not need to change hashed passwords to
clear text—when you restore the archive, new hashed-passwords are automatically generated using the target Edge SWG
(ProxySG) appliance’s configuration-passwords-key keyring.

Note: This procedure is not valid for signed archives. Signing guarantees that the archive
has not beenmodified.

To change encrypted passwords to clear text, manually search for every instance of encrypted-password, remove the
encrypted- prefix, and change the encrypted password to clear text.

Consider the following text:

security encrypted-password "$1$rWzR$BT5c6F/RHLPK7uU9Lx27J."
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In the previous example, if the actual password is symantec, edit the entry as follows:

security password "symantec"

Note: Hashed passwords do not have to be changed to clear text. When you restore the
archive, they are restored as specified on the source device. The difference between
hashing and encryption is that encryption enables information to be decrypted and read,
while hashing is amathematical function used to verify the validity of data. For example, a
systemmight not need to know a user’s password to verify that password. The system can
run a hash function on the password and confirm that themathematical result matches
that specified for the user
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Share a Configuration
To ease initial configuration, you can take a post-setup configuration file (one that does not include those configuration
elements that are established in the setup console) from an running appliance and push it to a newly-manufactured or
restored system that is to have the same or similar configuration.

If you push a configuration archive to an appliance that is already configured, the archive is applied to the existing
configuration, changing any existing values. Thismeans, for example, that if the new configuration creates a realm called
RealmA and the existing configuration has a realm called RealmB, the combined configuration includes two realms,
RealmA and RealmB.

Use the Admin Console or the CLI to create a post-setup configuration file on one appliance and share it with other
systems.

Note: You cannot push configuration settings to a newly-manufactured systemuntil you
have completed initial setup of the system.

To create a configuration archive of the source device’s settings using the CLI:

1. Use an SSH client to establish a CLI session with the already-configured appliance.

2. In enablemode, enter the following command:

# show configuration post-setup

This displays the configuration on the current system,minus any configurations created through the setup
console, such as the hostname and IP address. It also includes the installable lists.

3. Save the configuration. You can save the file two ways:

n Copy the contents of the configuration to the clipboard.

n Save it as a text file on an FTP server accessible to the appliance. This is advised if you want to re-use the
file.

4. On the newly-manufactured appliance, retrieve the configuration file by doing one of the following:

n If you saved the configuration to the clipboard, go to the #(config) prompt and paste the configuration
into the terminal.

n If you saved the configuration on a remote server, enter the following command at the enable command
prompt:

# configure network "url"

See "Restore a Configuration Archive" on page 468 for information on formatting theURL for FTP.
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Tip: Alternatively, useManagement Center to push a configuration fromone Edge SWG
(ProxySG) appliance to one ormore devices at once. Formore information, refer to
Management Center documentation on the Export Backup job.

Troubleshooting
Refer to the following troubleshooting tips when pushing a shared configuration or restoring an archived configuration:

n If the configuration includes content filtering, youmust also download a content filter database. If the content-
filtering database has not yet been downloaded, any policy that references categories is not recognized.

n Unless you restore the SSL configuration-passwords-key keyring from the source device, archives can only be
restored onto the same device that was the source of the archive. This is because the encrypted passwords in the
configuration (login, enable, FTP, etc.) cannot be decrypted by a device other than that on which it was encrypted.

n Do not take an expanded archive from an operational appliance and install it onto another appliance. Expanded
archives contain system-specific settings (for example, hostnames, IP addresses, and connection forwarding
settings) that will cause conflicts.

n To use signed archives, your appliancemust have an SSL certificate guaranteed by a CA. If your appliance has a
built-in appliance certificate, you can use it and the corresponding appliance-ccl CCL to sign the archive. If your
appliance does not have a built-in appliance certificate, youmust do the following:

o Create a keyring on the appliance. A keyring contains a public/private key pair. It can also contain a
certificate signing request or a signed certificate.

o Create a Certificate Signing Request (CSR) and send it to a Certificate Signing Authority (CA).

o Have the CA sign the CSR.

To determine if your appliance has a built-in certificate, see "Use the Appliance Certificate to Sign the Archive" on
page 471.
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Required Ports, Protocols, and Services
Depending on your Edge SWG (ProxySG) appliance configuration, youmust open certain ports and protocols on your
firewalls for the appliance to function as intended, or to allow connectivity to various components and data centers. For
full details, refer to the following document:

https://techdocs.broadcom.com/us/en/symantec-security-software/web-and-network-security/proxysg/7-3/ports-
protocols-reference.html
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Configure Data Services
Refer to the following topics to learn about setting up content filtering providers on the Edge SWG (ProxySG) appliance:

n "Content Filtering Overview" on the facing page

Enable content filtering providers, including Blue Coat, YouTube, and a local database. Look upmatching Blue
Coat content filtering categories for any given URL.

n "View and Verify Threat Protection Services" on page 514

EnableWebPulse and Threat Risk Levels (subscription required) services for threat protection.

n "Use Intelligence Services to Classify Applications" on page 525

Enable the Application Classification service. Look up web applications, groups, and operations for a requested
URL. Test the attributes for a web application.

n "About Geolocation " on page 529

Enable Geolocation (subscription required). Identify countries associated with a given IP address for inbound
connections, or with a URL for outbound connections.

n "About Web Isolation" on page 541

Use the SymantecWeb Isolation service or an external web isolation service. Forward specified HTTP request
headers to the selected isolation service. Specify the SSL issuer keyring and server CCL to use for HTTPS requests
forwarded to the selected isolation service.
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Content Filtering Overview
Content Filtering allows you to categorize and analyzeWeb content. With policy controls, content filtering can support
your organization’sWeb access rules by managing or restricting access to Web content and blocking downloads from
suspicious and unratedWeb sites, thereby helping protect your network fromundesirable ormaliciousWeb content.

Content filtering is amethod for screening access to web content. It allows you to control access to web sites based on
their perceived content. On the Edge SWG (ProxySG) appliance, using a content filtering database in conjunction with
policy allows you to manage employee access to web content and to restrict access to unsuitable content. Restricting
access or blocking web content helps reduce the risk of malware infections caused by visiting questionable sites.

Content filtering categories comprehensively classify the vast and constantly growing number of URLs that are found on
theweb into a relatively small number of groups or categories. These categories then allow you to control access to web
content through policy.

A content filtering database:

n Has a pre-defined set of categories provided by the content filtering vendor. Individual content filter providers
such as Symantec Intelligence Services define the content-filtering categories and theirmeanings. Depending on
the vendor, a URL is listed under one ormore categories. Each URL can support amaximumof 16 categories.

n Does not block any web site or category. The role of the database is to offer additional information to the proxy
server and to the administrator about a client request. After you configure your content filter provider and
download the database, you canmap theURLs to the list of categories. You can then reference these categories in
policy and limit, allow, or block requests. Client access to aweb request depends on the rules and policies that you
implement in accordancewith company standards.

Some policies that youmight create, for example, are as follows:

n Block or unblock specific sites, categories, or specific file types such as executables.

n Apply different filtering policy for each site or group within your organization, by IP address or subnet. If you wish
to use password authentication to grant or deny access to the requested content, youmust have configured
authentication realms and groups on the Edge SWG (ProxySG) appliance. For information about configuring
authentication, see " Secure Access to the Appliance" on page 320.

n Allow schedule-based filtering to groups within your organization.

A valid vendor subscription or license is required to download a content filter database. For example, Symantec
WebFilter is licensed whereas some supported third-party vendors require a subscription.

For information on integrating your local appliance content filtering policy with Cloud SWG policy, refer to Universal
Policy: Auto Policy SynchronizationWebGuide.

Web filtering process flow

The following diagram illustrates the process flowwhen web content filtering is employed in the network. This diagram
does not include the dynamic categorization process; for details, see "About Dynamic Categorization " on page 496.
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1. The client requests aWeb page.

2. The Edge SWG (ProxySG) appliance checks the requested URL against the on-box content filtering database to
determine the categorization.

3. After the URL is categorized, the policy engine determines if the URL is allowable or not.

4. TheURL is allowed and the request continues to its destination

5. The policy denies the request and returns amessage concerning corporateWeb compliance.

Enable a Content Filter
Make sure that you have a valid license or subscription (if needed) for the provider before enabling a provider;
otherwise, health errors could occur.

The Edge SWG (ProxySG) appliance supports several content filter providers. To enable a provider, you can select the
Enable switch beside the provider name (if available); however, Broadcom recommends that you configure and verify
provider settings first:

n Local database: Create and upload your custom content filtering database to the Edge SWG (ProxySG) appliance.
This databasemust be in a text file format.

(SGOS 6.7.4 and later) You can configure up to seven additional local databases using the CLI. Refer to the #
(config local database_name) commands in the Command Line Interface Reference.

n Third-party content filtering vendor database: Internet Watch Foundation (IWF), Proventia, and Optenet are
supported.

Only IWF can be enabled in the Admin Console. Formore information, refer to https://www.iwf.org.uk/.

To configure Proventia and Optenet, refer to the Command Line Interface Reference.
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Note: You cannot usemultiple third-party content filtering vendor databases
simultaneously.

n Intelligence Services: A framework for the delivery of data feeds to Symantec platforms. Multiple data feeds are
entitled by subscription to an Intelligence Services solution bundle. These data feeds are delivered andmade
available to the Edge SWG (ProxySG) appliance through the Intelligence Services framework. You can obtain a
license for one ormore bundles, and also enable or disable data feeds in your solution bundle as your
requirements change. See "Configure Blue Coat Content Filtering" on page 509.

n (If available) SymantecWebFilter: Provides both an on-box content filtering database and theWebPulse service, a
cloud-based threat-protection feature. See "Configure Blue Coat Content Filtering" on page 509 to configure
settings before enabling the service for the first time.

n YouTube: The appliance obtains video categories from the YouTubeData API v3.0. After you enable YouTube
categories, you can reference these categories in policy to control YouTube traffic. Before you can enable
YouTube, you require a server key fromGoogle. See "Set the YouTube Server Key " on page 512 for information to
configure settings before enabling the service for the first time.

Note: This feature is provided on an "as-is" basis. Symantec has no control of, and is
not responsible for, information and content provided (or not) by YouTube.
Customer is required to apply and use its own API key in order to activate this
feature, and therefore obligated to comply with all terms of use regarding the
foregoing (for example, see https://developers.google.com/youtube/terms),
including quotas, restrictions and limits on use that may be imposed by YouTube.
Symantec shall not be liable for any change, discontinuance, availability or
functionality of the features described herein.

Add Category Review Link to Exception Messages
(SymantecWebFilter/Intelligence Services only)  Add a link to the default content filter exception pagewhen a user is
denied a request for a web page.

Exception pages are customized web pages (ormessages) sent to users under specific conditions defined by a company
and its security policies. An exception page is served, for example, when a category is blocked by company policy. The
Edge SWG (ProxySG) appliance offersmultiple built-in exception pages that can bemodified to meet your enterprise
needs. For content filtering, the appliance includes the content_filter_denied and content_filter_unavailable built-
in exception pages.

The content_filter_denied exception page includes the following information:

n an exception pagemessage that includes the content filtering category affecting the exception.

n a category reviewURL, where content categorizations can be reviewed and/or disputed.
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Typically, the exception page informs the user why a URL request is denied. When you add the link to exception pages,
the user can select it to request a review of the category assigned to the blocked URL. To customize the exception page,
refer to theWeb Visual Policy Manager Reference or Legacy Visual Policy Reference.

To add the category review link to exceptionmessages:

1. In the Admin Console, select Administration > Data Services > Content Filtering.

2. In theOptions section, select Enable category review message in exceptions.

The content_filter_unavailable exception page includes amessage that states the reason for the denial and provides
a probable cause. For example, the request was denied because an external content filtering servicewas not available
owing to transient network problems, or a configuration error.

Set Memory Allocation

The default memory allocation setting (Normal) is ideal formost deployments; increasing the setting is not
recommended inmost situations because content filtering databases can be very large and require significant resources
to process.

Youmight be able to adjust the amount of memory allocated to the database in the following cases:

n If you are not using ADN and have a high transaction rate for content filtering, you can increase thememory
allocation setting to High. This helps content filtering runmore efficiently.

n If you are using both ADN and content filtering but the transaction rate for content filtering is not very high, you
can reduce thememory allocation setting to Low. Thismakesmore resources available for ADN, allowing it to
support a larger number of concurrent connections.

To set memory allocation:

1. In the Admin Console, select Administration > Data Services > Content Filtering.

2. Under Options, select thememory allocation level.

Test the Category, Application, and Operation for a URL
If you're using Intelligence Services orWebFilter for content filtering, you have the additional ability to deny or allow
access to certain web applications and/or operations; this is done via policy (either VPM or CPL). To determine the
application or operation name associated with a URL so that you can create policy to block or allow it, you can do aURL
test.

In addition to URL category filtering, you can filter content by Web application and/or specific operations or actions done
within those applications. For example, you can create policy to:

n Allow users to access all social networking sites, except for Facebook. Conversely, block access to all social
networking sites except for LinkedIn.

n Allow users to post comments and chat in Facebook, but block uploading of pictures and videos.
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n Prevent the uploading of videos to YouTube, but allow all other YouTube operations such as viewing videos others
have posted. Conversely, preventing uploading but block access to some videos according to the video’s category.

n Allow users to access their personal email accounts, but prevent them from sending email attachments.

This feature allows administrators to block actions in accordancewith company policy to avoid data loss accidents,
prevent security threats, or increase employee productivity.

To test the category, application, and operation associated with a URL:

1. In the Admin Console, select Administration > Data Services > Content Filtering.

2. In the Test Category Match section, enter theURL and select Test URL. The browser opens a new pagewith the
category, application, and operation assigned to theURL.

Note: Themaximumnumber of categories for any single URL is 16. If more than 16
categories are specified, the Edge SWG (ProxySG) appliance arbitrarily matches
against 16 out of the total number specified.

TheURL facebook.com/video/upload_giver.php is categorized as follows:

n Social Networking; Audio/Video Clips

n Facebook

n Upload Videos

The test results in this example indicate that the URL has two categories (Social Networking and Audio/Video
Clips), is the Facebook application, and is the Upload Videos operation.

Note that not all URLs have applications and operations associated with them. For URLs that WebFilter has not
assigned an application or operation, the test results indicate none.

If you have a license, you can also test applications and operations using Application Classification. Refer to the
SGOS Administration Guide for details. See "Use Intelligence Services to Classify Applications" on page 525.
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About Symantec WebFilter and the WebPulse Service
SymantecWebFilter, in conjunction with theWebPulse service, offers a comprehensive URL-filtering solution. Symantec
WebFilter provides an on-box content filtering database andWebPulse provides an off-box dynamic categorization
service for real-time categorization of URLs that are not categorized in the on-box database. WebPulse dynamic
categorization includes both traditional content evaluation, for categories such as pornography, as well as realtime
malware and phishing threat detection capabilities. For a list of current categories, see the Site Review category
descriptions website. WebPulse services are offered to all customers using SymantecWebFilter.

WebPulse, part of the Symantec Global IntelligenceNetwork (GIN), is a cloud-based infrastructure specifically designed
to harness the power of user-driven behavior and to translate user input into global web intelligence and web threat
intelligence. Symantec GIN is a collaborative defense cloud that powers Symantec secureweb gateway solutions by
integrating input fromdiverse enterprises, Symantec Endpoint Protection users, and billions of emails scanned by
Symantec email security products. WebPulse usesmultiple technologies to analyze this input to deliver fast and accurate
web categorization and ratings. Within theWebPulse framework, each incoming URL request is processed by many
different threat analysismethods, both automated andmanual. ThemasterWebFilter database is continuously updated
based on the analysis of these requests, and the Edge SWG (ProxySG) appliance expediently updates its on-box copy of
the SymantecWebFilter database.

About 95% of theWeb requestsmade by a typical enterprise user (for the English language) are present in the on-box
SymantecWebFilter database, thereby minimizing bandwidth usage andmaintaining quick response times.

By default, theWebPulse service is enabled and configured to dynamically categorize unrated and newWeb content for
immediate enforcement of policy. Typically, the response time from the dynamic categorization service is about 500
milliseconds and is subject to the response/performance of the site in question. However, if this service is causing
significant delays to your enterprise web communications, you can run it in Backgroundmode. If dynamic categorization
is disabled, proactive threat detection, content and reputation ratings are also disabled. The appliance contacts the
WebPulse service usingmutual endpoint authentication over TLS. For best security, the connection is always encrypted.
If you opt to use a non-secure connection, all data is sent over the connection as plain text. For information, see
"ConfigureWebPulse" on page 519.

About Dynamic Categorization
The dynamic categorization service analyzes and categorizes new or previously unknown URLs, which are not in the on-
box SymantecWebFilter database. Dynamic categorization can be processed in twomodes—immediately or in the
background.

By default, dynamic categorization is set to be performed immediately, which is in real time. When a user requests a URL
that has not already been categorized by the SymantecWebFilter database (for example, a newweb site), theWebPulse
dynamic categorization service queries the target Web site and retrieves the page’s content. WebPulse analyzes the
page’s content and context in search of malicious content. If malicious content is found, an appropriate category (for
example, Spyware/Malware sources or Phishing) is returned.

If no malicious content is found, WebPulse’s dynamic real time rating service determines the language of the page, a
category for the page, and a confidence factor that the category is correct. If the confidence factor is high, the calculated
category is returned. In situations where the dynamic categorization service cannot categorize a URL with enough
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confidence to dynamically return a category with a high confidence level, the category rating request for the particular
page is labeled none. All URLs received by WebPulse that are not categorized in the SymantecWebFilter database are
logged and forwarded to Symantec’s centralized processing center, where they are prioritized for rating by a series of
automated URL analysis tools and/or human analysis. These ratings are then used to update themaster Symantec
WebFilter database, and the automatic database update feature then refreshes the local SymantecWebFilter database
on the Edge SWG (ProxySG) appliance.

When dynamic categorization is performed in Backgroundmode, the Edge SWG (ProxySG) appliance continues to
service theURL request without waiting for a response from theWebPulse dynamic categorization service. The system
category pending is assigned to the request, indicating that the policy was evaluated with potentially incomplete
category information. WhenWebPulse returns a category rating, the rating is stored in a dynamic categorization cache so
that the next time theURL is accessed, WebPulsewill not be required to determine its category.

Note: The dynamic service is consulted only when the installed SymantecWebFilter
database does not contain authoritative category information for a requested URL. If the
category returned by theWebPulse service is blocked by policy, the offendingmaterial
does not re-enter the network.

TheURL is first looked up in the local SymantecWebFilter database. The expected results are shown in the following
table.

Found in
Local
WebFilter
Database

Found
in
Rating
Cache

Process Mode Result / Description

Yes Any Any The corresponding list of categories in the database is returned.

No Yes Any The corresponding list of categories in the ratings cache is
returned.

No No Dynamic Categorization disabled None. No categories are available for the URL.
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Found in
Local
WebFilter
Database

Found
in
Rating
Cache

Process Mode Result / Description

No No Dynamic Categorization in
BackgroundMode

Pending. The Edge SWG (ProxySG) appliance continues to
service the URL request without waiting for a response from
WebPulse.

If a response is received, it is added to the rating cache, so
future requests for that same URL will have the appropriate list
of categories returned immediately.

Reference to the site is recorded for future categorization in the
WebFilter database by automated background URL analysis or
human analysis.

If a response is not received in a timely manner, or the request
results cannot be categorized, nothing is added to the rating
cache.

Note: It is possible that multiple requests for
the same content can result in a Pending
status if WebPulse has not completed
processing the first request before
subsequent requests for the same URL are
received by the Edge SWG (ProxySG)
appliance.

No No Dynamic Categorization in Real-
time Mode and categories
returned by WebPulse

A request to categorize the URL is sent to WebPulse and the
Edge SWG (ProxySG) appliance waits for a response.

The response is added to the rating cache and also used as the
list of categories for the current request.
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Found in
Local
WebFilter
Database

Found
in
Rating
Cache

Process Mode Result / Description

No No Dynamic Categorization in Real-
time Mode and categories not
returned by WebPulse

None. Categories might not be returned because:

n The Edge SWG (ProxySG) appliance did not get a
response from the WebPulse service.

n The WebPulse service was unable to retrieve the
requested URL in a timely manner.

n The WebPulse service cannot categorize the request
with high confidence.

References to all URLs requested in WebPulse are recorded for
future categorization in WebFilter by automated background
analysis or human analysis.

Note: Timeout is currently set to three
seconds. Average response time for
WebPulse to retrieve the content and
perform real-time analysis is under 500
milliseconds.

Any Any Any Unlicensed. A problem exists with the WebFilter license.

Any Any Any Unavailable. A problem (other than licensing) exists with the
local WebFilter database or accessing the WebPulse service.

About the Dynamic Categorization Process
Dynamic analysis of content is performed through theWebPulse cloud service and not locally on the Edge SWG
(ProxySG) appliance. There is a small amount of bandwidth used for the round-trip request and response, and a slight
amount of timewaiting for the service to provide results. As the service is only consulted for URLs that cannot be locally
categorized using the SymantecWebFilter database andWebPulse results are cached on the appliance, the user
experience is generally not affected.

To avoid per-request latency, youmight want to run dynamic categorization in backgroundmode. Formodifying the
default, see "ConfigureWebPulse" on page 519.

The following diagram illustrates SymantecWebFilter’s content filtering flowwhen dynamic categorization is enabled.
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Clear the WebPulse Cache
Use the following CLI command:

# (config bluecoat) service clear-cache

Dynamic Categorization States
Dynamic categorization has three states:

n Enabled: The service attempts to categorize unrated web sites. This is the default state.

n Disabled: If the service is disabled, the Edge SWG (ProxySG) appliance does not contact theWebPulse service,
regardless of any policy that might be installed.

n Suspended: Categorization from the database continues, but the service is no longer employed. This occurs when
the installed database is over 30 days old due to the expiration ofWebFilter download credentials or network
problems. After credentials are renewed or network problems are resolved, the service returns to Enabled.
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Supported Content Filter Providers
Before you begin setting up content filtering, ensure that you have a valid subscription from a content filter provider of
your choice. Only YouTube and the local database do not require a subscription or license. Content filtering
configuration on the appliance consists of:

n Enabling the content filter provider

n Downloading the content filter database

n Applying policy

The following content filter providers are supported:

n " Local Database " below

n "Intelligence Services andWebFilter" on the next page

n "Categories for YouTube" on the next page

n "Third-Party Content Providers" on page 503

See Also:

n "Downloading the Content Filter Database" on page 503

Local Database
A local database is a text file that consists of define category CPL definitions. Defining categories in a local database
instead of a policy file is useful because:

n A local database ismore efficient than policy if you have a large number of URLs

n A local database separates administration of categories frompolicy. This separation is useful for three reasons:

o It allows different individuals or groups to be responsible for administering the local database and policy.

o It keeps the policy file from getting cluttered.

o It allows the local database to share categories acrossmultiple boxes that have different policy.

However, some restrictions apply to a local database that do not apply to policy definitions:

n Nomore than 200 separate categories are allowed.

n Category namesmust be 32 characters or less.

n A given URL pattern can appear in nomore than four category definitions.

n The local database produces only themost specific URL match and returns a single category.
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The same policy syntax will produce a different match. If more that one category is provided, policy processing
may matchmore than one category and hencewill returnmore than one category. See "Local DatabaseMatching
Example" on page 507 formore information.

You can use any combination of the local database, policy files, or the VPM tomanage your category definitions. You can
also use both a local database and a third party vendor for your content filtering needs.

(SGOS 6.7.4.107 and later) The appliance supports up to seven additional local databases, which you configure in the
CLI. Refer to the #(config local database_name) commands in the Command Line Interface Reference for details.

To configure a local database, see "Configure a Local Database" on page 505.

Tip: Symantec recommends putting your local database on the same server as any policy
files you are using.

Intelligence Services and WebFilter
Symantec provides two on-box content filtering data sources:

n Intelligence Services: Subscription service that delivers existing and new data services such as Threat Risk Levels.
To configure Intelligence Services, see "Intelligence Services" on page 509.

n WebFilter: Content filtering database that protects data and users fromnetwork attacks. To configureWebFilter,
see "Blue Coat WebFilter" on page 509.

Tip: TheWebFilter data sourcewill be removed in a future release of SGOS 7.x.

You can't use both data sources at once; Intelligence Services is recommended for its advanced capabilities.

See Also:

n "Configure Threat Risk Levels" on page 523

Categories for YouTube
Before enabling categories for YouTube, you require an API server key. For instructions, see "Configure Categories for
YouTube" on page 512.
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Note: This feature is provided on an "as-is" basis. Symantec has no control of, and is not
responsible for, information and content provided (or not) by YouTube. Customer is
required to apply and use its own API key in order to activate this feature, and therefore
obligated to comply with all terms of use regarding the foregoing (for example, see
https://developers.google.com/youtube/terms), including quotas, restrictions and limits
on use that may be imposed by YouTube. Symantec shall not be liable for any change,
discontinuance, availability or functionality of the features described herein.

Third-Party Content Providers
Currently, the Edge SWG (ProxySG) appliance supports Internet Watch Foundation (IWF), Proventia, and Optenet. You
can enable IWF under Providers (Administration > Data & Cloud Services > Content Filtering). Proventia and
Optenet can be configured through the CLI only. Refer to the Command Line Interface Reference for details.

Downloading the Content Filter Database
The dynamic nature of the Internet makes it impossible to categorize web content in a static database. With the constant
flow of newURLs, URLs of lesser-known sites, and updatedWeb content, maintaining a current database presents a
challenge. To counter this challenge, the Edge SWG (ProxySG) appliance supports frequent content filter database
downloads.

Formore information about the SymantecWebFilter database, see "About SymantecWebFilter and theWebPulse
Service" on page 496.

About Database Updates

Symantec enables all customers with a valid content filtering license to schedule automatic downloads of content filter
databases. By default, automatic updates are enabled; The Edge SWG (ProxySG) appliance checks for updates once in
every fiveminutes and downloads an incremental updatewhen available.

After selecting your provider(s) of choice, youmust enter the license information and download the database(s) on the
Edge SWG (ProxySG) appliance. You can download a database on demand or schedule a periodic download using the
automatic download feature.

Typically, a complete database download occurs when you enable the provider and add the license key for the first time.
Thereafter, the Edge SWG (ProxySG) appliance periodically checks the download server for updates to the installed
database. If the database is current, no download is performed.

When an update is available, it is automatically downloaded and applied. An update provides themost current
categorization of URLs and contains only the changes between the current installed version and the latest published
version of the database, and hence ismuch smaller than a full copy of the database. In the unlikely event that this
conditional download fails, the Edge SWG (ProxySG) appliance downloads the latest published version of the complete
database.
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Note: By default, the Edge SWG (ProxySG) appliance checks for database updates once in
every fiveminutes. While you can schedule the time interval for an automatic database
update, the frequency of checks is not configurable.
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Configure a Local Database
The local database is a text file that must be located on aweb server that is accessible by the Edge SWG (ProxySG)
appliance on which you want it configured. You can't upload the local database from a local file. The local database file
allows define categorydefinition blocks only. Refer to the Content Policy Language Reference for details on using this
policy gesture.

To configure a local database:

1. Create a text file in the following format:

define category category_name
url1
url2
urln

end

define category category_name
url1
url2
urln

end

Each category can have an unlimited number of URLs.

2. Upload the text file to aweb server that the Edge SWG (ProxySG) appliance can access.

3. In the Admin Console, select Administration > Data Services > Content Filtering.

4. In the Providers section, select Local Database (default) to configure the default local database.

(In SGOS 6.7.4. and later) To configure additional local databases, select Add Local Database. You can configure
up to seven additional local databases. The browser displays the Add/Edit Local Database page.
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5. In the Settings section, enter or edit the following settings as needed:

Setting
or field

Description

Enable
Local
Database

Enables or disables the local database.

Note: When you enable the service for the first time and apply changes, a databa
se download is initiated.

Lookup
Mode

(Optional) For a web request, the lookupmode determines the databases that the Edge SWG (ProxySG)
appliance searches for a category match. To perform a lookup, the database must be enabled. The lookup
sequence executed is policy, local database, IWF, Blue Coat content filter, and third-party database.

n Always: (Default) Database is always consulted for category information. If a URL is categorized
under more than one category in different databases, policy is checked against each category listed.

n Uncategorized: Database lookup is skipped if the URL match is found in policy, Blue Coat content
filter, or IWF database.

Show
Local
Database
Source

Display the contents of the local database file.

6. In theDownload section, enter or edit the following settings as needed:

Setting or
field

Description

URL The database download location.

Username
and Password

If the database is located on a server that requires a password for access, youmust configure the
appliance to use that password when accessing the database:

Automatically
check for
updates

By default, the Edge SWG (ProxySG) appliance checks for database updates once in every five minutes.

To schedule the time interval for an automatic database update, select between and enter the start
and end times of the interval. You can't specify the frequency of checks.

Download
Now

If needed, select this to download the database immediately. The Download Status field shows the
download progress.

Cancel
Download

(Available while a download is in progress) To stop any download of the content filtering database that
is currently in progress (including a download initiated from the CLI), click Cancel Download. The
console displays a “Canceling download” dialog. When the download is canceled, the dialog message
changes to “Download Canceled”.
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Setting or
field

Description

Refresh
Status

(Available while a download is in progress) When the database is downloaded, the download log
includes detailed information on the database.

If you have just configured content filtering and are downloading the database for the first time, the
Edge SWG (ProxySG) appliance downloads the latest published version of the complete database.
Subsequent database updates occur incrementally.

Note: Incremental updates are not available for local databases.

Local Database Matching Example
The local database produces only themost specific URL match and returns a single category. Consider the following
examples.

Local Database

Consider the following syntax.

define category no_detect_protocol
mail.google.com

end

define category google
google.com

end

Local database result:

https://<proxy>:8082/ContentFilter/TestUrl/mail.google.com/
Local: no_detect_protocol
Blue Coat: Mail

Gmail
none

Policy

This example uses the same syntax as the local database example.

<proxy>
ALLOW

define category no_detect_protocol
mail.google.com

end
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define category google
google.com

end

Policy Result:

https://<proxy>:8082/ContentFilter/TestUrl/mail.google.com/
Policy: no_detect_protocol; google
Blue Coat: Mail, Search Engine

Gmail
none

As shown, policy returns both categories; whereas, the local database returns only theURL match.
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Configure Blue Coat Content Filtering
You can use one of two Blue Coat content filtering services for content filtering and Application Classification: Blue Coat
WebFilter or Intelligence Services.

To configure a Blue Coat content filter, youmust "Configure the Blue Coat Data Source" below.

Blue Coat WebFilter
Blue Coat WebFilter (BCWF) is an on-box content filtering database that protects data and users fromnetwork attacks.
All SymantecWebFilter subscribers are a part of theWebPulse cloud service, which continuously updates the on-box
database. SymantecWebFilter andWebPulse provide dynamic real-time rating, which can instantly categorizeWeb sites
when a user attempts to access them.

BCWF requires a valid license, a downloaded database, and a constant connection to Symantec servers to maintain
license validity and download regular database updates. If you enable the feature but do not have a valid license, you will
be unable to download the BCWF database.

Intelligence Services
n (Applicable to SGOS 7.1.x and earlier and someupgrades to SGOS 7.2.x and later) If it isn’t already set, make sure

that Intelligence Services is the data source (see "Configure the Blue Coat Data Source" below. Then, the appliance
can perform categorization using the Intelligence Services database.

In addition, you can download a new version of the databasewhen required, and also check the feature’s health
status.

n Verify that your subscribed bundles are listed in the Admin Console. See "Verify Subscribed Bundles" on page 554.

Intelligence Services requires a valid license for the bundles that include the data feeds you want to use, a downloaded
database, and a constant connection to Symantec servers to maintain license validity and download regular database
updates. If you enable the feature but do not have a valid license, you will be unable to download the Intelligence
Services database.

Configure the Blue Coat Data Source

Note: This procedure is applicable only if you have the option to select eitherWebFilter or
Intelligence Services as a content filtering data source.

To configure the data source:

1. In the Admin Console, select Administration > Data Services> Content Filtering.

2. In the Providers section, select Blue Coat. The browser displays the Configure Blue Coat Content Filtering page.
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3. In the Settings section, enter or edit the following settings as needed:

Setting or
field

Description

Enable
Blue Coat
Filtering

Enables or disables the service.

Note: When you enable the service for the first time and apply changes, a
database download is initiated.

WebPulse
Status

Select Edit to configure WebPulse. See step 3 in "Configure WebPulse" on page 519.

Lookup
Mode

(Optional) For a web request, the lookupmode determines the databases that the Edge SWG (ProxySG)
appliance searches for a category match. To perform a lookup, the database must be enabled. The lookup
sequence executed is policy, local database, IWF, Blue Coat content filter, and third-party database.

n Always: (Default) Database is always consulted for category information. If a URL is categorized
under more than one category in different databases, policy is checked against each category listed.

n Uncategorized: Database lookup is skipped if the URL match is found in policy, a local database, or
IWF database.

Data
Source

SelectWebFilter or Intelligence Services.

Tip: If a Symantec WebFilter username and password are configured on the
appliance, but you save a configuration archive (or Symantec Management
Center backs up the configuration) while the data source is set to Intelligence
Services, the archive does not save the WebFilter username/ password. To
archive the WebFilter username and password, switch the data source back to
WebFilter and save a separate configuration file.

4. In theDownload section, enter or edit the following settings as needed:

Setting or
field

Description

URL The default database download location. If you have been instructed to use a different URL, enter it
here.

Username
and Password

Enter valid subscription credentials to download the database. If the database has previously been
downloaded on a local web server that requires authentication, youmust configure the Edge SWG
(ProxySG) appliance to use credentials that allow access to the Web server, which hosts the content
filter database.
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Setting or
field

Description

Automatically
check for
updates

By default, the Edge SWG (ProxySG) appliance checks for database updates once in every five minutes.

To schedule the time interval for an automatic database update, select between and enter the start
and end times of the interval. You can't specify the frequency of checks.

Download
Now

If needed, select this to download the database immediately. The Download Status field shows the
download progress.

Note: When you enable the service for the first time, a database download is
initiated.

Cancel
Download

(Available while a download is in progress) To stop any download of the content filtering database that
is currently in progress (including a download initiated from the CLI), click Cancel Download. The
console displays a “Canceling download” dialog. When the download is canceled, the dialog message
changes to “Download Canceled”.

Refresh
Status

(Available while a download is in progress) When the database is downloaded, the download log
includes detailed information on the database.

If you have just configured content filtering and are downloading the database for the first time,
theEdge SWG (ProxySG) appliance downloads the latest published version of the complete database.
Subsequent database updates occur incrementally.

See "Downloading the Content Filter Database" on page 503 for information on database downloads.

5. (If needed) Enable the service. In the Settings section, select Enable Blue Coat Filtering.

License Validity and Database Expiration

A valid subscription is required to update the database. Each time a database download is triggeredmanually or using
automatic download, the validity of the database is reset.

When your license expires, you can no longer download the latest version. The expiry of a database license does not
have an immediate effect on performing category lookups for the on-box categories. You can continue to use the on-
box database until the expiry of the database.

When the database expires, the category unlicensed is assigned to all URLs and no lookups occur on the database.

See Also:

n "About SymantecWebFilter and theWebPulse Service" on page 496
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Configure Categories for YouTube
The appliance recognizes three types of YouTubeURLs. The effectiveness of policy and coaching pages differs amongst
the different URL types. Refer to the following table.

URL Type Example(s) of User Action Deny policy works Coaching page works

YouTube
homepage

User plays a video at www.youtube.com within a
desktop web browser.

The URL starts with: http://www.youtube.com/watch?v=

Yes Yes

YouTube
mobile
website

User plays a video at www.youtube.com within a mobile
web browser (the URL redirects to
http://m.youtube.com/index).

The URL starts with: http://m.youtube.com/watch?v=

Yes Yes

Embedded
in an
<iframe>

User plays a video that has been embedded in a blog
post.

The URL could start with:
http://www.youtube.com/embed/

Yes. The deny page is
confined within the <iframe>.

Yes. The coaching page
is confined within the
<iframe>.

Video
transport

User plays a YouTube playlist within a desktop web
browser.

The URL could start with:
*.c.youtube.com/videoplayback?

Yes. The user may see an
error message for the
blocked video.

No

For information on implementing coaching pages, refer to theNotify User action in theWeb Visual Policy Manager
Reference.

The list of categories is static. In the Visual Policy Manager, you can view the categories in the category list
(Configuration > Edit Categories) and in theRequest URL Category object, but you can't add, rename, edit, or
remove them.

Set the YouTube Server Key
Before you can enable YouTube as a provider, youmust obtain an API server key and set it on the Edge SWG (ProxySG)
appliance. For instructions, refer to the following article:

https://knowledge.broadcom.com/external/article/168418

After you set the server key, select YouTube in the Admin Console at Configuration > Content Filtering > General.
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View YouTube Categories in the Access Log
If the feature is enabled and categories are selected, and if you use an ELFF format for access logs, you can use the
existing category access-log field to report on specified categories; however, the categories will be logged without the
provider name. In addition, some categories share nameswith Symantec categories, such as Entertainment.

To distinguish between Symantec-defined categories and YouTube categories in the access log, specify the ELFF field cs-
categories-qualified. This field provides a list of all content categories of the request URL, qualified by the provider.
For example, traffic matching YouTube’s Entertainment category would be logged as Entertainment@YouTube.

For information on access log formats, see "About Access Log Formats" on page 580.
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View and Verify Threat Protection Services
The appliance supports the following threat protection solutions:

n WebPulse: An off-box dynamic categorization service for real-time categorization of URLs that are not rated or
categorized in the on-box database. See "About WebPulse" below.

n Threat Risk Levels: A service that usesWebPulse to perform real-time lookups to analyze the threat risk level of
URLs. See "About Threat Risk Levels" below.

In the Admin Console, theAdministration > Data Services > Threat Protection page provides an overview of threat
protection services. Fromhere, you can:

n Enable or disable a service by switching the Enable toggle.

n Verify successful database download in the Last Download field.

n Determine if any downloads failed in the Failed Attempts field; then, troubleshoot connection or licensing issues
if needed.

n Configure service settings; see below formore information.

About WebPulse
WebPulse is a cloud service that provides the off-box component of Symantec’s complete content filtering solution. The
WebPulse cloud service blocksmalware hosts, ratesWeb content and protects Edge SWG (ProxySG) appliances. Formore
information, see "About SymantecWebFilter and theWebPulse Service" on page 496.

See Also:

n "ConfigureWebPulse" on page 519

About Threat Risk Levels
The Threat Risk Levels service analyzes a requested URL's potential risk and summarizes it in the form of a numeric value
(see "About WebPulse" above). You can reference these values in policy to protect your network and your users from
potentially malicious web content. WebPulse is used for real-time Threat Risk Level lookups.

See Also:

n "Configure Threat Risk Levels" on page 523
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Considerations Before Configuring WebPulse
TheWebPulse protocol regulates the communication between the dynamic categorization client on the Edge SWG
(ProxySG) appliance and theWebPulse cloud service.

Before configuringWebPulse services (see "ConfigureWebPulse" on page 519), answer the following questions:

n Do you use proxy chaining or SOCKS gateways?

If you use a forwarding host for forwarding dynamic categorization requests through upstreamproxies or use
SOCKS gateways, see "About Proxy Chaining Support forWebPulse Services" below formore information on the
forwarding options inWebPulse.

n Would you like to configure private networks to identify traffic relating to your internal networks while using
WebPulse for content rating accuracy?

If you specify your private networks, information pertaining to the configured internal network is removed by the
Edge SWG (ProxySG) appliance, prior to sending a dynamic categorization request across to theWebPulse service.
For understanding the interaction between private networks and dynamic categorization, see "About Private
Information Sent to WebPulse" on the next page.

n Would you like to providemalware feedback notification to theWebPulse community?

This option is applicable only if you have a ProxyAV configured on the Edge SWG (ProxySG) appliance, and
malware scanning andWebFilter are enabled. When the appliance is integrated with the ProxyAV, the appliance
monitors the results of the ProxyAV scan and notifies theWebPulse servicewhen a new virus ormalware is found.
This feedback helps update themalware and content ratings and protects the entire community of WebPulse
users. For information on adding a ProxyAV and enablingmalware scanning, seeMalicious Content Scanning
Services.

About Proxy Chaining Support for WebPulse Services
Proxy chaining is amethod for routing client requests through a chain of Edge SWG (ProxySG) appliances until the
requested information is either found in cache or is serviced by theOCS. The Edge SWG (ProxySG) allows you to forward
dynamic categorization requests through upstreamproxies and SOCKS gateways.

Forwarding Hosts and Dynamic Categorization
To forward dynamic categorization requests through an upstreamHTTP proxy, configure a forwarding host that is
defined as a proxy and specify theHTTP port for the connection. You can then select that forwarding host in the
WebPulse configuration.

If forwarding is configured, you cannot enable secure dynamic categorization; if secure dynamic categorization is
enabled, you cannot select a forwarding host.
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SOCKS Gateways
If you use proxy chaining for load balancing or for forwarding the dynamic categorization request through an upstream
SOCKS gateway, youmust configure the SOCKS gateway before configuring theWebPulse service.

Note: Before configuring the SOCKS gateway target forWebPulse, verify that the SOCKS
gateway is operating correctly.

When both SOCKS and forwarding are configured, the Edge SWG (ProxySG) connects to the SOCKS gateway first, then to
the forwarding host, and then to theWebPulse service.

About Private Information Sent to WebPulse
A private network is an internal network that uses private subnets and domains, for example, your intranet. For
information on configuring private subnets or private domains, refer to the SGOS Administration Guide.

By default, dynamic categorization is enabled on the Edge SWG (ProxySG) appliance. When a requested URL is not in the
dynamic categorization ratings cache or categorized in theWebFilter database, the request is sent to theWebPulse cloud
service for dynamic categorization. By configuring private subnets and private domains within your network, you can
use dynamic categorization to ensure accuracy of content filter ratings, while preserving the security of sensitive
information relating to your private networks.

Before a request is sent for content rating to theWebPulse cloud service, the following conditions are verified on the
appliance:

n Is WebPulse service and dynamic categorization enabled?

n Is dynamic categorization permitted by policy?

n Is the host specified in the private domain or private subnet list?

Any request that is determined to be part of your configured private network is not sent to WebPulse.

The Edge SWG (ProxySG) appliancemight send information fromHTTP and HTTPS requests to theWebPulse service if
they are not directed to hosts that are part of the configured private network.

Note: Private network domain names and IP subnets can be user-defined.

Customer information sent to theWebPulse service is controlled by user-defined policy, although you can still use the
default policy and configuration settings provided by the Edge SWG (ProxySG) appliance. Overriding the default settings
with your organization’s policy definitions results in more control of the type of information that is sent to theWebPulse
service.
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WhenWebPulse service is enabled, the default configuration settings send the fixed customer data and the following
information:

n Customer License Key (Example: QA852-KL3RA)

n Scheme (Example: HTTP, HTTPS)

n Method (Examples: GET, POST)

n URL Host

n URL Port

n URL Path

n URL query string

n Referer header

n User-Agent header

However, this additional information can be controlled by policy and/or configuration settings:

n If the service send-request-info setting is set to disable, by default, only the customer license key, URL scheme,
method, host, port, and path are sent to theWebPulse service; URL query string, and the Referer and User-Agent
headers are not sent.

n If the service send-request-info setting is set to enable, by default, referrer and user agent information and so on
can be sent to the server. Symantec gathers this customer information fromback-end logs and analyzes the data
to help improve its threat protection. In its analysis, Symantec does not consider the source of the data; that is,
customer information is anonymous.

Note: Be aware that personal informationmight be included in theURL query string. If
this information is sent to WebPulse, Symantecmight use it when accessing content from
theweb site to categorize it.

You can further control whether to include theURL path and query string, and individually control whether the Referer
or User-Agent headers are sent for specific requests. Restrictions are accomplished through the use of policies that can
be defined from the Admin Console or CLI.

The following table lists the type of information that is sent to theWebPulse service based on default settings for all
SGOS versions supportingWebPulse.

Information Sent to the WebPulse Service service send request- info disable service send request- info enable

Customer License Key (Example: QA852-KL3RA) Yes Yes

Scheme (Examples: HTTP, HTTPS) Yes Yes
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Information Sent to the WebPulse Service service send request- info disable service send request- info enable

Method (Examples: GET, POST) Yes Yes

URL Host/Port Yes Yes

URL Path1 Yes Yes2

URL Query String No Yes2

Referer Header No Yes2

User-Agent Header No Yes2

Content-Type No Yes2

Content-Length No Yes2

1. Path = URL minus any query string.

2. Can be controlled using CPL.
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Configure WebPulse
To configure theWebPulse service:

1. In the Admin Console, select Administration > Data Services > Threat Protection.

2. In Threat Protection, selectWebPulse.

TheWebPulse page displays service settings.

3. Enter or edit the following settings as needed:

Task Setting or field Description

Check or
change the
status of the
service, the
Blue Coat
content
filter, and
download

Enable WebPulse
Service

Switch the toggle to enable or disable the service.

If you disable the WebPulse service, dynamic categorization andmalware feedback
are also disabled. References to perform dynamic categorization in policy are also
disregarded. For more information, see "About Symantec WebFilter and the
WebPulse Service" on page 496.

Blue Coat Content
Filtering

Verify that Blue Coat is enabled as your content filter provider. If disabled, switch
the toggle to enable the setting.

When this option is disabled, the WebPulse option is unavailable.

Last Download
Status

Confirm that the last download succeeded. The field displays statistics about the
last download, whether or not it succeeded.

If you receive a download error, check your network configuration andmake sure
that the appliance can connect to the Internet or URL to the database.

Change
WebPulse
protocol
settings

Forwarding Target (Optional) Select a forwarding host.

SOCKS gateway
target

(Optional) Select a SOCKS gateway target.
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Task Setting or field Description

Configure
dynamic
analysis

Select one of:

n Real-time

n Background

n Disable

If Symantec
WebFilter license
has expired and
dynamic
categorization is
enabled, the
service enters a
suspended state.
For more
information, see
"Dynamic
Categorization
States" on
page 500.

Specifies a categorizationmode or disables dynamic categorization. If enabled,
verify that Blue Coat content filtering is enabled.

n Real-time: (Default) If the category of the request is not already known, the
URL request will wait for the WebPulse service to respond with the
categorization before proceeding. The advantage of real-time mode
categorization is that Symantec policy has access to the results, allowing
policy decisions to be made immediately after receiving all available
information.

n Background: When dynamic categorization is triggered, the URL request
continues to be serviced without waiting for a response from the WebPulse
service. The system category "pending" is assigned to the request, indicating
that the policy was evaluated with potentially incomplete category
information. The result of the categorization response is entered into a
categorization cache. This cache ensures that any subsequent requests for
the same or similar URLs can be categorized quickly, without needing to
query the WebPulse cloud service again.

n Disable: Disable dynamic categorization. The appliance does not contact the
WebPulse service when a category match for a URL is not found in the on-
box database.

Enable or
disable
sending
malware
feedback

Send potential
malware sources
to WebPulse

Switch the toggle to enable or disable sending malware feedback to WebPulse.

If the appliance is integrated with the Content Analysis for ICAP scanning while
Blue Coat content filtering andWebPulse are enabled, and a malware threat is
detected, the appliance issues a malware notification to WebPulse to update the
WebFilter database.

When this option is disabled, the Edge SWG (ProxySG) appliance does not notify
WebPulse about malware URLs that Content Analysis or WebFilter detects; however,
you can use policy to override the default malware feedback settings.
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Analyze the Threat Risk of a URL
The Threat Risk Levels service analyzes a requested URL's potential risk and summarizes it in the form of a numeric value
(see "About the Threat Risk Levels" below). You can reference these values in policy to protect your network and your
users frompotentially malicious web content. Threat Risk Levels are calculated based on numerous factors that measure
current site behavior, site history, and potential of futuremalicious activities. This service is part of Intelligence Services.
For information on Intelligence Services, refer to the "Content Filtering Overview" on page 491.

How the Threat Risk Service Works with WebPulse
To have the Threat Risk Levels feature return both risk levels and category information for requests, the Edge SWG
(ProxySG) appliancemust have valid Intelligence Services and Threat Risk Levels licenses. Although it is not required, you
should also enable theWebPulse categorization service on the appliance. EnablingWebPulse ensures that a risk level is
returned for every user request, provided there is no connection problem. If the risk level for a request does not exist in
the on-box database, the appliance queriesWebPulse for information and forwards the request to WebPulse for risk
level analysis and categorization. The appliance then caches the information that it retrieves fromWebPulse.

See Also:

n "About SymantecWebFilter and theWebPulse Service" on page 496

About the Threat Risk Levels
The Threat Risk Levels service assigns threat risk levels to URLs according to specific criteria: 

Level Description

Low (Levels
1-2)

The URL has an established history of normal behavior and has no future predictors of threats; however, this level
should be evaluated by other layers of defense (such as Content Analysis andMalware Analysis).

Medium-
Low (Levels
3-4)

The URL has an established history of normal behavior, but is less established than URLs in the Low group. This
level should be evaluated by other layers of defense (such as Content Analysis andMalware Analysis).

Medium
(Levels 5-6)

The URL is unproven; there is not an established history of normal behavior. This level should be evaluated by
other layers of defense (such as Content Analysis andMalware Analysis) and considered for more restrictive
policy.

Medium-
High (Levels
7-9)

The URL is suspicious; there is an elevated risk. Symantec recommends blocking at this level.

High (Level
10)

The URL is confirmed to be malicious. Symantec recommends blocking at this level.

The service returns a system-defined value in the rare instancewhen a threat risk level does not apply:
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CPL

Use for
url.threat_
risk.level=

Use in Threat Risk
Level objects

Description

none Threat Risk Level not
available

The URL does not have a threat risk level assigned to it and the request is not
forwarded to WebPulse (or it has been forwarded and there is still no data).

pending Threat Risk Level data
pending background
WebPulse analysis

No risk level is assigned to the URL on the appliance, but the appliance performed a
WebPulse request in the background. Subsequent requests for the URL could match
a result from the WebPulse cache.

unavailable Threat Risk Level
database or service not
accessible

A non-licensing problem exists with the WebFilter database or with accessing the
WebPulse service.

unlicensed Threat Risk Level feature
not licensed

The Threat Risk Levels license is not valid.

See Also:

n "Configure Threat Risk Levels" on the facing page
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Configure Threat Risk Levels
Before using Threat Risk Levels, make sure you have the following:

n A constant connection to Symantec servers to maintain license validity and download periodic database updates.

n A valid license for the solution bundles that include Threat Risk Levels. Refer to your Symantec point of contact
formore information.

If you enable the feature but do not have a valid license:

n You cannot download the database.

n Any existing threat risk policy will not work.

After verifying that you have a license, you canmake sure that you have the Threat Risk Levels service. See "Verify
Subscribed Bundles" on page 554.

Enable Threat Risk Levels
Before you can use Threat Risk Levels or related policy, youmust enable the service on the appliance.

1. In the Admin Console, select Administration > Data Services > Threat Protection.

2. In Threat Protection, select Threat Risk Levels.

The Threat Risk Levels page displays service settings.

3. In Threat Risk Levels, switch the Enable Threat Risk Levels toggle.

4. Make sure that WebPulse and dynamic categorization are both enabled. If the console displays amessage
"WebPulse Status: Enabled, Dynamic Categorization Status: Enabled", you don't have to make any more changes
here.

Otherwise, select Edit WebPulse Settings to enableWebPulse and Dynamic Categorization. For instructions, see
"ConfigureWebPulse" on page 519.

Check Threat Risk Levels Database and License Status
When you enable the Threat Risk Levels service, the appliance starts to download the database in the background. The
Admin Console displays the download in progress; wait for the download to complete before attempting to use the
feature. The License and Download Status field displays statistics when download is complete.

1. In the Admin Console, select Administration > Data Services > Threat Protection.

2. In Threat Protection, select Threat Risk Levels.
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3. In License and Download Status, the Status field displays statistics about the previous successful and
unsuccessful downloads. If download was successful, the field shows the database version amongst other
information. If the last download was unsuccessful, the field contains an error.

4. (If needed) Select one of the following

n Download Now to force a database download.

n Refresh Status to view the status of the download in progress.

n Cancel Download to cancel a download in progress (including a download initiated from the CLI).

Look up the Threat Risk Level of a URL
Determine the threat risk of a specific web page.

1. In the Admin Console, select Administration > Data Services > Threat Protection.

2. In Threat Protection, select Threat Risk Levels.

3. In Check Risk Level Match, enter a valid URL in theURL to Test field and select Test URL.

The console displays the threat risk level associated with theURL, as described in "Analyze the Threat Risk of a
URL" on page 521.
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Use Intelligence Services to Classify Applications
The Application Classification service uses the Intelligence Services database.

Before you can use the feature:

n Make sure that Intelligence Services is set as the data source. See "Configure the Blue Coat Data Source" on
page 509.

n Ensure that your license is valid.

After enabling the feature, you can review:

n Applications and operations for a URL

n Application groups for a URL

Note: Some application groups and content filter categories have similar names,
such as “Social Media”, and you can use both groups and categories in policy;
however, they are used for different functions and each should be controlled using
appropriate VPM objects or policy gestures.

n Attributes associated with aweb application

In addition, you can download new database versions when required, and also check the feature’s health status.

Enable Application Classification
To enable application classification:

1. In the Admin Console, select Administration > Data Services > Application Classification.

The browser displays the Application Classification page.

2. In the Application Classification section, select Enable Application Classification.

Before you can use Intelligence Services to classify applications or related policy, youmust enable the feature on
the appliance.

You can use eitherWebFilter or the Intelligence Services categorization data feed for content filtering. When Blue
Coat content filtering is enabled (Administration > Data Services > Content Filtering), the appliance uses
whatever data source is selected as the non-third-party on-box content filtering database for Application
Classification.
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Note: When you enable the service for the first time and apply changes, a database
download is initiated.

Tip: To disable this service, make sure that Application Attributes is disabled. See
"Review Application Attributes" on the facing page.

Look up the Application, Group(s), and Operation for a URL
Use the Application Classification feature to review the applications and operations for a web page. Application groups
allow you to apply policy actions to groups of similar applications.

To look up web applications, groups, and operations for a URL:

1. In the Admin Console, select Administration > Data Services > Application Classification.

The browser displays the Application Classification page.

2. In the Application Classification section:

n To look up the application, group(s), and operation for a URL, enter a URL and select Check URL. The
console displays the lookup results. Refer to "Classification Lookup Results" below to determinewhat the
messagesmean.

You can also useWebFilter to review the applications and operations (but not application groups) for a
URL. See "Test the Category, Application, and Operation for a URL" on page 494.

n (Optional) To view the list of supported applications, groups, or operations in the downloaded database,
select All Applications,All Groups, orAll Operations respectively. The list appears in a new browser
window. If the page says "unavailable", the database has not been downloaded.

Classification Lookup Results
Message Text Meaning

Application:
<application_name>

The URL is associated with the specified application. To obtain more detailed information about the
application, see "Review Application Attributes" on the facing page.

Application: none The URL is not associated with any application.

Group: <group_
name>

The URL is associated with the specified application group(s).

Group: none The URL is not associated with any defined application group.

Operation:
<operation_name>

The URL is associated with the specified operation.
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Message Text Meaning

Operation: none The URL is not associated with any operation.

Download the Application Classification Database
When you enable the Application Classification service, the appliance starts to download the database in the
background. The Admin Console displays the download in progress; wait for the download to complete before
attempting to use the feature. The console displays statistics when download is complete.

To download the Application Classification database:

1. In the Admin Console, select Administration > Application Classification.

2. In theDownload Application Classification section, select Download Now. The console shows a download is in
progress.

To cancel any download of the Application Classification database that is currently in progress (including a
download initiated from the CLI), select Cancel Download. The License and Download Status indicates that
download was canceled by the user.

Review Application Attributes
You can find out more information about a web application by looking at the attributes and their values. Attributes can
provide insight into aweb application and its governance, risk management, and compliance.

To use the Application Attributes feature, youmust have a valid Application Classification subscription, included in an
Intelligence Services bundle, that includes attributes.

Enable Application Attributes

Before enabling Application Attributes, verify that Application Classification is enabled.

To enable application attributes:

1. In the Admin Console, select Administration > Data Services > Application Classification.

The browser displays the Application Classification page.

2. In the Application Attributes section, select Enable Application Attributes.
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Tip: Youmust disable Application Attributes before attempting to disable Application
Classification.

Download the Application Attributes Database

Note: Application Classification and Application Attributes share the same database.

To download the Application Attributes database:

1. In the Admin Console, select Administration > Application Classification.

2. In theDownload Application Attributes section, select Download Now. The console shows a download is in
progress.

To cancel any download of the Application Attributes database that is currently in progress (including a download
initiated from the CLI), select Cancel Download. The License and Download Status indicates that download was
canceled by the user.

To display current download statistics in License and Download Status, select Refresh Status. The License and
Download Status indicates that download was canceled by the user.

See Also:

n "Configure Blue Coat Content Filtering" on page 509
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About Geolocation
To comply with local regulations, assist with traffic analysis, or reduce the risk of fraud and other security issues, youmay
need to know the origin of traffic in your network, or restrict outbound connections to specific countries. SGOS supports
geolocation in both reverse proxy and forward proxy modes:

n Geolocation in forward proxy mode: Restrict by country the outbound connections that your usersmake, based
on the geographic region of URLs.

n Client geolocation in reverse proxy mode: Identify the source of traffic through the Edge SWG (ProxySG)
appliance based on IP address (and when applicable, the effective client IP address; refer to the Visual Policy
Manager Reference for information on effective client IP address). Both IPv4 and IPv6 are supported.

Before using geolocation, youmust download a database that maps IPv4 and IPv6 addresses to the countries with
which they are associated. It also provides the supported names and ISO codes for countries, such as “United States
[US]”. You can use country names or codes in policy to perform actions such as denying traffic to or from specific
countries.

Prerequisites for Using Geolocation
Before you can use geolocation:

n Verify that you have a valid license for the feature. In the Admin Console, select Administration > Licensing
> Licensed Components and Subscriptions and look for license details in the Subscription section.

If you do not have a valid license, the appliance is unable to download the database and the Admin Consolemight
display Health Monitoring errors. The access logsmight also display errormessages about the subscription.
Review "Troubleshoot Geolocation Errors" on page 538 formore information.

n Enable the geolocation service. See "Enable Geolocation" on the next page.

n Download and verify the geolocation database. See "Download DatabaseUpdates" on the next page.
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Using Geolocation
Before you can use geolocation features, youmust enable the service on the appliance. When the database is
downloaded successfully, you can use inbound and outbound geolocation features and write policy using the country
name or country code as defined in the geolocation database. You will also be able to see the supported country names
and codes:

n In the Admin Console (Administration > Data Services > Geolocation).

n In output for the #show geolocation countries and #(config geolocation) view countries CLI commands.

n When you add geolocation objects in the Visual Policy Manager (VPM).

Enable Geolocation
Enable geolocation:

1. In the Admin Console, select Administration > Data Services > Geolocation.

2. In theGeolocation section, select Enable Geolocation.

When you enable the geolocation service, the appliance starts to download the database in the background. The Admin
Console displays the download in progress; wait for the download to complete before attempting to use the feature.
The License and download status field on theGeolocation page displays statistics when download is complete.

What if the Initial Download is Not Successful?

If you receive a download error and the appliance health status is Critical shortly after you attempt to download the
database, the downloadmight have failed. To confirm if this is the case, look for errormessages in the License And
Download Status field.

Note: The Critical error appears if the initial download attempt fails. After the database
downloads successfully, the service periodically checks for a newer version of the
database. If several update checks fail to connect, aWarning error appears in Health
Monitoring until the failure is corrected.

Download Database Updates
To download database updates:

1. In the Admin Console, select Administration > Data Services > Geolocation.

2. In theDownload Database section, select Download Now.
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Verify the Database Download

To verify that the databasewas downloaded, in theGeolocation Lookup section, select Show list of countries in
Geolocation database to display the countries in a new browser tab.

In addition, the License and download status field in theDownload Database section shows statistics about the
previous successful and unsuccessful downloads. If the last download was unsuccessful, the field contains an error.

If you receive a download error, check your network configuration andmake sure that the appliance can connect to the
Internet or URL to the database.

Cancel a Database Download in Progress

To stop any download of theGeolocation database that is currently in progress (including a download initiated from the
CLI), select Cancel Download in the Download Database section. The Admin Console displays a “Canceling download”
dialog. When the download is canceled, the dialogmessage changes to “Download Canceled”.

Use Geolocation Lookup
You can use geolocation lookup to test inbound and outbound connections. For example:

n In forward proxy, you can write policy that allows or denies outbound connections to specific geographic
locations associated with a given URL. See "Using Geolocation " on the previous page .

n In reverse proxy, you can identify the country that is associated with the origin of a client connection and use the
country code or name in policy. See "Determine Locations of IP Addresses for Incoming Connections" on
page 536.
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Test Outbound Connections Based on Geographic Location
If you intend to write policy that allows or denies outbound connections to specific geographic locations, you can test
what policy decisions would bemade for a given URL based on location criteria.

To test a URL, select at least one country and specify whether to allow or deny connections to the selected region(s). The
appliance determines the IPv4 and IPv6 address (or addresses) to which theURL resolves and returns the associated
country for each address. The test results showwhether each IP address is allowed or denied based on your criteria.

Note: For better security, the allow/deny determination ismade during DNS resolution,
before a connection is attempted.

To test URLs, ensure that:

n The geolocation service is enabled; see "Using Geolocation " on page 530.

n The geolocation database is downloaded to the appliance; see "Using Geolocation " on page 530.

n Primary and alternate DNS servers are configured; see "Configure DNS" on page 111 .

Test outbound connections based on geolocation:

1. Specify an IP address or URL to test.

a. In the Admin Console, select Administration > Data Services > Geolocation.

b. In theGeolocation Lookup section, enter an IP address of URL. URLsmust be in the form of a fully-
qualified domain name (FQDN).

2. Select Evaluate Geolocation Result Against A Test Policy Rule. TheGeolocation Condition and Policy Action
options appear.

3. Select the countries to allow or deny in policy. In theGeolocation Condition dialog that opens, select countries.
Geolocation Condition displays the selected locations.

4. Specify whether to allow or deny connections to the regions. For Policy Actions, select one of the following:

a. Deny selected geolocation: Denies connections to the selected locations.

b. Allow selected geolocation: Allows connections to the selected locations.

If the DNS lookup returns countries that are among the ones you selected in step 2, the selected verdict
(Deny/Allow) is applied. If the lookup returns countries that are not in the selected list, the opposite verdict
is applied.
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5. Select Lookup Geolocation. TheGeolocation Results section shows:

n IP Address: The resolved IP addresses for theURL.

n Geolocation: The geographical location of each IP address and its two-letter country code.

Note: IP addressmappings to locations change over time, and periodic
geolocation database updates reflect these changes. A changed IP address
mapping can cause the following behavior:
- DNS lookup results are different from a previous lookup
- geolocation policy is no longer working as expected

Use current lookup results to update policy as appropriate.

n Policy Action: Whether policy would deny or allow the connection to the IP address.

Example: Test Policy Based on Geolocation
Given geolocation policy that allows connections only to IP addresses in theUnited States, you want to determine if any
connections to web pages under torproject.org would be allowed.

1. In the Admin Console, select Administration > Data Services > Geolocation.

2. In the IP Address/URL field, type “torproject.org”.

3. Select Evaluate Geolocation Result Against A Test Policy Rule. TheGeolocation Condition and Policy Action
options appear.

4. Select Germany in theGeolocation Condition dialog.

5. For Policy Actions, select Allow selected geolocation.

6. Select Lookup Geolocation. TheGeolocation Results section shows the resolved IP addresses for torproject.org,
the geographical location of each IP address, and whether policy would deny or allow the connection.
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Note: If you perform the lookup in this example and receive different location results, the
discrepancy might be due to IP addressmappings changing over time.

If any region's verdict is Allowed, the connection will be allowed. The first server in the list that is in a permitted region
and which responds to the connection request will be used for the connection.

For example, in the example above, IP addresses resolve to Germany and Finland. The connection permission for each IP
address in theGermany is Allow, and all others are Deny. The IP address 116.202.120.165 in Germany would be used
for connections to torproject.org, unless subsequent policy rules result in a Deny.

Forward Proxy Use Cases: Write Geolocation Policy
Refer to the following examples of writing geolocation policy for outgoing connections. For detailed usage information
on policy gestures, refer to the Content Policy Language Reference.
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Use Case 1

You require policy that scans files from IP addresses in Russia. You can use the following CPL:

; scan connections to Russia using the specified ICAP service
<cache>
supplier.country=RU response.icap_service(AV_scan)

Use the supplier.country= condition for policy decisions based on the response payload. In this case, policy evaluation
occurs after a connection ismade.

In the VPM, use theResolved Country Destination object for the supplier.country= condition. Refer to the legacy
or web Visual Policy Manager Reference for information.

Use Case 2

You require policy that denies connections based on both geolocation and type of requested URL. You can use the
following CPL:

; 1. allow all countries, except the following override
; 2. deny connections to China when a batch file is requested
<proxy>
supplier.allowed_countries(all)
<proxy>
url.extension=BAT supplier.allowed_countries[CN] (deny)

Use the supplier.allowed_countries() action when policy evaluationmust occur before a connection ismade.

In the VPM, use the Set Geolocation Restriction Action object for the supplier.allowed_countries() property.
Refer to the legacy or web Visual Policy Manager Reference for information.
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Determine Locations of IP Addresses for Incoming Connections
After you download a geolocation database, you can identify the country that is associated with a given IP address. You
can then use the country code or country name in policy.

Identify a country by IP address:

1. In the Admin Console, select Administration > Data Services > Geolocation.

2. In theGeolocation Lookup section, in the IP Address/URL field, enter a valid URL or IP address.

3. Select Lookup Geolocation. The country associated with the IP address, as defined in the geolocation database,
displays next to the IP Address field.

Note: IP addressmappings to locations change over time, and periodic geolocation
database updates reflect these changes. A changed IP addressmapping can cause the
following behavior:
- geolocation lookup results are different from a previous lookup
- geolocation policy is no longer working as expected

Use current lookup results to update policy as appropriate.
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If the IP address you enter is not valid, an error appears. See "Troubleshoot Geolocation Errors" on the next page for
more information.

To write policy about a specific country, use the country code specified in square brackets beside the country name in
the country list. For example, the country code for theUnited States is “US”. To view the list of countries in the
geolocation database, select Show Geolocation database. The list opens in a separate browser window.

Reverse Proxy Use Cases: Write Geolocation Policy
Refer to the following examples of writing geolocation policy for incoming connections.

The client.address.country=<"country_name"> condition returns the country fromwhich traffic originates, based on
the client IP address. For detailed usage information on policy gestures, refer to the Content Policy Language Reference.

Use Case 1

You require policy to allow client connections only fromNorth America. You can use the following CPL:

; only accept client connections from North America
<proxy>
allow client.address.country=(US, CA)
deny("Restricted location: $( x-cs-client-ip-country)")

Use Case 2

You require policy to allow client connections only fromNorth America, including proxied traffic as specified. You can use
the following CPL:

; only accept traffic from North America with support for proxied traffic
; with client address in X-Forwarded-For
<proxy>
client.effective_address("$(request.header.X-Forwarded-For)")

<proxy>
client.effective_address.country=(US, CA) ok
deny("Restricted location: $( x-cs-client-effective-ip-country)")

In the VPM, theClient Geolocation object is available in the Source column in policy layers. Refer to the Visual Policy
Manager Reference for information.

537 of 676



SGOS Administration (Admin Console Edition)

Troubleshoot Geolocation Errors
Youmight encounter the following geolocationmessages. Refer to the specified troubleshooting steps.

Note: This is not a valid IP
Cause: You have entered an invalid IP address in the IP field when performing geolocation lookups. 

Fix: Correct the IP address and look it up again.

Note: The geolocation database is currently unavailable
Cause: No geolocation database is installed. 

Fix: Download the database. See "Using Geolocation " on page 530.

This device does not have a valid geolocation license
Cause: The appliance does not have a valid geolocation license. 

Fix: Ensure that the following are true: 

n  Each Edge SWG (ProxySG) appliance in your deployment has its own license. 

n The licensing status for your appliance is in good health.

Warning: The geolocation database is not installed
This error appears in the browser window that opens when you select the ShowGeolocation database link in the
Geolocation Lookup section. It can also appear in the CLI. 

Cause: No geolocation database is installed. 

Fix: Download the database. See "Using Geolocation " on page 530. 

Warning: Obsolete country name
Thismessage appears when you try to install CPL policy. An example of themessage is, “Warning: Obsolete country
name: 'Russian Federation' is now 'Russia'”. 

Cause: CPL includes an outdated country name. 

Fix: Use the suggested country name. You can also refer to the geolocation database for current country names and
codes. In the Admin Console, select Administration > Data Services > Geolocation . In the Geolocation Lookup
section, select the Show Geolocation database link to display the list.
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Access Log Errors
The following access log errorsmay appear in the access log if there is a problemwith your subscription. 

n The Geolocation subscription file is out of date 

n  Failed trying to get the subscription settings from theGeolocation subscription file 

n  Failed trying to download theGeolocation subscription file 

n  Failed trying to extract and activate theGeolocation payload file 
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Remove Geolocation Settings
To remove geolocation settings, purge the geolocation database and remove policy.

Remove the Database
Remove the database:

1. Disable geolocation.

a. In the Admin Console, select Administration > Data Services > Geolocation . 

b. In the General section, disable the Enable Geolocation  switch.

c. Select Save to apply changes.

2. Log in to the CLI and enter the following command:

#(config geolocation)purge

The CLI returns to the #(config geolocation) node.

You can issue the view countries command to verify that the geolocation database has been removed. The output
should show no list of countries and warn that the database is not installed:

#(config geolocation)purge
#(config geolocation)view countries
Countries defined by system:
Invalid
None
Unavailable
Unlicensed
Additional locations:
Countries defined by geolocation database:
Warning: The geolocation database is not installed

Remove Policy
Remove geolocation policy:

1. Launch theWeb VPM.

2. Remove any geolocation objects or rules. Refer to theWeb Visual Policy Manager Reference for instructions.

3. Select Install Policy.
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About Web Isolation
Themost common element of cyber-security solutions is detection. Anti-virus/malware, network sandboxes, next-
generation firewalls, and web application firewalls all depend on detection. In some cases, such as sandboxes,
notification of malicious content arrives to the administrator after the user has received the content because of the time
required to ascertain the verdict.

The SymantecWeb Isolation solution addresses this security weakness. Instead of relying onmalware detection, Web
Isolation protects users from cyber attacks by isolatingmalware and preventing it from reaching users' browsers. A
common use case is to protect employees who browse uncategorized and potentially malicious sites.

Web Isolation is a client-less solution that enables users to safely browse the internet on any device using any browser.
The zero footprint negates the need for software installation on the clients.

Web Isolation:

n Provides a safe visual streamof the original web site in the user's browser.

o End users browse the site as if the site was running directly in the browser.

n Preserves original browsing experiencewith full usability and control.

o Only safely rendered information arrives at the user’s browser.

n Executes web sessions away from endpoints.

Requirements
To use theWeb Isolation feature, you require:

n SGOS 7.3.x and later

n configured isolation policy

As an alternative to the SymantecWeb Isolation service, you can use a third-party isolation service; however, you can't
enable both services at the same time. See "ConfigureWeb Isolation" on the next page for configuration instructions for
both options.
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Configure Web Isolation
The Edge SWG (ProxySG) appliance can integratewith cloud-based SymantecWeb Isolation service or a custom isolation
service; you can't enable both services at the same time. When isolation policy is installed and enabled, the appliance
forwardsmatching traffic to the configured isolation service.

Formore information about this feature, refer to https://knowledge.broadcom.com/external/article/201609.

Tip: Web Isolation requires SGOS 7.3.x and later and correctly configured isolation policy. 

Configureweb isolation:

1. (If using a custom isolation service) Obtain the hostname/IP address and port to use for communication with the
isolation service.

2. In the Admin Console, select Administration > Data Services > Isolation.
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3. In the Isolation section, specify settings for the service:

Field/Setting Description

Destination Type Select SYMC Isolation Service to forwardmatching traffic to the cloud-
based Symantec Web Isolation service.

Select Custom Destination to forwardmatching traffic to a configured
custom isolation service.

Hostname (Custom Destination only) Specify a hostname or IPv4/IPv6 address for the
custom isolation service.

Port (Custom Destination only) Specify the port for the custom isolation server.
By default, the port is 8080.

Enable Secure Connection (Custom Destination only) Select to secure connections to the isolation
server.

SSL Device Profile (If Enable Secure Connection is selected) Specify an existing SSL device
profile to use for securing the HTTP/S requests to the isolation service over
a secure tunnel. This device profile specifies the client certificate and the CA
to use for validating the certificate from the isolation service SSL tunnel
terminator.

Note: This device profile is not used to validate the isol
ated traffic. After the SSL tunnel to the isolation service
is terminated, the HTTP/S requests are forwarded to th
e isolation service and the Edge SWG (ProxySG) applian
ce will use the bluecoat-isolation or specified Server
CCL to validate the isolation proxy certificate. See Serv
er CCL for more information.

Include Headers Send originating client IP address, authenticated user, or authenticated
group details in the HTTP headers of traffic forwarded to the isolation
service:

n User: Authenticated user (x-authenticated-user).

n Group: Group of the authenticated user (x-authenticated-
groups).

n XFF: Originating client IP address (X-Forwarded-For).

n (Appliance ID: (Added in version 7.3.2) Appliance ID/serial number.
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Field/Setting Description

SSL Issuer Keyring Specify a keyring for SSL interception of Shared Isolation Domains.
Otherwise, the appliance uses the default keyring.

Note: To isolate HTTPS requests, enable SSL
interception and write policy that includes SSL intercept
rules for the traffic you want to isolate. SSL intercept
policy should use this keyring for the isolated traffic.

Server CCL If not using the cloud isolation service, specify a CCL to validate the isolation
server certificate used for isolated requests. For instructions on creating a
CCL and adding CA certificates to the list, refer to "Manage CA Certificate
Lists" on page 279.

4. (If needed) Select Reset to default to set all options to their default selections.
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Manage System Images
Refer to the following topics to manage the Edge SWG (ProxySG) appliance system images:

n "Upgrade andManage Systems " on the next page

Manage SGOS software system images. Upgrade or downgrade the SGOS version. Set system image properties
such as default, lock, and replace.
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Upgrade and Manage Systems
The Admin Console displays up to five available systems.

To view system information, in the Admin Console, select Administration > Systems > Software System Images.
Look in System Image Catalog for the following information:

Field or
Setting

Description

# Indicates the index number of the system image. Youmay need to refer to system image numbers when using #
(config installed-systems) commands.

System
Version

Shows SGOS version, build number, and other system information. Expand a system to viewmore details,
including boot status.

Locked Indicates if the system is locked. Locked systems can't be removed or replaced until unlocked.

Replace When there are five systems on the appliance, indicates that the system is to be replaced when a new system is
loaded.

Default Indicates that the system will be booted on the next hardware restart.

Running The system that is currently running. It can't be deleted or replaced while running.

Refer to the following sections to manage systems.

Set the Default Boot System
This setting allows you to select the system to be booted on the next hardware restart. If a system starts successfully, it
is set as the default boot system. If a system fails to boot, the next most recent system that booted successfully
becomes the default boot system.

1. In the Admin Console, select Administration > Systems > Software System Images.

2. In System Image Catalog, select the preferred system version in theDefault column.

Upgrade the System Version
When you install a new system image, it becomes the default system. Perform a hardware reboot to run the new
version.

1. In the Admin Console, select Administration > Systems > Software System Images.

2. Download a new version of SGOS fromMyBroadcom:

a. In System Image Catalog, select Available Systems. The browser opens the download page.

b. Log in to MyBroadcom and download the upgrade version.
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c. If needed, move the system image to a location that the appliance can access.

3. Upload the system image:

a. Select New Upload. TheUpload and install the system image dialog opens.

b. To upload the image from the local workstation, select Local > the system image from local file.

To upload the image from a remote location, select URL. In the fields that appear, enter the URL of the
system image (include the entire path and filename) and specify which system to replace.

Optionally, switch the Enforce installation of signed images toggle to specify that only signed system
images can be installed.

Select Upload to upload the system image.

4. Select Restart and Load Default to perform a hardware reboot. A Restart Systemdialog appears as follows.

The system indicates when it is restarted successfully:

On the Restart Systemdialog, select Okay.

5. To check the version after the reboot, select Administration > Systems > Software System Images and look
for the system specified asDefault.

547 of 676



SGOS Administration (Admin Console Edition)

Lock or Unlock a System
Any system can be locked, except a system that has been selected for replacement. If all systems, or all systems except
the current system, are locked, the appliance cannot load a new system. If a system is locked, it cannot be replaced or
deleted.

1. In the Admin Console, select Administration > Systems > Software System Images.

2. In System Image Catalog:

n Select the system(s) to lock in the Lock column.

n Clear the system(s) to unlock in the Lock column.

Replace a System
You can specify the system to be replaced when a new system is downloaded. If no system is specified, the oldest
unlocked system is replaced by default. You cannot specify a locked system for replacement.

1. In the Admin Console, select Administration > Systems > Software System Images.

2. In System Image Catalog, select the system to replace in theReplace column.

Delete a System
You can delete any of the system versions except the current running system. A locked systemmust be unlocked before
it can be deleted. If the system you want to delete is the default boot system, you need to select a new default boot
systembefore the system can be deleted. You can't delete a system version through the Admin Console; youmust use
the CLI.

To delete a system, type the following commands:

# (config) installed-systems
# (config installed-systems) delete system_number

where system_number is the system you want to delete.
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Manage Licensing
Refer to the following topics to manage Edge SWG (ProxySG) appliance licenses:

n "About Licensing" on the next page

Install the appliance base license and view license status. View licensed components and information on
Intelligence Services bundles.
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About Licensing
Each Edge SWG (ProxySG) appliance requires a license to function. The license is associated with an individual serial
number and determines what software features are available and the number of concurrent users that are supported.
When you configure a new hardware appliance, the initial configuration wizard automatically installs a trial license that
allows you to use all software features with support for an unlimited number of concurrent users for 60 days. (Trial
periods are not applicable to virtual appliances.)

Note: This information does not apply to the SWG VA. For licensing and upgrade
information specific to the SWG VA, refer to the appropriate virtual appliance
documentation.

Locate the Edge SWG (ProxySG) Serial Number
Each Edge SWG (ProxySG) serial number is the appliance identifier used to assign a license key file. The appliance
contains an EEPROMwith the serial number encoded, and it recognizes the serial number upon systemboot-up.

To locate the serial number, in the Admin Console, select Administration > Licensing > Licensed Components and
Subscriptions. Look in the View section for the serial number.

License Types
The following license types are available:

n Trial: The 60-day license that ships with new physical appliances. All licensable components for the trial edition are
active and available to use. In addition, the base SGOS user limit is unlimited. When a full license is installed, any
user limits imposed by that license are enforced, even if the trial period is still valid.

n Demo: A temporary license that can be requested from Symantec to extend the evaluation period.

n Permanent: A license for hardware platforms that permanently unlocks the software features you have
purchased. When a permanent license is installed, any user limits imposed by that license are enforced, even if the
trial period is still valid.

n Subscription-based: A license that is valid for a set period of time. After you have installed the license, the Edge
SWG (ProxySG) appliancewill have full functionality, and you will have access to software upgrades and product
support for the subscription period.

When a full license (permanent or subscription-based) or demo license is installed during the trial period, components
previously available in the trial period, but not part of that license, remain available and active for the remainder of the
trial period. However, if the license edition is different than the trial edition you selected, only functionality available in
the edition specified in the license remains available for trial. If you do not want the trial components to be available
after you install a full license, you can disable them.
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Licensing Terms
Within sixty (60) days of the date fromwhich the user powers up the Edge SWG (ProxySG) appliance (“Activation
Period”), the administratormust complete the licensing requirements as instructed by the appliance to continue to use
all of the features. Prior to the expiration of the Activation Period, the SGOS softwarewill deliver notices to install the
license each time the administrator logs in to manage the product. Failure to install the license prior to the expiration of
the Activation Periodmay result in some features becoming inoperable until the administrator has completed licensing.

License Expiration
When the base license expires, the Admin Console banner displays a "No license"message:

Selecting Show Details opens the Licensing page.

A license expiration notificationmessage is also logged in the Event Log. "View the Event Log Tail" on page 445 for
information on event logs.

When the appliance doesn't have a valid license, it stops processing requests. In addition, for services set to Intercept:

n In a transparent deployment, if the default policy is set to Allow, the appliance acts as if all services are set to
Bypass, passing traffic through without examining it. If default policy is set to Deny, traffic to these services is
denied with an exception. For details, see "Exceptions Due to Base License Expiration" below.

n In an explicit deployment, regardless of the default policy setting, traffic to these services is denied with an
exception. For details, see "Exceptions Due to Base License Expiration" below.

Exceptions Due to Base License Expiration

In some cases, exceptions occur when the base license expires. Exceptions include:

n HTTP (Web browsers): An HTML page is displayed stating the license has expired.

n SSL: An exception page appears when an HTTPS connection is attempted, but only if the appliance is deployed
explicitly or in the case of transparent proxy deployments, SSL interception is configured.

n FTP clients: If the FTP client supports it, amessage is displayed stating the license has expired.

n You can still perform configuration tasks through the CLI, SSH console, serial console, or Telnet connection.
Although a component is disabled, feature configurations are not altered. Also, policy restrictions remain
independent of component availability.

To correct license issues, refer to "Install the Base License" on page 556 or your Broadcompoint of contact.
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See Also:

n "Manage Edge SWG (ProxySG) Licenses" on the facing page

n "Install the Base License" on page 556
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Manage Edge SWG (ProxySG) Licenses
Manage the appliance base license and licensed components.

Note: The license is associated with an individual serial number and determines what
software features are available and the number of concurrent users that are supported.
See "Locate the Edge SWG (ProxySG) Serial Number" on page 550 for details.

View License Status and Components
To view the license status in the Admin Console, select Administration > Licensing > Licensed Components and
Subscriptions. The View section displays base license information such as serial number, license date, andmaximum
number of concurrent users. The Licensed Components section other license components, indicates whether or not they
are valid, and shows their expiration dates.

Review Licensed Components

Each component that can be licensed is listed under Licensed Components, along with its validity and its expiration date.

n To view the latest information after applying a license or update, select Refresh.

n Expand the name of a component to display details, as follows:
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Install the Edge SWG (ProxySG) License
There aremultiple ways to install the base Edge SWG (ProxySG) license. Use themethod that is appropriate:

If the following is true: Use this method:

The appliance and software are not registered yet. "Register and License the Appliance and
Software" on page 556

The appliance is a new system and is already registered. "Retrieve the License on a Registered
System" on page 557

The Edge SWG (ProxySG) serial number is not associated with a software license
(you registered the hardware separately).

OR

The appliance is unable to access the licensing portal.

"Install the License Manually on a
Registered System" on page 557

Verify Subscribed Bundles
After you verify requirements, make sure your subscribed bundles appear in the Admin Console as expected. Verify that
the bundles are correct and valid.

1. In the Admin Console, select Administration > Licensing > Licensed Components and Subscriptions.

2. In Subscription, look for the names of your subscribed bundles and their expiration dates.

Expand the name of a subscription to displays the feeds that it includes, as follows:

For example:
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n If you have an Intelligence Services license, the Subscription section should display Intelligence Services bundles.

n If you have not disabled the built-in Security Policy, the section should display the Default Security Policy in a
standard subscription bundle.

See Also:

n "Install the Base License" on the next page
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Install the Base License
Before you can register and license your appliance, youmust have the following:

n The serial number of your appliance. See "Locate the Edge SWG (ProxySG) Serial Number" on page 550.

n AMyBroadcom account. See "About the Edge SWG (ProxySG) Admin Console " on page 4.

There aremultiple ways to install the base Edge SWG (ProxySG) license. Use themethod that is appropriate:

If this is your appliance/license status Complete this task

Appliance is not registered or licensed "Register and License the Appliance and Software" below

New appliance is registered but not licensed "Retrieve the License on a Registered System" on the facing page

Previously-registered older appliance is not licensed "Install the License Manually on a Registered System" on the facing
page

Registered appliance can't access the licensing
portal/internet

Notes

n After the initial license installation, youmight decide to use another feature that requires a license. The license
must be updated to support the new feature.

n Amessage is written to the event log when you install a license through the appliance.

Register and License the Appliance and Software
If you have not manually registered the appliance, you can automatically register the appliance and install the software
license in one step.

Note: Locate the email from Symantec that contains the activation code(s) for your
software. You require these activation codes, as well as your appliance serial number, to
complete the licensing process. Refer to Knowledge Base article
166429: https://knowledge.broadcom.com/external/article?articleId=166429

To register and license the appliance and software:

1. In the Admin Console, select Administration > Licensing > Licensed Components and Subscriptions.

2. In the Install section, select Register/Manage. The licensing portal opens in a browser window and prompts you
for yourMyBroadcom login information.

3. Enter your login credentials and log in. The portal prompts you to enter your activation code.
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4. Enter the activation code and follow the prompts to complete the process.

5. When prompted to accept the license agreement, read and accept the terms. The software license is now
associated with the appliance.

6. (If necessary) Repeat the previous steps for your other activation codes.

7. Restart the appliance.

Retrieve the License on a Registered System
If the Edge SWG (ProxySG) appliance is a new system and the appliance has been registered, retrieve the associated
license.

To retrieve the software license:

1. In the Admin Console, select Administration > Licensing > Licensed Components and Subscriptions.

2. In the Install section, select Retrieve.

3. In the Retrieve License Key dialog, enter yourMyBroadcom account login information and select Request
license.

4. (Optional) Select Show results to verify a successful retrieval. If any errors occur, check the ability for the
appliance to connect to Internet.

5. Restart the appliance.

Install the License Manually on a Registered System
Install the licensemanually if:

n The Edge SWG (ProxySG) serial number is not associated with a software license (you have registered the
hardware separately)

n The appliance is unable to access the licensing portal.

Install the licensemanually:

1. Follow the steps in "Register and License the Appliance and Software" on the previous page to log in to the
licensing portal. Select License Download. The portal prompts you for your appliance serial number.

2. Follow the prompts to enter your serial number and download the license file.

3. Save the license file to a location that your appliance can access.

4. In the Admin Console, select Administration > Licensing > Licensed Components and Subscriptions.

5. In the Install section, under License Key Manual Installation, select an installationmethod:
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Method Instructions

Text
editor

1. Select Install from Text Editor.

2. In the Load Edit and Install from text editor dialog, enter the contents manually or copy and paste the
contents from another file.

3. Select Install.

Local file 1. Select ... > Local File.

2. In the Load Edit and Install from local file dialog, browse to the directory of the file on the local
system.

3. Select Install.

Remote
URL

1. Select ... > Remote URL.

2. In the Load Edit and Install from remote URL dialog, enter the fully-qualified URL, including the
filename, where the file is located.

3. Select Download.

Configure License Updates
You can update the licensemanually (such as when changes aremade to add-on components) or configure the appliance
to automatically update the license, where the appliance contacts the Symantec licensing server 30 days before the
license is to expire.

With the auto-update feature:

n If a new license has been purchased and authorized, the license is automatically downloaded.

n If a new license is not available, the appliance continues to contact the server daily for a new license until the
current license expires.

Outside the license expiration window, the appliancemakes this connection once every 30 days to check for new license
authorizations.

To manually update the license:

1. In the Admin Console, select Administration > Licensing > Licensed Components and Subscriptions.

2. In the Install section, switch theUse Auto-Update toggle.

To configure license auto-update:

1. In the Admin Console, select Administration > Licensing > Licensed Components and Subscriptions.

2. In the Install section, select Update.
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Configure Edge SWG (ProxySG) Logging
Refer to the following topics to configure logging on the Edge SWG (ProxySG) appliance:

n "General Logging Configuration" on the next page

Manage facilities, upload schedule and formats for access logs. Specify general event log settings. Configure an
SMTP server and a recipient list for emailing event logs. Enable and set the event level separately for email and
syslog and override these default notification settings per event ID when needed (SGOS 7.3.8+).

Note: Refer to the ProxySG Log Fields and CPL Substitutions Reference:
https://techdocs.broadcom.com/us/en/symantec-security-software/web-and-
network-security/proxysg/7-3/inde-0/proxy-sg-log-fields-and-substitutions.html

n "Configure Event Logging" on page 595

Specify general event log settings. Configure an SMTP server and a recipient list for emailing event logs. Enable
and set the event level separately for email and syslog and override these default notification settings per event
ID when needed (SGOS 7.3.8+).
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General Logging Configuration
The Edge SWG (ProxySG) appliance can create access logs for the traffic flowing through the system; in fact, each
protocol can create an access log record at the end of each transaction for that protocol (such as for each HTTP request).

These log records can be directed to one ormore log facilities, which associates the logs with their configured log
formats, upload schedules, and other customizable components. In addition, access logs can be encrypted and digitally
signed before uploading.

Data stored in log facilities can be automatically uploaded to a remote location for analysis and archive purposes. Logs
are uploaded using supported protocols. After logs are uploaded, reporting tools such as Symantec Reporter can be
used to analyze the log files. For information on using Symantec Reporter, refer to Reporter documentation .

Enable Access Logging
You can enable or disable access logging globally. When access logging is disabled, logging is turned off for all log objects,
even if logging policy exists or logging configurations are set. When access logging is enabled, connection information is
sent to the default log facility for the service (for example, HTTP traffic is logged to themain file). Logging begins
immediately for all configured protocols.

Tip: By default, protocols are associated with specific logs to allow you to start access
logging as soon as you enable the feature. If you want to change the defaults, make the
changes before enabling access logging. See the following sections.

To enable access logging:

1. Select Administration > Access Logging > General.

2. InDefault Logging Policy, switch the Enable toggle.

Set Logging Defaults
To set logging defaults, select Administration > Access Logging > General. In Default Logging Policy, do any of the
following as needed:

n Change a protocol's default log by selecting it under Default Log.

n Enable or disable log configuration for a protocol by switching the Enable toggle.

Specify Global Logging Settings
To determinewhich access logs contribute to high disk usage, to look for a trend in log sizes, or for other troubleshooting
scenarios, you can set the Edge SWG (ProxySG) appliance to take certain actions when the combined size of all access
logs reaches specified global limits:
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n Stop all access logging.

n Delete the oldest entries (overflow) from any of the log facilities regardless of which log caused the total size to
reach the global limit.

n Attempt an early upload of the log that caused the total size to reach the global limit.

You can also upload all configured access logs immediately.

Aftermonitoring which logs the appliance uploads over a period of time, you canmodify the amount of space allocated
to individual logs for early upload.

To specify global logging settings:

1. Select Administration > Access Logging > General.

2. InGlobal Settings, specify the following as needed:

Section
Setting or
field

Description

Global
log file
limit

Limit total
combined
log sizes to

Maximum total size of all log files, i.e., the sum of the sizes of all the individual logs.

If limit
reached

Specify what the appliance should do when the total log size reaches the maximum:

n Stop logging: Stop all access logging and attempt an immediate upload.

n Delete oldest log entries: Delete the oldest entries (overflow) from any of the log
facilities regardless of which log caused the total size to reach the global limit.

Note: To ensure that the appliance uploads older log entries before
they are deleted, make sure that you have correctly specified an
upload server, an early upload threshold for each individual log, and a
global early upload threshold. Inability to connect to the upload server
(for example, due to incorrect settings or network issues) will result in
data loss.

Global
Early
Upload

Start early
upload
when sum
of all log
sizes
reaches

Specify the sum total of all log sizes that triggers an early upload. The appliance attempts to
upload the log that caused the total log size to reach the global limit.

Individual logs each have their own early upload setting (see "Configure an Access Log" on
page 566), which remain in effect even if you specify a global value. This means that, provided
that upload is configured and working, the global early upload threshold could trigger a log
upload before the file size reaches the threshold defined in the specific log facility.

Global
Upload

Upload All Upload all logs immediately.

Cancel All Prevent further attempts to upload all log facilities and cancel all uploads that are in progress.
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Configure an Access Log
The appliance ships with several pre-defined access logs. Before creating a new one, check the existing ones to see if they
fit your needs. If you want to use a custom log format with the new log facility, youmust create the log format before
associating it with a log (see "Configure an Access Log Format" on page 593).

To add a new access log or edit an existing access log, see "Configure an Access Log" on page 566. During configuration,
you can opt to digitally sign access logs and set up the upload schedule.

Digitally Sign Access Logs
You can digitally sign access logs to certify that a particular Edge SWG (ProxySG) appliancewrote and uploaded this log
file. Signing is supported for both content types— text and gzip—and for both upload types—continuous and periodic.
Each log file has a signature file associated with it that contains the certificate and the digital signature for verifying the
log file. The signature file has the same name as the access log file but with a .sig extension; that is, filename.log.sig, if the
access log is a text file, or filename.log.gzip.sig, if the access log is a gzip file.

Note: Signing is disabled by default.

You can digitally sign your access log files with or without encryption. If the log is both signed and encrypted, the signing
operation is done first, meaning that the signature is calculated on the unencrypted version of the file. Youmust decrypt
the log file before verifying the file. Attempting to verify an encrypted file fails.

When you create a signing keyring (whichmust be done before you enable digital signing), keep inmind the following:

n The keyringmust include an external certificate. (An external certificate is one for which the Edge SWG (ProxySG)
appliance does not have the private key.)

n The certificate purposemust be set for smime signing. If the certificate purpose is set to anything else, you cannot
use the certificate for signing.

n Add the%c parameter in the filenames format string to identify the keyring used for signing. If encryption is
enabled along with signing, the%c parameter expands to keyringName_Certname.

Note: The signing feature is not available for custom clients.

Verify a Digital Signature

If the file whose digital signature you want to verify is also encrypted, youmust decrypt the file prior to verifying the
signature. You can use a program such as OpenSSL to verify the signature. For example, use the following command in
OpenSSL:

openssl smime -CAfile cacrt -verify -in filename.sig -content filename.log -inform DER -out logFile
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where:

n cacrt: CA certificate used to issue the certificate in the signature file.

n filename.sig: File containing the digital signature of the log file.

n filename.log: Log file generated after decryption. If the access log is a gzip file, it contains a .gz extension.

n logFile: Filename that is generated after signature verification

See Also:

n "Configure an Access Log" on page 566

Configure an Access Log Upload Schedule
The upload schedule defines the frequency of the access logging upload to a remote server, the time between
connection attempts, the time between keep-alive packets, the time at which the access log is uploaded, and the
protocol that is used. When configuring an upload schedule, you can specify either periodic uploading or continuous
uploading. Both periodic and continuous uploading can send log information from an Edge SWG (ProxySG) appliance
farm to a single log analysis tool. This allows you to treat multiple appliances as a single entity and to review combined
information from a single log file or series of related log files.

With periodic uploading, the SGOS software transmits log entries on a scheduled basis (for example, once daily or at
specified intervals) as entries are batched, saved to disk, and uploaded to a remote server.

Note: When you configure a log for continuous uploading, it continues to upload until
you stop it. To stop continuous uploading, switch to periodic uploading temporarily. This is
sometimes required for gzip or encrypted files, whichmust stop uploading before you can
view them.

With continuous uploading, the Edge SWG (ProxySG) continuously streams new access log entries from the device
memory to a remote server. Here, streaming refers to the real-time transmission of access log information. SGOS
transmits access log entries using the specified client, such as FTP client. A keep-alive data packet is sent to keep the data
connection open.

Continuous uploading allows you to view the latest logging information almost immediately, send log information to a
log analysis tool for real-time processing and reporting, maintain the Edge SWG (ProxySG) performance by sending log
information to a remote server (avoiding disk writes), and save device disk space by saving log information on the
remote server.
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Note: If the remote server is unavailable to receive continuous upload log entries, SGOS
saves the log information on the device disk. When the remote server is available again,
the appliance resumes continuous uploading.

If you do not need to analyze the upload entries in real time, use periodic uploading
because it ismore reliable than continuous uploading. If there is a problem configuring
continuous uploading to Microsoft Internet Information Server (IIS), use periodic
uploading instead.

See Also:

n "Configure an Access Log" on page 566

Configure an Access Log Format
To add a new access log format or edit an existing access log format, see "Configure an Access Log Format" on page 593.

See Also:

n "Configure an Access Log" on page 566

Encrypt the Access Log
To encrypt access log files, youmust first place an external certificate on the Edge SWG (ProxySG) appliance. The device
derives a session key from the public key in the external certificate and uses it to encrypt the log. When an access log is
encrypted, two access log files are produced: an ENC file (extension .enc), which is the encrypted access log file, and a
DER file (extension .der), which contains the appliance session key and other information. You need four things to
decrypt an encrypted access log:

n The ENC file

n TheDER file

n The external (public key) certificate

n The corresponding private key

The encryption feature is not available for custom clients.

Troubleshoot Access Logging
Problem: The Edge SWG (ProxySG) appliance is uploading logsmore frequently than expected.

Description: If access logging is enabled, logs can accrue on the Edge SWG (ProxySG) appliance’s hard drive even if the
upload client is not configured for specific protocols (often the case if you configured streaming or P2P). Eventually the
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size of these combined logs, triggers theGlobal Early Upload threshold in Global Settings (Administration > Access
Logging > General). The appliance attempts to upload all configured logsmore often than expected. For example, a
main log that is configured for upload every 24 hours starts to upload small portions of themain log every 10 minutes.

Solution: To prevent the access logs that do not have an upload client configured from triggering the Start an Early
upload threshold, edit the default logs for each protocol that you do not need uploaded. Set them to <None> inUpload
Client on the Edit Log page (select Administration > Access Logging > General and select a log to edit).
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Configure an Access Log
To configure an access log:

1. Select Administration > Access Logging > General.

2. In Logs, do the following under Logs:

n To add a log: Click Add New Log.

n To edit an existing log, select the name of a log in the list.

3. On the Add New Log or Edit log page, specify or change the log properties as follows.

Section
Setting or
field

Description

Log Setting Log Name Name of the log. If editing an existing log, this is a read-only field.

The name can include specifiers from "Access Log Filename Formats" on page 586. For
example, if you name the file:

n AccLog, the name is AccLog

n AccLog%C%m%d%H%M%S, the name is AccLog appliance_name month day hour
min sec

n C%m%d, the name is appliance_name month day

n Y%m%d%C, the name is year month day appliance_name

Log Format Supported log format. For a list of formats, see "Configure an Access Log Format" on
page 593.

Note: If you change the log format of a log, remember that ELFF
formats require an ELFF header in the log (the list of fields being
logged are mentioned in the header) and that non-ELFF formats
do not require this header.

The format of data written to the log changes as soon as the
format change is applied; for best practices, do a log upload
before the format change and immediately after (to minimize the
number of log lines in a file with mixed log formats).

Upload the log facility before you switch the format.

Description (Optional) Description of log, used for identification purposes only.
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Section
Setting or
field

Description

Log File
Limits

The
maximum
size of each
remote file

The maximum size for each remote log file (the file on the upload server) defaults to 0,
meaning that all data is sent to the same log file. If you set a maximum size, a new log file
opens when the file reaches that size. This setting is valid for both periodic and
continuous uploads.

Start early
upload
when sum
of all log
sizes
reaches

Log size that triggers an early upload. The appliance attempts to upload the log when the
limit is reached.

This early upload setting remains in effect even if you specify a global value (see "Specify
Global Logging Settings" on page 560). This means that, provided that upload is
configured and working, the global early upload threshold could trigger a log upload
before the file size reaches the threshold defined in the specific log facility.

Upload Client Upload
Client

Supported upload client. See "Configure an Upload Client" on page 571.

SelectNone to disable log uploads.

Open
Settings

Displays client settings for the current log.

Test Upload Test uploading the current access log. Before you begin, make sure you have configured
the upload client completely.

1. Select Test Upload.

The appliance displays a "Format Syntax correct" or "Format Syntax incorrect"
message.

2. Check the event log for upload results.

For the duration of the test, configure the event log to use the verbose event level. This
logs more complete log information. After you test uploading, you can check the event log
for the test upload event and determine whether any errors occurred.
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Section
Setting or
field

Description

Transmission
Parameters

Encryption
Certificate

The appliance uses the selected external certificate to encrypt the uploaded log. The
external certificate must be imported to the appliance before you can use it here. Not
available for custom clients.

(Optional setting for digitally signing access logs.)

Signing
Keyring

The access log is digitally signed using the selected keyring. The signing keyring, with a
certificate set to smime, must already exist on the appliance. A certificate set to any other
purpose cannot be used for digital signatures. Not available for custom clients.

(Optional setting for digitally signing access logs.)

Save the log
file as

Specify whether or not to compress the uploaded access log:

n gzip file: (Default) Compress the log.

n text file: Don't compress the log.

If you select gzip file for the Kafka Client, you can configure the appliance to add a
MessageSet header to compressed log entries. Doing so allows for better performance
when the compressed data is sent to the broker. For details, see "Ensure Logs are
Processed Correctly" on page 576.

Send partial
buffer after

Applies only if text file is selected above.

Specify the maximum time between text log packets, meaning that it forces a text upload
after the specified length of time even if the internal log buffer is not full. If the buffer fills
up before the time specified in this setting, the text uploads right away, and is not
affected by this maximum setting.

This setting is valid only for continuous uploading.

Bandwidth
Class

(Optional) Select a bandwidth class. The default setting is none, which means that
bandwidth management is disabled for this log facility by default.

Before you canmanage the bandwidth for this log facility, youmust first create a
bandwidth-management class. It is the log facility that is bandwidth-managed—the
upload client type does not affect this setting.

Less bandwidth slows down the upload, while more could flood the network.
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Section
Setting or
field

Description

Upload
Schedule

See
"Configure
an Access
Log Upload
Schedule" on
page 563 for
details.

Upload the
access log

Upload type:

n continuously: Stream access log entries to a remote server.

n periodically: Transmit on a scheduled basis.

Wait
between
connect
attempts

Number of seconds between connection attempts.

Time
between
keep-alive
log packets

Applies only if continuously is selected for upload type above.

Number of seconds between keep-alive packets.

Keep-alives maintain the connection to FTP and HTTP servers during low periods of
system usage. When no logging information is being uploaded, the SGOS software sends
a keep-alive packet to the remote server at the interval you specify, from 1 to 65535
seconds. If you set this to 0 (zero), you effectively disable the connection during low usage
periods. The next time that access log information needs to be uploaded, the Edge SWG
(ProxySG) automatically reestablishes the connection.

Daily or In
Intervals

Specify when logs are uploaded or rotated:

n If Daily, specify the time of day to upload logs (for periodic) or rotate logs (for
continuous) in the Upload at field.

n If In Intervals, specify the amount of time, in the Hours andMinutes fields,
between uploads.

Upload Now Applies only if periodically is selected for upload type above.

You can upload the access logs now or you can cancel any access-log upload currently in
progress (if you are doing periodic uploads). You can rotate the access logs now (if you
are doing continuous uploads). These actions do not affect the next scheduled upload
time.

Cancel
Upload

Applies only if periodically is selected for upload type above.

Allows you to stop repeated uploadattempts if theWeb server becomes unreachable
while an upload is in progress. Clicking this sets log uploading back to idle if the log is
waiting to retry the upload. If the log file is in the process of uploading, it takes time for it
to take effect.
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Section
Setting or
field

Description

Rotate Now Applies only if continuously is selected for upload type above.

Log rotation helps prevent logs from growing excessively large. Especially with a busy
site, logs can grow quickly and become too big for easy analysis. With log rotation, SGOS
periodically creates a new log file, and archives the older one without disturbing the
current log file.
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Configure an Upload Client
The Edge SWG (ProxySG) appliance supports the following upload clients:

n FTP client, the default

n HTTP client

n Custom client

Note: Youmust have a socket server to use the Custom client.

n Symantec Reporter client

n Kafka client

Note: You can configure the appliance to add a KafkaMessageSet header to
compressed log entries. Making any change to an access log's upload client
configuration that reverses theMessageSet header state (that is, the header's
presence or absence in the log files) can cause future log uploads to fail. To prevent
these issues fromoccurring, see "Ensure Logs are Processed Correctly" on page 576.

n SCP client

Symantec also supports secure FTP (FTPS), secure HTTP (HTTPS), secure Custom client, and secure Kafka client. The
Custom client is based on plain sockets.

The general options you enter in theUpload Client tab affect all clients. Specific options that affect individual clients are
discussed in the FTP client, HTTP client, or Custom client, or the access-log ftp-client, https-client, or custom-client CLI
commands.

Only one client can be used at any one time. All four can be configured, but only the selected client is used.

The appliance provides access logging with two types of uploads to a remote server:

n Continuous uploading, where the device continuously streams new access log entries from the devicememory to
a remote server.

n Scheduled (periodic) uploading, where the device transmits log entries on a scheduled basis. See "General Logging
Configuration" on page 560.

The appliance allows you to upload either compressed access logs or plain-text access logs. The device uses the gzip
format to compress access logs. Gzip compressed files allowmore log entries to be stored in the device. Advantages of
using file compression include:
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n Reduces the time and resources used to produce a log file because fewer disk writes are required for each
megabyte of log-entry text.

n Uses less bandwidth when the device sends access logs to an upload server.

n Requires less disk space.

Compressed log files have the extension .log.gz. Text log files have the extension .log. For greater security, you can
configure the SGOS software to encrypt and sign the access log.

Symantec supports several upload clients for the appliance. Multiple upload clients can be configured per log facility, but
only one can be enabled and used per upload.

Note: For information on the Reporter Client, refer to the Symantec Reporter WebGuide.

To configure an upload client:

1. In the Admin Console, select Administration > Access Logging > General.

2. In Logs, select a configured log.

3. On the Edit Log page, inUpload Client, select an upload client:

n "CustomClient Settings" below

n "FTP Client Settings" on the facing page

n "HTTP Client Settings" on page 574

n "Kafka Client Settings" on page 575

n "SCP Client Settings" on page 578

Custom Client Settings
Specify the following as needed:

Area Settings

Primary
Server:

n Host: Specify the host IP address (in IPv4 format) of the upload destination. 

n Port: The default port is 69. Enter a different port if needed.

Alternate
Server

n Host: Specify the host IP address (in IPv4 format) of the alternate upload destination.

n Use port from primary server: Selected by default; clear the selection and specify a different port if
needed.

Other
Settings

Use secure connections (SSL): Select if you are using secure connections. If this setting is enabled, the IP address
must match the IP address in the certificate presented by the server.
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FTP Client Settings
Specify the following as needed:

Area Settings

Primary
Server

n Host: Specify the host IP address (in IPv4 or IPv6 format) or domain name that resolves to an IPv4/IPv6
address of the upload destination.

n Port: The default port is 21. Enter a different port if needed.

n Upload Path: Directory path where the access log is uploaded on the server.

n Username: User name that is known on the host.

n Change password: Enable to change the password on the FTP server. Enter and confirm the password.

Alternate
Server:

n Host: Specify the host IP address (in IPv4 or IPv6 format) of the alternate upload destination.

n Use port, upload path and username from primary server: Selected by default; clear the selection and
specify a different port, path, and user name if needed.

Other
Settings:

n Filename: Log filename format, which supports the following specifiers and text:

o %f for the log name

o %c for the name of the external certificate used for encryption, if applicable. If you use more than one
external certificate to encrypt logs, include this specifier to keep track of which external certificate
was used to encrypt the uploaded log file.

o %l for the fourth parameter of the Edge SWG (ProxySG) appliance IP address

o %m and %d are date specifiers (month and day, respectively)

o %H% , %M, and %S, are time specifiers (hour, minute, and second, respectively)

If you configure logs for continuous upload and do not have time specifiers in the Filename field, each
access log file produced overwrites the previous file.

o .gzip.log or .log for the log file extension

For additional specifiers that this log format might support, see "Access Log Filename Formats" on page 586.

n Timestamp: The time stamp format used in access log entries and filename. Select UTC to reflect the UTC
standard. Select Local time to reflect the local time zone.

n Use secure connections (SSL): Select if you are using FTPS.

n Use passive FTP: Enabled by default, the Edge SWG (ProxySG) appliance connects to the FTP server.
Otherwise, the FTP server uses the PORT command to connect to the appliance.
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HTTP Client Settings
Access log uploads done through an HTTP/HTTPS client use theHTTP PUTmethod. The destination HTTP server (where
the access logs are being uploaded) must support thismethod. Microsoft's IIS allows the server to be directly configured
for write (PUT/DELETE) access. Other servers, such as Apache, require installing a newmodule for the PUTmethod for
access log client uploads.

You can create either an HTTP or an HTTPS upload client through theHTTP client dialog. (Create an HTTPS client by
selectingUse secure connections (SSL).)

Note: To create an HTTPS client, youmust also import the appropriate CA Certificate.

Specify the following as needed:

Area Settings

Primary
Server

n Host: Specify the host IP address (in IPv4 or IPv6 format) or domain name that resolves to an IPv4/IPv6
address of the upload destination.

n Port: The default port is 80. Enter a different port if needed. For HTTPS, use port 443.

n Upload Path: Directory path where the access log is uploaded on the server.

n Username: User name that is known on the host.

n Change password: Enable to change the password on the HTTP/S server. Enter and confirm the password.

Alternate
Server:

n Host: Specify the host IP address (in IPv4 or IPv6 format) of the alternate upload destination.

n Use port, upload path and username from primary server: Selected by default; clear the selection and
specify a different port, path, and user name if needed.
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Area Settings

Other
Settings:

n Filename: Log filename format, which supports the following specifiers and text:

o %f for the log name

o %c for the name of the external certificate used for encryption, if applicable. If you use more than one
external certificate to encrypt logs, include this specifier to keep track of which external certificate
was used to encrypt the uploaded log file.

o %l for the fourth parameter of the Edge SWG (ProxySG) appliance IP address

o %m and %d are date specifiers (month and day, respectively)

o %H% , %M, and %S, are time specifiers (hour, minute, and second, respectively)

If you configure logs for continuous upload and do not have time specifiers in the Filename field, each
access log file produced overwrites the previous file.

o .gzip.log or .log for the log file extension

For additional specifiers that this log format might support, see "About Access Log Formats" on page 580

n Timestamp: The time stamp format used in access log entries and filename. Select UTC to reflect the UTC
standard. Select Local time to reflect the local time zone.

n Use secure connections (SSL): Select if you are creating an HTTPS client. Youmust also create a key pair,
import or create a certificate, and, if necessary, associate the key pair and certificate (called a keyring), with
the SSL device profile. If this setting is enabled, the IP address must match the IP address in the certificate
presented by the server.

Kafka Client Settings
You can use the Apache Kafka access log upload client to upload logs from the appliance to a Kafka broker cluster. A
Kafka consumer client can consume the log data and process them tomake them suitable for import into a log analysis
tool.

To use Apache terminology, the appliance is the Kafka producer client, the SymantecWeb Security Service or your own
client is the Kafka consumer client, and the cluster of servers running Kafka broker software is the Kafka broker cluster.
The appliance publishes log entries to consumer-specific feeds called topics. Formore information on Kafka concepts
and terminology, refer to Apache documentation: http://kafka.apache.org/documentation.html

Note: As of this writing, the Kafka broker does not natively support SSL encryption. To
have a secure communication channel from the Edge SWG (ProxySG) appliance, youmust
provide an authentication adapter between the appliance and the Kafka broker cluster.
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The appliance can add aMessageSet header to gzipped log files before they are uploaded to the Kafka broker. This
allows Kafka to process compressed data correctly, rather than as a large uncompressed data file. For details, see "Ensure
Logs are Processed Correctly" below.

You require the following to use Kafka as the upload client:

n The appliancemust be able to access the Kafka broker cluster.

n A Kafka consumer client must exist to consume and process log data. If the appliance is running in FIPSmode, the
key formutual authenticationmust be FIPS-compliant.

Specify the following as needed:

Area Settings

Primary
Server

n Host: Specify the host IP address (in IPv4 or IPv6 format) or domain name that resolves to an IPv4/IPv6
address of the upload destination.

n Port: The default port is 9092. 

n SSL Device Profile: Select an existing SSL device profile to use for mutual authentication.

Alternate
Server:

n Host: Specify the host IP address (in IPv4 or IPv6 format) of the alternate upload destination.

n Use port and SSL device profile from primary server: Selected by default; clear the selection and specify
a different port and SSL device profile if needed.

Other
Settings:

n Use secure connections (SSL): Select an existing SSL device prrofile if you want to secure the connection
between the appliance and the broker.

n Topic: Topic name for this specific log facility. You can use any string-format combination, but the default is
SG_%f, where %f is automatically replaced with the name of the log facility. Other supported format
characters are:

o %c for the client name

o %i for the IP address

For additional specifiers that this log format might support, see "About Access Log Formats" on page 580

Ensure Logs are Processed Correctly

If you selected gzip file for Kafka, you can configure the appliance to add aMessageSet header to the compressed log
files so that the Kafka broker processes the data as gzip-compressed data. Use the following command to enable/disable
the setting (by default, the setting is disabled):

# (config log log_name) kafka-client [no] message-set-codec

Refer to the Command Line Interface Reference for details on this command.

When all of the following conditions are true, theMessageSet header is added to log files:
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n Kafka is the upload client for the log

n gzip is selected as the log file type

n the Kafka codec is enabled in the CLI

When one ormore of the following conditions are true, theMessageSet header is not added to log files:

n Kafka is not the upload client for the log

n Kafka is the upload client for the log but gzip is not selected as the file type

n Kafka is the upload client but the codec setting is disabled

Making any change to an access log's upload client configuration that reverses the previousMessageSet header state
(that is, the header's presence or absence in the log files) can cause future log uploads to fail. For example, if you change
a log’s upload client from FTP to Kafkawith gzip and codec enabled, the header did not exist in previous log files but it is
added to the files after the upload client change. If you then change the Kafka file type from gzip to text, the header is
no longer added to the log files. In both of these scenarios, youmust take additional steps to ensure that logs are
processed correctly.

To prevent problems from arising when youmake any changes that affect theMessageSet header state, clear thewrite
buffer and remove any stored logs from the appliance. Symantec recommends that you perform these steps in the
specified order: manually upload the logs, make your desired log changes, and then delete the access logs from the
appliance.

Example: Changing the codec for Kafka client

1. Upload the access logs. In the Admin Console, select Administration > Access Logging > General and edit a
log to configure the upload schedule.

Example: Your dns log uses the Kafka client and the gzip file format. InUpload Client, select the dns log and click
Test Upload.

2. Change the codec setting as appropriate. In the CLI, issue one of the following commands:

# (config log log_name) kafka-client message-set-codec

The header is added to the start of compressed log entries.

# (config log log_name) kafka-client no message-set-codec

Headers are not added to the start of any log entries.

Example: You are enabling the header for the first time. Issue the following command for your dns log, named
dns:

# (config log dns) kafka-client message-set-codec

3. Delete the access logs. In the CLI, issue the following command for each log using the Kafka client:
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# (config log log_name) commands delete-logs

Example: Issue the following command for the log named dns:

# (config log dns) commands delete-logs

The dns logs stored on the appliance are deleted. Subsequent uploads of the dns logs, whether system-initiated
or user-initiated, will have theMessageSet header unless you do any of the following:

n select a different upload client

n change the log file format to text

n disable the codec setting

Whenever you intend to make any of thesemodifications, follow the previous procedure to ensure that logs
continue to be processed correctly.

SCP Client Settings
The SCP protocol allows you to transfer data securely over an SSH connection. If your site has an SSH server, you can
configure an SCP client for secure access log uploads. Using the SCP client is useful if your organization does not permit
other securemethods such as HTTPS or FTPS.

Before setting up the SCP client, youmust configure the hosts, client keys, HMACs, and ciphers for outbound SSH
connections.

Note: Continuous upload is not supported over SCP client.

Specify the following as needed:

Area Settings

Primary
Server

n Host: Specify the host IP address (in IPv4 or IPv6 format) or domain name that resolves to an IPv4/IPv6
address of the upload destination.

n Port: The default port is 22. Enter a different port if needed.

n Upload Path: Directory path where the access log is uploaded on the server.

n Username: User name that is known on the host.

n Change password: Enable to change the password on the SCP server. Enter and confirm the password.

Alternate
Server:

n Host: Specify the host IP address (in IPv4 or IPv6 format) of the alternate upload destination.

n Use port, upload path and username from primary server: Selected by default; clear the selection and
specify a different port, path, and user name if needed.
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Area Settings

Other
Settings:

n Filename: Log filename format, which supports the following specifiers and text:

o %f for the log name

o %c for the name of the external certificate used for encryption, if applicable. If you use more than one
external certificate to encrypt logs, include this specifier to keep track of which external certificate
was used to encrypt the uploaded log file.

o %l for the fourth parameter of the Edge SWG (ProxySG) appliance IP address

o %m and %d are date specifiers (month and day, respectively)

o %H% , %M, and %S, are time specifiers (hour, minute, and second, respectively)

If you configure logs for continuous upload and do not have time specifiers in the Filename field, each
access log file produced overwrites the previous file.

o .gzip.log or .log for the log file extension

For additional specifiers that this log format might support, see "About Access Log Formats" on the next
page.

n Timestamp: The time stamp format used in access log entries and filename. Select UTC to reflect the UTC
standard. Select Local time to reflect the local time zone.
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About Access Log Formats
The appliance supports the following access log formats:

n "CustomorW3C ELFF Format" below

n "SQUID-Compatible Format " on page 585

n "NCSA Common Access Log Format" on page 585

The Edge SWG (ProxySG) appliance can create access logs with any one of six formats. Four of the six are reserved
formats and cannot be configured; however, you can create additional logs using customor ELFF format strings. When
using an ELFF or custom format, a blank field is represented by a dash character.

When using the SQUID or NCSA log format, a blank field is represented according to the standard of the format.

See "Access Log Filename Formats" on page 586 for supported specifiers for the access log filename.

Custom or W3C ELFF Format
TheW3C ELFF is a subset of the Symantec format. ELFF is specified as a series of space delimited fields. Each field is
described using a text string. The types of fields are described in the following table.

Field Type Description

Identifier A type unrelated to a specific party, such as date and time.

prefix-
identifier

Describes information related to a party or a transfer, such as c-ip (client’s IP) or sc-bytes (howmany bytes were
sent from the server to the client)

prefix
(header)

Describes a header data field. The valid prefixes are:

n c = Client

n s = Server

n r = Remote

n sr = Server to Remote

n cs = Client to Server

n sc = Server to Client

n rs = Remote to Server

ELFF formats are created by selecting a corresponding custom log format using the table below. Unlike the Symantec
custom format, ELFF does not support character strings and requires a space between fields.

Selecting the ELFF format does the following:
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n Puts one ormoreW3C headers into the log file. Each header contains the following lines:

#Software: SGOS x.x.x
#Version: 1.0
#Date: 2002-06-06 12:12:34
#Fields: date time cs-ip…

n Changes all spaces within fields to + or %20. The ELFF standard requires that spaces only be present between
fields. ELFF formats are described in the following table.

Symantec
Custom Format

ELFF Description

space character N/A Multiple consecutive spaces are compressed to a single space

% - Expansion field

%% - '%' character

%a c-ip IP address of the client

%b sc-bytes Number of bytes sent from appliance to client

%c rs(Content-Type) Response header: Content-Type

%d s-suppliername Hostname of the upstream host (not available for a cache hit)

%e time-taken Time taken (in milliseconds) to process the request

%f sc-
filtercategory

Content filtering category of the request URL

%g timestamp Unix type timestamp

%h c-dns Hostname of the client (uses the client's IP address to avoid reverse DNS)

%i cs-uri The log URL

%j - Not used.

%k - Not used.

%l x-
bluecoatspecial-
empty

Resolves to an empty string

%m cs-method Request method used from client to appliance

%n - Not used.

%o - Not used.

%p r-port Port from the outbound server URL

%q - Not used.
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Symantec
Custom Format

ELFF Description

%r cs-requestline First line of the client's request

%s sc-status Protocol status code from appliance to client

%t gmttime GMT date and time of the user request in format: [DD/MM/YYYY:hh:mm:ss GMT]

%u cs-user Qualified username for NTLM. Relative username for other protocols

%v cs-host Hostname from the client's request URL. If URL rewrite policies are used, this field's
value is derived from the 'log' URL

%w s-action Type of action the Edge SWG (ProxySG) appliance took to process this request (see
"Action Field Values" on the facing page).

%x date GMT Date in YYYY-MM-DD format

%y time GMT time in HH:MM:SS format

%z s-icap-status ICAP response status

%A cs(User-Agent) Request header: User-Agent

%B cs-bytes Number of bytes sent from client to appliance

%C cs(Cookie) Request header: Cookie

%D s-supplier-ip IP address used to contact the upstream host (not available for a cache hit)

%E - Not used.

%F - Not used.

%G - Not used.

%H s-hierarchy How and where the object was retrieved in the cache hierarchy.

%I s-ip IP address of the appliance on which the client established its connection

%J - Not used.

%K - Not used.

%L localtime Local date and time of the user request in format: [DD/MMM/YYYY:hh:mm:ss +nnnn]

%M - Not used.

%N scomputername Configured name of the appliance

%O - Not used.

%P s-port Port of the appliance on which the client established its connection

%Q cs-uri-query Query from the log URL

%R cs(Referer) Request header: Referer

%S s-sitename Service type used to process the transaction
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Symantec
Custom Format

ELFF Description

%T duration Time taken (in seconds) to process the request

%U cs-uri-path Path from the log URL. Does not include query.

%V cs-version Protocol and version from the client's request, e.g. HTTP/1.1

%W sc-filterresult Content filtering result: Denied, Proxied or Observed

%X cs(XForwarded-
For)

Request header: X-Forwarded-For

%Y - Not used.

%Z s-icap-info ICAP response information

Example Access Log Formats
Squid log format: %g %e %a %w/%s %b %m %i %u %H/%d %c
NCSA common log format: %h %l %u %t "%r" %s %b
NCSA extended log format: %h %l %u %L "%r" %s %b "%R" "%A"
Microsoft IIS format: %a, -, %x, %y, %S, %N, %I, %e, %b, %B, %s, 0, %m,
%U, -

The Symantec custom format allows any combination of characters and format fields. Multiple spaces are compressed
to a single space in the actual access log. You can also enter a string, such as My default is %d. The appliance goes
through such strings and finds the relevant information. In this case, that information is %d.

Action Field Values

The following table describes the possible values for the s-action field.

Value Description

ACCELERATED (SOCKS only) The request was handed to the appropriate protocol agent for handling.

ALLOWED An FTP method (other than the data transfer method) is successful.

DENIED Policy denies a method. A DENIED s-action value is returned for CIFS, Endpoint Mapper, MAPI, FTP, P2P, Shell
Proxy, SOCKS proxy, streaming proxies, and SSL proxy when policy denies a request. When the same kind of
denial happens in the HTTP proxy, TCP_DENIED is reported.

FAILED An error or failure occurred.

LICENSE_
EXPIRED

(SOCKS only) The request could not be handled because the associated license has expired.

TCP_
ACCELERATED

For CONNECT tunnels that are handed off to the following proxies: HTTP, SSL, Endpoint mapper, and P2P for
BitTorrent/EDonkey/Gnutella.

TCP_AUTH_
HIT

The requested object requires upstream authentication, and was served from the cache.
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Value Description

TCP_AUTH_
HIT_RST

The requested object requires upstream authentication, but the client connection was reset before the
complete response was delivered.

TCP_AUTH_
MISS

The requested object requires upstream authentication, and was not served from the cache. This is part of
CAD (Cached Authenticated Data).

TCP_AUTH_
MISS_RST

The requested object requires upstream authentication, and was not served from the cache; the client
connection was reset before the complete response was delivered.

TCP_AUTH_
FORM

Forms-based authentication is being used and a form challenging the user for credentials is served in place of
the requested content.

Note: Upon submission of the form, another access log entry is generated to
indicate the status of the initial request.

TCP_AUTH_
REDIRECT

The client was redirected to another URL for authentication.

TCP_
BYPASSED

A TCP-Tunnel connection was bypassed because an upstream ADN concentrator was not discovered; this can
occur only when the bypass-if-no-concentrator feature is enabled and all conditions for activating the feature
are met.

TCP_CLIENT_
REFRESH

The client forces a revalidation with the origin server with a Pragma: no-cache. If the server returns 304 Not
Modified, this appears in the Statistics:Efficiency file as In Cache, verified Fresh.

TCP_CLIENT_
REFRESH_RST

The client forces a revalidation with the origin server, but the client connection was reset before the complete
response was delivered. TCP_DENIED Access to the requested object was denied by a filter.

TCP_ERR_MISS An error occurred while retrieving the object from the origin server.

TCP_HIT A valid copy of the requested object was in the cache.

TCP_HIT_RST A valid copy of the requested object was in the cache, but the client connection was reset before the complete
response was delivered.

TCP_LOOP The current connection is dropped because the upstream connection would result in a looped connection.

TCP_MEM_HIT The requested object was, in its entirety, in RAM.

TCP_MISS The requested object was not in the cache.

TCP_MISS_RST The requested object was not in the cache; the client connection was reset before the complete response was
delivered.

TCP_NC_MISS The object returned from the origin server was noncacheable.

TCP_NC_MISS_
RST

The object returned from the origin server was noncacheable; the client connection was reset before the
complete response was delivered.

TCP_PARTIAL_
MISS

The object is in the cache, but retrieval from the origin server is in progress.
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Value Description

TCP_PARTIAL_
MISS_RST

The object is in the cache, but retrieval from the origin server is in progress; the client connection was reset
before the complete response was delivered.

TCP_POLICY_
REDIRECT

The client was redirected to another URL due to policy.

TCP_REFRESH_
HIT

A GIMS request to the server was forced and the response was 304 Not Modified; this appears in the
Statistics:Efficiency file as In Cache, verified Fresh.

TCP_REFRESH_
HIT_RST

A GIMS request to the server was forced and the response was 304 Not Modified; the client connection was
reset before the complete response was delivered.

TCP_REFRESH_
MISS

A GIMS request to the server was forced and new content was returned.

TCP_REFRESH_
MISS_RST

A GIMS request to the server was forced and new content was returned, but the client connection was reset
before the complete response was delivered.

TCP_RESCAN_
HIT

The requested object was found in the cache but was rescanned because the virus-scanner-tag-id in the object
was different from the current scanner tag.

TCP_RESCAN_
HIT_RST

The requested object was rescanned (see TCP_RESCAN_HIT) but the client connection was reset before the
complete response was delivered.

TCP_
SPLASHED

The user was redirected to a splash page.

TCP_
SWAPFAIL

The object was believed to be in the cache, but could not be accessed.

TCP_
TUNNELED

The CONNECT method was used to tunnel this request (generally proxied HTTPS).

TCP_
WEBSOCKET

The request was a WebSocket upgrade request. You can determine if the traffic was plain WebSocket or secure
WebSocket by looking at the scheme (HTTP or HTTPS).

TUNNELED Successful data transfer operation. TCP_ Refers to requests on the HTTP port.

SQUID-Compatible Format
The SQUID-compatible format contains one line for each request. For SQUID-1.1, the format is: time elapsed
remotehost code/status bytesmethod URL rfc931 peerstatus/peerhost type For SQUID-2, the columns stay the same,
though the content withinmight change a little.

NCSA Common Access Log Format
The common log format contains one line for each request. The format of each log entry is shown below:

remotehost rfc931 authuser [date] "request" status bytes

Each field is described in the following table.
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Field Description

authuser The username of the authenticated user.

bytes The content length of the document transferred.

[date] Date and time of the request.

remotehost DNS hostname or IP address of remote server.

"request" The request line exactly as it came from the client.

rfc931 The remote log name of the user. This field is always —.

status The HTTP status code returned to the client.

Access Log Filename Formats
The following table details the specifiers for the access log upload filenames.

Specifier Description

%% Percent sign.

%a Abbreviated weekday name.

%A Full weekday name.

%b Abbreviatedmonth name.

%B Full month name.

%c The certificate name used for encrypting the log file (expands to nothing in non-encrypted case).

%C The appliance name.

%d Day of month as decimal number (01 – 31).

%f The log name.

%H Hour in 24-hour format (00 – 23).

%i First IP address of the appliance, displayed in x_x_x_x format, with leading zeros removed.

%I Hour in 12-hour format (01 – 12).

%j Day of year as decimal number (001 – 366).

%l The fourth (last) octet in the appliance IP address For example, for the IP address 10.11.12.13, %l would be 13.

%m Month as decimal number (01 – 12).

%M Minute as decimal number (00 – 59).

%p Current locale’s A.M./P.M. indicator for 12-hour clock.

%S Second as decimal number (00 – 59).
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Specifier Description

%U Week of year as decimal number, with Sunday as first day of week (00 – 53).

%v Milliseconds; usually used in conjunction with %H%M%S to get more accuracy in the log filename.

%w Weekday as decimal number (0 – 6; Sunday is 0).

%W Week of year as decimal number, with Monday as first day of week (00 – 53).

%y Year without century, as decimal number (00 – 99).

%Y Year with century, as decimal number.

%z, %Z Timezone name or abbreviation; no characters if time zone is unknown.
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Default Access Log Formats
The following describes the default access log formats and how to create customized access log formats. For a
description of each value in the log, see "About Access Log Formats" on page 580.

bcreportercifs_v1

Designed to for Proxy deployments that use ADN to transfer data with CIFS, and send that access information to
Symantec Reporter. This format includes the following fields:

date time c-ip c-port r-ip r-port s-action s-ip cs-auth-group csusername x-client-connection-bytes x-
server-connection-bytes xserver-adn-connection-bytes
x-cifs-method x-cifs-client-readoperations x-cifs-client-write-operations x-cifs-client-
otheroperations x-cifs-server-operations x-cifs-error-code
x-cifs-server x-cifs-share x-cifs-path x-cifs-orig-path x-cifs-client-bytes-read x-cifs-server-bytes-
read x-cifs-bytes-written x-cifs-uid x-cifs-tid
x-cifs-fid x-cifs-file-size x-cifs-file-type

This is a reserved format and cannot be edited.

bcreportermain_v1

Designed to send HTTP access information to Symantec Reporter. This format includes the following fields:

date time time-taken c-ip cs-username cs-auth-group s-supplier-name ssupplier-ip s-supplier-country s-
supplier-failures x-exception-id scfilter-result
cs-categories cs(Referer) sc-status s-action cs-rs(Content-Type) cs-uri-scheme cs-host cs-uri-port cs-
uri-path cs-uriquery cs-uri-extension cs(User-Agent)
s-ip sc-bytes cs-bytes x-virusid x-bluecoat-application-name x-bluecoat-application-operation x-
bluecoat-application-groups cs-threat-risk
x-bluecoat-transaction-uuid x-icap-reqmod-header(X-ICAP-Metadata) x-icap-respmod-header(X-
ICAPMetadata)

This is a reserved format and cannot be edited.

bcreporterssl_v1

Designed to send HTTPS access information to Symantec Reporter. This format includes the following fields:

date time time-taken c-ip cs-username cs-auth-group s-supplier-name ssupplier-ip s-supplier-country s-
supplier-failures x-exception-id scfilter-result
cs-categories sc-status s-action cs-method rs(Content-Type) cs-uri-scheme cs-host cs-uri-port cs-uri-
extension cs(User-Agent) s-ip sc-bytes cs-bytes x-virus-id
x-rs-certificate-observederrors x-cs-ocsp-error x-rs-ocsp-error x-rs-connection-negotiatedcipher-
strength x-rs-certificate-hostname
x-rs-certificate-hostnamecategory cs-threat-risk x-rs-certificate-hostname-threat-risk

This is a reserved format and cannot be edited.
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bcreporterstreaming_v1

Designed to send streamingmedia access information to Symantec Reporter. This format includes the following fields:

date time time-taken c-ip sc-status s-action sc-bytes rs-bytes csmethodcs-uri-scheme cs-host cs-uri-
port cs-uri-path cs-uri-query csusername cs-auth-group
cs(Referer) cs(User-Agent) c-starttime filelength filesize avgbandwidth x-rs-streaming-content x-
streamingrtmp-app-name x-streaming-rtmp-stream-name
x-streaming-rtmp-swf-url xstreaming-rtmp-page-url s-ip s-dns s-session-id x-cache-info

This is a reserved format and cannot be edited.

bcreporterwarp_v1

Designed to log reverse proxy traffic data.With this data, reverse proxy administrators can run reports for inspecting
traffic flow between the appliance and backend web application servers. The bcreporterwarp_v1 access log format is
recommended forWAF deployments because it includes detailed information for requests that WAF blocks (or
monitors). To populate theWeb Application Protection and Geolocation access log fields, youmust have valid
subscriptions for the respective service and enable the feature on the appliance. This format includes the following
fields:

date time time-taken c-ip cs-username cs-auth-group x-bluecoattransaction-uuid x-exception-id cs
(Referer) sc-status s-action csmethod rs(Content-Type)
cs-uri-scheme cs-host cs-uri-port cs-uri-path cs-uri-query cs-uri-extension cs(User-Agent) s-ip sc-
bytes cs-bytes xvirus-id x-cs-client-ip-country
x-user-x509-serial-number x-user-x509-subject rs-bytes x-cs-client-effective-ip x-cs-client-effective-
ipcountry cs(X-Forwarded-For) rs-service-latency
r-ip x-bluecoatapplication- name x-bluecoat-waf-attack-family x-risk-score x-bluecoatwaf- block-
details x-bluecoat-waf-monitor-details
x-bluecoat-requestdetails-header x-bluecoat-request-details-body x-bluecoat-waf-scaninfo

Note: x-bluecoat-request-details-header includes all header content up to the body
of an HTTP request, not just common fields like host and referrer.

This is a reserved format and cannot be edited.

bcsecurityanalytics_v1

Designed to send appropriate log entries to the Security Analytics Platform. This format includes the following fields:

date time c-ip c-port s-ip s-port s-source-ip s-source-port r-ip rport s-supplier-ip s-supplier-port
r-supplier-ip r-supplier-port rsupplier-dns x-virus-id
cs(Referer) x-cs(Referer)-uri-category xbluecoat-application-name x-bluecoat-application-operation x-
bluecoatapplication-groups

This is a reserved format and cannot be edited.
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Formore information on the Security Analytics Platform, refer to documentation:
https://techdocs.broadcom.com/content/broadcom/techdocs/us/en/symantec-security-software/web-and-network-
security/security-analytics/8-1.html

cifs

An ELFF format that includes the following fields:

date time c-ip c-port r-ip r-port s-action s-ip cs-auth-group csusername x-client-connection-bytes x-
server-connection-bytes x-serveradn-connection-bytes
x-cifs-method x-cifs-client-read-operations xcifs-client-write-operations x-cifs-client-other-
operations x-cifsserver-operations x-cifs-error-code x-cifs-server
x-cifs-share x-cifspath x-cifs-orig-path x-cifs-client-bytes-read x-cifs-server-bytesread x-cifs-
bytes-written x-cifs-uid x-cifs-tid x-cifs-fid x-cifsfile-size
x-cifs-file-type

collaboration

Designed to logWebEx actions. It is an ELFF format that includes the following fields:

date time c-ip r-dns duration x-collaboration-method s-action xcollaboration-user-id x-collaboration-
meeting-id x-webex-site

dns

An ELFF format that includes the following fields.

date time time-taken c-ip x-dns-cs-transport x-dns-cs-opcode x-dns-csqtype x-dns-cs-qclass x-dns-cs-
dns x-dns-cs-address x-dns-rs-rcode xdns- rs-a-records
x-dns-rs-cname-records x-dns-rs-ptr-records s-ip

main

An ELFF format that includes the following fields:

date time time-taken c-ip sc-status s-action sc-bytes cs-bytes csmethod cs-uri-scheme cs-host cs-uri-
port cs-uri-path cs-uri-query csusername cs-auth-group
s-supplier-name rs(Content-Type) cs(Referer) cs(User-Agent) sc-filter-result cs-categories x-virus-id
s-ip

mapi

An ELFF format that includes the following fields:

date time c-ip c-port r-ip r-port x-mapi-user x-mapi-method cs-bytes sr-bytes rs-bytes sc-bytes x-
mapi-cs-rpc-count x-mapi-sr-rpc-count xmapi-rs-rpc-count
x-mapi-sc-rpc-count s-action cs-username cs-authgroup s-ip
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mapi-http

Associated with theMAPI-HTTP protocol (Office 365 traffic) by default. It is an ELFF format that includes the following
fields:

date time c-ip c-port r-ip r-port x-mail-message-id x-mail-user xmail- operation x-mail-from x-mail-to
x-mail-cc s-action x-mailattachments
x-mail-attachments-removed s-icap-info cs-icap-status rsicap-status x-virus-id x-virus-details x-icap-
error-code x-icap-errordetail

ncsa

Reserved format that cannot be edited. TheNCSA/Common format contains the following strings:

remotehost rfc931 authuser [date] "request" status bytes

The ELFF/custom access log format strings that represent the previous strings are:

$(c-ip) - $(cs-username) $(localtime) $(cs-request-line) $(sc-status) $(sc-bytes)

p2p

An ELFF format that includes the following fields:

date time c-ip c-dns cs-username cs-auth-group cs-protocol x-p2pclient-type x-p2p-client-info x-p2p-
client-bytes x-p2p-peer-bytes duration s-action

squid

Reserved format that cannot be edited. You can create a new SQUID log format using custom strings. The default SQUID
format is SQUID-1.1 and SQUID-2 compatible.

SQUID uses several definitions for its field formats:

SQUID-1:time elapsed remotehost code/status/peerstatus bytes method URL

SQUID-1.1: time elapsed remotehost code/status bytes method URL rfc931 peerstatus/peerhost type

SQUID-2 has the same fields as SQUID-1.1, although some of the field values have changed.

ssl

An ELFF format that includes the following fields:

date time time-taken c-ip s-action x-rs-certificate-validate-status xrs-certificate-observed-errors x-
cs-ocsp-error x-rs-ocsp-error cs-host s-supplier-name
x-rs-connection-negotiated-ssl-version x-rsconnection-negotiated-cipher x-rs-connection-negotiated-
cipher-size xrs-certificate-hostname
x-rs-certificate-hostname-category x-csconnection-negotiated-ssl-version x-cs-connection-negotiated-
cipher xcs-connection-negotiated-cipher-size
x-cs-certificate-subject s-ip ssitename
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streaming

An ELFF format that includes the following fields:

c-ip date time c-dns cs-uri-scheme cs-host cs-uri-port cs-uri-path csuri-query c-starttime x-duration
c-rate c-status c-playerid cplayerversion c-playerlanguage
cs(User-Agent) cs(Referer) c-hostexe chostexever c-os c-osversion c-cpu filelength filesize
avgbandwidth protocol transport audiocodec videocodec channelURL
sc-bytes c-bytes s-pkts-sent c-pkts-received c-pkts-lost-client c-pkts-lost-net c-pktslost- cont-net
c-resendreqs c-pkts-recovered-ECC c-pkts-recoveredresent
c-buffercount c-totalbuffertime c-quality s-ip s-dns stotalclients s-cpu-util x-cache-user s-session-
id x-cache-info xclient-address s-action
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Configure an Access Log Format
The appliance ships with several default log formats, whichmight be sufficient for your needs. If these formats do not
meet your needs, you can create a customor ELFF format and specify the string and other qualifiers used.

To create a custom log format based on a reserved log format, see "Configure a Customor ELFF Log Format" below. See
"Default Access Log Formats" on page 588 to determinewhich log formats are reserved. Reserved log formats can't be
edited ormodified.

To view the default and custom log formats that exist on the system, use the following procedure.

Configure a Custom or ELFF Log Format
First, decidewhat protocols and log formats to use, and determine the logging policy and the upload schedule. Then,
perform the following:

n Associate a log format with the log facility.

n Associate a log facility with a protocol and/or create policies for protocol association and to manage the access
logs and generate entries in them (if you do both, policy takes precedence).

n Determine the upload parameters for the log facility. Formore information, see "Default Access Log Formats" on
page 588.

To create a format based on a reserved format, see "Create a Format Based on a Reserved Format" on the next page.

To configure a customor ELFF format:

1. In the Admin Console, select Administration > Access Logging > General.

2. In Log Formats, select Add New Format to create a new format or select an existing format to edit it.

3. On the Create/Edit Format page, specify the following as needed:

Note: If the page says View Format instead of Create/Edit Format, the format is
reserved and can't be edited. See "Create a Format Based on a Reserved Format" on
the next page for details.

Setting or field Description

Format Name
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Setting or field Description

Format type:

n Custom format string

n W3C Extended Log File
Format (ELFF) string

Specifies either a custom log format or an ELFF format.

Note: ELFF strings can't start with spaces. The access log
ignores any ELFF or custom format fields it doesn't
understand. In a downgrade, the format still contains all the
fields used in the upgraded version, but only the valid fields for
the downgraded version display any information.

Log fields Valid fields to include in the format, separated by spaces.

Test Format Validates the specified format-string syntax. Test the format every time you add or
remove log fields.

When testing is complete, the console displays a message indicating whether the
syntax is valid, including deprecated fields.

Multiple-valued header policy Specifies what happens with HTTP headers that have multiple instances:

n Log all headers

n Log last header

n Log all header

Create a Format Based on a Reserved Format
Theremight be instances where the reserved log format is insufficient for your purposes and requires either a log format
extension or reduction. Although the reserved log formats cannot be directly manipulated, you can create new custom
log formats based on these reserved log formats.

To create a format based on a reserved format:

1. In the Admin Console, select Administration > Access Logging > General.

2. In Log Formats, select an existing reserved format.

3. On the View Format page, select the access log fields and copy them to the clipboard. (The log fields appear to be
unavailable, but you will be able to select them.)

4. Create a new format using steps in "Configure a Customor ELFF Log Format" on the previous page, and paste the
access log fields to the new format. Make additional edits as needed.
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Configure Event Logging
You can configure the appliance to log system events as they occur. Event logging allows you to specify the types of
system events logged and the size of the event log. The appliance can also notify you by email if an event is logged.

When viewed from the CLI, Admin Console, or Syslog, the event log displays events according to the configured logging
level. When you select an event level, all levels above it are included. Clear an event logging level to omit it, and all levels
above it, from logs and notifications.

Select Events to Log
(Version 7.3.7.x and earlier) Select the event log level. The event logging level options are listed from themost to least
important events.

Select events to log:

1. In the Admin Console, select Administration > Logging > Event Logging.

2. Under General Settings, the log levels are listed from themost important to least important events:

n Severe errors only: Displays only severe errormessages. This option can't be cleared.

n Configuration changes plus above: Displays severe and configuration change events.

n Policy events plus above: Displays severe, configuration change, and policy event messages.

n Informational messages plus above: Displays severe, configuration change, policy event, and
informationmessages.

n All messages: Displays all events and errors with the greatest amount of detail.

To select events to log, select each level or select the least important level you want to log. For example, if you
select Policy events, Configuration changes and Severe errors are also selected.

Tip: In version 7.3.8.1 and later, you can specify separate log levels for email and
Syslog, and specify exceptions to the default notifications. See "Configure
Notification Defaults and Overrides" on page 602.

Set Event Log Size
Limit the size of the appliance’s event log and specify what occurs when the log size limit is reached.

Set event log size:

595 of 676



SGOS Administration (Admin Console Edition)

1. In the Admin Console, select Administration > Logging > Event Logging.

2. Under General Settings, enter themaximum size of the event log in Limit Event Log Size To. The default value
is 50 MB.

3. BesideWhen Limit Reached, specify what happens when the event log reaches themaximum size:

n Overwrite Earlier Events: The appliance overwrites the older half of the event entries, replacing it with
themost recent events. There is no way to recover the overwritten events.

n Stop Logging New Events: The appliance retains all of the entries to date, but new events are not
recorded.

Configure Email Notifications
Configure the appliance to send event notifications to individuals in your organization using SMTP. To do this, you
require either the hostname or IP address and port of the SMTP server, as well as the email addresses of the recipients.

Note: The Admin Console does not validate the SMTP server address or email address
information, so ensure they are correct before saving changes.

Configure email notifications:

1. In the Admin Console, select Administration > Logging > Event Logging.

2. Under SMTP Settings, configure the SMTP server:

n SMTP Server: Enter the SMTP server hostname or the IPv4 or IPv6 address.

n Port: Enter the SMTP server port.

n "From" Field For Email: (Optional) Specify the sender’s email address in the From email field. For example,
enter the email address of the labmanager responsible for administering appliances. If you do not specify
an email address here, event notifications display the name of the appliance for the sender’s address. For
information on configuring the appliance name, see "Identification and General Information" on page 454.

3. To add recipients:

a. UnderMail Recipients, select Add Recipient. The console opens an Add Recipient dialog.

b. In the dialog, enter a valid email address and select Add. The email address appears in the Email Address
list.

To edit an entry in the Email address list, select the Edit icon beside it. In the Edit Recipient dialog that opens, edit
the email address and select Update.

To remove an entry from the Email address list, select the Delete icon beside it.

596 of 676



SGOS Administration (Admin Console Edition)

Which Events are Emailed to Recipients?
When email notifications are enabled and configured, events whose levels you selected are sent to recipients.

n Version 7.3.7.x and earlier: The logging level is specified for both email and Syslog. See "Select Events to Log" on
page 595.

n Version 7.3.8.1 and later: Different logging levels are available for email and Syslog. See "ConfigureNotification
Defaults and Overrides" on page 602.
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View Event Log Configuration and Content
You can view the event log configuration, from show or from view in the event-log configurationmode.

To view the event log configuration:

n Type the following command from anywhere in the CLI:

> show event-log configuration
Settings:
Event level: severe + configuration + policy + informational
Event log size: 10 megabytes
If log reaches maximum size, overwrite earlier events
Syslog loghost: <none>
Syslog notification: disabled
Syslog facility: daemon
Event recipients:
SMTP gateway:
mail.heartbeat.bluecoat.com

n Type the following command from the (config) prompt:

#(config) event-log
#(config event-log) view configuration
Settings:
Event level: severe + configuration + policy + informational
Event log size: 10 megabytes
If log reaches maximum size, overwrite earlier events
Syslog loghost: <none>
Syslog notification: disabled
Syslog facility: daemon
Event recipients:
SMTP gateway:
mail.heartbeat.bluecoat.com

To view the event log contents, use one of the following commands:

Note: The results displayed include events only for the configured event logging levels.
Formore information, see "Configure Event Logging" on page 595.

n # show event-log

n # (config event-log) view

[start [YYYY-mm-dd] [HH:MM:SS]] [end [YYYY-mm-dd] [HH:MM:SS]] [regex regex | substring string]

Pressing the ENTER key shows the entire event log without filters.
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The order of the filters is unimportant. If start is omitted, the start of the recorded event log is used. If end is omitted,
the end of the recorded event log is used.

If the date is omitted in either start or end, it must be omitted in the other one (that is, if you supply just times, youmust
supply just times for both start and end, and all times refer to today). The time is interpreted in the current time zone of
the appliance.

Understanding the Time Filter
The entire event log can be displayed, or either a starting date/time or ending date/time can be specified. A date/time
value is specified using the notation ([YYYY-MM-DD] [HH:MM:SS]). Parts of this string can be omitted as follows:

n If the date is omitted, today's date is used.

n If the time is omitted for the starting time, it is 00:00:00.

n If the time is omitted for the ending time, it is 23:59:59.

At least one of the date or the timemust be provided. The date/time range is inclusive of events that occur at the start
time as well as dates that occur at the end time.

Note: If the notation includes a space, such as between the start date and the start time,
the argument in the CLI should be quoted.

Understanding the Regex and Substring Filters
A regular expression can be supplied, and only event log records that match the regular expression are considered for
display. The regular expression is applied to the text of the event log record not including the date and time. It is case-
sensitive and not anchored. You should quote the regular expression.

Since regular expressions can be difficult to write properly, you can use a substring filter instead to search the text of the
event log record, not including the date and time. The search is case sensitive.

Regular expressions use the standard regular expression syntax as defined by policy. If both regex and substring are
omitted, then all records are assumed tomatch.

Example
# show event-log start "2009-10-22 9:00:00" end "2019-10-22 9:15:00"
2019-10-22 09:00:02+00:00UTC "Snapshot sysinfo_stats has fetched /sysinfo-stats " 0 2D0006:96
../Snapshot_worker.cpp:183 2019-10-22 09:05:49+00:00UTC "NTP: Periodic query of server
ntp.bluecoat.com, system clock is 0 seconds 682 ms fast compared to NTP time. Updated system clock. "
0 90000:1 ../ntp.cpp:631
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Configure Syslog Event Monitoring
Syslog is an event-monitoring protocol that is especially popular in UNIX environments. Sites that use Syslog typically
have a loghost node, which acts as a sink (repository) for several devices on the network. Youmust have a Syslog
daemon operating in your network to use Syslogmonitoring. The Syslog format is Date Time Hostname Event.

Most clients using Syslog havemultiple devices sendingmessages to a single Syslog daemon. This allows viewing a single
chronological event log of all of the devices assigned to the Syslog daemon. An event on one network devicemight
trigger an event on other network devices, which, on occasion, can point out faulty equipment.

If redundancy is necessary for your deployment, configure additional loghost servers for notification. Whenmultiple
loghosts are available, the event logmessage is sent simultaneously to multiple servers, reducing the possibility of data
loss.

To retrieve event logs and view themon an external server, see "Securely Retrieve Event Logs From the Appliance" on
page 605.

Note: When a host is removed from the active Syslog host list, amessage indicating that
Syslog has been deactivated is sent to the host(s). Thismessage alerts administrators that
this host will no longer be receiving logs from this appliance.

Configure Syslog event monitoring:

1. In the Admin Console, select Administration > Logging > Event Logging.

2. Under Syslog Loghosts, select Enable Syslog.

3. To add Syslog loghosts:

a. Select Add Loghost. The console opens an Add Loghost dialog.

b. In the dialog, specify the following settings:

n Protocol: (Version 7.x) Select a transport protocol: UDP, TCP, or TLS.

In version 6.7.x, only UDP is supported.

Note: When configuring Syslogmonitoring, make sure that the protocol is
enabled on the Syslog host server. Use TLS for best security instead of
UDP or TCP.
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n Host: IPv4 or IPv6 address of your loghost server, or specify a domain name that resolves to an
IPv4 or IPv6 address.

n Port: (Version 7.x) Port of the log host. If you do not specify a port number, the appliance uses the
default ports.

If you select TLS, optionally select aDevice Profile.

To edit an entry in the loghosts list, select the Edit icon beside it. In the Edit Loghost dialog that opens, make your
changes and select Update.

To remove an entry from the loghosts list, select the Delete icon beside it.

Note: Event logmessages are automatically sent to all Syslog servers in the loghost
list.

Which Events are Sent to Syslog Servers?
When Syslog is enabled and configured, events whose levels you selected are sent to the Syslog servers.

n Version 7.3.7.x and earlier: The logging level is specified for both email and Syslog. See "Select Events to Log" on
page 595.

n Version 7.3.8.1 and later: Different logging levels are available for email and Syslog. See "ConfigureNotification
Defaults and Overrides" on the next page.
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Configure Notification Defaults and Overrides
In version 7.3.8.1 and later, you can configure different event levels to send via email and Syslog. To exclude certain
events fromnotifications, or to add events that would otherwise not be included in the default selection, you can specify
overrides.

Note: The Admin Console does not validate the SMTP server address or email address
information, so ensure they are correct before saving changes.

Configure notification defaults and overrides:

1. Specify event levels for email and Syslog notifications. The following options are listed underMail and Syslog
sections:

n Enabled State: Enable or disable sending specific event notifications.

Mail also supportsAuto, which preserves the previous behavior (for example, after an upgrade).

n Level: Select event levels for which to send notifications. See "Select Events to Log" on page 595 for details
on levels.

See "Example: Specify Default Notifications and Set Overrides" on the facing page formore information.

2. Specify the notification behavior for certain events. You can reset overrides (set themback to Default) in several
ways.

n Reset overrides for all events:

o Select Clear All Mail Overrides to reset mail overrides for all event IDs.

o Select Clear All Syslog Overrides to reset Syslog overrides for all event IDs.

n Reset overrides for an existing Event ID:

o Under theMail Override or Syslog Override column, select Default.

o Under Actions, select the Clear overrides icon.

See "Example: Specify Default Notifications and Set Overrides" on the facing page formore information.

3. To add an override, select Add Override. On the Add Override dialog, specify the following information:

n Event Id: Enter the ID for events to exclude from the default notification behavior.

n Mail Override: Select Enabled orDisabled, or leave theDefault option to not override the default
behavior.
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n Syslog Override: Select Enabled orDisabled, or leave theDefault option to not override the default
behavior.

You can set eitherMail or Syslog toDefault, but not both.

Example: Specify Default Notifications and Set Overrides
Send email notifications for all severe events while excluding event ID 60020 and including event ID 600f0.

1. In the Admin Console, select Administration > Logging > Event Logging.

2. Make sure that an SMTP server andmail recipients are configured.

3. Enable email notifications for severe errors. Under Default Notifications, select the following options forMail:

n Enabled State: Enabled

n Level: Severe errors only

4. Enablemail notifications for event ID 600f0. Under Overridden Notifications, select Add Override. On the Add
Override dialog, specify the following settings:

n Event Id: 600f0

n Mail Override: Enabled

5. Disablemail notifications for event ID 60020. Under Overridden Notifications, select Add Override. On the Add
Override dialog, specify the following settings:

n Event Id: 60020

n Mail Override: Disabled
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Securely Retrieve Event Logs From the Appliance
As an alternative to sending logs to Syslog servers (see "Configure Syslog Event Monitoring" on page 600), you can
retrieve event log data over a secure connection and save it on an external server.

To transfer event logs over a secure connection, the remote server periodically retrieves the event log data from the
appliance. With this in mind, you should configure event log settings on the appliance to make sure that the retrieved
data reflects all current events.

Ensure that Current Event Log Data is Retrieved
To ensure that you retrieve current event log data, set the event log to overwrite older events. With this setting, the
event log comprises two files, which are rotated when there is log overflow. For example, if themaximum size of 10 MB
is reached and an event needs to bewritten to the log, the two log files are rotated, resulting in the loss of the older 5 MB
file. To prevent data loss, you should configure event log settings so that the older 5 MB log file is retrieved before it is
overwritten.

To determine an appropriatemaximum size, you could consider the rate of event log growth, including factors such as
logging levels and the typical number of events that occur in your environment. In turn, consider both log growth and
the log’smaximum size to determine how often the external server should retrieve log data. For assistance, refer to your
Symantec Support Engineer.

To ensure that current event log data is retrieved:

1. Verify or change the event log’smaximum size. See "Set Event Log Size" on page 595.

2. Specify that the event log should overwrite older events. See "Set Event Log Size" on page 595.

3. Set the frequency with which the external server retrieves event log data. Specify an amount of time that allows
the server to retrieve all data before it is overwritten.

For example, consider an event log that logs all levels above Verbose and grows quickly. To ensure that no data is
lost, you set the log size to a 10 MB maximumand specify that event log data is retrieved every 50 seconds. See
the following example.

Example: Using cURL over HTTPS to Retrieve Event Log Data

Note: This example is not intended to be used for a real-world scenario; it could be
inadequate for your purposes. This example ismeant for demonstration purposes only.

The following is an example of using cURL to retrieve event log data over HTTPS every five seconds.

#!/bin/sh
# This script archives Event Log data into the specified file \
(<archive_filename>).
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# The script will collect new Event Log entries every 5 seconds by default.
# Specify a different time interval if you wish (<refresh-time-in-seconds>).
# You will need to set the username and userpass for your system.

username="admin"
userpass="admin"

if [ "$#" -lt 2 ]; then
echo "usage: archive-eventlog <IP_Address> <archive_filename> \

[refresh-time-in-seconds]"
          exit 1
fi

sg_addr=$1
saved=$2

# Optional refresh time
refresh_time=$3
if [ "${refresh_time}" = "" ]; then

          # Default is for 5 seconds
          refresh_time=5
fi

base_path="/tmp/"
temp_file="${base_path}tmp_eventlog.$$"
temp_file_ok="${base_path}tmp_eventlog_ok.$$"
rm -rf ${temp_file} ${temp_file_ok}

while true; do
        curl https://${sg_addr}:8082/eventlog/fetch=0xffffffff -k --user \
             ${username}:${userpass} > ${temp_file} 2> /dev/null
if [ $? -eq 0 ]; then
     # We successfully got data downloaded
     # Pre-check that the download ends in a "good line" or fix it.
     eof_char=`tail -c 1 ${temp_file} | tr '\n' 'X'`
     if [ "${eof_char}" != "X" ]; then
          # Looks like the last line is incomplete
          # Let's trim away the incomplete line to clean up the data
          # Trimmed lines will be in the next refresh
          sed '$d' ${temp_file} > ${temp_file_ok}
else
          mv ${temp_file} ${temp_file_ok}
fi
if [ -e ${saved} ]; then
# We have previously archived data, so add to it
         last_line=`tail -1 ${saved}`
         # Test the last archived line is in the new content
         grep "${last_line}" ${temp_file_ok} 2>/dev/null 1>&2
 if [ $? -eq 0 ]; then
      # Add the content after the last matching line
      match_line=`echo "${last_line}" | tr / .`
      sed "0,/${match_line}/d" ${temp_file_ok} >> \
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           ${saved} 2> /dev/null
else
       # Nothing matched so add all data just downloaded
       cat ${temp_file_ok} >> ${saved} 2> /dev/null
   fi
else
   # No previously archived data, so add all of the \
       data just downloaded
   cat ${temp_file_ok} > ${saved} 2> /dev/null
   fi
fi

  # Cleanup before resting
  rm -rf ${temp_file} ${temp_file_ok}
  sleep ${refresh_time}
done
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Use SNMP to Monitor Network Devices
n "About SNMP" on the facing page

Use Simple Network Management Protocol (SNMP) to monitor network devices for health or status conditions
that require administrative attention. The appliance supports SNMPv1, SNMPv2c, and SNMPv3.

n "About Management Information Bases (MIBs)" on page 612

AManagement Information Base (MIB) is a text file that contains the description of amanaged object. SNMP uses
a specified set of commands and queries, and theMIBs contain information about these commands and the
target objects.

n "Configure SNMP Service Listeners" on page 613

Create an SNMP management service and add listeners. At least one SNMP listenermust be enabled before using
SNMP to monitor the appliance.

n "Configure General SNMP Settings" on page 614

Configure protocols, traps, and informs for SNMP.

n "About SNMPv1 and SNMPv2" on page 616

Configure SNMPv1 and SNMPv2 community strings.

n "About SNMPv3" on page 619

Configure SNMPv3 users, traps, and optional localized keys.
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About SNMP
Simple Network Management Protocol (SNMP) is used in network management systems to monitor network devices for
health or status conditions that require administrative attention. The appliance supports SNMPv1, SNMPv2c, and
SNMPv3.

Some typical uses of SNMP include:

n Monitoring device uptimes

n Providing information about OS versions

n Collecting interface information

n Measuring network interface throughput

For the appliance to listen for SNMP commands, youmust enable at least one SNMP listener. After you add and enable
an SNMP service, you are ready to configure SNMP communities and users and enable traps and informs. Formore
information, see Configure General SNMP Settings.

Community strings are used for SNMPv1 and SNMPv2c only. SNMPv3 replaces the use of a community string with the
ability to define a set of users. Formore information, see "Configure SNMPv1 and SNMPv2c Communities" on page 617.

Types of SNMP Management
The appliance provides the capability to configure SNMP for single network management systems, amultiple user NMS,
and for notification only.

If you are not using a network manager to interrogate the state of the appliance, configure the appliance to provide
required traps without any SNMP read-write operations. As a result, no ports are defined as listeners for SNMP. If any or
all SNMP listeners in the services are deleted or disabled, you can still configure traps and informs to go out.

Components of an SNMP Managed Network
An SNMPmanaged network consists of the following:

n Managed devices—Network nodes that contain an SNMP agent and reside on amanaged network.

n Agents—Software processes that respond to queries using SNMP to provide status and statistics about a network
node.

n Network Management Systems (NMSs)—Each NMS consists of a combination of hardware and software used to
monitor and administer a network. An NMS executes applications that monitor and control managed devices. You
can have one ormoreNMSs on any managed network. You can select the SNMP versions the appliance supports
to match the configuration of your SNMPmanager, as well as select the ports on which SNMP listens. SNMP traps
and informswork over UDP only; SGOS does not support traps and informs over TCP connections, even if that is
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supported by yourmanagement tool.

You can configure the appliance to work with a sophisticated network environment with NMS users that have
different access requirements for using SNMP than in a single NMS environment. For example, some usersmight
have access to particular network components and not to others because of there areas of responsibility. Some
usersmight have access based on gathering statistics, while others are interested in network operations.

About SNMP Traps and Informs
SNMP agents (software running on a network-connected device) not only listen for queries for data, but also can be
configured to send traps or informs (alert messages) to a network-monitoring device that is configured to receive SNMP
traps. The only difference between a trap and an inform is that the SNMPmanager that receives an inform request
acknowledges themessagewith an SNMP response; no response is sent for regular traps.

SNMP traps work with SNMPv1, SNMPv2c, and SNMPv3. SNMP informswork with SNMPv2c and SNMPv3 only.

You can use the CLI to configure traps to be triggered upon events such things as hardware failures and elevations or
decreases in component thresholds. The following SNMP traps and informs are available:

n coldStart—signifies that the SNMP entity, supporting a notification originator application, is reinitializing itself and
that its configurationmight have been altered. ThisMIB is described in SNMPv2-MIB.txt.

n warmStart—The SNMP entity, supporting a notification originator application, is reinitializing itself such that its
configuration is unaltered. ThisMIB isdescribed in SNMPv2-MIB.txt.

n linkUp—The SNMP entity, acting in an agent role, has detected that the ifOperStatus object for one of its
communication links left the down state and transitioned into some other state (but not into the notPresent
state). This other state is indicated by the included value of ifOperStatus. ThisMIB is described in IF-MIB.txt.

n linkDown—The SNMP entity, acting in an agent role, has detected that the ifOperStatus object for one of its
communication links is about to enter the downstate from someother state (but not from the notPresentstate).
This other state is indicated by the included value of ifOperStatus. ThisMIB is described in IF-MIB.txt.

The following traps require additional configuration:

n Authentication failure traps first must be enabled. See "Configure SNMPv1 and SNMPv2c Communities" on
page 617.

n The attack trap occurs if attack detection is set up. Refer to "Preventing Denial of Service Attacks" in SGOS
Administration documentation.

n The disk/sensor traps are driven by the healthmonitoring settings (as is the healthmonitoring trap). Refer to
"Changing Threshold and Notification Settings" in SGOS Administration documentation.

n The health check trap occurs if it is set up in the health check configuration. See Configure Health Check
Notifications.
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n The policy trap goes off if there is policy to trigger it. Refer to the Visual Policy Manager Reference or the Content
Policy Language Reference. Many of the feature descriptions throughout this guide also include information
about setting policy.
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About Management Information Bases (MIBs)
AManagement Information Base (MIB) is a text file (written in the ASN.1 data description language) that contains the
description of amanaged object. SNMP uses a specified set of commands and queries, and theMIBs contain
information about these commands and the target objects.

One of themany uses forMIBs is to monitor system variables to ensure that the system is performing adequately. For
example, a specific MIB canmonitor variables such as temperatures and voltages for system components and send
traps when something goes above or below a set threshold.

The SymantecMIB specifications adhere to RFC1155 (v1-SMI), RFC1902 (v2-SMI), RFC1903 (v2-TC), and RFC1904 (v2-
CONF.)

Note: Some commonMIB types, such as 64-bit counters, are not supported by SNMPv1.
Use SNMPv2c for better security; use SNMPv3 for best security.

The appliance uses both public MIBs and Symantec proprietary MIBs. You can download theMIB files from the
MyBroadcomportal.

Note: To load the SymantecMIBs on an SNMP network manager, also load the
dependent MIBs. Most commercial SNMP-based products load theseMIBs when the
software starts.

To downloadMIBs, refer to KB151364.

Formore information on specific MIBs, refer to Critical Resource Monitoring of the ProxySG Using SNMP documentation
on Tech Docs.
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Configure SNMP Service Listeners
You can create an SNMP management service and add listeners. At least one SNMP listenermust be enabled before
using SNMP to monitor the appliance.

1. In the Admin Console, select Configuration > Services > Management Services.

2. In Management Services, select an existing SNMP service or add a new one. 

The Edit Management Service page displays service and listener settings.

3. In Listeners:

n To add a listener, select Add Listener.

n To edit a listener, select the existing listener.

The Add/Edit Listener dialog opens.

4. Enter or edit the following settings as needed:

Setting or
field

Description

Enable
Listener

Select to enable or disable the listener.

IP
Address

The client addresses to which the service applies. The most common selection is All, which means the
service applies to requests from any client (IPv4 and IPv6).

You can also restrict this listener to a specific IP address (IPv4 or IPv6) or user subnet (for IPv4) or prefix
length (for IPv6).

Port The port number on which this service listens.

Create or edit asmany listeners as needed.
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Configure General SNMP Settings

To configure general SNMP settings:

1. In the Admin Console, select Administration > SNMP > SNMP.

2. Under General Settings:

n In the Protocols area, SNMPv1, SNMPv2, and SNMPv3 are all enabled by default. Select the specific
versions that match the configuration of your SNMPmanager.

Note: Only SNMPv3 uses the SNMP3 Engine ID, which is required to be
unique among SNMP agents and systems that are expected to work together.

The Engine ID is set by default to a value that is derived from the appliance
serial number and the Symantec SNMP enterprise code. This is a unique
hexadecimal identifier that is associated with the appliance. It appears in each
SNMP packet to identify the source of the packet. The configured bytesmust
not all be equal to zero or to 0FFH (255).

To return the Engine ID to the default value after changing it, select Reset to
Default. You do not have to reboot the system aftermaking configuration
changes to SNMP.

n In the Traps and Informs area, enable traps and informs, as required.

a. Select Enable Traps and Informs to enable SNMP traps (for SNMPv1, SNMPv2c, and SNMPv3) or
informs (for SNMPv2c and SNMPv3).

b. Select Enable SNMP Authentication Failure Traps to have an SNMP authentication failure trap
sent when the SNMP protocol has an authentication failure.

Note: For SNMPv1 and SNMPv2c, this happens when the community
string in the SNMP packet is not correct (does not match one that is
supported). For SNMPv3, this happens when the authentication hash of
an SNMP packet is not correct for the specified user.

c. (If traps and informs are enabled) Select Perform Test Trap to perform a test trap using the
specified settings. Performing the test saves all current settings immediately.
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On the dialog that opens, type the Trap Data (string) to be sent, and select Test. This sends a policy
notification, as defined in the BLUECOAT-SG-POLICY-MIB, to all configured trap and inform
recipients, and it is intended as a communications test.

n In theMIB Variables area, set the following SNMP parameters:

o In the sysContact field, enter a string that identifies the person responsible for administering the
appliance.

o In the sysLocation field, enter a string that describes the physical location of the appliance.
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About SNMPv1 and SNMPv2
SNMPv1 and SNMPv2 use community strings to restrict access to SNMP data. After you define a community string, you
set an authorizationmode of either read or read-write to allow access using that community string. Themode none
allows you to use a community string for traps and informs only.

SNMP Traps for SNMPv1 and SNMPv2c
The appliance can send SNMP traps (for SNMPv1 and SNMP v2c) and informs (for SNMPv2c) to amanagement station
as they occur. Each SNMP notification is sent to all defined trap and inform receivers (of all protocols). You can also
enable authorization traps to send notification of attempts to access the Admin Console.

If the system reboots for any reason, a cold start trap is sent. A warm start trap is sent if a you perform a software-only
reboot without a hardware reset. No configuration is required.

See Also

n "Configure SNMPv1 and SNMPv2c Communities" on the facing page
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Configure SNMPv1 and SNMPv2c Communities
To configure SNMPv1 or SNMPv2c communities:

1. In the Admin Console, select Administration > SNMP > SNMP.

2. Under V1 and V2c Communities:

o To add a community, select Add Community.

o To edit an existing community, select it in the list.

The browser opens the Add/Edit Community page.

3. Under Properties, specify the following settings:

Setting or field Description

Community String Name for the string.

Authorization Authorization level:None, Read-only, or
Read-write.

4. Under Access Control, select Enforce Access Control For Requests to configure an access control list.

Note: An ACL is not applicable if you selectedNone for Authorization.

a. Select Add ACL Entry to add an entry or select an existing one to edit it.

b. Enter the Source Address and Prefix Length.

c. Select Apply to save the ACL entry.

Select Discard to delete an ACL entry.

5. Under V1 and V2c Traps and Informs, select Add Trap or Inform Receiver or select Edit beside an existing
receiver. The console opens an Add/Edit Trap or InformReceiver dialog.

6. On the Add/Edit Trap or InformReceiver dialog, specify the following settings:
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Setting or field Description

Type Specify a trap or an inform: SNMPv1 Trap,
SNMPv2c Trap, or SNMPv2c Inform.

The SNMPmanager that receives an inform
request acknowledges the message with an
SNMP response. The SNMPmanager does
not send a response for traps.

IP Address IP address for the trap or inform receiver.

Port Port for the trap or inform receiver.
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About SNMPv3
For SNMPv3, you configure users instead of community strings. You then configure the traps and informs by user rather
than by community string.

Configure SNMP Users for SNMPv3
When you set up users, you configure authentication and privacy settings, as required.

The enhanced security of SNMPv3 is based on each user having an authentication passphrase and a privacy passphrase.
For environments in which there are increased security concerns, you have the option of setting up localized keys
instead of passphrases.

You can enable authentication without enabling privacy, however, you cannot enable privacy without enabling
authentication. In an authentication-only scenario, a secure hash is done so the protocol can validate the integrity of the
packet. Privacy adds the encryption of the packet data.

About Passphrases and Localized Keys
Although it is optional to use passphrases or localized keys, using either provides the increased security of SNMPv3. For
most deployments, passphrases provide adequate security. For environments in which there are increased security
concerns, you have the option of setting localized keys instead of passphrases. In the configuration, if you set a
passphrase, any localized keys are immediately deleted and only the passphrase remains. If you set a localized key, any
passphrase is deleted and the localized key is used.

If you need to use localized keys, you can enter one for the appliance and add keys for other specified Engine IDs. Since
the appliance acts as an agent, its localized key is all that is needed to conduct all SNMP communications, with the single
exception of SNMP informs. For informs, you need to provide the localized key that corresponds to each engine ID that
is going to receive your informs.

Configure SNMP Traps and Informs for SNMPv3
Before you can configure SNMPv3 traps and informs, youmust set up users and their associated access control settings.
The difference between a trap and an inform is that the SNMPmanager that receives an inform request acknowledges
themessagewith an SNMP response; no response is sent for regular traps.

See Also

n "Configure SNMPv3 Users, Localized Keys, and Traps" on the next page
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Configure SNMPv3 Users, Localized Keys, and Traps
To configure SNMPv3 users:

1. In the Admin Console, select Administration > SNMP > SNMP.

2. Under V3 Users:

o To add a community, select Add User.

o To edit an existing user, select it in the list.

The browser opens the Add/Edit User page.

3. Under Properties, specify the following settings:

Setting or field Description

Username Enter a name for the user.

Authentication Select an authenticationmode:None,MD5,
or SHA.

If you select MD5 or SHA, you can select
Change Passphrase to specify a
passphrase. Alternatively, set up localized
keys for authentication in the next step.

Privacy (Available only if an authenticationmode is
selected) Select a privacy mode: None,
AES, or DES.

If you select AES or DES, you can select
Change Passphrase to specify a
passphrase. Alternatively, set up localized
keys for privacy in the next step.

Authorization Select an authorization level:None, Read-
only, or Read-write.

4. (If Authenticationmode or Privacymodewas selected; optional) Instead of passphrases, you can use localized
keys for authentication and privacy.

Under Localized Keys, select Add Localized Key and select Authentication or Privacy. To edit an existing key,
select it in the list. The console opens an Add/Edit Localized Authentication/Privacy Key dialog.
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Note: If you create a localized key, any existing passphrase is deleted from the
system and the key is used instead.

Setting or field Description

Engine ID If Self is selected, the automatically
generated engine is used. Otherwise, enter a
hexadecimal string with an even number of
digits, up to 64 digits.

New Localized Key

Confirm Localized Key

Enter and confirm a localized key.

5. Under V3 Traps and Informs, select Add Trap or Inform Receiver or select an existing receiver to edit. The
console opens an Add/Edit Trap or InformReceiver dialog.

6. In the dialog, specify the following settings:

Setting or field Description

Type Select SNMPv3 Trap or SNMPv3 Inform.

IP Address IP address for the trap or inform receiver.

Port Port for the trap or inform receiver.
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Verify Service Health and Status
Refer to the following to learn about appliance health checks:

n "Overview of Health Checks" on the facing page

Enable access logging globally or for specified logs. Associate logs with upload clients and configure log formats.
Specify whether to upload a log periodically or continuously, and configure settings such as log file limits and early
upload.

n "Configure Health Monitoring" on page 645

Configure thresholds and notifications for general metrics and licensingmetrics. Configure notifications for status
metrics and subscriptionmetrics.
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Overview of Health Checks
The Edge SWG (ProxySG) appliance performs health checks to test for network connectivity and to determine the
responsiveness of external resources. Examples of external resources include: DNS servers, forwarding hosts, SOCKS
gateways, authentication servers, and ICAP services (for example, anti-virus scanning services).

System-defined health checks are based on:

n Forwarding configuration

n SOCKS gateways configuration

n DNS server configuration

n ICAP service configuration

n Authentication realm configuration

n WhetherWebPulse is enabled

You also can create user-defined health checks, including a composite health check that combines the results of multiple
other health check tests. For information on health check types, see "About Health Check Components" on the next
page.

Health checks fall into three broad categories:

n Determining if the IP address can be reached. Health check types that fall into this category are:

o Forwarding hosts

o SOCKS gateways

o User-defined host health checks

n Determining if a service is responsive. Health check types that fall into this category are:

o Authentication servers

o DNS server

o WebPulse service

o ICAP services

n Determining if a group is healthy. Group tests are compilations of individual health checks, and the health of the
group is determined by the status of the groupmembers. Health check types that fall into this category are:

o Forwarding groups

o SOCKS gateway groups
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o ICAP service groups

o User-defined composite health checks

Information provided by health checks allows you to accomplish the following:

n Detect potential network issues before they become critical. For example, if the health check for an individual
host fails, the appliance sends an alert (using e-mail, SNMP, or by writing to an event log) to the designated
recipients, if configured.

n Track response times and report failures. For example, if the DNS server performance suffers a reduction, the
users experience response time delays. TheDNS health check records the average response time (in milliseconds)
and allows you to interpret the reason for the performance reduction. Should theDNS server become
unavailable, the failed health check triggers an alert.

Furthermore, the appliance uses health check information to accomplish the following:

n When combined with failover configurations, health checks redirect traffic when a device or service failure occurs.
For example, a health check detects an unhealthy server and a forwarding rule redirects traffic to a healthy server
or proxy.

n Monitor the impact of health check states on the overall health of the appliance.

About Health Check Components
Health checks have two components:

n Health check type, which is the kind of device or service the specific health check tests. The following types are
supported:

o Forwarding host and forwarding group

o SOCKS gateway and SOCKS gateway group

o DNS servers

o External Authentication servers

o ICAP service and ICAP service group

o Dynamic Real-Time Rating Service

o User-defined host and composite health checks

See "Health Check Types" on the facing page formore information.

n Health check test, which is themethod of determining network connectivity, target responsiveness, and basic
functionality:
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o Health checks (external targets):

l Authentication

l ICMP

l DNS

l TCP

l SSL

l HTTP

l HTTPS

l ICAP

l WebPulse

o Health checks (group targets):

l Groups

l Composite

Note: Somehealth checks (such as forwarding hosts and SOCKS gateways) can
be configured to report the result of a composite health check instead of their
own test.

Some health check types only have onematching test, while others have a selection. Formore information about
health check types and tests, see "Health Check Tests" on the next page.

Health Check Types
Most health checks are automatically created and deleted when the underlying entity being checked is created or
deleted. When a forwarding host is created, for example, a health check for that host is created. Later, if the forwarding
host is deleted, the health check for it is deleted as well. User interaction is not required, except to change or customize
the health check behavior if necessary. However, if a health-check is referenced in policy, you cannot delete the
corresponding host or the health check itself until the reference in policy is deleted. In addition to the automatically
generated health checks generated, run, and deleted, Symantec also supports two types of user-defined health checks.
These health checks aremanually created, configured, and deleted.

n Composite health checks: Amethod to take the results from a set of health checks (automatically generated or
user-defined health checks) and combine the results.

n Host health checks: Amethod to test a server, using a selection of ICMP, TCP, SSL, HTTP, and HTTPS tests.
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Note: Although a host health check tests an upstream server, it can also be used to test
whether a proxy is working correctly. To test HTTP/HTTPS proxy behavior, for example,
you can set up a host beyond the proxy, and then use forwarding rules so the health check
passes through the proxy to the host, allowing the proxy to be tested.

User-defined health checks allow you to test for attributes that the appliance does not test automatically. For example,
for a forwarding host, you could perform three user-defined tests— an HTTP test, an HTTPS test, and a TCP test of other
ports. Then, you can set up a composite health check that combines the results of these user-defined tests to represent
the health of the forwarding host. The appliance reports the status of the (user-defined) composite health check as the
forwarding host's health, instead of the default forwarding host health check. All health check types are given
standardized names, based on the name of the target. For example:

n Forwarding hosts and groups have a prefix of fwd

n DNS servers have a prefix of dns

n SOCKS gateways and gateway groups have a prefix of socks

n Authentication realms have a prefix of auth

n Content Analysis services have prefixes of icap

n User-defined or composite health checks have a prefix of user

Health Check Tests
Based on the health check type, the appliance periodically tests the health status, and thus the availability of the host.
You can configure the time interval between tests. If the health check test is successful, the appliance considers the host
available. The health check tests are described in the table below.

Health check
test

Description
Used with
health check
type

Response
Times

The minimum, maximum, and average response times are tracked, with their values being
cleared whenever the health check changes state.

All

ICMP Test
(Layer 3)

The basic connection between the appliance and the origin server is confirmed. The server
must recognize ICMP echoing, and any intervening networking equipment must support ICMP.
The appliance sends a ping (three ICMP echo requests) to the host. ICMP tests do not support
policy for SOCKS gateways or forwarding.

Forwarding
hosts, SOCKS
gateways, or
user-defined
hosts
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Health check
test

Description
Used with
health check
type

TCP Socket
Connection
Test (Layer 4)

A TCP test establishes that a TCP layer connection can be established to a port on the host.
Then the connection is dropped. TCP tests for a SOCKS gateway do not support policy for
SOCKS gateways or forwarding. TCP tests for a forwarding host or a userdefined health check
support SOCKS gateways policy but not forwarding policy.

Forwarding
hosts, SOCKS
gateways, or
user-defined
hosts

SSL Test A connection is made to a target and the full SSL handshake is conducted. Then, much like the
TCP test, the connection is dropped. For a forwarding host, a terminating HTTPS port must be
defined or the test fails. SSL tests for a forwarding host or a userdefined health check support
SOCKS gateways policy. The SSL tests do not support forwarding policy. An SSL test executes
the SSL layer in policy and obeys any settings that apply to server-side certificates, overriding
any settings obtained from a forwarding host.

Forwarding
hosts or user-
defined hosts

HTTP/HTTPS
Tests for
Servers and
Proxies

HTTP/HTTPS tests execute differently depending on whether the upstream target is a server
or a proxy. For a forwarding host, the server or a proxy is defined as part of the forwarding
host configuration. For a userdefined health check, the target is always assumed to be a
server.

For a server:

The HTTP test sends an HTTP GET request containing only the URL path to an HTTP port.

n The HTTPS test sends an HTTPS GET request containing only the URL path over an SSL
connection to a terminating HTTPS port.

If an appropriate port is not available on the target, the test fails.

For a proxy:

n The HTTP test sends an HTTP GET request containing the full URL to an HTTP port.

n Since a server is required to terminate HTTPS, the HTTPS test sends an HTTP
CONNECT request to the HTTP port.

If an appropriate HTTP port is not available on the proxy, either test fails. An HTTP/HTTPS test
requires a full URL for configuration. The HTTP/HTTPS tests for a forwarding host support
SOCKS gateway policy but not forwarding policy. The HTTP/HTTPS tests for a user-defined
health check support SOCKS gateway and forwarding policy. An HTTPS test executes the SSL
layer in policy and obeys any settings that apply to server-side certificates, overriding any
settings obtained from a forwarding host.

Forwarding
hosts or user-
defined hosts

HTTP/HTTPS
Authentication

For HTTP/HTTPS tests, you can test authentication using a configured username and
password. The passwords are stored securely in the registry.

Forwarding
hosts or user-
defined hosts

HTTP/HTTPS
Allowed
Responses

For an HTTP or HTTPS test, this is the set of HTTP response codes that indicate success. The
default is to accept only a 200 response as successful. You can specify the sets of response
codes to be considered successful.

Forwarding
hosts or user-
defined hosts
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Health check
test

Description
Used with
health check
type

Content
Analysis Tests

The tests for Content Analysis are specialized tests devised for each particular kind of Content
Analysis service. The health check system conducts by sending requests to the configured
services, which reports back a health check result.

ICAP,
WebPulse
services

Group Individual tests that are combined for any of the four different available groups (forwarding,
SOCKS gateways, and ICAP services). If any of the members is healthy, then the group as a
whole is considered healthy.

These settings are configurable. By default, group health tests are used for two purposes:

n Monitoring and notification

n Policy

Forwarding
groups,
SOCKS
gateways
groups, and
ICAP external
service
groups

DNS Server The DNS server maps the hostname, default is www.bluecoat.com, to an IP address. The
health check is successful if the hostname can be resolved to an IP address by the DNS server.

DNS

Authentication Authentication health checks assess the realm’s health using data maintained by the realm
during active use. Authentication health checks do not probe the authentication server with an
authentication request.

Authentication
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Background DNS Resolution Tests
To keep the list of IP addresses associated with a hostname current, the appliance tests DNS resolution for all resolvable
hostnames used in the health check system, including forwarding hosts, WebPulse, and SOCKS gateways. TheDNS
system is checked whenever the time-to-live (TTL) value of theDNS entry expires.

Note: If a hostname consists of a dotted IP address, no DNS resolution is performed.

When a host is resolved by DNS tomultiple IP addresses, health checks keep those addresses current through
background updates. You can specify the timing for the updates. After the test or tests are conducted for each IP
address, the results are combined. If the result for any of the resolved IP addresses is healthy, then the host is
considered healthy because a healthy connection to that target can bemade.

To specify the intervals for background DNS testing:

1. In the Admin Console, select Administration > Health Checks > Health Checks.

2. In the Background DNS section, specify the following settings as needed:

Setting or field Description

Minimum time to
live for DNS results

Cannot be zero (0). Test results are valid for this length of time. Retests can occur any time after
this value.

Maximum time to
live for DNS results

(Optional) How long the DNS test results remain valid before a retest is required.

Interval to wait
after DNS
resolution error

If the background DNS test discovers errors, this value specifies how long to wait before
retesting. If a specific error repeatedly displays in the event logs, further network
troubleshooting is required.
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Default Health Check Settings
You can edit health check intervals, severity, thresholds, and notifications for automatically generated health checks in
two ways:

n Setting the global defaults. These settings affect all health checks, unless overridden by explicit settings. See
"Override Health Check Default Settings" on page 632 for the steps to override settings per health check.

n Setting explicit values on each health check.

The default health check values are:

n Ten seconds for healthy and sick intervals (an interval is the period between the completion of one health check
and the start of the next health check).

n One for healthy and sick thresholds. A healthy threshold is the number of successful health checks before an
entry is considered healthy; a sick threshold is the number of unsuccessful health checks before an entry is
considered sick.

n Warning for the severity notification, which governs the effect that a health check has on the overall health status
of the appliance.

n Disabled for logging health check status using e-mails, event logs, or SNMP traps.

Note: All health checks are initially configured to use global defaults. The only exception is
the DRTR service, which has the healthy interval set to 10800 seconds (3 hours), and the
failure trigger set to 1.

Change Default Health Check Settings
To change default health check settings:

1. In the Admin Console, select Administration > Health Checks > Health Checks.

2. InDefault Settings, specify the following settings as needed:

Setting or
field

Description

Healthy
Interval

Interval, in seconds, between health checks to a service that was determined to be healthy. The default is
10. The healthy interval can be between 1 second and 31536000 seconds (about one year).

Healthy
Threshold

Threshold for the number of successful health checks before an entry is considered healthy. The threshold
can be between 1 and 65535. The default is 1.
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Setting or
field

Description

Sick
Interval

Interval, in seconds, between health checks to a service that was determined to be unhealthy or out of
service. The default is 10. The sick interval can be between 1 second and 31536000 seconds (about 1 year).

Sick
Threshold

Threshold for the number of failed health checks before an entry is considered unhealthy. The threshold
can be between 1 and 65535. The default is 1.

Failure
trigger
threshold

(Disabled by default) If enabled, the threshold for the number of failed connections to the server before a
health check is triggered. Valid values can be between 1 and 2147483647.

The failures are reported back to the health check as a result of either a connection failure or a response
error. The number of these external failures is cleared every time a health check is completed. If the
number of failures meets or exceeds the threshold and the health check is idle, the health of the device or
service is immediately checked.

Response
time
threshold

(Disabled by default) Specify the maximum response time threshold, in milliseconds. The threshold time can
be between 1 and 65535.

Explicit health settings override the global defaults. To override the default settings for a health check, see "Override
Health Check Default Settings" on the next page.

To execute a health check immediately, see "Execute an Instant Health Check" on page 643.
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Override Health Check Default Settings
You can enable or disable health checks and configure them to report as healthy or unhealthy during the time they are
disabled.

Setting a health check as disabled but reporting healthy allows the appliance to use the device or servicewithout
performing health checks on it. If, for example, you have configured a forwarding host on the appliance, a health check
for the forwarding host is automatically created. If you then configure the health check as disabled reporting healthy,
the appliance considers the forwarding host as healthy without performing periodic health checks on it.

If the case of a group health check that is disabled but reporting healthy, all members of the group are treated as healthy
regardless of the status of themembers’ individual health check result.

Note: Individual health checks formembers of a group remain active; they can be used
apart from the group.

Setting a health check as disabled but reporting sick is useful to remove an upstreamdevice for servicing, testing, or
replacement. This setting takes the device offline after it completes processing pre-existing traffic. Then the device can
be safely disconnected from the network without altering any other configuration. You cannot enable or disable all
health checks at once.

See Also:

n "Override Default Notification Settings" on page 637

User-Defined Health Checks
You canmanually create andmanage ICMP, TCP, HTTP, HTTPS, or SSL health check tests for any upstream TCP/IP device.
You can use these user-defined health check types to send notifications of health check state changes.

Undermost circumstances, you do not need to create user-defined health checks because the automatically generated
health checksmeet most needs. However, to check for things that Symantec does not test for automatically—for
example, the health of the Internet or of the router, youmight create user-defined heath checks.

If, for example, you want to control Web traffic based on the apparent health of the Internet, you can create a user-
defined health check to target known Internet sites. As long as a certain number of the sites are healthy, you can
consider the Internet as healthy.

Further, you can use policy to configure forwarding rules on the appliance. Subsequently, if the user-defined health
check determining internet accessibility transitions to unhealthy, all requests directed to the appliancewill be forwarded
to the alternate appliance until the primary appliance transitions to healthy again.

The appliance supports two types of user-defined health checks:
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n Host: This health check type is for any upstream TCP/IP device. You can't create user-defined health checks for
external service tests, such as authentication servers, ICAP, and theWebPulse service. See "Configure Health
Check Settings" below.

n Composite: This health check type combines the results of other existing health checks. It can include other
composite health checks, health checks for user-defined hosts, and any automatically generated health checks.
See "Composite Health Checks" on page 640.

For information about configuring parameter and notification settings for automatically generated health check types,
see "Default Health Check Settings" on page 630.

Configure Health Check Settings
You can configure settings for user-defined health checks and system-defined health checks. Some settings are available
depending on the health check type. See "Health Check Tests" on page 626 formore information.

To configure health check settings:

1. In the Admin Console, select Administration > Health Checks > Health Checks.

2. In theHealth Checks List:

n Select Add > Add Health Checks to add a new health check.

n Select an existing health check to edit it.

3. On the Add/Edit Health Check page, inUser Defined Host Health Check, enter or edit the following as needed:

Health check type Setting or
field

Description

All

Available when
creating a user-
defined health
check

Service Name Unique name for the health check.
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Health check type Setting or
field

Description

N/A

Available when
creating a user-
defined health
check

Type of Test Select the type of test:

n HTTP

n HTTPS

n ICMP

n SSL

n TCP

See "Health Check Types" on page 625 for more information on these types.

All Enable Health
Check

Select the enabled or disabled behavior:

n Enabled: Enable the health check and report changes in the health state.

n Disabled: Healthy: Disable the health check and always report the
service as healthy.

n Disabled: Unhealthy: Disable the health check and always report the
service as unhealthy.

HTTP/HTTPS URL URL of the target.

Enable basic
authentication

(For Basic user authentication) Select and enter the username and password of
the target.

Enable basic
proxy
authentication

(For Basic proxy authentication when intermediate proxies exist between
appliance and the target) Select and enter the username and password of the
target.

Allowed
Response
Codes

List of HTTP/HTTPS response codes that are considered successes, separated by
semi-colons. If one of them is received by the health check, the health check
considers the HTTP(S) test to have been successful.

Note: The 200 response code is added by default.

ICMP Host Hostname of the target. The hostname can be an IPv4 or IPv6 host or address.

SSL Host Hostname of the target. The hostname can be an IPv4 or IPv6 host or address.

Port Port to use for the target.

TCP Host Hostname of the target. The hostname can be an IPv4 or IPv6 host or address.

Port Port to use for the target.
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4. Specify whether to keep the default settings or to override them. The Settings section shows the current interval
and threshold settings for this health check. By default, new health check settings are all set toDefault. For
descriptions of the default settings, see "Default Health Check Settings" on page 630

n To override a default setting:

a. Select Default and change it toOverride.

b. (Applicable to theFailure trigger thresholdand Response time threshold options, which are
disabled by default) select the threshold toggle.

c. Enter a new value in the field.

n To revert an overridden setting to the default, select Overrideand change it toDefault. (If applicable, the
Default option shows the default value; for example,Default (10) indicates that the default setting is 10
seconds.)

Override Default Notification Settings
See "Override Default Notification Settings" on page 637.

See Also:

n "Overview of Health Checks" on page 623

n "Override Health Check Default Settings" on page 632

n "Composite Health Checks" on page 640
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Configure Health Check Notifications
The appliance allows you to configure notifications that alert you to changes in health status and to emerging issues. By
default, notifications for health check events and status are disabled.

You can set up health check notifications globally and per individual health check. Explicit health settings override the
global defaults.

To configure health check notifications globally:

1. Select Administration > Health Checks > Health Checks.

2. InDefault Notifications, select the Severity level for the health check:

n No effect: The health check has no impact on the overall health of the device.

n Warning: If the health check fails, the device needs to bemonitored and the health check status displays
asWarning. This is the default setting.

n Critical: If the health check fails, the device is in critical condition

3. Select the options to enable notifications:
Notification
type

Setting Description

Email and
SNMP

Notify on a
transition to
healthy

Send a notification when the health check changes from any state to a healthy state.

Email and
SNMP

Notify on a
transition to
sick

Send a notification when the health check changes from any state to a sick state.

Event log Log a
transition to
healthy as

Log the event when the health check changes from any state to a healthy state with the
selected severity level (Informational or Severe).

Log a
transition to
sick as

Log the event when the health check changes from any state to a sick state with the
selected severity level (Informational or Severe).
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Notification
type

Setting Description

Email, event
log, and
SNMP

Notify/log for
each IP
address

Notify/log any change in health state for each IP address within the health check.

For example, if you create a health check “user.google” with the URL “google.com”, the
appliance checks the health for each IP address that the Google URL/domain resolves
to.

Note that these checks are internal and not visible in the console.

If any one of these internal health checks is healthy, the overall “user.google” health
check is healthy.

Tip: To specify recipients for email notifications, see "Configure Email Notifications" on
page 596. For event logging, messages can be logged as either informational or severe.

Override Default Notification Settings
All notification settings are set to defaults in a new health check:
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For each notification setting, use the toggle to select Override; theDefault (value) setting indicates the default
behavior. For example, by default, notification is emailed upon transition to healthy:
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When a setting is overridden, you can specify the behavior. For example, override the global email notification setting
and do not notify on a transition to healthy:

To override notification settings for the health check:

1. Select Administration > Health Checks > Health Checks.

2. InHealth Checks:

n Select Add > Add Health Checks to add a new user-defined health check.

n Select Add > Add Composite Health Checks to add a new composite health check.

n Select an existing health check or composite health check to edit it.

3. On the Add/Edit Health Check page, inNotifications:

n To override a default setting, select Override. TheDefault option shows the default behavior, such
as "Default (On)".

n To revert a notification setting that was overridden, select Default.

For descriptions of the notification settings, see steps 2 and 3 in "Configure Health Check Notifications" on page 636.
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Composite Health Checks
You can create a composite health check to combine the results of multiple health checks. A composite health check can
contain any number of individual health checks. Further, forwarding host and SOCKS gateway health checks can be
configured to use the result of a composite health check.

By default, to report healthy, all members of a composite health check must be healthy. However, you can configure the
number of members that must be healthy for the composite result to report healthy.

Composite health checks with nomembers always appear unhealthy.

Tip: User-defined composite health checks are not the same as automatically generated
group tests. Group tests are automatically generated and can't be deleted. Some editing is
permitted, but you cannot add or removemembers of the group through the health
checksmodule. Youmust modify the forwarding or SOCKS gateways groups to update the
automatically generated group tests. For a group test, the default is for the group to be
healthy if any member is healthy. For a composite test, the default is for the group to be
healthy if all members are healthy. (The default is configurable.)

Configure Composite Health Check Settings
To configure a composite health check:

1. In the Admin Console, select Administration > Health Checks > Health Checks.

2. InHealth Checks:

n Select Add > Add Composite Health Checks to add a new composite health check.

n Select an existing composite health check to edit it.
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3. On the Add/Edit Composite Health Check page, in Properties, enter or edit the following as needed:

Setting or field Description

Name (Available when creating a composite health check) Unique name for the health check. The
name is automatically prepended with "user."

Enable Health Check Select the enabled or disabled behavior:

n Enabled: Enable the health check and report changes in the health state.

n Disabled: Healthy: Disable the health check and always report the service as healthy.

n Disabled: Unhealthy: Disable the health check and always report the service as
unhealthy.

This health check is
healthy when

Select whether any, all, or specific members must be healthy for the composite health check
to be healthy.

To add or remove services, see "Modify Composite Health Check Membership" below.

Modify Composite Health Check Membership
Tomodify composite health check membership:

1. In the Admin Console, select Administration > Health Checks > Health Checks.

2. InHealth Checks:

n Select Add > Add Composite Health Checks to add a new composite health check.

n Select an existing composite health check to edit it.

3. On the Add/Edit Composite Health Check page, in Selected Health Checks:

n To addmembers, select Select Health Checks. In the Select Health Check Members dialog, select services
to add to the composite health check and confirm your action. The services appear in the Selected
Members list.

n To removemembers, select Remove for the services to remove.

Alternatively, select Select Health Checks. In the Select Health Check Members dialog, clear services to
remove them from the composite health check and confirm your action. The services are removed from
the SelectedMembers list.

Override Default Notification Settings
See "Override Default Notification Settings" on page 637.
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See Also:

n "Overview of Health Checks" on page 623

n "Override Health Check Default Settings" on page 632
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Verify Health Check Settings
You can verify settings of the health checks configured on the appliance. In the Admin Console, select Administration >
Health Checks > Health Checks. TheHealth Checks List shows all configured health checks.

Setting or
field

Description

Enable The enabled or disabled state of the health check.

Name Unique name of the health check.

State State of the service. See "Enabled Health Check States" below.

Type Health check type:

n Composite: User-defined composite health check.

n User defined host: User-defined health check.

n (If the services are defined on the appliance) System-defined health checks including Authentication,
DNS Server, ICAP.

See "Health Check Types" on page 625 for information.

Test Health check test. See "Health Check Tests" on page 626 for information.

Settings Whether notification settings for intervals and thresholds are the system default or overridden. See "Default
Health Check Settings" on page 630.

Notifications Whether notificationmethods are the system default or overridden. See "Configure Health Check Notifications"
on page 636.

Execute an Instant Health Check
Although the appliance automatically executes health checks, you can perform an instant health check. In the Admin
Console, select Administration > Health Checks > Health Checks. In theHealth Checks, select Perform health
check for the health check. Composite health checks with a large number of members can take longer to complete.

Enabled Health Check States
If a health check is enabled, the Admin Console displays the health check state (select Administration > Health
Checks > Health Checks). Refer to the following:
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State Description
Health

Target device or service is healthy, or all selectedmembers in the composite health
check are healthy.

Healthy

Health has not yet been tested successfully. Healthy

Some selectedmembers in the composite health check are healthy.

Not applicable to health checks that require all members be healthy for a healthy state.

Healthy

Device or service can't be used, or all selectedmembers in the composite health check
are unhealthy.

Unhealthy

See Also:

n "Override Health Check Default Settings" on page 632
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Configure Health Monitoring
The healthmonitor records the aggregate health of the appliance, by tracking status information and statistics for select
resources, and aids in focusing attention when a change in health state occurs. On the appliance, the healthmonitor
tracks the status of key hardware components (such as the thermal sensors, and CPU use), and the health status for
configured services (such as ADN). When the healthmonitor detects deviations in the normal operating conditions of
the device, the health status changes.

Note: The Admin Console banner displays any health statusmessages.

A change in health status does not always indicate a problem that requires corrective action; it indicates that a
monitoredmetric has deviated from the normal operating parameters. The healthmonitor aids in focusing attention to
the possible cause(s) for the change in health status. The following example shows a licensing error. Click Show Details
formore information; in this example, the Admin Console displays the Licensing pages.

About Health Monitoring
Health Monitoring allows you to set notification thresholds on various internalmetrics that track the health of a
monitored systemor device. Eachmetric has a value and a state. The value is obtained by periodically measuring the
monitored systemor device. In some cases, the value is a percentage or a temperaturemeasurement; in other cases, it is
a status such as Disk Present or Awaiting Approval.

The state indicates the condition of themonitored systemor device:

n OK: Themonitored systemor device is behaving within normal operating parameters.

n WARNING: Themonitored systemor device is outside typical operating parameters andmay require attention.

n CRITICAL: Themonitored systemor device is failing, or is far outside normal parameters, and requires immediate
attention.

The current state of ametric is determined by the relationship between the value and itsmonitoring thresholds. The
Warning and Critical states have thresholds, and each threshold has a corresponding interval.

All metrics begin in theOK state. If the value crosses theWarning threshold and remains there for the threshold's
specified interval, themetric transitions to theWarning state. Similarly, if the Critical threshold is exceeded for the
specified interval, themetric transitions to the Critical state. Later (for example, if the problem is resolved), the value
drops back down below theWarning threshold. If the value stays below theWarning threshold longer than the specified
interval, the state returns to OK.
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Every time the state changes, a notification occurs. If the value fluctuates above and below a threshold, no state change
occurs until the value stays above or below the threshold for the specified interval of time.

This behavior helps to ensure that unwarranted notifications are avoided when values vary widely without having any
definite trend. You can experiment with the thresholds and intervals until you are comfortable with the sensitivity of the
notification settings.

Health Monitoring Example
The following example provides an example of healthmonitoring. The graph is divided into horizontal bands associated
with each of the three possible states. The lower horizontal line represents theWarning threshold and the upper
horizontal line is the Critical threshold. The vertical bands represent five-second time intervals.

Assume both thresholds have intervals of 20 seconds, and that themetric is currently in theOK state.
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1. At time 0, themonitored value crosses theWarning threshold. No transition occurs yet. Later, at time 10, it
crosses the critical threshold. Still, no state change occurs, because the threshold interval has not elapsed.

2. At time 20, the value has been above thewarning threshold for 20 seconds--the specified interval. The state of
themetric now changes to Warning, and a notification is sent. Note that even though themetric is currently in the
critical range, the State is still Warning, because the value has not exceeded the Critical threshold long enough to
trigger a transition to Critical.

3. At time 25, the value drops below the Critical threshold, having been above it for only 15 seconds. The state
remains at Warning.

4. At time 30, it drops below theWarning threshold. Again the state does not change. If the value remains below the
warning threshold until time 50, then the statewill change to OK.

5. At time 50, the state transitions to OK. This transition occurs because themonitored value has remained below
theWarning threshold for the configured interval of 20 seconds.

Health Monitoring Cycle
The healthmonitoring process is a cycle that begins with the health state at OK. When the healthmonitor detects a
change in the value of amonitoredmetric, the health state changes.

Note: A change in health status does not always indicate a problem that requires
corrective action; it indicates that amonitoredmetric has deviated from the normal
operating parameters.

To facilitate prompt attention for a change in the health state, you can configure notifications on the appliance.

Planning Considerations
The healthmonitor indicates whether the appliance is operating within the default parameters set on the appliance.
Review these settings and adjust them to reflect the normal operating parameters for your environment. You can
configure:

n Thresholds, to definewhat measurements generatewarnings or critical alerts. See "Change Threshold and
Notification Settings" on page 659.

n Time intervals, that determinewhether a threshold has been crossed and whether an alert should be sent. See
"Change Threshold and Notification Settings" on page 659.

n Themeans by which alerts are delivered, any combination of e-mail, SNMP trap, event log, or none.
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About Health Monitoring Metric Types
The appliancemonitors the status of the followingmetrics:

Note: Unless otherwise specified, thresholds are configurable, meaning that you can
specify the threshold levels that trigger an alert.

Hardware components such as Disk, Voltage, Temperature, Fan, Sensor Count Status. Thesemetrics are not configurable
and are preset to optimal values. For example, on someplatforms, aWarning is triggered when the CPU temperature
reaches 55 degrees Celsius.

n System resources such as CPU Utilization, Memory Utilization, and interfaces

n ADN status. Thesemetrics are preset to optimal values. They are not configurable.

n Expiration and utilizationmetrics for various licenses

n Cloud Services communication status

n ICAP connections

n Health checks. Thismetric is not configurable. This takes into account themost acute value amongst the
configured health checks and the severity component for each health check. See "Additional Information on
Health Checks" below.

n Expiration and download statuses of subscribed services

These healthmonitoringmetrics are grouped in the Admin Console into General, Licensing, and Status, and Subscription
metrics.

Additional Information on Health Checks
Severity of a health check indicates how the value of a failed health check affects the overall health of the appliance, as
indicated by the healthmonitor.

If, for example, three health checks are configured on the appliance:

n dns.192.0.2.4 with severity No-effect

n fwd.test with severity Warning

n auth.service with severity Critical

The value of the health check statusmetric adjusts in accordancewith the success or failure of each health check and its
configured severity as shown below:
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n If all three health checks report healthy, the health check statusmetric is OK.

n If dns.192.0.2.4 reports unhealthy, the health check status remains OK. The health check statusmetric does not
change because its severity is set to no-effect.

n If fwd.test reports unhealthy, the health check status transitions to Warning. This transition occurs because the
severity for this health check is set to warning.

n If auth.service reports unhealthy, the health check status becomes Critical because its severity is set to critical.
Subsequently, even if fwd.test reports healthy, the health check status remains critical as auth.service reports
unhealthy. The health check status transitions to OK only if both fwd.test and auth.service report healthy.

Configured Health Checks Reporting as...

dns.192.0.2.4 with severity No-effect Healthy Unhealthy Unhealthy Healthy Healthy Healthy Healthy

fwd.test with severity Warning Healthy Healthy Unhealthy Unhealthy Unhealthy Healthy Healthy

auth.service with severity Critical Healthy Healthy Healthy Healthy Unhealthy Unhealthy Healthy

Health Check Status OK OK Warning Warning Critical Critical OK

You can configure the default Severity for all health checks in theDefault Settings section on theAdministration >
Health Checks and Monitoring > Health Checks page. Formore information on configuring the severity option for
health checks, see "Default Health Check Settings" on page 630.
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Thresholds and Notifications for General Metrics
TheGeneral section on theAdministration > Health Checks and Health Monitoring > Health Monitoring page
displays the thresholds, intervals, and notification settings for general systemmetrics. These values are configurable; see
"Change Threshold and Notification Settings" on page 659 for instructions on changing these settings. Refer to the
following overview of themetrics.

n To view the current state of thesemetrics, see "ViewHealth Monitoring Statistics" on page 447.

n To view the statistics on CPU utilization andmemory utilization on the appliance, see"Statistics" on page 430.

n To view the statistics on interface utilization, refer to the SGOS Administration Guide.

Metric

Default Values

NotesCritical
Threshold/Interval

Warning
Threshold/Interval

CPU Utilization 95% / 120 seconds 80% / 120 seconds Measures the value of the primary CPU on
multiprocessor systems—not the average of all CPU
activity.

Memory Utilization 95% / 120 seconds 90% / 120 seconds Measures memory use and tracks whenmemory
resources become limited, causing new connections to
be delayed.

Interface Utilization 90% / 120 seconds 60% / 120 seconds Measures the traffic (in and out) on the interface to
determine if it is approaching the maximum capacity
(bandwidth maximum).

Cloud Services: Common
Policy Communication
Status

48 hours 24 hours Monitors the success of cloud common policy
synchronization. If a sync fails for 24 hours, a warning
is issued.

ICAP Connections 80% / 120 seconds N/A Sets alert notifications for queued and deferred ICAP
connections.

Default Threshold Values and States
Refer to the following table for a quick glance at the health states and their corresponding threshold values.

Metric
Health States and Corresponding Defaults

OK Warning Critical

CPU Utilization less than 80% 80% 95%

Memory Utilization less than 90% 90% 95%

Interface Utilization less than 60% 60% 90%
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Metric
Health States and Corresponding Defaults

OK Warning Critical

Cloud Services: Common Policy Communication Status less than 24 hours since last successful update 24 hours 48
hours
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Thresholds and Notifications for Licensing Metrics
The Licensing section on theAdministration > Health Checks and Health Monitoring > Health Monitoring page
displays the thresholds, intervals, and notification settings for the utilization of user-limited licenses and the expiration
of time-limited licenses. These values are configurable; see "Change Threshold and Notification Settings" on page 659 for
instructions on changing these settings. Licenses that do not expire or do not have a user limit are not reported here
because there is no need to monitor them for a change in state that could affect the appliance's health. The threshold
values for license expirationmetrics are set in days until expiration. In this context, a critical threshold indicates that
license expiration is imminent. Thus, the Critical threshold value should be smaller than theWarning threshold value. For
example, if you set theWarning threshold to 45, an alert is sent when there are 45 days remaining in the license period.
The Critical threshold would be less than 45 days, for example 5 days. For license expirationmetrics, the threshold
interval is irrelevant and is set to 0.

Refer to the following overview of themetrics. To view the current state of thesemetrics, see "ViewHealth
Monitoring Statistics" on page 447.

Metric Default Values Notes

Critical
Threshold/Interval

Warning Threshold/Interval

User License Utilization 90% / 120 seconds 80% / 120 seconds Monitors the number of users using the
appliance.

License Expiration 0 days / 0 15 days / 0 (For new appliances; see
note below)

Warns of impending license expiration.

SSL Proxy License
Expiration

0 days / 0 30 days / 0 (For existing appliances
upgrading from previous versions)

Warns of impending license expiration.

Cloud Services:
Common Policy
Expiration

0 days / 0 30 days / 0 Monitors the days until entitlement
expiration.

Geolocation Expiration 0 days / 0 30 days / 0 Monitors the days until entitlement
expiration.

CachePulse Expiration 0 days / 0 30 days / 0 Monitors the days until entitlement
expiration.

Application Protection
Expiration

0 days / 0 30 days / 0 Monitors the days until entitlement
expiration.

Content Filter
Expiration

0 days / 0 30 days / 0 Monitors the days until entitlement
expiration.

Application
Classification
Expiration

0 days / 0 30 days / 0 Monitors the days until entitlement
expiration.
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Metric Default Values Notes

Critical
Threshold/Interval

Warning Threshold/Interval

Threat Risk Expiration 0 days / 0 30 days / 0 Monitors the days until entitlement
expiration.

License Server
Communication Status

0 days/0 6 days / 0 Monitors the appliance’s ability to
connect to the license validation server.

License Validation
Status

0 days/0 30 days / 0 Detects license validity.

Default Threshold Values and States
Refer to the following table for a quick glance at the health states and their corresponding threshold values.

Metric
Health States and Corresponding Defaults

OK Warning Critical

User License Utilization less than 80% 80% 90%

License Expiration more than 15 days*

more than 30 days

15 days*

30 days

0 days*

0 days

Cloud Services: Common Policy Expiration more than 30 days 30 days 0 days

Expiration of subscription services such as:

n Application Protection

n CachePulse

n Geolocation

n Application Classification

more than 30 days 30 days 0 days

License Server Communication Status more than 6 days 6 days 0 days

License Validation Status more than 30 days 30 days 0 days

* For new appliances.
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Notifications for Status Metrics
The Status section on theAdministration > Health Checks and Health Monitoring > Health Monitoring page
displays the notification settings for statusmetrics. These values are configurable; see "Change Threshold and
Notification Settings" on page 659 for instructions on changing these settings. Thresholds for thesemetrics are not
configurable and thus not available on this page.

Refer to the following overview of themetrics. To view the current state of thesemetrics, see "ViewHealth
Monitoring Statistics" on page 447.

Metric Threshold States and Corresponding Values

Disk Status Critical:

n Bad

Warning:

n Removed

n Offline

n Present (failing)

n Present (unsupported failing)

OK:

n Not Present

n Present

n Present (unsupported)

Motherboard temperature and CPU
temperature

Threshold states and values depend onmodel.

System Fan Speed

Voltage — Bus Voltage, CPU Voltage,
Power Supply Voltage
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Metric Threshold States and Corresponding Values

ADN Connection OK:

n Connected

n Connecting

n Connection Approved

n Disabled

n Not Operational

Warning:

n Approval Pending

n Mismatching Approval Status

n Partially Connected

Critical:

n Disconnected

n Connection Denied

ADN Manager OK:

n Not a Manager

n No Approvals Pending

Warning:

n Approvals Pending

Health Check OK:

n No health checks with Severity: Warning or Critical are failing. A health check
with Severity: No-effect might be failing.

Warning:

n One or more health checks with Severity: Warning has failed.

Critical:

n One or more health checks with Severity: Critical has failed.

Sensor Count Status On platforms that support it, this metric indicates if environmental sensors (which
monitor temperature, fan speed, and voltage) are operational when the appliance
boots up.
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Metric Threshold States and Corresponding Values

Reboot Informational only: warm restart

System rebooted with the restart regular command: cold restart

System rebooted with restart upgrade command (Restart and Load Default
option) or non-user initiated reboot such as power loss.

Failover Informational only. If a failover occurs, notification is sent by the newmaster:

yyyy-mm-dd hh:mm:ss timezone: master_device_identifier failed.
Appliance_name is the new master.

Default Threshold Values and States
Refer to the following table for a quick glance at the health states and their corresponding threshold values.

Metric
Health States and Corresponding Defaults

OK Warning Critical

Disk status Present/Not
Present/
Present
(unsupported)

Removed/Present
(failing)/Present
(unsupported
failing)

Error

Temperature Varies by model

Fan Speed

Voltage

ADN Connection Status Connected

Connecting

Connection
Approved

Disabled

Not
Operational

Approval Pending

Mismatching
Approval Status

Partially
Connected

Disconnected

Connection
Denied

ADN Manager Status Not a
Manager

No Approvals
Pending

Approval Pending
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Metric
Health States and Corresponding Defaults

OK Warning Critical

Health Check Status No health
checks with
Severity:
Warning or
Critical are
failing. A
health check
with Severity:
No-effect
might be
failing.

One or more
health checks
with Severity:
Warning has
failed.

One or more
health checks
with
Severity:
Critical has
failed.
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Thresholds and Notifications for Subscription Metrics
The Subscription section on theAdministration > Health Checks and Health Monitoring > Health Monitoring
page displays displays the notification settings for subscription services. Although each subscription service is listed
individually, youmust specify a global notificationmethod that applies to every metric. For example, if you select
Application Classification Communication Status and specify Email as the notificationmethod, Email is specified for all
subscription services.

Thresholds and intervals for license expiration are specified permetric on theAdministration > Health Checks and
Health Monitoring > Health Monitoring page.

See "Change Threshold and Notification Settings" on the facing page for instructions on changing the threshold and
notification settings.

Metric Threshold States and Corresponding Values

Local Database

Note: The default local database metric is
'Local Database default' and each custom
database metric is 'Local Database database_
name’.

Symantec WebFilter

Proventia Database

Optenet Database

IWF Database

Content Filter

Application Classification

Threat Risk

Application Attributes

Application Protection

CachePulse

Geolocation

OK:

n No update errors

Warning:

n 10 or more subsequent database downloads (after
the first successful one) have failed.

Critical:

n When the feature is first enabled, the initial attempt to
download the database failed: <service_name>
failed on initial download

n 20 or more subsequent database downloads (after
the first successful one) have failed.
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Change Threshold and Notification Settings
When available, you can configure the thresholds for themetrics to suit your network requirements. For the defaults,
see "About Health MonitoringMetric Types" on page 648 more information.

For healthmonitoring notifications, by default, all alerts arewritten to the event log. Any combination of the following
types of notification can be set:

n Log: Inserts an entry into the event log. See "Configure Event Logging" on page 595 formore information.

n SNMP trap: Sends an SNMP trap to all configuredmanagement stations. See "Use SNMP to Monitor Network
Devices" on page 608 formore information

n E-mail: Sends e-mail to all persons listed in the Event log properties. To use this option, youmust add the recipient
list to the event logMail option and ensure a valid SMTP gateway is specified. See "Configure Event Logging" on
page 595 formore information.

Use the following procedure to modify the current settings.

1. In the Admin Console, select Administration > Health Checks and Monitoring > Health Monitoring.

2. In theGeneral, Licensing, Status, or Subscription section, select Edit for themetric to modify.

An Edit <metric_name> dialog opens.

3. Modify the threshold values (depending on themetric, some values are not applicable):

n To change the critical threshold, enter a new value in theCritical Threshold field.

n To change the critical interval, enter a new value in theCritical Interval field.

n To change thewarning threshold, enter a new value in theWarning Threshold field.

n To change thewarning interval, enter a new value in theWarning Interval field.

4. Modify the notification settings.

n To add an entry to the event log, select Log.

n To send an SNMP trap to all configuredmanagement stations, select SNMP.

n Tomail all defined email recipients, select Email.

In the following example, the thresholds are unchanged and all notificationmethods are selected.
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See "Configure Event Logging" on page 595 formore information.
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Service Information
n "Send Service Information to Support" on page 663

Send service information to Symantec for troubleshooting. Specify whether to send service info manually or
automatically when the appliance stops responding.

n "About Snapshots" on page 666

Take periodic snapshots of system information or advanced statistics. View and download snapshots to help
troubleshoot technical issues.

n "About Packet Capture" on page 669

Configure packet capture (PCAP). Start, stop, and download PCAP. View current statistics about PCAP.

n "Policy Tracing for Troubleshooting" on page 673

Temporarily enable or disable global policy tracing for troubleshooting.
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Service Information Summaries
In the Admin Console, you can use snapshots and packet captures to provide diagnostic information.

n "View and Download Snapshots" below: SysInfo provides a snapshot of statistics and events on the appliance.

n "View, Run, and Download Packet Captures" below: Use this onboard packet capture utility to capture packets of
Ethernet frames going in or out of an appliance.

View and Download Snapshots
To configure snapshot jobs, see "About Snapshots" on page 666.

To view and download snapshots:

1. In the Admin Console, select Administration > Service Information > Summary.

2. In Snapshots Link, select View all snapshots.

The browser opens a newwindowwith a list of the 100 most recent snapshots.

3. To view a snapshot, select theView link for a snapshot in the list.

To download a snapshot, select theDownload link for a snapshot in the list.

View, Run, and Download Packet Captures
To configure packet captures, see "About Packet Capture" on page 669.

To view, run, and download packet captures:

1. In the Admin Console, select Administration > Service Information > Summary.

2. In Packet Capture Links, select the appropriate link for a task.

Link Description

Show packet capture statistics Shows current packet capture data.

Start packet capture or Stop packet capture Starts the packet capture or stops one in progress.

Download packet capture file Downloads packet capture data.
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Send Service Information to Support
The service information options allow you to send service information to Symantec using either the Admin Console or
the CLI. You can select the information to send, send the information, view the status of current transactions, and cancel
current transactions. You can also send service information automatically in case of a crash.

You can send service information to Symantec Support as needed, automatically when a crash occurs, or at regular
intervals.

Send Service Information Immediately
You can send service information to Symantec using either the Admin Console or the CLI. For information about sending
service information automatically, see "Send Service Information Automatically" on the next page. To send service
information on a specified schedule, see "Send Service Information Periodically" on the next page.

Youmust specify a case number before you can send service information. Refer to Symantec Support formore
information searching and creating cases:

https://support.broadcom.com

The following list details information that you can send:

n packet captures

n event logs, whichmust be enabled and logging event data

n memory cores

n policy trace file

n SysInfo

n access logs, whichmust be enabled and logging traffic data

n snapshots, whichmust be enabled and created on the system

n contexts

To send service information immediately:

1. In the Admin Console, select Administration > Service Information > Send Information.

2. In Send Selected Info Now, expand Select show and send.

3. Enter a valid case number in theAuto-Send Case Number field.

4. In the list of service information types, select the information to send.

If you select Access Logs, Snapshots, or Contexts, youmust also specify the files to send.
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Options for items that you do not have on your system are unavailable and can't be selected.

5. Select Send.

Send Service Information Automatically
Enabling automatic service information allows you to enable the transfer of relevant service information automatically
whenever a crash occurs. This saves you from initiating the transfer, and increases the amount of service information
that Symantec can use to solve the problem. The core image, system configuration, and event log are system-use
statistics that are sent for analysis. If a packet capture exists, it is also sent. The auto-send feature requires that a valid
support case is entered. If you do not have an open case youmust first contact Symantec Support.

Caution: A core image and packet capture can contain sensitive information— for
example, parts of an HTTP request or response. The transfer to Symantec is encrypted,
and therefore secure; however, to avoid sending potentially sensitive information to
Symantec, disable automatically sending the service information.

To send service information automatically:

1. In the Admin Console, select Administration > Service Information > Send Information.

2. In Automatic Operation, enter a valid case number in theAuto-Send Service Request Number field.

3. (If applicable) In the CustomReports section, select files to include in the automatic upload. If no custom access
logs or snapshot jobs are configured, this section is empty.

4. Switch theAutomatically send service information on crash toggle.

Send Service Information Periodically
You can send service information reports at regular intervals to Symantec Support.

To send service information periodically:

1. In the Admin Console, select Administration > Service Information > Send Information.

2. In Periodic Operation, enter a valid case number in the Periodic-Send Service Case Number field.

3. In the Interval field, enter the number of hours between sending reports. The default value is 24.

4. In theMaximum Number Of Reports To Send field, specify themaximumnumber of reports to include. The
default value is 10.

5. (If applicable) In the CustomReports section, select files to include in the automatic upload. If no custom access
logs or snapshot jobs are configured, this section is empty.

6. Switch the Periodically send service information toggle.
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Manage the Bandwidth for Service Information
You can control the allocation of available bandwidth for sending service information. Some service information items
are large, and youmight want to limit the bandwidth used by the transfer. Changing to a new bandwidthmanagement
class does not affect service information transfers already in progress. Changing the details of the bandwidth
management class used for service information, such as changing theminimumormaximumbandwidth settings, affects
transfers already in progress if that class was selected prior to initiating the transfer.

Note: Before you canmanage the bandwidth for the automatic service information
feature, youmust first create an appropriate bandwidthmanagement class.

To manage bandwidth for service information:

1. In the Admin Console, select Administration > Service Information > Send Information.

2. In Bandwidth Classes, switch theUse a Bandwidth Class to send service information toggle.

3. In theBandwidth Class list, select a bandwidth class.
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About Snapshots
The snapshot subsystemperiodically pulls a specified console URL and stores it in a repository, offering valuable
resources for Symantec customer support in diagnosing problems. By default, two System Information (SysInfo)
snapshots are defined:

n sysinfo: Takes a snapshot of the system information URL once every 24 hours. This snapshot job keeps the last
100 snapshots.

n sysinfo-stats: Takes an hourly snapshot of the system information statistics (sysinfo-stats). This snapshot job
keeps the last 168 snapshots. Determining which console URL to poll, the time period between snapshots, and
howmany snapshots to keep are all configurable options for each snapshot job.

You can also add snapshot jobs for any advanced statistic on the appliance. See "Advanced Statistics" on page 436 for
details.

Snapshot jobs configured on the appliance are available in the Admin Console at Administration > Service
Information > Snapshots. The Snapshots Jobs section shows the following:

Setting or field Description

Enable (Not available for system-defined jobs, which are always
enabled) Shows whether the snapshot job is enabled. When
enabled, the job runs at the set Interval.

Name Name of the snapshot job.

Target Source SysInfo or advanced statistic URL of the snapshot.

Interval Intervening time between each job, expressed in minutes. 

Take Total number of snapshots to take for the job. If there is no
limit, takes are Infinite.

Keep Maximum number of snapshots to store for the job.

Next Snapshot The time that the next job is configured to start, expressed in
UTC.

Edit Edit the current job. See "Configure Snapshot Jobs" on
page 668 .

Download All Reports Download all snapshots taken for the current job. The system
downloads the snapshots as a gzip file named snapshot_
name.txt.gz.

Clear All Reports Delete all saved snapshots for the current job. On the Clear
Snapshot Reports dialog, select Clear to confirm deletion.

Delete (Not available for system-defined jobs) Delete the current
job.
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Tip: When troubleshooting issues with Symantec Technical Support, youmight be
requested to configure snapshot jobs with non-default settings.

To view all snapshots information, select the Show All Snapshots link. The browser opens a newwindowwith a list of
the 100 most recent snapshots.

See Also:

n "Configure Snapshot Jobs" on the next page
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Configure Snapshot Jobs
To add or edit snapshot jobs:

1. In the Admin Console, select Administration > Service Information > Snapshots.

2. In the Snapshot Jobs section:

n To create a new job, select Add Job.

n To edit an existing job, select it or select Edit under Actions.

The Add/Edit Snapshot Job page displays job settings.

3. Enter or edit the following settings as needed:

Setting or field Description

Enable job
executions

(Not available for system-defined jobs, which are always enabled) Enable the job to run. When
enabled, the job runs at the set Interval.

Name Specify a unique name for the snapshot job.

Target Select the source SysInfo or advanced statistic URL of the snapshot. The Select Target dialog
displays all available system targets.

Interval Specify how often to execute the job, in minutes. Default is 1440.

Total number to
take

Specify the total number of snapshots to take for the job:

n Default is Infinite; snapshots are taken unless job execution is disabled.

n Enter a number.

Maximum number
to keep

Specify the maximum number of snapshots to store for the job. Default is 30.
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About Packet Capture
A packet capture (PCAP) captures all received packets that are either directly addressed to the appliance through an
interface’s MAC address or through an interface’s broadcast address. The utility also captures transmitted packets that
are sent from the appliance. The collected data can then be transferred to the desktop or to Broadcom for analysis.

Running PCAP increases the amount of processor usage performed in TCP/IP. To analyze captured packet data, you
must have a tool that reads Packet Sniffer Pro 1.1 files (such asWireshark or Packet Sniffer Pro 3.0).

You can capture packets of Ethernet frames going into or leaving an appliance. Packet capturing allows filtering on
various attributes of the frame to limit the amount of data collected. Any packet filtersmust be defined before a capture
is initiated, and the current packet filter can only bemodified if no capture is in progress.

Configure PCAP
You can configure packet capturing and start a capture. To control which packets are captured, specify a filter
expression.

Note: To analyze captured packet data, youmust have a tool that reads Packet Sniffer Pro
1.1 files (for example, Ethereal or Packet Sniffer Pro 3.0).

In the Admin Console, select Administration > Service Information > Packet Capture. The Capture section displays
options for configuring and running captures.

Setting or
field

Description

Direction Capture incoming, outgoing, or all packets.

Interface Capture packets through a specified interface or all interfaces.

Filter Define or change the PCAP filter expression. Type an expression in the field, or select Expressions to select from a
list of templates. In the list of Common PCAP Filter Expressions dialog that opens, select an expression to insert into
the Filter field.

To remove the filter, select Clear.

For more information, see "Common PCAP Filter Expressions" on the next page.

Start
Capture

Specify settings for the packet capture; see "Packet Capture Settings" on page 671. Then, select Start Capture.

When you start the capture, the console displays a "Capture in Progress" message and options to stop the capture.

Download Download the last PCAP.
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Setting or
field

Description

Stop

Stop and
Download

(Available when a packet capture is in progress) Stop the capture without downloading, or stop the capture and
download the file.

The name of a downloaded packet capture file has the format:

bluecoat_date_filter-expression.cap

where date is the UTC date and time of the packet capture and filter-expression is the filter expression(s)
used.

Note: Because the filter expression can contain characters that are not supported by
a file system, a translation can occur. The following characters are not translated:
- Alphanumeric characters (a-z, A-Z, 0-9)
- Periods (.)

The following characters are translated:
- Space (replaced by an underscore)
- All other characters (including the underscore and dash) are replaced by a dash
followed by the ASCII equivalent; for example, a dash is translated to -2D and an
ampersand (&) to -26.

After the file is downloaded, you can upload it to a remote server using FTP. See "Upload Packet Capture Data Via
FTP" on page 672.

Refresh
Status

Update the details in the Status field.

Status Shows the status of the last or current capture.

Common PCAP Filter Expressions
When running a PCAP, you can filter on various attributes of the frame to limit the amount of data collected.

Specify filters in Berkeley Packet Filter (BPF) format , which is also used by the tcpdump program. A few simple examples
are provided below. If filters with greater complexity are required, refer to sources on the Internet and in books that
describe the BPF syntax.

Note: Somequalifiersmust be escaped with a backslash because their identifiers are also
keywords within the filter expression parser:
- ip proto protocol
where protocol is a number or name (icmp, udp, tcp)
- ether proto protocol
where protocol can be a number or name (ip, arp, rarp)
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PCAP Filter Expressions

Seemore filter expressions in the Admin Console by selectingAdministration > Service Information > Packet
Capture. In the Capture section, select Expressions.

Filter Expression Packets Captured

ip host 10.25.36.47 Captures packets from a specific host with IP address 10.25.36.47.

not ip host 10.25.36.47

not port 8082

Captures packets from all IP addresses except 10.25.36.47.

Captures packets from all ports except 8082.

ip host 10.25.36.47 and ip host
10.25.36.48

Captures packets sent between two IP addresses: 10.25.36.47 and
10.25.36.48.

Packets sent from one of these addresses to other IP addresses are not
filtered.

ether host 00:e0:81:01:f8:fc Captures packets to or fromMAC address 00:e0:81:01:f8:fc:.

port 80 Captures packets to or from port 80.

Using Filter Expressions in the CLI

To specify filters using CLI, issue the following command:

# pcap filter expr parameters

Tip: Define parameters within double quotationmarks to avoid confusion with special
characters. For example, a space is interpreted by the CLI as an additional parameter, but
the CLI accepts only one parameter for the filter expression. Enclosing the entire filter
expression in quotations allowsmultiple spaces in the filter expression.

To remove a filter, use the command:

# pcap filter

Packet Capture Settings
On the Start Packet Capture dialog, specify the following settings:
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Setting Description

Buffer
size

Capture Allmatching packets or Selected packets.

If capturing selected packets, specify one of the following:

n first nmatching packets. If the number of packets reaches this limit, packet capturing stops automatically. n is
a value between 1 and 1000000.

n last nmatching packets. Any packet received after the memory limit is reached results in the discarding of the
oldest saved packet prior to saving the new packet. The saved packets in memory are written to disk when the
capture is stopped. n is a value between 1 and 1000000.

n first nmatching kbytes. Enter the number of kilobytes to capture. If the buffer reaches this limit, packet
capturing stops automatically. The value is limited to 3% of the available systemmemory at startup (not to
exceed 4GB). If a value is not specified, the default packet capture file size is 100MB.

n last nmatching kbytes. Any packet received after the memory limit is reached results in the discarding of the
oldest saved packet prior to saving the new packet. The saved packets in memory are written to disk when the
capture is stopped. The value is limited to 3% of the available systemmemory at startup (not to exceed 4GB). If
a value is not specified, the default packet capture file size is 100MB.

Byte
limit
per
packet

(Optional) Truncate the number of bytes saved in each frame. Select Save First and enter a number between 1 and
65535 in the bytes of each packet field.

Packet capture collects no more than the specified bytes of packets from each frame when writing to disk.

Bytes
to keep
in core
image

(Optional) Number of kilobytes of packets kept in a core image. Select Include and enter a value in the K Bytes in
core image field. You can capture packets and include them along with a core image. This is extremely useful if a
certain pattern of packets causes the unit to restart unexpectedly. The core image size The value is limited to 3% of
the available systemmemory at startup (not to exceed 4GB). By default, no packets are kept in the core image.

Upload Packet Capture Data Via FTP
Use the following command to transfer packet capture data from the appliance to an FTP site. After uploading is
complete, you can analyze the packet capture data.

# pcap transferftp://url/path/filename.cap username password

If the FTP server requires a username and password, specify them.

672 of 676



SGOS Administration (Admin Console Edition)

Policy Tracing for Troubleshooting
Use global policy tracing to troubleshoot issues with users' access to websites or other resources. You can also enable
policy tracing in a policy rule, which traces only transactions that match a specific policy rule. Policy rule-generated traces
can significantly limit the number of entries in the resulting trace file, which canmake trace inspection easier. Refer to the
Content Policy Language Reference formore information.

You can view the contents of trace files are generated though the global setting or a policy rule.

Enable Global Policy Trace

Caution: Global policy tracing records every policy-related event in every layer, and
should only be used for troubleshooting. Tracing all policy execution requires heavy CPU
resources, and also generates a large trace file. Policy tracing also slows down the
appliance's ability to handle traffic. It is unwise to use policy tracing in production
environments.

Enable global policy tracing:

1. In the Admin Console, select Administration > Service Information > Policy Tracing.

2. In theGlobal Policy Tracing section, select the Enable Global Policy Tracing switch.

3. Specify the tracing level:

n (Default) Proxy Traffic: Trace traffic related to client requests.

n All Execution: Trace all traffic. Select this option formost troubleshooting scenarios.

4. Select Save.

5. Troubleshoot the issue.

6. Select the Enable Global Policy Tracing switch to disable global policy tracing.

7. Select Save.

View Policy Trace Files
You can view policy trace files that were generated on the appliance. The contents of trace files are in plain text, and
open in a new browser tab.

Files created from the global policy trace are named default_trace.html. When you use policy (such as the Trace
VPM object) to generate a trace, you can specify a destination folder and the name of the policy trace. In the following
example, the policy rule-generated trace file name is located in test and is named custom.html.
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View policy trace files:

1. In the Admin Console, select Administration > Service Information > Policy Tracing.

2. In the Policy Trace Files section, select a policy trace name to view it.

The file opens in a new browser tab. If prompted to enter the Edge SWG (ProxySG) username and password, enter
them in the dialog that appears.

To delete a policy trace file, select the delete icon beside the name. Alternatively, select Delete All Files to delete
all generated trace files. On the confirmation dialog that appears, select Delete.

The following example shows the policy trace file contents in plain text. In addition, the last line shows the
trace.destination("test.custom") property, which specifies the location and name of the trace file.
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Documentation Legal Notice

This Documentation, which includes embedded help systems and electronically distributedmaterials, (hereinafter
referred to as the “Documentation”) is for your informational purposes only and is subject to change or withdrawal by
Broadcom at any time. This Documentation is proprietary information of Broadcom andmay not be copied, transferred,
reproduced, disclosed, modified or duplicated, in whole or in part, without the prior written consent of Broadcom.

If you are a licensed user of the software product(s) addressed in theDocumentation, youmay print or otherwisemake
available a reasonable number of copies of the Documentation for internal use by you and your employees in
connection with that software, provided that all Broadcom copyright notices and legends are affixed to each reproduced
copy.

The right to print or otherwisemake available copies of the Documentation is limited to the period during which the
applicable license for such software remains in full force and effect. Should the license terminate for any reason, it is
your responsibility to certify in writing to Broadcom that all copies and partial copies of the Documentation have been
returned to Broadcomor destroyed.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, BROADCOM PROVIDES THIS DOCUMENTATION “AS IS” WITHOUT
WARRANTYOF ANY KIND, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT. IN NO EVENTWILL BROADCOM BE LIABLE TO YOU OR
ANY THIRD PARTY FOR ANY LOSSOR DAMAGE, DIRECTOR INDIRECT, FROM THEUSEOF THIS DOCUMENTATION,
INCLUDING WITHOUT LIMITATION, LOST PROFITS, LOST INVESTMENT, BUSINESS INTERRUPTION, GOODWILL, OR LOST
DATA, EVEN IF BROADCOM IS EXPRESSLY ADVISED IN ADVANCEOF THE POSSIBILITYOF SUCH LOSSOR DAMAGE.

The use of any software product referenced in theDocumentation is governed by the applicable license agreement and
such license agreement is not modified in any way by the terms of this notice.

Themanufacturer of this Documentation is Broadcom Inc.

Provided with “Restricted Rights.” Use, duplication or disclosure by theUnited States Government is subject to the
restrictions set forth in FAR Sections 12.212, 52.227-14, and 52.227-19(c)(1) - (2) and DFARS Section 252.227-7014(b)
(3), as applicable, or their successors.

Copyright © 2005-2022 Broadcom. All Rights Reserved. The term “Broadcom” refers to Broadcom Inc. and/or its
subsidiaries. All trademarks, trade names, servicemarks, and logos referenced herein belong to their respective
companies.

.
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